Trend Micro Incorporated reserves the right to make changes to this document and to the product described herein without notice. Before installing and using the product, review the readme files, release notes, and/or the latest version of the applicable documentation, which are available from the Trend Micro website at:


Trend Micro, the Trend Micro t-ball logo, Apex Central, eManager, and ScanMail are trademarks or registered trademarks of Trend Micro Incorporated. All other product or company names may be trademarks or registered trademarks of their owners.

Copyright © 2019. Trend Micro Incorporated. All rights reserved.

Document Part No.: SMEM148567/1901034

Release Date: March 2019

Protected by U.S. Patent No.: 5,951,698
This documentation introduces the main features of the product and/or provides installation instructions for a production environment. Read through the documentation before installing or using the product.

Detailed information about how to use specific features within the product may be available at the Trend Micro Online Help Center and/or the Trend Micro Knowledge Base.

Trend Micro always seeks to improve its documentation. If you have questions, comments, or suggestions about this or any Trend Micro document, please contact us at docs@trendmicro.com.

Evaluate this documentation on the following site:

http://www.trendmicro.com/download/documentation/rating.asp
Privacy and Personal Data Collection Disclosure

Certain features available in Trend Micro products collect and send feedback regarding product usage and detection information to Trend Micro. Some of this data is considered personal in certain jurisdictions and under certain regulations. If you do not want Trend Micro to collect personal data, you must ensure that you disable the related features.

The following link outlines the types of data that ScanMail for Microsoft Exchange collects and provides detailed instructions on how to disable the specific features that feedback the information.


Data collected by Trend Micro is subject to the conditions stated in the Trend Micro Privacy Policy:

# Table of Contents

## Preface

Preface ............................................................................................................................ ix  
ScanMail Documentation ............................................................................................... x  
Audience ....................................................................................................................... x  
Document Conventions ................................................................................................. xi

## Part I: Introducing ScanMail and Getting Started

### Chapter 1: Introducing Trend Micro ScanMail for Microsoft Exchange

- System Requirements ................................................................................................. 1-2  
- What’s New ............................................................................................................... 1-6  
- Features and Benefits ............................................................................................... 1-7  
- Version Comparison ................................................................................................. 1-17  
- How ScanMail Protects the Microsoft Exchange Environment ......................... 1-19  
- About Uncleanable Files .......................................................................................... 1-23  
- ScanMail Technology ............................................................................................... 1-23

### Chapter 2: Getting Started with ScanMail

- Getting Started ........................................................................................................... 2-2  
- Understanding the Product Console .......................................................................... 2-2  
- ScanMail Registration ............................................................................................... 2-9  
- ScanMail Activation ................................................................................................. 2-11  
- About ScanMail Updates .......................................................................................... 2-17  
- Office 365 Protection with Trend Micro Cloud App Security ......................... 2-22
Chapter 3: Establishing and Maintaining Security for Your Exchange Servers

Establishing a Security Baseline ................................................................. 3-2
Maintaining Security .............................................................................. 3-3
Managing Outbreak Situations ............................................................. 3-4

Chapter 4: Managing ScanMail

Understanding Real-time Monitor ......................................................... 4-2
Understanding the Server Management Console ............................. 4-4
Starting and Stopping the Services ..................................................... 4-10
Understanding ScanMail Icons .......................................................... 4-10

Part II: Configuring Scans and Scan Filters

Chapter 5: Understanding Smart Protection

About Trend Micro Smart Protection ......................................................... 5-2
Configuring Local Sources ................................................................. 5-7
Scan Service Settings ......................................................................... 5-8

Chapter 6: Configuring Scans

About Scans .......................................................................................... 6-2
Compressed File Handling ................................................................. 6-7
About ScanMail Actions .................................................................... 6-9
Notifications ....................................................................................... 6-23

Chapter 7: Configuring Security Risk Scans

About Security Risk Scans ................................................................. 7-2
ScanMail Scan Hierarchy ................................................................. 7-3
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Configuring Attachment Blocking</td>
<td>8-2</td>
</tr>
<tr>
<td></td>
<td>About Attachment Blocking</td>
<td>8-2</td>
</tr>
<tr>
<td></td>
<td>Enabling Real-time Attachment Blocking</td>
<td>8-3</td>
</tr>
<tr>
<td></td>
<td>About the Attachment Blocking Global Policy</td>
<td>8-3</td>
</tr>
<tr>
<td></td>
<td>Adding an Exception to the Attachment Blocking Global Policy</td>
<td>8-7</td>
</tr>
<tr>
<td></td>
<td>Editing an Attachment Blocking Exception</td>
<td>8-8</td>
</tr>
<tr>
<td>9</td>
<td>Configuring Content Filtering</td>
<td>9-2</td>
</tr>
<tr>
<td></td>
<td>About Content Filtering</td>
<td>9-2</td>
</tr>
<tr>
<td></td>
<td>Enabling Real-time Content Filtering</td>
<td>9-3</td>
</tr>
<tr>
<td></td>
<td>Global Settings</td>
<td>9-4</td>
</tr>
<tr>
<td></td>
<td>Configuring Content Filtering Policies</td>
<td>9-4</td>
</tr>
<tr>
<td></td>
<td>Configuring a Content Filtering Exception</td>
<td>9-13</td>
</tr>
<tr>
<td></td>
<td>Editing a Content Filtering Policy</td>
<td>9-14</td>
</tr>
<tr>
<td>10</td>
<td>Configuring Data Loss Prevention</td>
<td>10-2</td>
</tr>
<tr>
<td></td>
<td>About Data Loss Prevention (DLP)</td>
<td>10-2</td>
</tr>
<tr>
<td></td>
<td>Data Identifier Types</td>
<td>10-2</td>
</tr>
<tr>
<td></td>
<td>About Data Loss Prevention Templates</td>
<td>10-12</td>
</tr>
<tr>
<td></td>
<td>About Data Loss Prevention Policies</td>
<td>10-17</td>
</tr>
</tbody>
</table>
Chapter 11: Configuring Spam Prevention
- About Spam Prevention .............................................................................. 11-2
- About Email Reputation .............................................................................. 11-3
- About Content Scanning .............................................................................. 11-6

Chapter 12: Configuring Advanced Spam Prevention
- About Advanced Spam Prevention ........................................................... 12-2
- Configuring Advanced Spam Prevention Settings ................................. 12-3
- Configuring Writing Style Training Settings ............................................. 12-6
- Configuring Writing Style Verification Settings ........................................ 12-8

Chapter 13: Configuring Web Reputation
- About Web Reputation Services ............................................................... 13-2
- Configuring the Web Reputation Scan Service ......................................... 13-3
- Enabling Web Reputation ........................................................................... 13-4
- Configuring Web Reputation Targets ....................................................... 13-4
- Configuring Web Reputation Actions ....................................................... 13-5
- Configuring Web Reputation Notifications ............................................ 13-6

Chapter 14: Configuring URL Time-of-Click Protection
- About URL Time-of-Click Protection ......................................................... 14-2
- Enabling URL Time-of-Click Protection ..................................................... 14-2
- Configuring URL Time-of-Click Protection .............................................. 14-2

Chapter 15: Configuring Search & Destroy
- About Search & Destroy ............................................................................. 15-2
- Configuring Search & Destroy Access Accounts ....................................... 15-2
- Activating Search & Destroy ....................................................................... 15-4
About Mailbox Searches ............................................................... 15-6
Configuring a Mailbox Search ....................................................... 15-13
Configuring Search & Destroy Settings ........................................ 15-20
Viewing Search & Destroy Event Logs ........................................ 15-21
Troubleshooting Search & Destroy .............................................. 15-22

Chapter 16: Configuring Virtual Analyzer

About Virtual Analyzer ............................................................... 16-2
Configuring Virtual Analyzer Settings ........................................ 16-3

Part III: Managing ScanMail

Chapter 17: Managing the Quarantine Area

About the Quarantine ............................................................... 17-2
Configuring the Quarantine Folder/Directory .............................. 17-2
Performing a Quarantine Query ............................................... 17-3
Scheduling Automatic Quarantine Maintenance ....................... 17-4
Manually Performing Quarantine Maintenance ......................... 17-5
Resending Quarantined Messages ............................................ 17-5

Chapter 18: Monitoring ScanMail

Viewing the Summary Screen .................................................... 18-2
About Alerts .............................................................................. 18-6
About Reports ........................................................................... 18-12
About Logs ................................................................................ 18-15

Chapter 19: Performing Administrative Tasks

Configuring Proxy Settings ....................................................... 19-2
Configuring External Disclaimer ............................................. 19-2
Part IV: Getting Help

Chapter 20: Understanding Security Risks

Understanding the Terms ................................................................. 20-2
About Internet Security Risks .......................................................... 20-2
About Spyware/Grayware ................................................................. 20-13

Chapter 21: Frequently Asked Questions

Scanning and Updating ................................................................. 21-2
Expressions and Keywords .......................................................... 21-3
File Handling ................................................................................. 21-13
Quarantine and Log Management .............................................. 21-15
Logs, Quarantine Records, and Server Groups ......................... 21-19
Logging On and Registration ..................................................... 21-20
Security Threats ............................................................................. 21-24
Virtual Analyzer ............................................................................. 21-28
Chapter 22: Troubleshooting

Updating the Scan Engine Manually ......................................................... 22-2
Updating the Pattern File (lpt$vpn.xxx) Manually .................................. 22-3
Known Issues ................................................................................................. 22-4

Chapter 23: Technical Support

Troubleshooting Resources ......................................................................... 23-2
Contacting Trend Micro ............................................................................... 23-3
Sending Suspicious Content to Trend Micro ........................................... 23-4
Other Resources .............................................................................................. 23-5

Appendix A: ScanMail Windows Event Log Codes

Appendix B: Best Practices

Set Up Account for Installation with Microsoft Windows Authentication ........................................................................................................................ B-2
Real-time Scan Settings for Server Roles ................................................... B-2
Attachment Blocking Policies ................................................................. B-3
   Exception Rule Replication ................................................................. B-4
   Sample Usage Scenarios ................................................................. B-4
Content Filtering Active Directory Integrated Policies ....................... B-5
   Content Filtering Policy Replication ........................................ B-6
Data Loss Prevention Policies ............................................................... B-6
   Data Identifiers and Template Creation ....................................... B-7
   Data Loss Prevention Policy Replication .................................... B-8
Data Loss Prevention: Hidden Keys .................................................... B-8
Optimizing Web Reputation .................................................................. B-9
   Troubleshooting Web Reputation Performance Issues ............ B-10
Search & Destroy Best Practices .............................................................. B-10
   Search & Destroy Prerequisites ................................................ B-11
   Using Search & Destroy in Mixed Exchange Environments ...... B-12
Configuring Search & Destroy in a Multiple Data Center Environment .............................................................. B-14
Optimizing Search Criteria ................................................................. B-14
Optimizing Mailbox Searches ............................................................ B-15
Deleting Mailbox Searches ................................................................. B-15
Exchange Management Shell Commands ....................................... B-16
Virtual Analyzer - Integration Pre-requisites ........................................... B-18
Internal Domains ................................................................................ B-19
Recommended Settings ............................................................................... B-20

Index

Index .............................................................................................................. IN-1
Welcome to the Trend Micro™ ScanMail™ for Microsoft™ Exchange Administrator’s Guide. This book contains basic information about the tasks you need to perform to manage ScanMail to protect your Exchange servers. It is intended for novice and advanced users of ScanMail who want to manage ScanMail.

This preface discusses the following topics:

- ScanMail Documentation on page x
- Audience on page x
- Document Conventions on page xi
ScanMail Documentation

The product documentation consists of the following:

- **Online Help**: Web-based documentation that is accessible from the product console

  The Online Help contains explanations about ScanMail features.

- **Installation and Upgrade Guide**: PDF documentation that discusses requirements and procedures for installing and upgrading the product

- **Administrator's Guide**: PDF documentation that discusses getting started information and product management

- **Readme File**: Contains late-breaking product information that might not be found in the other documentation. Topics include a description of features, installation tips, known issues, and product release history.

- **Knowledge Base**: Contains the latest information about all Trend Micro products. Other inquiries that were already answered are also posted and a dynamic list of the most frequently asked question is also displayed.

  [http://esupport.trendmicro.com](http://esupport.trendmicro.com)

---

**Note**


---

**Audience**

The ScanMail documentation assumes a basic knowledge of security systems, including:

- Antivirus and content security protection
- Spam protection
• Network concepts (such as IP address, netmask, topology, LAN settings)
• Various network topologies
• Microsoft Exchange Server administration
• Microsoft Exchange Server 2019, 2016 and 2013 server role configurations
• Various message formats

Document Conventions

The documentation uses the following conventions.

**Table 1. Document Conventions**

<table>
<thead>
<tr>
<th>CONVENTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>UPPER CASE</td>
<td>Acronyms, abbreviations, and names of certain commands and keys on the keyboard</td>
</tr>
<tr>
<td><strong>Bold</strong></td>
<td>Menus and menu commands, command buttons, tabs, and options</td>
</tr>
<tr>
<td><em>Italics</em></td>
<td>References to other documents</td>
</tr>
<tr>
<td>Monospace</td>
<td>Sample command lines, program code, web URLs, file names, and program output</td>
</tr>
<tr>
<td><strong>Navigation &gt; Path</strong></td>
<td>The navigation path to reach a particular screen</td>
</tr>
<tr>
<td></td>
<td>For example, <strong>File &gt; Save</strong> means, click <strong>File</strong> and then click <strong>Save</strong> on the interface</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Configuration notes</td>
</tr>
<tr>
<td><strong>Tip</strong></td>
<td>Recommendations or suggestions</td>
</tr>
<tr>
<td>CONVENTION</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>! Important</td>
<td>Information regarding required or default configuration settings and product limitations</td>
</tr>
<tr>
<td>! WARNING!</td>
<td>Critical actions and configuration options</td>
</tr>
</tbody>
</table>
Part I

Introducing ScanMail and Getting Started
Introducing Trend Micro ScanMail for Microsoft Exchange

Trend Micro™ ScanMail™ for Microsoft™ Exchange protects your Exchange mail servers. Once installed, ScanMail can protect your servers from viruses/malware, Trojans, worms, spyware/grayware and malicious URLs. ScanMail also sustains business and network integrity by filtering spam messages and messages containing undesirable or unwanted content. ScanMail notifications send timely alerts to administrators or other designated individuals whenever significant system events or outbreak activities occur.

Topics include the following:

• System Requirements on page 1-2
• What’s New on page 1-6
• Features and Benefits on page 1-7
• Version Comparison on page 1-17
• How ScanMail Protects the Microsoft Exchange Environment on page 1-19
• About Uncleanable Files on page 1-23
• ScanMail Technology on page 1-23
System Requirements

The following lists the system requirements for running Trend Micro™ ScanMail™ for Microsoft™ Exchange.

ScanMail with Exchange Server 2019

The following table lists the system requirements for running ScanMail with Exchange Server 2019.

**TABLE 1-1. System Requirements for Installation with Exchange Server 2019**

<table>
<thead>
<tr>
<th>RESOURCE</th>
<th>REQUIREMENTS</th>
</tr>
</thead>
</table>
| Processor         | • x64 architecture-based processor that supports Intel™ 64 architecture (formally known as Intel EM64T)  
                     • x64 architecture-based computer with AMD™ 64-bit processor that supports AMD64 platform |
| Memory            | 4GB RAM exclusively for ScanMail                                             |
| Disk space        | 5GB free disk space                                                          |
|                   | At least 30GB during installation                                            |
| Operating System  | Microsoft™ Windows Server™ 2019 Standard or Datacenter (64-bit)              |

**Note**

For ScanMail deployment on Server Core edition, Trend Micro recommends running installation package on Windows Server with Desktop Experience feature and deploy ScanMail remotely.

<table>
<thead>
<tr>
<th>Mail Server</th>
<th>Microsoft Exchange Server 2019 or above</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Server</td>
<td>• Microsoft Internet Information Services (IIS) 10.0</td>
</tr>
<tr>
<td>Browser</td>
<td>• Microsoft™ Internet Explorer™ 7.0 or above</td>
</tr>
<tr>
<td></td>
<td>• Mozilla Firefox™ 3.0 or above</td>
</tr>
</tbody>
</table>
Introducing Trend Micro ScanMail for Microsoft Exchange

**Resource Requirements**

<table>
<thead>
<tr>
<th>MSXML</th>
<th>4.0 Service Pack 2 or above</th>
</tr>
</thead>
<tbody>
<tr>
<td>.NET framework</td>
<td>4.7.2</td>
</tr>
</tbody>
</table>

ScanMail with Exchange Server 2016

The following table lists the system requirements for running ScanMail with Exchange Server 2016.

**TABLE 1-2. System Requirements for Installation with Exchange Server 2016**

<table>
<thead>
<tr>
<th>RESOURCE</th>
<th>REQUIREMENTS</th>
</tr>
</thead>
</table>
| Processor              | • x64 architecture-based processor that supports Intel™ 64 architecture (formally known as Intel EM64T)  
                          | • x64 architecture-based computer with AMD™ 64-bit processor that supports AMD64 platform |
| Memory                 | 1GB RAM exclusively for ScanMail                                           |
|                        | (2GB RAM recommended)                                                       |
| Disk space             | 5GB free disk space                                                         |
| Operating System       | • Microsoft™ Windows Server™ 2016 Standard or Datacenter (64-bit)           |
|                        | • Microsoft™ Windows Server™ 2012 R2 Standard or Datacenter (64-bit)         |

**Important**

You must also install Windows Server 2012 R2 Update (KB2919355 and KB2919442) with Microsoft™ Windows Server™ 2012 R2.

| Mail Server            | Microsoft Exchange Server 2016 or above                                   |
ScanMail with Exchange Server 2013

The following table lists the system requirements for running ScanMail with Exchange Server 2013.

**TABLE 1-3. System Requirements for Installation with Exchange Server 2013**

<table>
<thead>
<tr>
<th>RESOURCE</th>
<th>REQUIREMENTS</th>
</tr>
</thead>
</table>
| Processor           | • x64 architecture-based processor that supports Intel™ 64 architecture (formally known as Intel EM64T)  
                     | • x64 architecture-based computer with AMD™ 64-bit processor that supports AMD64 platform |
| Memory              | 1GB RAM exclusively for ScanMail  
                     | (2GB RAM recommended) |
| Disk space          | 5GB free disk space                               |
## Resource Requirements

<table>
<thead>
<tr>
<th>Resource</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>• Microsoft™ Windows Server™ 2012 R2 Standard or Datacenter (64-bit)</td>
</tr>
<tr>
<td></td>
<td><strong>Important</strong></td>
</tr>
<tr>
<td></td>
<td>You must also install Windows Server 2012 R2 Update (KB2919355 and KB2919442) with Microsoft™ Windows Server™ 2012 R2.</td>
</tr>
<tr>
<td></td>
<td>• Microsoft™ Windows Server™ 2012 Standard or Datacenter (64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft™ Windows Server™ 2008 R2 Standard with Service Pack 1 or above (64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft™ Windows Server™ 2008 R2 Enterprise with Service Pack 1 or above (64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft™ Windows Server™ 2008 R2 Datacenter RTM with Service Pack 1 or above (64-bit)</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows Server 2008 R2 is not supported.</td>
</tr>
<tr>
<td>Mail Server</td>
<td>Microsoft Exchange Server 2013 SP1 or above</td>
</tr>
<tr>
<td>Web Server</td>
<td>• Microsoft Internet Information Services (IIS) 8.5</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Internet Information Services (IIS) 8.0</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Internet Information Services (IIS) 7.5</td>
</tr>
<tr>
<td>Browser</td>
<td>• Microsoft™ Internet Explorer™ 7.0 or above</td>
</tr>
<tr>
<td></td>
<td>• Mozilla Firefox™ 3.0 or above</td>
</tr>
<tr>
<td>MSXML</td>
<td>4.0 Service Pack 2 or above</td>
</tr>
<tr>
<td>.NET framework</td>
<td>4.5 or later</td>
</tr>
</tbody>
</table>
Cluster Installations

The following lists supported cluster environments:

- Exchange Server 2019 with Database Availability Group (DAG) model
- Exchange Server 2016 with Database Availability Group (DAG) model
- Exchange Server 2013 with Database Availability Group (DAG) model

ScanMail Integration with Trend Micro Products

You can optionally integrate ScanMail with other Trend Micro products. The following table outlines the supported products and versions.

**TABLE 1-4. Integrated Trend Micro Product Support**

<table>
<thead>
<tr>
<th>TREND MICRO PRODUCT</th>
<th>SUPPORTED VERSIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trend Micro Apex Central™</td>
<td>• 2019</td>
</tr>
<tr>
<td>Smart Protection Server</td>
<td>• 3.0 or above</td>
</tr>
<tr>
<td></td>
<td>• OfficeScan Server Integrated Smart Protection Server</td>
</tr>
<tr>
<td>Deep Discovery Advisor</td>
<td>• 2.92 or later</td>
</tr>
<tr>
<td>Deep Discovery Analyzer</td>
<td>• 5.0 or later</td>
</tr>
<tr>
<td></td>
<td>• 6.0 or later</td>
</tr>
</tbody>
</table>

What’s New

The following new features are available in this version of ScanMail.
Introducing Trend Micro ScanMail for Microsoft Exchange

Table 1-5. New Features in 14.0

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log forwarding to SIEM</td>
<td>This version provides sending security risk, policy violation, spam and audit logs to the popular Security Information and Event Management (SIEM) platforms.</td>
</tr>
<tr>
<td>Updated URL-Time-of-Click Filter</td>
<td>This version enables you to add specific recipients as URL Time-of-Click protection target.</td>
</tr>
<tr>
<td>Improved Summary Screen</td>
<td>This version updates the Summary screen to provide details in-a-glance, and enables you to view Summary data and graph in a scope of last 30 days by default. You can also view details by selecting last 7 days or Today to view current day's data.</td>
</tr>
<tr>
<td>Updated Attachment Blocking Filter</td>
<td>This version enables you to block all password protected Microsoft Office documents and compressed files.</td>
</tr>
<tr>
<td>Apex Central Support</td>
<td>This version of ScanMail replaces Trend Micro Control Manager with Trend Micro Apex Central to provide capability to control antivirus and content security programs from a central location regardless of the program’s physical location or platform.</td>
</tr>
</tbody>
</table>

Features and Benefits

ScanMail provides the following features and benefits.

Web-based Product Console

Use SSL to access remote servers through a secure product console.
# Installation and Support

## Table 1-6. Installation and Support

<table>
<thead>
<tr>
<th>Feature</th>
<th>Benefits</th>
</tr>
</thead>
</table>
| Fast and Simple Installation | • Install to a single or multiple Microsoft Exchange servers using a single installation program.  
                              | • Install to cluster environments.                                       |
| Cluster Support          | Cluster Support                                                          |
|                          | • Exchange 2019:                                                          |
|                          |   • Database Availability Group (DAG)                                     |
|                          | • Exchange 2016:                                                          |
|                          |   • Database Availability Group (DAG)                                     |
|                          | • Exchange 2013:                                                          |
|                          |   • Database Availability Group (DAG)                                     |
# Antivirus Features and Scan Types

## TABLE 1-7. Antivirus Features and Scan Types

<table>
<thead>
<tr>
<th>FEATURE</th>
<th>BENEFIT</th>
</tr>
</thead>
</table>
| Powerful and Creative Antivirus Features | - SMTP scanning (Transport scanning) and store level scanning.  
- Leverage Microsoft Virus Scanning API to scan messages at a low-level in the Exchange store.  
- Quickly scan messages using multi-threaded in-memory scanning.  
- Detect and take action against viruses/malware, Trojans, and worms.  
- Detect and take action against spyware/grayware.  
- Use true file type recognition to detect falsely labeled files.  
- Use Trend Micro recommended actions or customize actions against viruses/malware.  
- Detect all macro viruses/malware and remove them or use heuristic rules to remove them. |
<p>| Advanced Threat Scan Engine (ATSE) | The Advanced Threat Scan Engine (ATSE) uses a combination of pattern-based scanning and heuristic scanning to detect document exploits and other threats used in targeted attacks. |
| IntelliTrap | This version of ScanMail incorporates IntelliTrap technology. Use IntelliTrap to scan for packing algorithms to detect packed files. Enabling IntelliTrap allows ScanMail to take user-defined actions on infected attachments and to send notifications to senders, recipients, or administrators. |</p>
<table>
<thead>
<tr>
<th>Feature</th>
<th>Benefit</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Trust Scan</td>
<td>Real-time scan can skip scanning email messages at the store level when the message has been scanned by ScanMail at the Hub Transport Level.</td>
</tr>
<tr>
<td></td>
<td>Once ScanMail scans a message on an Edge or Hub Transport server, ScanMail adds scan information to the message. When the message reaches the Mailbox, ScanMail evaluates the scan information to prevent redundant use of resources. ScanMail only scans the message if the message was scanned with an older scan engine or pattern file or if ScanMail has not previously scanned the message.</td>
</tr>
<tr>
<td>• A Category for Unscannable Message Parts</td>
<td>ScanMail separates the unscannable message count from the virus/malware count. Unscannable files can be files that fall outside of the Scan Restriction Criteria, encrypted files, or password protected files.</td>
</tr>
<tr>
<td>Manual Scan and Scheduled Scan</td>
<td>ActiveUpdate does not interrupt Manual Scan or Scheduled Scan.</td>
</tr>
<tr>
<td></td>
<td>For Exchange Server 2013 and Exchange Server 2016, these pages appear only for Mailbox server roles. ScanMail provides three incremental scan options:</td>
</tr>
<tr>
<td></td>
<td>• Scan messages delivered during a time period</td>
</tr>
<tr>
<td></td>
<td>• Scan messages with attachments</td>
</tr>
<tr>
<td></td>
<td>• Scan messages that have not been scanned by ScanMail</td>
</tr>
<tr>
<td>Smart Scan</td>
<td>Smart scan moves security capabilities from the server to the cloud.</td>
</tr>
<tr>
<td></td>
<td>An integral part of the Trend Micro Smart Protection Network, Smart Scan provides the following benefits:</td>
</tr>
<tr>
<td></td>
<td>• Fast, real-time security status lookup capabilities in the cloud</td>
</tr>
<tr>
<td></td>
<td>• Reduces the overall time it takes to deliver protection against emerging threats</td>
</tr>
<tr>
<td></td>
<td>• Lowers memory consumption on endpoints</td>
</tr>
</tbody>
</table>
Introducing Trend Micro ScanMail for Microsoft Exchange

**Updates**

- Receive scheduled or on-demand component updates and customize your update source.

---

### Multiple Scan Filters

**Table 1-8. Multiple Scan Filters**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment Blocking</td>
<td>• Block named attachments or block attachments by true file type, file extension, or file name.</td>
</tr>
<tr>
<td></td>
<td>• Active Directory integrated exception rules</td>
</tr>
<tr>
<td>Content Filtering</td>
<td>• Use rule-based filters to screen out message content deemed to be offensive or otherwise objectionable.</td>
</tr>
<tr>
<td></td>
<td>• Active Directory integrated policies</td>
</tr>
</tbody>
</table>
|                          | • Content Filtering Logs

*This version of ScanMail displays the keyword in content filtering logs when there is a match.*

---

**Note**

If the keyword or regular expression is too long to display, logs display truncated information.
<table>
<thead>
<tr>
<th><strong>Feature</strong></th>
<th><strong>Benefits</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Loss Prevention</td>
<td>• Use rule-based filters to detect, filter, and mask sensitive data before it transmits out of the network.</td>
</tr>
<tr>
<td></td>
<td>• Select from over 100 predefined templates and data identifiers, or create customized expressions and keyword lists to meet company-specific mandates.</td>
</tr>
<tr>
<td></td>
<td>• Create customized rules to block, mask, log, and delete sensitive data transmitting across the network.</td>
</tr>
<tr>
<td></td>
<td>• Create Data Loss Prevention policies and deploy to ScanMail servers from Apex Central to ensure that company-wide policies remain consistent across all servers.</td>
</tr>
<tr>
<td>Spam Prevention Rules</td>
<td>• Use spam prevention filters with adjustable sensitivity levels to screen out spam while reducing falsely identified messages.</td>
</tr>
<tr>
<td></td>
<td>• End User Quarantine (EUQ) with Spam Confidence Level (SCL)</td>
</tr>
<tr>
<td></td>
<td>This version of ScanMail provides &quot;Integrate with Outlook Junk E-mail&quot; and &quot;Integrate with End User Quarantine&quot; solutions. You can select either solution during installation.</td>
</tr>
<tr>
<td></td>
<td>• Junk E-Mail folder</td>
</tr>
<tr>
<td></td>
<td>In this version of ScanMail, you can select to send detected Spam messages to the standard Outlook folder. The creation of a separate Spam folder is no longer necessary.</td>
</tr>
<tr>
<td>Advanced Spam Prevention</td>
<td>The Advanced Spam Prevention includes Business Email Compromise (BEC) technology that detects a probable scam or attack using email messages that appear to be from a high profile user, such as, a corporate user from the executive team.</td>
</tr>
</tbody>
</table>
Introducing Trend Micro ScanMail for Microsoft Exchange

<table>
<thead>
<tr>
<th>Feature</th>
<th>Benefits</th>
</tr>
</thead>
</table>
| Web Reputation              | • This version of ScanMail leverages Web Reputation technology, which evaluates the integrity of all requested web pages.  
• Web Reputation features help ensure that the pages that users access are safe and free from web threats, such as malware, spyware, and phishing scams that are designed to trick users into providing personal information.  
• Web Reputation blocks web pages based on their reputation ratings. It queries Trend Micro servers for these ratings, which are correlated from multiple sources, including web page links, domain and IP address relationships, spam sources, and links in spam messages. By obtaining ratings online, Web Reputation uses the latest available information to block harmful pages.  
• Web Reputation helps deter users from following malicious URLs when the feature is enabled. Web reputation queries Trend Micro servers for the reputation rating when an email message with a URL in the message body or message attachment is received. Depending on the configuration, Web Reputation can quarantine, delete, or tag the email message with URLs. |
| URL Time-of-Click Protection | The URL Time-of-Click Protection rewrites the URLs in the email message body during scanning the message, and analyze these URLs only when the message recipient clicks on these URLs. |
| Search & Destroy            | Search & Destroy provides administrators the ability to search and remove mailbox components (for example, email messages, meetings, tasks) containing undesirable content from Exchange mailbox servers. |

**Note**

The Search & Destroy menu only appears after configuring the Search & Destroy Administrator or Search & Destroy Operator roles.
**Virtual Analyzer integration**

Administrators can leverage the Virtual Analyzer in Deep Discovery Advisor or Deep Discovery Analyzer to evaluate files and URLs. ScanMail sends the suspect files or URLs to Virtual Analyzer which then performs content simulation and analysis in an isolated virtual environment to identify characteristics commonly associated with many types of malware.

After Virtual Analyzer completes the analyses, ScanMail receives a report indicating the risk level of the file or URL. Administrators can configure ScanMail to perform specific actions on analyzed files or URLs based on the company’s security level policy.

<table>
<thead>
<tr>
<th><strong>FEATURE</strong></th>
<th><strong>BENEFITS</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Analyzer integration</td>
<td>Administrators can leverage the Virtual Analyzer in Deep Discovery Advisor or Deep Discovery Analyzer to evaluate files and URLs. ScanMail sends the suspect files or URLs to Virtual Analyzer which then performs content simulation and analysis in an isolated virtual environment to identify characteristics commonly associated with many types of malware. After Virtual Analyzer completes the analyses, ScanMail receives a report indicating the risk level of the file or URL. Administrators can configure ScanMail to perform specific actions on analyzed files or URLs based on the company’s security level policy.</td>
</tr>
</tbody>
</table>

**TABLE 1-9. Email Message Flow Protection**

<table>
<thead>
<tr>
<th><strong>FEATURE</strong></th>
<th><strong>INBOUND EMAIL</strong></th>
<th><strong>OUTBOUND EMAIL</strong></th>
<th><strong>INTERNAL EMAIL</strong></th>
<th><strong>DETAILS</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Risk Scan</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>Enabled by default on both inbound and outbound messages.</td>
</tr>
<tr>
<td>Attachment Blocking</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>Supports specific sender(s)/recipient(s) configuration.</td>
</tr>
<tr>
<td>Content Filtering</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>Supports specific sender(s)/recipient(s) configuration.</td>
</tr>
<tr>
<td>Data Loss Prevention</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>Configurable, and enabled for outbound messages by default. Supports specific sender(s)/recipient(s) configuration.</td>
</tr>
<tr>
<td>Spam Prevention</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Spam Prevention</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>Business Email Compromise (BEC) Writing Style feature works only for Inbound messages.</td>
</tr>
<tr>
<td>Feature</td>
<td>Inbound Email</td>
<td>Outbound Email</td>
<td>Internal Email</td>
<td>Details</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------</td>
<td>----------------</td>
<td>----------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Web Reputation</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>URL Time-of-Click Protection</td>
<td>✔</td>
<td></td>
<td></td>
<td>Supports configuring feature for specific recipient(s).</td>
</tr>
<tr>
<td>External Disclaimer</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Virtual Analyzer integration</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>Configurable, and enabled for inbound messages by default.</td>
</tr>
</tbody>
</table>
Informative Monitoring Tools

**TABLE 1-10. Informative Monitoring Tools**

<table>
<thead>
<tr>
<th>FEATURE</th>
<th>BENEFITS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notifications</td>
<td>ScanMail can automatically send notifications when it does the following:</td>
</tr>
<tr>
<td></td>
<td>• Detects and takes action against a virus or other threat detected in an email message</td>
</tr>
<tr>
<td></td>
<td>• Blocks an infected attachment</td>
</tr>
<tr>
<td></td>
<td>• Detects suspicious URLs</td>
</tr>
<tr>
<td></td>
<td>• Filters out undesirable content from an email message</td>
</tr>
<tr>
<td></td>
<td>• Detects a significant system event</td>
</tr>
<tr>
<td></td>
<td>• Detects virus/malware outbreak conditions</td>
</tr>
<tr>
<td></td>
<td>• ScanMail can notify designated individuals during real-time, manual, or scheduled scanning.</td>
</tr>
</tbody>
</table>

**Note**

For correct resolution of ScanMail notifications with Simple Network Management Protocol (SNMP), you can import the Management Information Base (MIB) file to your network management tools from the following path in the ScanMail installation directory: `trend_smex_v2.mib`.

<table>
<thead>
<tr>
<th>Informative and Timely Reports and Logs</th>
<th>Benifits</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Keep up-to-date using activity logs</td>
<td>Keep up-to-date using activity logs that detail significant events</td>
</tr>
<tr>
<td>• Send or print graphical reports</td>
<td>Send or print graphical reports</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Quarantine</th>
<th>Benifits</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Set ScanMail to quarantine</td>
<td>Set ScanMail to quarantine suspicious email messages</td>
</tr>
<tr>
<td>• Query logs for quarantine events</td>
<td>Query logs for quarantine events and resend quarantined messages when you decide they are safe</td>
</tr>
<tr>
<td>• resend quarantined messages when</td>
<td></td>
</tr>
</tbody>
</table>
Version Comparison

The following table lists versions of ScanMail and the features for each:

**TABLE 1-11. ScanMail Version Comparison**

<table>
<thead>
<tr>
<th>SUPPORT</th>
<th><strong>ScanMail 12.x</strong></th>
<th><strong>ScanMail 14.x</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>• Microsoft™ Windows Server™ 2008 R2 Standard with Service Pack 1 or above (64-bit)</td>
<td>• Microsoft™ Windows Server™ 2008 R2 Standard with Service Pack 1 or above (64-bit)</td>
</tr>
<tr>
<td>Version</td>
<td>• Microsoft™ Windows Server™ 2008 R2 Enterprise with Service Pack 1 or above (64-bit)</td>
<td>• Microsoft™ Windows Server™ 2008 R2 Enterprise with Service Pack 1 or above (64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft™ Windows Server™ 2008 R2 Datacenter RTM or above (64-bit)</td>
<td>• Microsoft™ Windows Server™ 2008 R2 Datacenter RTM or above (64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft™ Windows Server™ 2012 Standard or Datacenter (64-bit)</td>
<td>• Microsoft™ Windows Server™ 2012 Standard or Datacenter (64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft™ Windows Server™ 2012 R2 Standard or Datacenter (64-bit)</td>
<td>• Microsoft™ Windows Server™ 2012 R2 Standard or Datacenter (64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft™ Windows Server™ 2016 Standard or Datacenter (64-bit)</td>
<td>• Microsoft™ Windows Server™ 2016 Standard or Datacenter (64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft™ Windows Server™ 2019 Standard or Datacenter (64-bit)</td>
<td>• Microsoft™ Windows Server™ 2019 Standard or Datacenter (64-bit)</td>
</tr>
<tr>
<td>SUPPORT</td>
<td>SCANMAIL 12.x</td>
<td>SCANMAIL 14.x</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------</td>
</tr>
<tr>
<td>Minimum Exchange Version</td>
<td>Microsoft™ Exchange Server 2010 with Service Pack 3</td>
<td>Microsoft™ Exchange Server 2013 with Service Pack 1</td>
</tr>
<tr>
<td></td>
<td>• Microsoft™ Exchange Server 2013 with Service Pack 1</td>
<td>• Microsoft™ Exchange Server 2016</td>
</tr>
<tr>
<td></td>
<td>• Microsoft™ Exchange Server 2016</td>
<td>• Microsoft™ Exchange Server 2019</td>
</tr>
<tr>
<td>Scan Mechanism</td>
<td>Microsoft™ Exchange Server 2010:</td>
<td>Microsoft™ Exchange Server 2013/2016/2019:</td>
</tr>
<tr>
<td></td>
<td>• VSAPI 2.6</td>
<td>• Exchange Web Service</td>
</tr>
<tr>
<td></td>
<td>• Transport Agent</td>
<td>• Transport Agent</td>
</tr>
<tr>
<td></td>
<td>• Microsoft™ Exchange Server 2013/2016:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Exchange Web Service</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Transport Agent</td>
<td></td>
</tr>
<tr>
<td>Transport Level Real-Time Scan</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Quarantine Manager</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Active Message Filter</td>
<td>Integrated as delete function for inbound and outbound messages</td>
<td>Integrated as delete function for inbound and outbound messages</td>
</tr>
<tr>
<td>Notification</td>
<td>• Collaborative Data Object</td>
<td>Collaborative Data Object</td>
</tr>
<tr>
<td></td>
<td>• Collaborative Data Object EX</td>
<td>Collaborative Data Object EX</td>
</tr>
<tr>
<td></td>
<td>• Exchange Web Service</td>
<td>Exchange Web Service</td>
</tr>
<tr>
<td>Manual Scan/ Scheduled Scan</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
How ScanMail Protects the Microsoft Exchange Environment

Trend Micro recognizes the unique dangers posed by security threats to Microsoft Exchange servers. Trend Micro designed ScanMail to protect Exchange from these numerous and diverse security risks. ScanMail uses a filtering strategy to protect Exchange. ScanMail subjects the email message to each filter in the following order:

- Spam Prevention
- Advanced Spam Prevention
- Data Loss Prevention
- Content Filtering
- Attachment Blocking
- Security Risk Scan (advanced threat scan)
- Web Reputation

In addition, ScanMail provides notifications and log queries to assist administrators to monitor and react to security risks.

**Table 1-12. How ScanMail Protects the Microsoft Exchange Environment**

<table>
<thead>
<tr>
<th><strong>Feature</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Spam Prevention</td>
<td><strong>Email Reputation</strong>&lt;br&gt;ScanMail includes Email Reputation, which allows you to block spam messages before they enter the network.</td>
</tr>
<tr>
<td></td>
<td><strong>Content Scanning</strong>&lt;br&gt;ScanMail uses the Trend Micro spam engine and spam pattern file to screen out spam messages before they are delivered to the Information Store. Administrators can create approved and blocked senders lists if End User Quarantine is enabled. If End User Quarantine is enabled, end users can create their own lists of approved senders.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Advanced Spam Prevention      | The Advanced Spam Prevention provides configuring ScanMail for Business Email Compromise (BEC) to detect a probable scam or attack using email messages that appear to be from a high profile user, such as, a corporate user from the executive team. You can also configure the whole internal domain of senders for BEC to scan for probably scam or attack.  

The Advanced Spam Prevention also provides option to select Conservative or Aggressive mode for scanning. The Aggressive Mode requires Virtual Analyzer to scan content in an isolated virtual environment, while the Conservative Mode scans content using other methods in the absence of Virtual Analyzer. |
| Data Loss Prevention          | ScanMail can filter content for sensitive information in different message parts based on policies set by the administrator. ScanMail filters outgoing email messages and can perform specific actions on email messages that contain sensitive information.                                                                                      |
| Content Filtering             | ScanMail can filter content in a message header, subject, body, and/or attachment based on policies set by the administrator. ScanMail filters incoming and outgoing email messages and can perform specific actions on email messages that contain undesirable content in the message body or attachments.                                                                                      |
| Attachment Blocking           | ScanMail can block undesirable attachments according to administrator-defined types or specific names. During scanning, ScanMail can replace the detected file with a text message and then deliver the message to the intended recipient.                                                                                         |
Introducing Trend Micro ScanMail for Microsoft Exchange

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Risk Scan</td>
<td>Security risk scan employs one of the following scan engines:</td>
</tr>
<tr>
<td></td>
<td>• Security risk scan uses the latest version of the Trend Micro VSAPI scan engine to detect viruses/malware, spyware/grayware, worms, Trojans, and other malicious code. The Trend Micro scan engine uses pattern recognition and rule-based technologies to scan all incoming and outgoing messages for viruses/malware and other security risks in real time or on-demand.</td>
</tr>
<tr>
<td></td>
<td>• Security risk scan uses the Advanced Threat Scan Engine (ATSE) which employs a combination of pattern-based scanning and heuristic scanning to detect document exploits and other threats used in targeted attacks. Administrators can configure ScanMail to send suspicious files to Virtual Analyzer for further analysis.</td>
</tr>
<tr>
<td></td>
<td>The Advance Threat Scan Engine also uses Predictive Machine Learning to query Trend Micro’s cloud service when doing virus scanning for some files, such as, Windows executable file (PE) and script files. In contrast to traditional signature based malware detections, Predictive Machine Learning has more ability to detect malware variants.</td>
</tr>
<tr>
<td>Web Reputation</td>
<td>ScanMail queries Trend Micro rating servers and for the reputation rating when an email message with URLs in the message subject, body, or attachment arrives, before delivery to the information store.</td>
</tr>
<tr>
<td></td>
<td>ScanMail also optionally queries Trend Micro Deep Discovery Analyzer server for advanced threats detection when an email message with URLs could not be rated by Trend Micro rating servers.</td>
</tr>
<tr>
<td></td>
<td>However, administrators can enable approved list and bypass internal domain URLs to avoid scanning trusted URLs.</td>
</tr>
<tr>
<td>URL Time-of-Click Protection</td>
<td>The URL Time-of-Click Protection enables you to configure ScanMail to rewrite the URLs in the email message body during scanning, and analyze these URLs only when the message recipient clicks on these URLs.</td>
</tr>
</tbody>
</table>

1-21
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real-time Scan</td>
<td>ScanMail guards possible virus/malware entry points with real-time scanning of all incoming and outgoing messages, SMTP messages, documents posted on public folders, and files replicated from other Microsoft Exchange servers. During real time scanning, ScanMail takes actions against security risks according to the administrator’s configurations.</td>
</tr>
</tbody>
</table>
| Manual/Scheduled Scans | ScanMail performs manual and scheduled scanning on demand according to a manual prompt or schedule. On demand scanning eliminates viruses/malware from inside the Information Store databases, eradicates old virus/malware infections, and minimizes the possibility of reinfection. When performing a manual or scheduled scan, ScanMail takes actions against security risks depending on the administrator’s configurations.  
ScanMail allows the selection of individual Stores for scanning. For example, you can use this option to provide security risk scan and content security for a particular storage groups’ databases, rather than for all storage groups. |
| Alerts and notifications | ScanMail can send alerts about outbreaks and significant system events. Outbreak alerts notify administrators when the number of detected security risks exceeds a set number. This enables administrators to react quickly to security breaches in their Exchange environment. |
| Reports and logs     | ScanMail provides logs and reports to keep administrators informed about the latest security risks and system status. ScanMail logs significant events such as component updates and scan actions. Administrators can query these events to create log reports providing current and detailed information about the security of the Exchange environment.  
ScanMail can generate reports for system analysis that can be printed or exported. |
About Uncleanable Files

When ScanMail cannot successfully clean a file, it labels the file "uncleanable" and performs the user-configured action for uncleanable files. The default action is "Replace with text/file". ScanMail records all viruses/malware events and associated courses of action in the log file.

Some common reasons why ScanMail cannot perform the clean action are as follows:

- The file contains a Trojan, worm, or other executable program. To stop an executable from executing, ScanMail must completely remove it.
- ScanMail does not support the compression format used to compress the file. The scan engine only cleans files compressed using *pkzip* and only when the infection is in the first layer of compression.
- An unexpected problem prevents ScanMail from cleaning.

ScanMail Technology

The Trend Micro scan engine and spam engine detect viruses/malware and other security threats and screen out spam messages. These engines rely on the latest pattern files supplied by TrendLabs℠ and delivered through ActiveUpdate servers or a user-configured update source.

Trend Micro Scan Technology

ScanMail allows administrators to choose the level of malware detection that is appropriate for the company’s security policy. Administrators configure the security level ScanMail provides by configuring the scan engine and any further analyses necessary.

The following table outlines the scanning technology available in ScanMail.
### TABLE 1-13. Scanning Technology

<table>
<thead>
<tr>
<th>SCAN TECHNOLOGY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virus Scan Engine</td>
<td>The standard malware scan engine available in ScanMail. The Virus Scan Engine employs pattern matching and heuristic scanning technology to identify threats before malware can infect a system.</td>
</tr>
<tr>
<td>Advanced Threat Scan Engine (ATSE)</td>
<td>Advanced Threat Scan Engine performs aggressive heuristic scanning to check files for less conventional threats, including document exploits. Some detected files may be safe and should be further observed and analyzed in a virtual environment. Advanced Threat Scan Engine enhances the features provided by the Virus Scan Engine. For more information on Advanced Threat Scan Engine configuration, see Configuring Security Risk Scan Targets on page 7-7.</td>
</tr>
</tbody>
</table>
## Scan Technology

<table>
<thead>
<tr>
<th>Scan Technology</th>
<th>Description</th>
</tr>
</thead>
</table>
| Virtual Analyzer | Virtual Analyzer performs content simulation and analysis in an isolated virtual environment to identify characteristics commonly associated with many types of malware. In particular, Virtual Analyzer checks if files or URLs attached to messages contain exploit code. Although many files or URLs do not include executable data, attackers find ways to cause such files or URLs to exploit vulnerabilities in programs and operating systems that run them. Because of this, sending malicious files or URLs to target users has become an effective way for attackers to compromise systems.  

**Note**  
Virtual Analyzer is a separately licensed product that provides unique security visibility based on Trend Micro's proprietary threat analysis and recommendation engines. ScanMail integrates with the Virtual Analyzer in Deep Discovery Advisor and Deep Discovery Analyzer.  

For more information on Virtual Analyzer settings, see Configuring Virtual Analyzer on page 16-1. |

---

### The Trend Micro Virus Scan Engine

At the heart of all Trend Micro antivirus products lies a proprietary scan engine. This engine has a long history in the industry and has proven to be one of the fastest.

The ScanMail scan engine is designed to work closely with the Virus Scanning Application Programming Interface (VSAPI) 2.6 and 2.5 available from Microsoft Exchange.

- VSAPI provides a virus-scanning implementation with high performance so that scanning occurs before a client can access a message or attachment. This low-level access facilitates the elimination of viruses/malware that file-level scanners cannot eliminate.
• VSAPI enables message scanning once before delivery, rather than multiple times as determined by the number of intended recipients, reducing processing time. This single-instance scanning also prevents re-scanning when a user copies a message.

The scan engine provides:

• Real-time multi-threaded scanning

ScanMail performs all scanning in memory and is capable of processing multiple scan requests. When it receives multiple scan requests, it prioritizes and queues the requests that it cannot run immediately and runs the requests when resources become available. When a manual or scheduled scan is running and a client attempts to access a scannable object, ScanMail performs an immediate real-time scan.

ScanMail supports SMTP real-time email message scans.

• Non-redundant scanning

When ScanMail completes a scan of an object, it logs the object as scanned. If you access the object again, ScanMail checks to see if it has already been scanned and does not scan it a second time.

Scan Engine Updates

Trend Micro periodically makes new scan engine versions available. New engines are released, for example, when:

• Trend Micro incorporates new detection technologies into the software
• A new, potentially harmful, virus/malware is discovered that cannot be handled by the current engine
• Scanning performance is enhanced
• Support is added for additional file formats, scripting languages, encoding, and/or compression formats

To view the version number for the most current version of the scan engine, visit:

http://www.trendmicro.com
To view the version of the scan engine that ScanMail is currently using, open the product console and view **Summary > System.**

---

**Tip**

Trend Micro recommends frequently updating your scan engine. Scheduled updates can be used to conveniently and regularly update ScanMail components.

---

**The Trend Micro Pattern Files**

The Trend Micro scan engine uses an external data file, called the virus pattern file, to identify the latest security risks.

You can view the most current version, release date, and a list of all the new definitions included in the file from the following website:


To view the version of the pattern file that ScanMail is currently using on your ScanMail server, open the product console and view **Summary > System.**

---

**Tip**

Trend Micro recommends frequently updating your pattern files. Scheduled updates can be used to conveniently and regularly update ScanMail components.

---

**Pattern File Numbering**

To allow you to compare the current pattern file in your software products to the most current pattern file available from Trend Micro, pattern files have a version number.

The pattern file numbering system uses 7 digits, in the format xx.xxx.xx.

For the pattern file number 1.786.01:

- The first digit (1) indicates the new numbering system. (The second of two digits in this segment of the pattern file identifier will not be utilized until the number increases from 9 to 10.)
• The next three digits (786) represent the traditional pattern file number.

• The last two digits (01) provide additional information about the pattern file release.

How the Scan Engine Works with the Pattern File

The scan engine works together with the pattern file to perform the first level of detection, using a process called pattern matching. When the engine finds a match, it sends a notification through an email message to the system administrator.

Note
The scan engine includes an automatic cleanup routine for old pattern files (to help manage disk space).

About ActiveUpdate

ActiveUpdate provides the latest downloads of all ScanMail components over the Internet.

ActiveUpdate does not interrupt network services, or require you to reboot your computers. ScanMail can receive updates on a regularly scheduled interval or through manual updates.

Incremental Updates of the Pattern File

ActiveUpdate supports incremental updates of the pattern file. Rather than download the entire pattern file each time, ActiveUpdate can download only the portion of the file that is new, and append it to the existing pattern file. This efficient update method can substantially reduce the bandwidth needed to update your antivirus software.

Configure ScanMail to use ActiveUpdate and incremental updates to decrease the time spent updating.
Using ActiveUpdate with ScanMail

You can configure ScanMail to use the ActiveUpdate server as a source for manual and scheduled component updates. When it is time for the component update, ScanMail polls the ActiveUpdate server directly. ActiveUpdate determines if an update is available, and ScanMail downloads the updates if they are available.

Tip

For a more efficient download in a multi-server environment, configure ScanMail to allow other servers to download updates from it. This makes ScanMail a virtual ActiveUpdate server for other servers in your environment that receive incremental updates.

IntelliScan™

IntelliScan optimizes scanning performance by examining file headers using true file type identification and scanning only file types associated with malware risks. With true file type identification, IntelliScan identifies files disguised using false extension types.

IntelliScan provides the following benefits:

- **Performance optimization**: Using minimal system resources, IntelliScan does not affect the performance of crucial applications running on the host.
- **Shorter scanning period**: Using true file type identification, IntelliScan only scans files vulnerable to infection, significantly reducing scan times.

IntelliTrap

Virus writers often attempt to circumvent virus filtering by using real-time compression algorithms. IntelliTrap helps reduce the risk of such viruses entering the network by blocking real-time compressed executable files and pairing them with other malware characteristics. Because IntelliTrap identifies such files as security risks and may incorrectly block safe files, consider quarantining (not deleting or cleaning) files after enabling IntelliTrap. If users regularly exchange real-time compressed executable files, disable IntelliTrap.

IntelliTrap uses the following components:
• Virus Scan Engine
• IntelliTrap Pattern
• IntelliTrap Exception Pattern

**Trend Micro ActiveAction™**

ActiveAction identifies virus/malware types and recommends actions based on how each type invades a computer system or environment. ActiveAction categorizes malicious code, replication, and payload types as viruses/malware. When a scan detects a virus or malware threat, it takes the recommended action on the virus/malware type to protect the environment's vulnerable points.

---

**Tip**

Trend Micro recommends using ActiveAction for users who are not familiar with the available scan actions or are not sure which scan action is suitable for a certain type of virus/malware.

---

Using ActiveAction provides the following benefits:

• **Time saving and easy to maintain**: ActiveAction uses scan actions recommended by Trend Micro. Users do not have to spend time configuring the scan actions.

• **Updateable scan actions**: Virus/malware writers constantly change the way viruses/malware attack computers. Trend Micro updates ActiveAction settings in each new pattern file to protect clients against the latest threats and the latest methods of virus/malware attacks.

**About Hot Fixes, Patches, and Service Packs**

After an official product release, Trend Micro often develops hot fixes, patches, and service packs to address outstanding issues, enhance product performance, and add new features.

The following is a summary of the items Trend Micro may release:
Introducing Trend Micro ScanMail for Microsoft Exchange

- **Hot Fix**: a work-around or solution to customer-reported issues.
- **Patch**: a group of security patches suitable for deployment to all customers.
- **Service Pack**: significant feature enhancements that upgrade the product.

Your vendor or support provider may contact you when these items become available. Check the Trend Micro website for information on new hot fix, patch, and service pack releases:

[http://www.trendmicro.com/download](http://www.trendmicro.com/download)

All releases include a readme file that contains installation, deployment, and configuration information. Read the readme file carefully before performing installation.

**Enterprise Protection Strategy**

Trend Micro Enterprise Protection Strategy (EPS) was designed to help you manage all aspects of an outbreak life cycle, beginning with assessing a potential vulnerability and ending with restoration of systems after a threat is cleaned from your environment.

The Enterprise Protection Strategy is available for customers running Microsoft Windows.

---

**Note**

For the additional information on the Enterprise Protection Strategy, visit the Trend Micro website at:

[http://www.trendmicro.com](http://www.trendmicro.com)

---

**Outbreak Prevention Services**

Outbreak Prevention Services (OPS) are Trend Micro services that you can take advantage of using Apex Central. It allows enterprises to take proactive steps against new security risks before the necessary virus pattern files are available. By bridging the gap between threat notification and virus pattern delivery, enterprises can quickly contain virus outbreaks, minimize system damage, and prevent undue downtime.
OPS is a key component of the Trend Micro Enterprise Protection Strategy (EPS) - the culmination of a research initiative that identified best practices for preventing or deflecting potentially damaging virus attacks. This study was brought on by the apparent failure of conventional security measures to defend against new generation security risks, such as CodeRed and Nimda.

Trend Micro created Outbreak Prevention Services to address concerns at each stage of the life cycle. OPS harnesses the three core strengths of Trend Micro:

• Enterprise-class antivirus and content security products
• TrendLabs, the Trend Micro ISO-certified virus research and technical support center
• Partnerships with best-of-breed network security vendors and brings them together in a single powerful interface: Trend Micro Apex Central. With OPS, Apex Central provides answers to the following key security questions:
  • Am I under attack?
  • Can my system handle the attack?
  • How should I respond to the attack?
Chapter 2

Getting Started with ScanMail

This chapter explains how to register and activate ScanMail and describes the update process.

Topics include:

• *Getting Started on page 2-2*
• *Understanding the Product Console on page 2-2*
• *ScanMail Registration on page 2-9*
• *ScanMail Activation on page 2-11*
• *About ScanMail Updates on page 2-17*
Getting Started

After installing ScanMail, there are a number of tasks administrators can perform to ensure that everything is set up and working properly.

**Procedure**

1. Open the ScanMail product console.
2. Configure ScanMail to recognize an existing proxy server (if not completed during Setup).
3. Activate other ScanMail installed modules.
4. Register ScanMail to work with Trend Micro Trend Micro Apex Central™ (if not completed during Setup).
5. Perform an immediate update of ScanMail pattern files and scan engines.
7. Obtain the EICAR test file to confirm that the installation is working.

Understanding the Product Console

Access and control ScanMail through the intuitive product console. Use the product console to manage multiple Exchange servers and remote servers from any endpoint on the network. The ScanMail product console is password protected, ensuring that only authorized administrators can modify ScanMail settings. Administrators can view the product console from any endpoint on the network that is running a supported browser.

Viewing the Product Console on a Local Server

**Procedure**

1. Click Start > Programs > Trend Micro ScanMail for Microsoft Exchange > ScanMail Management Console.
Note
On Windows 2012 platforms, only a desktop shortcut is available.

2. Type the user name and password.
3. Click Log on.

Note
Use the account that belongs to Management Group configured during Setup to log on the ScanMail installations.

Viewing the Product Console from a Remote Server

Procedure
1. Use a supported browser to access:
   <https>://<servername>:<portnumber>/smex
   Where "servername" is the name of the server with the ScanMail installation and "port number" is the port number used to access the server.

   Note
   By default, HTTPS uses port 16373.

2. Type the user name and password.
3. Click Log on.
Product Console Main View

The ScanMail web console has an intuitive user interface that provides easy access to all the functions needed to configure and manage ScanMail.

![Product Console Main View](image)

**FIGURE 2-1.** The product console
Product Console Elements

Banner

The banner identifies and describes the product and provides access to Trend Micro support.

The banner displays the following:

- **Current server**: The server you manage from this console
- **Real-time monitor**: Click to access the Real-time Monitor
  
  For more information, see *Understanding Real-time Monitor on page 4-2*.
- **Server management**: Click to access the Server management console
  
  For more information, see *Understanding the Server Management Console on page 4-4*.
- **Log Off**: Click to end your session and close the product console

---

**Note**

Logging off the product console prevents unauthorized users from modifying the settings.

- **Help**: Get support by selecting an option from the drop-down list

  Help options include:

  - **Contents and Index**: Opens the online help table of contents and index
  - **Knowledge Base**: Access the Knowledge Base to get the latest information about product troubleshooting and frequently asked questions
• **Security Info:** Visit the Trend Micro Security Information page to read about the latest security risks

• **Sales:** View the Trend Micro web page to find resellers and service providers in your area

• **Support:** Access the Trend Micro technical support website

• **About:** View ScanMail and component version numbers and ScanMail system information
Side Menu

The side menu provides access to the main menu items for ScanMail.

![Figure 2-3. Product console side menu](image)

**Figure 2-3.** Product console side menu
Configuration Area

The configuration area allows administrators to configure and modify all ScanMail configurations and options.

**Figure 2-4. Product console configuration area**
Getting Help While Using the ScanMail Product Console

ScanMail offers the following types of help:

**Procedure**

- To get help using ScanMail features, read the context-sensitive help. Access context-sensitive help by clicking the help icon (Help) or open the Table of Contents by selecting **Contents and Index** from the **Help** drop-down list in the banner area.

- To access troubleshooting and FAQ information, select **Knowledge Base** from the drop-down list in the banner area.

- To access general information about computer security threats and alerts, select **Security Info** from the drop-down list in the banner area.

- To get information about how to contact Trend Micro sales representatives or service providers, select **Sales** from the drop-down list in the banner area.

ScanMail Registration

The product package or Trend Micro reseller provides a Registration Key for ScanMail. Registering ScanMail entitles administrators to standard support and telephone and online technical support. The length of the maintenance agreement depends on the contract arranged with the Trend Micro representative, but is usually 12 months.

Administrators must register and activate ScanMail to enable updates (even when using an evaluation-version Activation Code).

Online Purchase

After completing an online purchase, Trend Micro sends licensing and registration information, including a number that is used during the product registration process. The number needed for registration is either a Serial Number or a Registration Key.

A Serial Number is 24 characters in length, including hyphens, in the following format:
A Registration Key is 22 characters in length, including hyphens, in the following format:

XX-XXXX-XXXX-XXXX-XXXX

Most Trend Micro products use a Registration Key. When ready to register, go to the following Trend Micro website:

http://olr.trendmicro.com

Reseller Purchase

When you purchase ScanMail from a reseller, you receive a Registration Key with your product package or from your Trend Micro reseller. Registering ScanMail entitles you to standard support, which consists of pattern file updates, product version upgrades, and telephone and online technical support. The length of the maintenance agreement depends on the contract you arrange with your Trend Micro representative.

When you register, you receive an Activation Code that you can use to activate ScanMail.

Registering ScanMail

Use one of the following methods to register:

Procedure

• During installation

The installation program prompts for an online registration using the Registration Key. Follow the link to the Trend Micro website, register the product, and then return to the installation program to complete the installation process.

• Online

Visit the following Trend Micro website to register online and receive an Activation Code:

http://olr.trendmicro.com
• Contact Trend Micro directly

Provide a Trend Micro representative with the Registration Key to receive an Activation Code. Trend Micro maintains a list of North American contacts at:


---

**Note**

For maintenance renewal, contact Trend Micro sales or your reseller. Click **Update License** to manually update the maintenance expiration date on the **Product License** screen.

---

For more information, see *Technical Support on page 23-1*.

---

**ScanMail Activation**

The following conditions require activation.

• Installing ScanMail for the first time

For example, after purchasing a product version from a Trend Micro reseller and using the registration key to obtain an Activation Code.

• Changing the version type

For example, after obtaining a new Activation Code from a Trend Micro representative and using the product console to activate the new version.

---

**Note**

The evaluation version is fully functional for 30 days, after which ScanMail tasks continue to run, but no updates occur.

---

Activate ScanMail during installation or using the product console.
Activating ScanMail During Installation

Procedure

1. Run the installation program.
2. Type the Activation Code on the Product Activation screen.
3. Complete the installation to activate ScanMail.

Activating ScanMail Using the Product Console

Procedure

1. Click Administration > Product License.
2. Click Upgrade Instruction to register ScanMail.
   
   The Trend Micro website opens which allows online registration. Register online to obtain an Activation Code.
4. Type the Activation Code in the space provided.
5. Click Activate.

Activation Codes

ScanMail has two types of Activation Code: standard and suite. Both of these have two types of maintenance agreements: evaluation and full. When you register ScanMail, you receive one Activation Code depending on whether you chose Standard or Suite and the evaluation or fully licensed version.
Note

Trend Micro recommends obtaining a new Activation Code before the expiry date to allow uninterrupted protection for your Exchange server(s). Contact a Trend Micro representative to renew your license agreement.

For example: You choose ScanMail Suite and decide to install the evaluation version. You download ScanMail Suite, register, and receive a suite evaluation Activation Code. When you provide the Activation Code, ScanMail suite evaluation service begins.

Tip

Run a pilot installation in a test environment using an evaluation version of ScanMail. When you decide to install the fully licensed version, use the experience gained from this cost-free evaluation.

Standard Activation Code

Using the standard Activation Code activates ScanMail.

**TABLE 2-1. Standard Activation Code Features**

<table>
<thead>
<tr>
<th><strong>MAINTENANCE AGREEMENT</strong></th>
<th><strong>STANDARD FEATURES</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Evaluation</td>
<td>Using the evaluation Activation Code allows administrators to implement all ScanMail functions for a limited duration.</td>
</tr>
<tr>
<td>Fully licensed</td>
<td>A fully licensed Activation Code entitles administrators to the standard maintenance agreement and implements all ScanMail functions available for standard activations. ScanMail provides a warning when the license agreement is close to expiration.</td>
</tr>
</tbody>
</table>

Suite Activation Code

Using the suite Activation Code activates all the functions of the ScanMail Standard Activation Code plus content filtering, spam prevention, and End User Quarantine functions. In addition to scan engine and pattern file updates, you also receive spam engine and spam pattern file updates. Content filtering screens out undesirable content
from email messages arriving at the Exchange server. The spam engine and spam pattern file work to prevent the delivery of spam messages to Exchange client mailboxes.

**TABLE 2-2. Suite Activation Code Features**

<table>
<thead>
<tr>
<th><strong>MAINTENANCE AGREEMENT</strong></th>
<th><strong>SUITE FEATURES</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Evaluation</td>
<td>Using the evaluation Activation Code allows you to use ScanMail functions for a limited duration. During the evaluation period, ScanMail performs security risk scan, attachment blocking, content filtering, spam prevention, End User Quarantine, and web reputation functions, as well as scan engine and pattern file updates. Once such a code expires, you cannot reuse it. The expiring code disables any rules or other configuration settings that were created while it was in use. The expiration of one Activation Code does not affect another. For instance, if you are evaluating a product that has separate licensing for spam prevention, expiration of one license does not affect the other.</td>
</tr>
<tr>
<td>Fully licensed</td>
<td>A fully licensed Activation Code entitles you to standard maintenance agreement and allows you to implement the full functions of ScanMail. ScanMail warns you when your license agreement is close to expiration. When a full-version Activation Code expires, you can no longer download engine or pattern file updates. However, unlike an evaluation-version Activation Code, when a full-version Activation Code expires, all existing configurations and other settings remain in force. This provision maintains a level of protection in case you accidentally allow your license to expire.</td>
</tr>
</tbody>
</table>

**Suite Activation Code with Additional Features**

You can purchase or use a trial version of suite Activation Codes that provide additional licensing for features in ScanMail. These additional features are:

- **Email Reputation**: ScanMail provides Email Reputation features as a part of spam prevention. As the first line of defense, Trend Micro Email Reputation helps stop spam before it can flood your network and burden your system resources.
• **Data Loss Prevention**: Trend Micro Data Loss Prevention is a comprehensive software solution that helps organizations protect information from accidental disclosure and intentional theft. Through use of fully customizable, company-specific policy creation, and pre-packaged regulatory templates, Data Loss Prevention helps companies manage, control, and monitor their sensitive information.

### Activation Code Comparison

The following table illustrates the features available for each type of Activation Code.

**TABLE 2-3. Features Available for Each Type of Activation Code**

<table>
<thead>
<tr>
<th>Feature</th>
<th>SUITE AC</th>
<th>STANDARD AC</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>FULL</td>
<td>TRIAL</td>
</tr>
<tr>
<td>Product console</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Spam prevention, content filtering, and web reputation items on reports, logs, and quarantine manager</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Security Risk Scan</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced Threat Scan Engine</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Attachment Blocking</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Spam Prevention: Content Scanning</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced Spam Prevention</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Data Loss Prevention</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Spam Prevention: Email Reputation</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Content Filtering</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Web Reputation</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>URL Time-of-Click Protection</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Manual Scan / Scheduled Scan</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Reactivating ScanMail

Administrators may need to reactivate ScanMail when changing the product version. Reactivating involves changing the Activation Code from one number to another. After clicking **New Activation Code**, type the new Activation Code to receive all the benefits of the new ScanMail version.

**Procedure**

1. Click **Administration > Product License**.

   The **Product License** screen appears.

2. Click **New Activation Code**.

   The **Product License > New Activation Code** screen appears.

3. Type or paste the new Activation Code.

---

### Feature Comparison

<table>
<thead>
<tr>
<th>Feature</th>
<th>Suite AC</th>
<th>Standard AC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smart Protection</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ActiveUpdate</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>End User Quarantine</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Apex Central Support</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Search &amp; Destroy</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Virtual Analyzer</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Note**

End User Quarantine is not supported for Exchange Server 2016.
4. Click **Activate**.

This activates the new version of ScanMail and enables all the functions available according to that license.

---

### About ScanMail Updates

Security software can only be effective if it is using the latest technology. Since new viruses/malware and other malicious codes are constantly being released, it is crucial that you regularly update your ScanMail components to protect against new security threats.

ScanMail components available for updating are:

- Virus Pattern
- Spyware Pattern
- IntelliTrap Pattern
- IntelliTrap Exception Pattern
- Virus Scan Engine
- Contextual Intelligence Query Handler
- Anti-spam Pattern
- Anti-spam Engine
- URL Filtering Engine
- Smart Scan Agent Pattern
- Advanced Threat Scan Engine
- Advanced Threat Correlation Pattern

To find out if you have the latest components, view the ScanMail **Summary** screen from the product console. It shows your current version and lists the latest version available for download.

---

### Updating ScanMail - Prerequisite Tasks

**Procedure**

1. Register your software.

2. If a proxy server handles Internet traffic on your network, you must set the proxy server information.
3. Configure your update method and source.
   - Methods include **Manual Update** and **Scheduled Update**.
   - Sources include the ActiveUpdate server, the Internet, the intranet UNC PATH, and Apex Central.

---

**Configuring Proxy Settings**

Proxy servers are used for added security and more efficient use of bandwidth. If your network uses a proxy server, configure the proxy settings to connect to the Internet, download the updated components necessary to keep ScanMail updated, and check the license status online.

The following features use proxy servers:

- Smart Protection Network
- ActiveUpdate
- Product registration
- Web reputation

---

**Procedure**

1. Click **Administration > Proxy**.
2. Select **Use a proxy server for Web Reputation, URL Time-of-Click Protection, Predictive Machine Learning, updates, and product license notifications**. Select this check box to use a proxy server for web reputation queries to Trend Micro reputation servers, Time-of-Click Protection, Predictive Machine Learning, updates, and product license notifications.
3. Type the proxy server name or IP address.
4. Type the **Port**.
5. (Optional) Select **Use SOCKS 5 proxy protocol**.
6. If the proxy server requires authentication, specify the user name and password.

Configuring Manual Updates

Trend Micro recommends manually updating your scan engines and pattern files immediately after installing ScanMail or whenever there is an outbreak.

Procedure

1. Click Updates > Manual.
2. Select the component(s) that you want to update.
3. Click Update.

ScanMail begins downloading the components and displays a progress bar that shows you the elapsed time and the percentage of the download remaining.

ScanMail downloads the current components from the specified source.

Configuring Scheduled Update

Configure ScanMail to regularly check the update server and automatically download any available components. During a scheduled update, ScanMail checks the user specified download source for the latest components.

Tip

During times of outbreaks, Trend Micro responds quickly to update pattern files (updates can be issued more than once each week). Trend Micro also regularly updates the scan engine and other components. Trend Micro recommends updating components daily - or even more frequently in times of outbreaks - to help ensure ScanMail has the latest components.

Procedure

1. Select a source from which your updates will be downloaded.
a. Click Updates > Download Source.

The Download Source screen appears.

b. Select a download source.

c. Click Save.

2. Set up your schedule.

a. Click Updates > Scheduled.

b. Click Enable schedule updates to have ScanMail begin to update according to your schedule.

c. Set the Update Schedule.

i. Select an update frequency: by minutes, by hours, by days, or weekly.

ii. Set the start time for the schedule by selecting the hour and minute. Each time the update occurs, the download begins at this time.

3. Select the components for downloading from the update source.

a. Select the components that ScanMail downloads during each scheduled update.

   Tip
   When you select the check box at the top of the table, all components are selected.

b. Click Save.

   ScanMail will begin downloading the selected components according to your schedule.

Configuring the Download Source

To keep ScanMail updated, you need to download the latest components. Use this page to set the source where ScanMail receives the latest components. The default location is
the Trend Micro ActiveUpdate server. During manual or scheduled downloads, ScanMail checks the location you specify here, and downloads the latest components from that source.

---

**Important**

The Download Source menu is only available if you upgrade your ScanMail from the an older version with a Download Source, other than the ActiveUpdate server is configured. For the fresh installation of ScanMail, the Download Source menu is not available.

---

**Procedure**

- **Trend Micro ActiveUpdate server**: Select this option to download from the default update server.

  Trend Micro uploads new components to the ActiveUpdate server as soon as they are available. Select the ActiveUpdate server as a source if you require frequent and timely updates.

- **Intranet location containing a copy of the current file**: Select this option to download from an Intranet location.

  Download components from an Intranet source that receives updated components. Type the Universal Naming Convention (UNC) path of another server on your network.

  **Note**

  Setting one or more centralized Intranet locations can greatly reduce network traffic and update time. This option is also useful when you do not want to connect an email server directly to the Internet. Instead, you can connect a front-end server to the Trend Micro ActiveUpdate server on the Internet and then set your back-end servers to receive updates from the front-end server.

- **Allow other servers to download updates from this server**: Select this option to allow other ScanMail servers to download updates from this server.

  Click Allow other servers to download updates from this server to set ScanMail to create a duplicate copy of the update package on the current server. Normally, ScanMail only downloads components that the user has set it to download or the
increments of the components that it needs. When you set ScanMail to duplicate the update package, it will download all the components that are available for downloading.

For example: There are two Exchange servers (a and b) and each one has ScanMail installed. ScanMail is set up to update server "a" daily and download all components. ScanMail is set to update server "b" every week and download only the spam pattern component. Both servers receive updates from the Trend Micro ActiveUpdate server as required. Therefore, the components on these servers are not always identical and they require different incremental updates when they poll the ActiveUpdate server. Another, more efficient, way to configure your servers would be to set up server "a" to duplicate the update package. Then, you could set server "a" as the source for downloads for server "b", and server "b" could receive incremental updates from server "a" just as if server "a" was the ActiveUpdate server.

Note

You must duplicate the update package to clusters. That is, this option is grayed-out so that you must reproduce the components from one virtual server across all virtual servers on that node by default.

Office 365 Protection with Trend Micro Cloud App Security

Trend Micro provides a security service, called Cloud App Security to protect your Office 365 Exchange online, OneDrive for Business, and SharePoint online.

In a scenario where ScanMail cannot provide protection, it works together with Cloud App Security to protect your on-premises servers and online Exchange services.

Refer to the Trend Micro Cloud App Security and its online documentation for details. If you already have any account on Cloud App Security portal, you can log on to one of the following:

- US Region: https://admin.tmcas.trendmicro.com
• EU Region: https://admin-eu.tmcas.trendmicro.com
• Japan (JP) Region: https://admin.tmcas.trendmicro.co.jp

For more details, log on to ScanMail administration console, and navigate to Office 365 Protection screen.
ScanMail was designed to provide comprehensive security for your complete Exchange environment. The following information gives an overview of the major security features of ScanMail and describes how to quickly establish and maintain a security baseline.

Topics include:

- Establishing a Security Baseline on page 3-2
- Maintaining Security on page 3-3
- Managing Outbreak Situations on page 3-4
Establishing a Security Baseline

When you have registered and activated ScanMail, you are ready to configure ScanMail features. Trend Micro recommends the following steps to establish a security baseline for your Exchange servers.

Procedure

1. Update ScanMail.

   When ScanMail is released it contains a Smart Scan Agent pattern file, scan engine, virus pattern file, spam engine, and spam pattern file that was available at the time. However, Trend Micro continuously updates pattern files and engines. Update these components immediately following installation to gain optimal protection for ScanMail. See About ScanMail Updates on page 2-17.

2. Verify that ScanMail is running and functioning correctly.

   From the web management console, click Real-time monitor. The Real-time monitor page opens and shows ScanMail activities in real time. When you can read Real-time scan has been running since, then you know ScanMail is running. See Understanding Real-time Monitor on page 4-2.

3. Perform a manual scan of your entire Information Store.

   Trend Micro recommends performing a manual scan of your entire Information Store following installation. When ScanMail detects viruses/malware or other malicious code it takes action against them according to Trend Micro defaults. The Trend Micro default action for viruses/malware is clean, or quarantine when it is unable to clean.

When the manual scan is complete, you have established a security baseline for your Exchange environment and you can start to focus on maintaining a secure environment.
Note

After installation and activation, ScanMail begins to protect your Exchange servers. ScanMail uses Trend Micro default values to filter undesirable content, block potentially harmful attachments, and scan for viruses/malware and other security threats in real time. When you are ready, customize ScanMail configurations to gain the optimal protection and efficiency for your network.

Maintaining Security

To maintain security on your Exchange servers, Trend Micro recommends the following:

**TABLE 3-1. Maintaining Security**

<table>
<thead>
<tr>
<th>ACTION</th>
<th>BENEFIT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled updates</td>
<td>To ensure that ScanMail is always up-to-date, regularly update ScanMail components. To facilitate this, ScanMail allows you to configure scheduled updates. Scheduled updates check the Trend Micro update server according to the schedule you set and automatically download any available components.</td>
</tr>
<tr>
<td>Scheduled scans</td>
<td>Viruses/malware and other security threats can attack your Exchange servers from unexpected sources such as local unprotected computers and servers or by bypassing too lenient configurations. Run regular scheduled scans to significantly reduce this risk.</td>
</tr>
<tr>
<td>Enable action on mass-mailing behavior</td>
<td>Select <strong>Enable action on mass-mailing behavior</strong> from the Security Risk Scan Action screen to provide early warning of outbreaks.</td>
</tr>
<tr>
<td>Outbreak Alerts</td>
<td>When an attack occurs, it is vital that administrators receive early warning to prevent the attack from spreading. Trend Micro recommends setting ScanMail to send alerts to key network security professionals when outbreak conditions threaten your network. You can use Outbreak Alert to set ScanMail to automatically notify designated individuals.</td>
</tr>
</tbody>
</table>
Consider your overall security

ScanMail for Microsoft Exchange is designed to guard your Exchange mail servers. ScanMail does not provide protection to non-Exchange mail servers, file servers, desktops, or gateway devices. ScanMail protection is enhanced when used together with other Trend Micro products such as Trend Micro OfficeScan™ to protect your file servers and desktops, and Trend Micro InterScan VirusWall™ or InterScan™ Messaging Security Suite to protect your network perimeter.

Visit the Trend Micro website for a more comprehensive list of solutions for all your network security needs.


Exclude ScanMail folders from scans

File-based antivirus software usually allows you to set up folders to exclude from scanning. Trend Micro recommends setting up the following folders to exclude from scanning when using ScanMail with other antivirus software:

- SMEX/storage/
- SMEX/temp
- SMEX/debug

Note

These folder names are the names that ScanMail uses by default when it installs.

Managing Outbreak Situations

Outbreaks happen when viruses/malware, Trojans, worms, or other spyware/grayware suddenly attack many Exchange servers or personal computers on your network. There are many reasons why an attack might occur such as out-of-date components, poor configuration of anti-virus software, or a new malware arising for which there is not yet a pattern file. Outbreaks are a critical time when administrators must endure a chaotic, time-consuming process of communication, often to global and decentralized groups within their organizations.
The actions that administrators take when outbreaks happen can be broken down into four general stages:

1. Confirming that the security incident is a legitimate problem and not a false alarm
2. Responding to the security incident
3. Analyzing the security incident
4. Recovering the Exchange servers and mailboxes

ScanMail has some very useful features that can assist administrators in every stage of an outbreak. Consider the following features when an outbreak threatens:

1. To confirm that the security incident is truly a malware outbreak:
   - Check the Trend Micro website for virus/malware alerts and the latest security advisory information.  
     http://www.trendmicro.com/vinfo/
   - Check ScanMail notifications. ScanMail can be configured to automatically send alerts when outbreak conditions exist. In addition, ScanMail can be configured to notify administrators or other designated individuals when ScanMail takes actions against detected threats.
   - For a quick analysis of the security incident, view the ScanMail Summary screen or create a one-time report. For more detailed information about the security incident, query ScanMail logs.

2. Responding
   - Manually update components to immediately download the latest ScanMail components.
   - Follow-up the update with a manual scan of the entire information store. Use the Trend Micro recommended defaults such as IntelliScan and ActiveAction or set even more aggressive scanning filters. If you know exactly what you are scanning for, select Specified files from the Security Risk Scan screen and type the name of the file for ScanMail to detect.

3. Analyzing
• Perform a Log Query to discover information about the attack. The log contains such useful information as the time and date, sender and receiver, and infected attachment names.

• If you need assistance to help analyze the security problem, send your virus/malware case to the Trend Micro Virus Response Service.


• If you need more assistance, contact Trend Micro support. See Contacting Trend Micro on page 23-3.

4. Recovering

• When you have restored your Exchange environment, consider changing your configurations and security policies. Consider the following points:
  • Set ScanMail to back up files before taking action and then set very aggressive configurations. This allows ScanMail to detect and eliminate many threats without taking irreversible actions.
  • Monitor the results using the real-time monitor or by generating logs and reports.
  • Use the Server Management tool to quickly and easily replicate configurations from one secure and tested ScanMail server to another.
Chapter 4

Managing ScanMail

This chapter describes how to open and use the product console, and how to manage your ScanMail servers.

Topics include:

- Understanding Real-time Monitor on page 4-2
- Understanding the Server Management Console on page 4-4
- Starting and Stopping the Services on page 4-10
- Understanding ScanMail Icons on page 4-10
Understanding Real-time Monitor

The Real-time monitor displays information about one Exchange server in real time. Administrators can view ScanMail scanning messages and the current count of any security risks detected on the server.

Use Real-time Monitor to monitor the local server, or any server connected to the network. This allows administrators to manage ScanMail servers from a centralized location.

---

Note

Details may be different depending on the Exchange version, server role, and license version.
### Real-time Monitor

**Note:** The ScanMail main console will not time-out while the real-time monitor is active.

- **Server name:** WIN-0JN171PM00M
- **Smart Scan Agent pattern:** 13.783.00
- **Virus pattern:** 12.783.00
- **IntelliTrap pattern:** 0.235.00
- **Spyware pattern:** 1.891.00
- **Spam pattern:** 23466.005
- **URL Filtering engines:** 3.910.1008
- **Advanced Threat Scan Engine:** 10.000.1040
- **Contextual Intelligence Query Handler:** 1.100.1047
- **Advanced Threat Correlation Pattern:** 1.112.00

Real-time scan has been running since: 11/14/2017 1:17:32 AM

<table>
<thead>
<tr>
<th>Scanning Status</th>
<th>Last reset time: 11/14/2017 1:17:32 AM</th>
<th>Reset Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Messages scanned</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>Viruses/Malware found</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Spyware/Grayware found</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Undeliverable messages</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Blocked attachments</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Spam messages</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Phishing messages</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Blocked connections - email reputation</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Content filtering violations</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Data Loss Prevention incidents</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Suspicious URLs - Web reputation</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Rewritten URLs</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Advanced spam incidents</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Advanced threat detections</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

**Scanned Messages**

<table>
<thead>
<tr>
<th>Date/Time</th>
<th>Message from</th>
<th>Total recipient(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>11/15/2017 10:59:49 PM</td>
<td>&lt;&lt;1 &gt;&gt;</td>
<td>1</td>
</tr>
<tr>
<td>11/15/2017 10:59:49 PM</td>
<td>&lt;&lt;1 &gt;&gt;</td>
<td>1</td>
</tr>
<tr>
<td>11/15/2017 8:15:48 PM</td>
<td><a href="mailto:administrator@do.not.reply">administrator@do.not.reply</a></td>
<td>1</td>
</tr>
<tr>
<td>11/15/2017 8:15:48 PM</td>
<td><a href="mailto:administrator@do.not.reply">administrator@do.not.reply</a></td>
<td>1</td>
</tr>
<tr>
<td>11/15/2017 8:15:48 PM</td>
<td><a href="mailto:administrator@do.not.reply">administrator@do.not.reply</a></td>
<td>1</td>
</tr>
<tr>
<td>11/15/2017 8:15:48 PM</td>
<td><a href="mailto:administrator@do.not.reply">administrator@do.not.reply</a></td>
<td>1</td>
</tr>
<tr>
<td>11/15/2017 6:57:53 PM</td>
<td><a href="mailto:administrator@do.not.reply">administrator@do.not.reply</a></td>
<td>1</td>
</tr>
</tbody>
</table>

**FIGURE 4-1. Real-time Monitor**

A brief description of the options is available below:

- **Reset Count:** Resets all Scanning Status counts and messages scanned to zero and clears Message Scanned information
- **Clear Content:** Clears Scanned Messages information
- **Close:** Closes the screen
Viewing Real-time Monitor for a Remote Server

Procedure

1. Access the remote server using the product console.
2. Click **Real-time monitor** in the banner.

   The **Real-time Monitor** screen opens displaying information about the remote server.

Understanding the Server Management Console

The ScanMail Server Management console allows you to view all of the ScanMail servers on a network. You will only see servers with the same type of Activation Code. View all ScanMail servers in a forest when you install ScanMail with Exchange 2019, 2016, or 2013.

**FIGURE 4-2. The Server Management console**

Activating Server Management

The **Server Management** console displays remote server status and allows you to replicate settings to remote servers. If you did not activate Server management during the ScanMail installation process, you need to activate Server management before you use the Server management console.
Procedure

1. Log on the ScanMail server using an account with local administrator privileges.
2. Click the Server management link at the top of the product console.
3. Specify an existing group in Active Directory and the activation wizard prompts you through the steps required to activate Server Management.

Using the Server Management Console

Use the Server Management console to do the following:

**Table 4-1. Server Management Console Features**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View pattern and engine version</td>
<td>View information about Smart Scan Agent Pattern, Virus Pattern, Advance Threat Correlation Pattern, Spyware Pattern, Virus Scan Engine, Contextual Intelligence Query Handler, Advanced Threat Scan Engine, Anti-spam Pattern, Anti-spam Engine, IntelliTrap Pattern, IntelliTrap Exception Pattern, and URL Filtering Engine.</td>
</tr>
<tr>
<td>View scan results</td>
<td>View information about the total messages scanned and the scan results for remote ScanMail servers. Scanning results also shows the number of detected:</td>
</tr>
<tr>
<td></td>
<td>• Security Risks</td>
</tr>
<tr>
<td></td>
<td>• Uncleanable Virus/ Malware</td>
</tr>
<tr>
<td></td>
<td>• Advanced Threats</td>
</tr>
<tr>
<td></td>
<td>• Blocked Attachments</td>
</tr>
<tr>
<td></td>
<td>• Spam</td>
</tr>
<tr>
<td></td>
<td>• Advanced Spam</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| View scan status      | Indicates whether the scan type is enabled or disabled. View the following scan status types for remote ScanMail servers:  
  • Store Security Risk Scan  
  • Transport Security Risk Scan  
  • Store Attachment Blocking  
  • Transport Attachment Blocking  
  • Store Content Filtering  
  • Transport Content Filtering  
  • Spam Prevention  
  • Advanced Spam Prevention  
  • Data Loss Prevention  
  • Web Reputation  
  • URL Time-of-Click Protection  
  • Virtual Analyzer |
| View last replication | View the server name, status, and duration of the last replication. |
### Feature Description

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| Replicate settings to remote servers | Replicate settings to one or multiple remote servers in the list. Administrators can choose to replicate All Settings, Overwrite server-dependent settings (such as quarantine and backup directories), or select from the Specified Settings below:  
  - Security Risk Scan  
  - Attachment Blocking  
  - Content Filtering  
  - Spam Prevention  
  - Advanced Spam Prevention  
  - Web Reputation  
  - URL Time-of-Click Protection  
  - Data Loss Prevention  
  - DLP Templates  
  - Manual Scan  
  - Scheduled Scan  
  - Smart Protection  
  - Virtual Analyzer  
  - Updates  
  - Alerts  
  - Reports  
  - Logs  
  - Special Group  
  - Server Groups  
  - Internal Domains  
  - Product License  
  - Administration (Proxy, External Disclaimer, Notification Settings, Real-time Scan Settings, Access Control, Apex Central) |
| View Smart Protection status | View information about your Smart scan servers including server name, scan service, scan setting, smart protection source, and server status. |

**Viewing Servers from the Product Console**

You can administer one server at a time using the ScanMail product console.
Note
Use an account with local administrator privileges and/or an account that belongs to the ScanMail administrative group. Administrators can use an account that is part of the Active Directory group or any Active Directory group that is part of the Exchange forest that was used to activate Server Management.

Procedure

• From a local server:

  a. Click Start > Programs > Trend Micro ScanMail for Microsoft Exchange > ScanMail Management Console.

  Note
  On Windows 2012 platforms, only a desktop shortcut is available.

  b. Type your user name and password.

  c. Click Enter.

• From a remote server:

  Use a web browser that supports frames and access the following:

  https://<servername>:<portnumber>/smex

  Where:

  • servername is the name of the server on which you installed ScanMail
  • port number is the port number you use to access that computer

  Note
  By default, HTTPS uses port 16373.
Using Server Management to Replicate Configurations

You can use **Server Management** to replicate any or all of your configurations from one ScanMail server to another. Replicating servers in this way is much faster and easier than configuring each server separately. In addition, it ensures that all ScanMail servers that provide the same kind of protection share the same configuration.

**Procedure**

1. Click **Server management** to open the **Server Management** screen.
2. Select target servers.
3. Click **Replicate**.
   
   The **Replication Settings** screen appears.
4. Select the settings that you want to replicate:
   
   • Click **All settings** to replicate all the configurations to the target server(s)
   • Click **Specified settings** to set each configuration that you want to replicate individually

   **Note**

   The server on which you are currently logged on is the source for the replication.
5. Select the check box to overwrite server-dependent settings. When this check box is selected, ScanMail can copy directory paths that you have set for such folders as the quarantine and backup folders.
6. Click **Deploy**.

   A screen appears showing a progress bar and the ongoing status of the replication.
Starting and Stopping the Services

ScanMail services may need to be started or stopped for procedures such as a manual rollback. You can start and stop services from the Microsoft Services console.

ScanMail adds the following services:

- **ScanMail for Microsoft Exchange Master Services**: The main ScanMail service
- **ScanMail for Exchange Remote Configuration Server**: For remote configuration
  
  **Note**
  
  This service is not added for ScanMail with Exchange Server 2019, 2016 and 2013 Edge Transport server roles.

- **ScanMail for Microsoft Exchange System Watcher**: Monitors logs for system events
- **ScanMail EUQ Monitor**: ScanMail adds this service if End User Quarantine was selected during installation

Understanding ScanMail Icons

The following table displays ScanMail icons.

**TABLE 4-2. ScanMail Icons**

<table>
<thead>
<tr>
<th>ICON</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="?" alt="Help" /></td>
<td>Click to view the ScanMail Help.</td>
</tr>
<tr>
<td><img src="?" alt="Enabled" /></td>
<td>Click to disable a rule or policy. When this icon displays, the rule or policy is currently enabled.</td>
</tr>
<tr>
<td><img src="?" alt="Disabled" /></td>
<td>Click to enable a rule or policy. When this icon displays, the rule or policy is currently disabled.</td>
</tr>
<tr>
<td><strong>ICON</strong></td>
<td><strong>DESCRIPTION</strong></td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="refresh" /> Refresh</td>
<td>Click to refresh the information on the screen.</td>
</tr>
<tr>
<td><img src="image" alt="warning" /> Warning</td>
<td>This indicates a warning status.</td>
</tr>
<tr>
<td><img src="image" alt="enabled" /> Enabled</td>
<td>This indicates an enabled status.</td>
</tr>
<tr>
<td><img src="image" alt="disabled" /> Disabled</td>
<td>This indicates a disabled status.</td>
</tr>
<tr>
<td><img src="image" alt="delete" /> Delete</td>
<td>Click to delete a template.</td>
</tr>
<tr>
<td><img src="image" alt="tooltip" /> Tooltip</td>
<td>Mouse over this icon to see helpful information about a feature.</td>
</tr>
<tr>
<td><img src="image" alt="show details" /> Show details</td>
<td>Click to expand the drop-down.</td>
</tr>
<tr>
<td><img src="image" alt="hide details" /> Hide details</td>
<td>Click to collapse the drop-down.</td>
</tr>
</tbody>
</table>
Part II

Configuring Scans and Scan Filters
Chapter 5

Understanding Smart Protection

This chapter discusses Trend Micro smart protection solutions and describes how to set up the environment required to use the solutions.

Topics include:

- About Trend Micro Smart Protection on page 5-2
- Configuring Local Sources on page 5-7
- Scan Service Settings on page 5-8
About Trend Micro Smart Protection

Trend Micro™ smart protection is a next-generation cloud-client content security infrastructure designed to protect customers from security risks and web threats. It powers both local and hosted solutions to protect users whether they are on the network, at home, or on the go, using light-weight agents to access its unique in-the-cloud correlation of email, web and file reputation technologies, as well as threat databases. Customers’ protection is automatically updated and strengthened as more products, services, and users access the network, creating a real-time neighborhood watch protection service for its users.

By incorporating in-the-cloud reputation, scanning, and correlation technologies, the Trend Micro smart protection solutions reduce reliance on conventional pattern file downloads and eliminate the delays commonly associated with desktop updates.

The Need for a New Solution

In the current approach to file-based threat handling, patterns (or definitions) required to protect endpoints are, for the most part, delivered on a scheduled basis. Patterns are delivered in batches from Trend Micro to agents. When a new update is received, the virus/malware prevention software on the agent reloads this batch of pattern definitions for new virus/malware risks into memory. If a new virus/malware risk emerges, this pattern once again needs to be updated partially or fully and reloaded on the agent to ensure continued protection.

Over time, there has been a significant increase in the volume of unique emerging threats. The increase in the volume of threats is projected to grow at a near-exponential rate over the coming years. This amounts to a growth rate that far outnumber the volume of currently known security risks. Going forward, the volume of security risks represents a new type of security risk. The volume of security risks can impact server and workstation performance, network bandwidth usage, and, in general, the overall time it takes to deliver quality protection - or "time to protect".

A new approach to handling the volume of threats has been pioneered by Trend Micro that aims to make Trend Micro customers immune to the threat of virus/malware volume. The technology and architecture used in this pioneering effort leverages technology that off-loads the storage of virus/malware signatures and patterns to the cloud. By off-loading the storage of these virus/malware signatures to the cloud, Trend
Micro is able to provide better protection to customers against the future volume of emerging security risks.

**Smart Protection Services**

Smart protection includes services that provide anti-malware signatures, web reputations, and threat databases that are stored in-the-cloud.

Smart protection services include:

- **File Reputation Services**: File Reputation Services off-loads a large number of anti-malware signatures that were previously stored on agent computers to smart protection sources.

  For details, see *File Reputation Services on page 5-3*.

- **Web Reputation Services**: Web Reputation Services allows local smart protection sources to host URL reputation data that were previously hosted solely by Trend Micro. Both technologies ensure smaller bandwidth consumption when updating patterns or checking a URL’s validity.

  For details, see *Web Reputation Services on page 5-3*.

**File Reputation Services**

File Reputation Services checks the reputation of each file against an extensive in-the-cloud database. Since the malware information is stored in the cloud, it is available instantly to all users. High performance content delivery networks and local caching servers ensure minimum latency during the checking process. The cloud-agent architecture offers more immediate protection and eliminates the burden of pattern deployment besides significantly reducing the overall agent footprint.

ScanMail must be in smart scan mode to use File Reputation Services.

**Web Reputation Services**

With one of the largest domain-reputation databases in the world, Trend Micro web reputation technology tracks the credibility of web domains by assigning a reputation
score based on factors such as a website's age, historical location changes and indications of suspicious activities discovered through malware behavior analysis. Web reputation then continues to scan sites and block users from accessing infected ones. Web reputation features help ensure that the pages that users access are safe and free from web threats, such as malware, spyware, and phishing scams that are designed to trick users into providing personal information. To increase accuracy and reduce false positives, Trend Micro Web reputation technology assigns reputation scores to specific pages or links within sites instead of classifying or blocking entire sites, since often, only portions of legitimate sites are hacked and reputations can change dynamically over time.

Web reputation helps deter users from following malicious URLs when the feature is enabled. Web reputation queries the assigned web reputation server for the reputation rating upon receipt of an email message with a URL in the message body or attachment. Depending on the configuration, Web Reputation can quarantine, delete, or tag the email message with URLs.

---

**Tip**

To save network bandwidth, Trend Micro recommends configuring the setting **Bypass internal domain URLs** as default to bypass scanning for the enterprise internal web sites.

---

**Smart Protection Sources**

Trend Micro delivers File Reputation Services and Web Reputation Services to ScanMail and smart protection sources.

Smart protection sources provide File Reputation Services by hosting the majority of the virus/malware pattern definitions. OfficeScan agents host the remaining definitions. The agent sends scan queries to smart protection sources if its own pattern definitions cannot determine the risk of the file. Smart protection sources determine the risk using identification information.

Smart protection sources provide Web Reputation Services by hosting web reputation data previously available only through Trend Micro hosted servers. The agent sends web reputation queries to smart protection sources to check the reputation of websites that a user is attempting to access. The agent correlates a website’s reputation with the specific web reputation policy enforced on the endpoint to determine whether access to the site will be allowed or blocked.
Trend Micro™ Smart Protection Network™

The Trend Micro™ Smart Protection Network™ is a next-generation cloud-client content security infrastructure designed to protect customers from security risks and web threats. It powers both on-premise and Trend Micro hosted solutions to protect users whether they are on the network, at home, or on the go. Smart Protection Network uses lighter-weight agents to access its unique in-the-cloud correlation of email, web, and file reputation technologies, as well as threat databases. Customers’ protection is automatically updated and strengthened as more products, services and users access the network, creating a real-time neighborhood watch protection service for its users.

Smart Protection Server

The Smart Protection Server retains a repository of file reputation virus/malware threats and verified web reputation threats. The implementation of a Smart Protection Server reduces bandwidth usage and provides a higher level of privacy for companies. Smart Protection Servers verify all queries against their local reputation data.

There are two types of Smart Protection Servers:

- **Integrated Smart Protection Server**: An integrated Smart Protection Server installs alongside other Trend Micro products. ScanMail can leverage these pre-existing server resources without the need to expend further resources.

- **Standalone Smart Protection Server**: A standalone Smart Protection Server installs on a VMware or Hyper-V server. The standalone server has a separate management console and the ScanMail web console does not manage it.

Smart Protection Sources Compared

The following table highlights the differences between Smart Protection Network and Smart Protection Server.
### Table 5-1. Smart Protection Sources Compared

<table>
<thead>
<tr>
<th>Basis of Comparison</th>
<th>Smart Protection Server</th>
<th>Trend Micro Smart Protection Network</th>
</tr>
</thead>
<tbody>
<tr>
<td>Availability</td>
<td>Available for internal agents, which are agents that meet the location criteria specified on the ScanMail web console</td>
<td>Available mainly for external agents, which are agents that do not meet the location criteria specified on the ScanMail web console</td>
</tr>
<tr>
<td>Purpose</td>
<td>Designed and intended to localize smart protection services to the corporate network to optimize efficiency</td>
<td>A globally scaled, Internet-based infrastructure that provides smart protection services to agents who do not have immediate access to their corporate network</td>
</tr>
<tr>
<td>Administration</td>
<td>ScanMail administrators install and manage these smart protection sources</td>
<td>Trend Micro maintains this source</td>
</tr>
<tr>
<td>Pattern update source</td>
<td>Trend Micro ActiveUpdate server</td>
<td>Trend Micro ActiveUpdate server</td>
</tr>
<tr>
<td>Agent connection protocols</td>
<td>HTTP and HTTPS</td>
<td>HTTPS</td>
</tr>
</tbody>
</table>

### Smart Protection Pattern Files

File Reputation Services and Web Reputation Services use the smart protection pattern files. Trend Micro releases these pattern files through the Trend Micro ActiveUpdate server.
### Table 5-2. Smart Protection Pattern Files

<table>
<thead>
<tr>
<th>Pattern File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smart Scan Agent Pattern</td>
<td>ScanMail downloads the daily updates to the Smart Scan Agent Pattern. When in smart scan mode, ScanMail uses the Smart Scan Agent Pattern when scanning for security risks. If the pattern cannot determine the risk of the file, ScanMail leverages another pattern, called the Smart Scan Pattern.</td>
</tr>
<tr>
<td>Smart Scan Pattern</td>
<td>Smart protection sources download the hourly updates to the Smart Scan Pattern. ScanMail verifies potential threats against the Smart Scan Pattern by sending scan queries to smart protection sources.</td>
</tr>
<tr>
<td>Web Blocking List</td>
<td>Smart protection sources download the Web Blocking List. ScanMail verifies a website’s reputation against the Web Blocking List by sending web reputation queries to a smart protection source. ScanMail correlates the reputation data received from the smart protection source with the web reputation policy enforced on the computer. Depending on the policy, ScanMail will either allow or block access to the site.</td>
</tr>
</tbody>
</table>

### Configuring Local Sources

Configure the local sources settings to use smart scan in Security Risk Scans.

#### Procedure

1. Click **Smart Protection > Local Sources** from the main menu.
   
   The **Local Sources** screen displays.

2. Click **Add**.
   
   The **Add Smart Protection Server** screen appears.

3. Type the **Server name or address** for the server you want to add.
4. Select **File Reputation service port** and type the port number for the Smart Protection Server providing file reputation services. Select **Web Reputation service port** and type the port number for the Smart Protection server providing web reputation services.

---

**Tip**

You can locate the port numbers of the Smart Protection Server by opening the server’s web console and viewing the **Reputation Services Summary** screen.

---

5. For a Smart Protection Server providing file reputation services, optionally select to enable Secure Sockets Layer (SSL) protocol.

6. Click the appropriate test connection button to verify a successful connection to the server.

7. Click **Add**.

   The Smart Protection Server displays at the bottom of the Smart Protection Server List.

8. Specify the **Query order**:

   • **As listed**: Select to query the servers by priority.

     Specify the priority of the Smart Protection Servers by clicking the up and down arrows. ScanMail will send queries to the Smart Protection Servers based on the priority in this list.

   • **Random**: Select to query the servers randomly.

9. Click **Proxy Settings** and configure proxy settings if ScanMail requires a proxy for server communication with Smart Protection Server.

10. Click **Save**.

---

**Scan Service Settings**

A brief description of the Scan Service Settings (**Smart Protection > Scan Service Settings**) is available below.
### Table 5-3. Scan Service Settings

<table>
<thead>
<tr>
<th>Scan Type</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Risk Scan</td>
<td>- <strong>Conventional Scan</strong>: Select the scan method used in previous ScanMail versions. All components used for security risk scans are stored locally on the ScanMail server.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Smart Scan - File Reputation service</strong>: Select the next-generation, in-the-cloud protection solution. At the core of this solution is an advanced scanning architecture that leverages threat signatures that are stored in the cloud. Install Smart Protection Servers on your network to further increase scan efficiency.</td>
</tr>
<tr>
<td>Web Reputation Services</td>
<td>- <strong>Smart Protection Network</strong>: Sends all web reputation queries to Trend Micro servers for verification.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Smart Protection Server</strong>: Verifies all web reputation queries locally. If the local server cannot verify the queries, the server sends them to Trend Micro servers for further analyses.</td>
</tr>
</tbody>
</table>
Chapter 6

Configuring Scans

This chapter explains how to configure Real-time, Manual, and Scheduled scans to protect your Exchange environment.

Topics include:

• About Scans on page 6-2
• Compressed File Handling on page 6-7
• About ScanMail Actions on page 6-9
• Notifications on page 6-23
About Scans

ScanMail has three types of scans: real-time scans, manual scans, and scheduled scans. To protect your Exchange environment, ScanMail scans messages and their attached files, searching for security risks and undesirable data. When ScanMail makes a detection, ScanMail automatically takes action against the detection according to your configurations.

You can configure ScanMail to scan specific targets and configure actions for ScanMail to take when it discovers a security risk or undesirable data in the targeted messages or files. You can also configure ScanMail to send notifications when it takes actions against security risks and undesirable data.

You can configure ScanMail to backup a file to the Backup folder before taking action on it. This is a safety precaution designed to protect the original file from damage.

Note

Trend Micro recommends deleting backed up files once you have determined that the original file was not damaged and that it is usable after ScanMail has executed an action on it. If the file becomes damaged or unusable, send it to Trend Micro for further analysis.

Even if ScanMail has completely cleaned and removed the virus itself, some viruses damage the original file code beyond repair.

By default, ScanMail scans all scannable outgoing, incoming, and stored messages in your Exchange environment. Scannable files are all files except files that are encrypted, password protected, or exceed user-configured scanning restrictions. Scanning all files provides the maximum security possible. However, scanning every message requires a lot of time and resources and might be redundant in some situations. Therefore, consider limiting the files ScanMail includes in scans.

Real-time Scan

ScanMail scans the following in real time:

• All incoming and outgoing email messages
• SMTP messages arriving at Exchange from the Internet
• Public-folder postings
• All server-to-server replications

Trust Scan

Real-time scan can skip scanning email messages at the store level when the message has been scanned by ScanMail at the Hub Transport Level.

Once ScanMail scans a message on an Edge or Hub Transport server, ScanMail adds scan information to the message. When the message reaches the Mailbox, ScanMail evaluates the scan information to prevent redundant use of resources. ScanMail only scans the message if the message was scanned with an older scan engine or pattern file or if ScanMail has not previously scanned the message.

Manual Scan

You can run a manual scan to ensure that ScanMail scans all messages in the Information Store once. Completely scanning the Information Store in this way minimizes the chance of infections from unexpected sources such as unprotected mail servers or improper configurations. Manual scanning scans the entire Information Store by default; however, you can configure ScanMail to scan any of the Mailbox Stores and Public Folder Stores. For clusters, ScanMail can scan each virtual server on one node.

Note

If you have more than one storage group, you may want to disable scanning the replicated databases. Go to Manual Scan and change the databases selected for scanning.

You can perform security risk scan, attachment blocking, content filtering and data loss prevention through manual scanning. These filters are similar to those used during real-time scan, except some actions are not available during manual or scheduled scans.

You can specify the store database that belongs to a current virtual server. If manual scan is in progress, you cannot start a new Manual Scan process and ActiveUpdate does not interrupt Manual Scan. However, if a Scheduled Scan is in progress, starting a
Manual Scan stops the scheduled scan. Scheduled scan resumes according to its schedule.

Scheduled Scan

Scheduled Scan runs automatically on the appointed date and time, and pauses after the configure time lapses. If the scan pauses before it completes, it resumes after the next scheduled date and time. Use Scheduled Scan to automate routine scans and improve scan management efficiency.

Starting another scheduled scan does not interrupt the scheduled scan that is already in progress. ActiveUpdate does not interrupt a scheduled scan.

Scheduled Scan List

A brief description of the options is available below.

• **Add**: Click to add a new scheduled scan to the list.

• **Delete**: Click to delete scheduled scan tasks selected from the list.

• **Stop All Schedules**: Click to stop all scheduled scans whether they are currently running or in queue.

• **Enable**: Click to enable/disable a scheduled scan.

About Manual Scans and Scheduled Scans on Cluster Servers

**Node-based Scanning**

The Manual and Scheduled Scans are node based. This means, only one manual or scheduled scan can be run on one node at the same time.

**Scans During a Failover or Following a Real-time Scan Change**

During a failover period on clusters, the database of the Information Store will be unmounted and mounted by another node. After failover, manual or scheduled scan tasks stop. This is also true when the real-time scan status changes on the same node (as
a result of enabling or disabling virus scanning, attachment blocking, or content filtering).

## Manual and Scheduled Scan Settings

A brief description of the options is available below.

**Table 6-1. Manual and Scheduled Scan Settings**

<table>
<thead>
<tr>
<th>SECTION</th>
<th>SETTINGS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Schedule</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Only available for Scheduled Scans.</td>
</tr>
<tr>
<td>Scan every:</td>
<td></td>
</tr>
<tr>
<td><strong>Day:</strong> Select to perform a scan every day at a specific time.</td>
<td></td>
</tr>
<tr>
<td><strong>Pause scan after:</strong></td>
<td></td>
</tr>
<tr>
<td>Select between 01 and 23 hours to pause the scan after the time lapses. ScanMail will resume the current scan at the next scheduled time.</td>
<td></td>
</tr>
<tr>
<td>Select 00 hours if you do not want to pause the scan, and want to keep it running until it completes.</td>
<td></td>
</tr>
<tr>
<td><strong>Week on:</strong> Select to perform a scan every week on a specific day and time.</td>
<td></td>
</tr>
<tr>
<td><strong>Month on day:</strong> Select to perform a scan every month on a specific date and time.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Database Selection</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All databases:</strong> Select this to scan all databases including any databases you add after this setting is configured.</td>
<td></td>
</tr>
<tr>
<td><strong>Specific databases:</strong> Select this to scan databases you specify.</td>
<td></td>
</tr>
<tr>
<td><strong>Refresh:</strong> Click to display the latest Mailbox databases.</td>
<td></td>
</tr>
</tbody>
</table>
### Section: Folder Selection

**Note**


- **All folders**: Select this option to scan all the folders on Exchange 2013 and Exchange 2016 servers.
- **Specific folders**: Select this option to scan folders you specify.
- **Enable public folder scan**: Select this to scan the public folders on Exchange 2013 and Exchange 2016 servers.

### Section: Scan Type Selection

- **Security risk scan**: Select this to scan for viruses/malware and advanced threats, based on the configured settings.
- **Attachment blocking**: Select this to perform a scan based on the attachment blocking settings.
- **Content filtering**: Select this to perform a scan based on the content filtering settings.
- **Data Loss Prevention**: Select this to perform a scan based on the Data Loss Prevention settings.

### Section: Incremental Scan Options

**Note**

If all check boxes are clear, all messages in the database(s) you specify are scanned.

- **Scan messages delivered**: Select this to scan messages delivered during a time period.
- **Scan messages with attachments**: Select this to only scan messages with attachments.
- **Scan messages that have not been scanned**: Select this to only scan messages that have not been previously scanned by ScanMail.

### Section: CPU Usage

**Note**

This feature allows you to manage performance by limiting the resources that manual and scheduled scans use.

- **Enable CPU usage limitation**: Select to limit CPU usage and specify the maximum CPU percentage used.
Compressed File Handling

Compressed files provide a number of special security concerns. Compressed files can be password-protected or encrypted, can harbor so-called “zip-of-death” security risks, and can contain numerous layers of compression.

Compression Types

The ScanMail scan engine can extract and scan files compressed using any of the most popular compression types (listed below). ScanMail can also check for viruses/malware being "smuggled" within nested compressions, for example, an infected file that is zipped, ARJ-compressed, MS-compressed, and zipped again.

The maximum number of recursive scan layers is 20. You can configure this limit from Security Risk Scan > Target > Scan Restriction Criteria.

<table>
<thead>
<tr>
<th>TABLE 6-2. Supported Compression Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Archive created by LHA (.lzh)</td>
</tr>
<tr>
<td>• Archive created by Pkzip (.zip)</td>
</tr>
<tr>
<td>• Archive created by RAR (.rar)</td>
</tr>
<tr>
<td>• Archive created by Tar (.tar)</td>
</tr>
<tr>
<td>• ARJ Compressed archive (.arj)</td>
</tr>
<tr>
<td>• BINHEX (.hqx)</td>
</tr>
<tr>
<td>• GNU Zip (.gz; .gzip)</td>
</tr>
<tr>
<td>• LZW/Compressed 16bits (.Z)</td>
</tr>
<tr>
<td>• MacBinary (.bin)</td>
</tr>
<tr>
<td>• Microsoft Cabinet (.cab)</td>
</tr>
<tr>
<td>• Microsoft Compressed/MSCOMP</td>
</tr>
<tr>
<td>• MIME (.eml; .mht)</td>
</tr>
<tr>
<td>• Teledisk format (.td0)</td>
</tr>
<tr>
<td>• Unix BZ2 Bzip compressed file (.bz2)</td>
</tr>
<tr>
<td>• UUEncode (.u)</td>
</tr>
<tr>
<td>• WinAce (.ace)</td>
</tr>
</tbody>
</table>

Blocking All Compressed Attachments

Consider configuring ScanMail to block all compressed files sent to clients. Users can be notified through their mail client that ScanMail blocked the attached file.
Procedure

1. Go to the Attachment Blocking Target tab.
   • For Manual or Scheduled Scans:
     [Scan type] > Attachment Blocking > Target
   • For Real-time Scans:
     Attachment Blocking > Global Policy > Target

2. Click Specific attachments, then click Attachment types and expand the category.

3. Click Compressed files.

4. Click Action and select an action.

5. Click Notification and select a notification method.

Security Risk Scan Compressed File Restrictions

The following tables describes the compressed file restrictions available in ScanMail.

**TABLE 6-3. Security Risk Scan Compressed File Restrictions**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decompressed file count exceeds</td>
<td>Type a number to configure a restriction for the number of decompressed files that ScanMail will scan. When the amount of decompressed files within the compressed file exceeds this number, then ScanMail only scans files up to the limit set by this option.</td>
</tr>
<tr>
<td>Size of decompressed files exceeds</td>
<td>Type a number that represents the size limit in MB. ScanMail only scans compressed files that are smaller or equal to this size after decompression.</td>
</tr>
</tbody>
</table>
### About ScanMail Actions

The actions that ScanMail takes when scans detect viruses/malware, suspicious URLs, or undesirable content can include the following:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of layers of compression exceeds</td>
<td>Type a number from 1-20. ScanMail only scans compressed files that have less than or equal to the specified layers of compression. For example, if you set the limit to 5 layers of compression, then ScanMail will scan the first 5 layers of compressed files, but not scan files compressed to 6 or more layers.</td>
</tr>
<tr>
<td>Size of decompressed file is &quot;x&quot; times the size of compressed file</td>
<td>ScanMail only scans compressed files when the ratio of the size of the decompressed file compared to the size of the compressed file is less than or equal to this number. This function prevents ScanMail from scanning a compressed file that might cause a Denial-of-Service (DoS) attack. A Denial-of-Service (DoS) attack happens when a mail server's resources are overwhelmed by unnecessary tasks. Preventing ScanMail from scanning files that decompress into very large files helps prevent this problem from happening.</td>
</tr>
</tbody>
</table>

**Note**

Not all actions are available for every type of scan. For details about the actions available for a specific scan, refer to the configuration settings for the scan or refer to *Scan Actions by Scan Settings on page 6-12.*
### Table 6-4. ScanMail Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Clean                   | Removes viral code from infected message bodies and attachments. The remaining email message text, any uninfected files, and the cleaned files are delivered to the intended recipient(s).  

Tip  
Trend Micro recommends using the default scan action "clean" for viruses/malware.  

Under some conditions, ScanMail cannot clean a file. These files are referred to as uncleanable. You can configure ScanMail to take a special action against these files when they are detected.  

During a manual or scheduled scan, ScanMail updates the Information Store and replaces the file with the cleaned one. |
| Replace with text/file  | ScanMail deletes the attachment, infected, malicious, or undesirable content and replaces it with text or a file. The email message is delivered to the intended recipient, but the text replacement informs them that the original content was infected and was replaced.  

Note  
For Data Loss Prevention and content filtering, ScanMail does not perform this action in Transport level scans when the violation is in the header/subject of the email message.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                 |
<p>| Quarantine entire message | ScanMail moves the email message to a restricted access folder, removing it as a security risk to the Exchange environment. This option is not available in manual and scheduled scanning. |</p>
<table>
<thead>
<tr>
<th>ACTION</th>
<th>DESCRIPTION</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quarantine message part</td>
<td>ScanMail moves the email message body or attachment to a restricted access folder, removing it as a security risk to the Exchange environment. ScanMail replaces the message part with the text/file you specify.</td>
<td>For Data Loss Prevention and content filtering, ScanMail does not perform this action in Transport level scans when the violation is in the header/subject of the email message.</td>
</tr>
<tr>
<td>Backup</td>
<td>ScanMail backs up the message, delivers, and records the detection in logs.</td>
<td>This action behaves the same as archive in previous versions of ScanMail.</td>
</tr>
<tr>
<td>Delete entire message</td>
<td>During real-time scanning, ScanMail deletes the entire email message.</td>
<td></td>
</tr>
<tr>
<td>Pass</td>
<td>ScanMail records the detection in a log and delivers the message unchanged.</td>
<td></td>
</tr>
<tr>
<td>Pass entire message</td>
<td>ScanMail records the detection in a log and delivers the message unchanged.</td>
<td></td>
</tr>
<tr>
<td>Pass message part</td>
<td>ScanMail records the detection in a log and delivers the message unchanged.</td>
<td>For Data Loss Prevention and content filtering, this does not apply to low priority policies.</td>
</tr>
</tbody>
</table>
Tag and deliver
ScanMail adds a tag to the header information of the email message that identifies it as spam and then delivers it to the intended recipient.

Quarantine message to user’s spam folder
ScanMail moves the email message to the Spam Mail folder located on the server-side of the Information Store.

Forward to sender’s manager
Forward the email message to the sender’s manager.

Forward to specific email address(es)
Forward the email message to the specific email address(es).

### Scan Actions by Scan Settings

The following table lists the scan actions available for each scan filter type.

**Table 6-5. Scan Actions by Scan Settings**

<table>
<thead>
<tr>
<th>Scan Setting</th>
<th>Available Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Risk Scan</td>
<td></td>
</tr>
<tr>
<td>• ActiveAction</td>
<td>• Do not notify</td>
</tr>
<tr>
<td></td>
<td>• Notify</td>
</tr>
<tr>
<td></td>
<td>• Notify when uncleanable</td>
</tr>
</tbody>
</table>
### Configuring Scans

#### Available Actions

<table>
<thead>
<tr>
<th>Scan Setting</th>
<th>Available Actions</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Mass-mailing behavior</td>
<td>• Clean</td>
<td>Not available for Manual and Scheduled Scans.</td>
</tr>
<tr>
<td></td>
<td>• Replace with text/file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Quarantine entire message</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Delete entire message</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Pass</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Quarantine message part</td>
<td></td>
</tr>
<tr>
<td>• All security risks</td>
<td>• Clean</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Replace with text/file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Quarantine entire message</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Delete entire message</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Pass</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Quarantine message part</td>
<td></td>
</tr>
<tr>
<td>Scan Setting</td>
<td>Available Actions</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>• Viruses</td>
<td>• Clean</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Replace with text/file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Quarantine entire message</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Not available for Manual and Scheduled Scans.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Delete entire message</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Pass</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Quarantine message part</td>
<td></td>
</tr>
<tr>
<td>• Worms/Trojans</td>
<td>• Replace with text/file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Quarantine entire message</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Not available for Manual and Scheduled Scans.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Delete entire message</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Pass</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Quarantine message part</td>
<td></td>
</tr>
<tr>
<td>Scan Setting</td>
<td>Available Actions</td>
<td></td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>• Advanced Threats</td>
<td>• Quarantine entire message</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Delete entire message</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Pass</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Replace with text/file</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Not available for Manual and Scheduled Scans.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Quarantine message part</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Only available for Manual and Scheduled Scans.</td>
<td></td>
</tr>
<tr>
<td>• Packed files</td>
<td>• Replace with text/file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Quarantine entire message</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Not available for Manual and Scheduled Scans.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Delete entire message</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Pass</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Quarantine message part</td>
<td></td>
</tr>
<tr>
<td>Scan Setting</td>
<td>Available Actions</td>
<td></td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>• Other malicious code</td>
<td>• Clean</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Replace with text/file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Quarantine entire message</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Not available for Manual and Scheduled Scans.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Delete entire message</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Pass</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Quarantine message part</td>
<td></td>
</tr>
<tr>
<td>• Spyware/Grayware</td>
<td>• Replace with text/file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Quarantine entire message</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Not available for Manual and Scheduled Scans.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Delete entire message</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Pass</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Quarantine message part</td>
<td></td>
</tr>
<tr>
<td>• Uncleanable files</td>
<td>• Replace with text/file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Quarantine entire message</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Not available for Manual and Scheduled Scans.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Delete entire message</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Pass</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Quarantine message part</td>
<td></td>
</tr>
<tr>
<td><strong>SCAN SETTING</strong></td>
<td><strong>AVAILABLE ACTIONS</strong></td>
<td></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Attachment Blocking</td>
<td>• Replace attachment with text/file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Quarantine entire message</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

Not available for Manual and Scheduled Scans.

• Quarantine message part
• Delete entire message
• Notify
• Do not notify
<table>
<thead>
<tr>
<th>Scan Setting</th>
<th>Available Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Filtering</td>
<td>• Replace with text/file</td>
</tr>
<tr>
<td></td>
<td>• Quarantine entire message</td>
</tr>
<tr>
<td></td>
<td>• Quarantine message part</td>
</tr>
<tr>
<td></td>
<td>• Delete entire message</td>
</tr>
<tr>
<td></td>
<td>• Backup</td>
</tr>
<tr>
<td></td>
<td>• Pass message part</td>
</tr>
<tr>
<td></td>
<td>• Pass entire message</td>
</tr>
<tr>
<td></td>
<td>• Forward to sender’s manager</td>
</tr>
<tr>
<td></td>
<td>• Notify</td>
</tr>
<tr>
<td></td>
<td>• Do not notify</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>Not available for Manual and Scheduled Scans.</td>
</tr>
<tr>
<td></td>
<td>Only available for “Match all conditions” policies.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>Not available for Manual and Scheduled Scans.</td>
</tr>
<tr>
<td></td>
<td>• Forward to specific email address(es)</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>Not available for Manual and Scheduled Scans.</td>
</tr>
<tr>
<td>SCAN SETTING</td>
<td>AVAILABLE ACTIONS</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Data Loss Prevention</td>
<td>• Replace with text/file</td>
</tr>
<tr>
<td></td>
<td>• Quarantine entire message</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>Not available for Manual and Scheduled Scans.</td>
</tr>
<tr>
<td></td>
<td>• Quarantine message part</td>
</tr>
<tr>
<td></td>
<td>• Delete entire message</td>
</tr>
<tr>
<td></td>
<td>• Backup</td>
</tr>
<tr>
<td></td>
<td>• Pass message part</td>
</tr>
<tr>
<td></td>
<td>• Forward to sender’s manager</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>Not available for Manual and Scheduled Scans.</td>
</tr>
<tr>
<td></td>
<td>• Forward to specific email address(es)</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>Not available for Manual and Scheduled Scans.</td>
</tr>
<tr>
<td></td>
<td>• Notify</td>
</tr>
<tr>
<td></td>
<td>• Do not notify</td>
</tr>
<tr>
<td>Spam Prevention</td>
<td>• Content Scanning: Spam</td>
</tr>
<tr>
<td></td>
<td>• Quarantine message to user’s spam folder</td>
</tr>
<tr>
<td></td>
<td>• Delete entire message</td>
</tr>
<tr>
<td></td>
<td>• Tag and deliver</td>
</tr>
<tr>
<td></td>
<td>• Pass</td>
</tr>
<tr>
<td><strong>SCAN SETTING</strong></td>
<td><strong>AVAILABLE ACTIONS</strong></td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td>• Content Scanning</td>
<td>• Quarantine message to user's spam folder</td>
</tr>
<tr>
<td></td>
<td>• Quarantine entire message</td>
</tr>
<tr>
<td></td>
<td>• Delete entire message</td>
</tr>
<tr>
<td></td>
<td>• Tag and deliver</td>
</tr>
<tr>
<td></td>
<td>• Pass</td>
</tr>
</tbody>
</table>

**Advanced Spam Prevention**

<table>
<thead>
<tr>
<th><strong>ANALYZED CATEGORY</strong></th>
<th><strong>AVAILABLE ACTIONS</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Quarantine message to user's spam folder</td>
</tr>
<tr>
<td></td>
<td>• Quarantine entire message</td>
</tr>
<tr>
<td></td>
<td>• Delete entire message</td>
</tr>
<tr>
<td></td>
<td>• Tag subject</td>
</tr>
<tr>
<td></td>
<td>• Pass</td>
</tr>
<tr>
<td></td>
<td>• Notify</td>
</tr>
<tr>
<td></td>
<td>• Do not notify</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>PROBABLE CATEGORY</strong></th>
<th><strong>AVAILABLE ACTIONS</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Quarantine message to user's spam folder</td>
</tr>
<tr>
<td></td>
<td>• Quarantine entire message</td>
</tr>
<tr>
<td></td>
<td>• Delete entire message</td>
</tr>
<tr>
<td></td>
<td>• Tag subject</td>
</tr>
<tr>
<td></td>
<td>• Pass</td>
</tr>
<tr>
<td></td>
<td>• Notify</td>
</tr>
<tr>
<td></td>
<td>• Do not notify</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>PHISHING INCIDENT</strong></th>
<th><strong>AVAILABLE ACTIONS</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Quarantine message to user's spam folder</td>
</tr>
<tr>
<td></td>
<td>• Quarantine entire message</td>
</tr>
<tr>
<td></td>
<td>• Delete entire message</td>
</tr>
<tr>
<td></td>
<td>• Tag and deliver</td>
</tr>
<tr>
<td></td>
<td>• Pass</td>
</tr>
</tbody>
</table>
## Advanced Scan Action Options

Configure advanced options to specify directories, message options, and further scanning.

<table>
<thead>
<tr>
<th>Scan Setting</th>
<th>Available Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Reputation</td>
<td>• Quarantine message to user's spam folder</td>
</tr>
<tr>
<td></td>
<td>• Quarantine entire message</td>
</tr>
<tr>
<td></td>
<td>• Delete entire message</td>
</tr>
<tr>
<td></td>
<td>• Tag and deliver</td>
</tr>
<tr>
<td></td>
<td>• Pass</td>
</tr>
<tr>
<td></td>
<td>• Notify</td>
</tr>
<tr>
<td></td>
<td>• Do not notify</td>
</tr>
<tr>
<td>URL Time-of-Click Protection</td>
<td></td>
</tr>
<tr>
<td>Dangerous</td>
<td>• Allow</td>
</tr>
<tr>
<td></td>
<td>• Warn</td>
</tr>
<tr>
<td></td>
<td>• Block</td>
</tr>
<tr>
<td>Highly Suspicious</td>
<td>• Allow</td>
</tr>
<tr>
<td></td>
<td>• Warn</td>
</tr>
<tr>
<td></td>
<td>• Block</td>
</tr>
<tr>
<td>Suspicious</td>
<td>• Allow</td>
</tr>
<tr>
<td></td>
<td>• Warn</td>
</tr>
<tr>
<td></td>
<td>• Block</td>
</tr>
<tr>
<td>Untested</td>
<td>• Allow</td>
</tr>
<tr>
<td></td>
<td>• Warn</td>
</tr>
<tr>
<td></td>
<td>• Block</td>
</tr>
</tbody>
</table>
### TABLE 6-6. Scan Actions: Advanced Options

<table>
<thead>
<tr>
<th>SETTING</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macros</td>
<td>Advanced macro scanning supplements regular virus scanning. It uses heuristic scanning to detect macro viruses/malware or strips all detected macro codes. Heuristic scanning is an evaluative method of detecting viruses that uses pattern recognition and rules-based technologies to search for malicious macro code.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Heuristic level</strong></td>
</tr>
<tr>
<td></td>
<td>• Level 1 uses the most specific criteria, but detects the least macro codes.</td>
</tr>
<tr>
<td></td>
<td>• Level 4 detects the most macro codes, but uses the least specific criteria and may falsely identify safe macro code as harboring malicious macro code.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Delete all macros detected by advanced macro scan:</strong> ScanMail deletes all of the macro codes that it detects.</td>
</tr>
<tr>
<td>Quarantine Settings / Quarantine Directory</td>
<td>The directory where ScanMail will save quarantined messages</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ScanMail supports UNC paths (except on Exchange Edge servers) when configuring directory settings. The logged on user account must have full control permissions for the UNC path specified.</td>
</tr>
<tr>
<td></td>
<td>• For security risk scans, URL analysis, and advanced spam prevention, configure the <strong>Advanced threat quarantine directory</strong> to specifically manage possible targeted attack threats.</td>
</tr>
</tbody>
</table>
### Configuring Scans

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup Settings / Backup Directory</td>
<td>The directory where ScanMail will save backup messages</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> \nScanMail supports UNC paths (except on Exchange Edge servers) when configuring directory settings. The logged on user account must have full control permissions for the UNC path specified.</td>
</tr>
<tr>
<td>Replacement Settings</td>
<td>The <strong>Replacement file name</strong> and <strong>Replacement text</strong> that ScanMail will use when a violation or incident occurs. ScanMail will replace the file/text with the replacement settings that you configure.</td>
</tr>
<tr>
<td>Forward Email Message Settings</td>
<td>The email address(es) and email message content that ScanMail forwards after detecting a violation or incident</td>
</tr>
</tbody>
</table>
| Unscannable Message Parts     | • Actions for encrypted and password protected files and files not in the scan restriction criteria  
• The **Replacement file name** and **Replacement text** that ScanMail will use when an unscannable message arrives. ScanMail will replace the file/text with the replacement settings that you configure. |

### Notifications

Administrators can configure ScanMail to send a notification by email message or SNMP when ScanMail takes action against security risks. Administrators can also automatically record notifications in the Windows Event Log.

Send notifications to:

- Warn the original user that their email message was altered
- Notify an administrator or other network security professional of a security risk
- Display information to the user about security risks and the actions taken
ScanMail gives you the option to append additional ScanMail fields to the default message or to create customized messages.

Tip

For correct resolution of ScanMail notifications with SNMP, you can import the Management Information Base (MIB) file to your network management tools from the following path in ScanMail Package: `tool\admin\trend.mib`.

### Notification Settings

**TABLE 6-7. Notification Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify administrator</td>
<td>• <strong>To</strong>: Type the email address for the administrator.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Subject</strong>: Type the subject of the message to send to the administrator.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Message</strong>: Click on a message element and add it to the notification.</td>
</tr>
<tr>
<td></td>
<td>Example: Click [<strong>Time</strong>] and add it to the message list. The notification message will contain the time when ScanMail took the action.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Send consolidated notifications periodically</strong>: ScanMail sends an email message that consolidates all the notifications for a period of time. Specify the period of time by typing a number in the box and selecting hour(s) or day(s).</td>
</tr>
<tr>
<td></td>
<td>• <strong>Send consolidated notifications by occurrences</strong>: ScanMail sends an email message that consolidates notifications for a set number of filtering actions. Specify the number of security risk occurrences by typing a number in the box.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Send individual notifications</strong>: ScanMail sends an email message notification every time ScanMail performs a filtering action.</td>
</tr>
</tbody>
</table>
### Configuring Scans

<table>
<thead>
<tr>
<th><strong>Setting</strong></th>
<th><strong>Details</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify sender</td>
<td>• <strong>Do not notify external sender(s):</strong> ScanMail will not send an email message notification to senders outside of the company network.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Disable sender notification for spoofing mails:</strong> ScanMail will not send an email message notification when the scan detects a spoofing message.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>This option is available for Security Risk Scan notifications only.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Subject:</strong> Type the subject of the message to send to the email message sender.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Message:</strong> Click on a message element and add it to the notification.</td>
</tr>
<tr>
<td></td>
<td>Example: Click [Time] and add it to the message list. The notification message will contain the time when ScanMail took the action.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Same notification that the internal senders receive:</strong> Select when the message ScanMail sends to external senders is the same as the message it sends to internal senders. ScanMail sends a message just like the one customized for internal senders.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Specify different notification below:</strong> Select when you want to send a different customized message to an external sender. Then click on a message element and add it to the notification.</td>
</tr>
<tr>
<td>Setting</td>
<td>Details</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Notify recipient(s)         | • **Do not notify external recipient(s):** ScanMail will not send an email message notification to senders outside of the company network.  
                                • **Subject:** Type the subject of the message to send to the recipient(s).  
                                • **Message:** Click on a message element and add it to the notification.  
                                Example: Click **Show details** and add it to the message list. The notification message will contain the time when ScanMail took action.  
                                • **Same notification that the internal recipients receive:** Select when the message ScanMail sends to external senders is the same as the message it sends to internal senders. ScanMail sends a message just like the one customized for internal senders.  
                                • **Specify different notification below:** Select when you want to send a different customized message to an external sender. Then click on a message element and add it to the notification. |
| SNMP                        | Select to send notifications by SNMP. Click to customize the SNMP message.  
                                • **IP address:** Type an IP address.  
                                • **Community:** Type the Community Name (Public or Private).  
                                • **Message:** Click on a message element and add it to the notification. |
| Write to Windows event log  | Select to record the notification to a Windows event log. |
Chapter 7

Configuring Security Risk Scans

This chapter explains how to configure Security Risk Scans to protect your Exchange environment.

Topics include:

• *About Security Risk Scans on page 7-2*
• *ScanMail Scan Hierarchy on page 7-3*
• *Security Risk Scan Actions on page 7-6*
• *Enabling Real-time Security Risk Scan on page 7-7*
• *Configuring Security Risk Scan Targets on page 7-7*
• *Configuring Security Risk Scan Actions on page 7-9*
• *Configuring Security Risk Scan Notifications on page 7-13*
About Security Risk Scans

ScanMail protects your Exchange environment by performing scans on all incoming and outgoing email messages. You can accept the Trend Micro default values set by the installation program or you can customize scanning by setting a number of configurations described in this chapter. You can configure ScanMail to run scans on-demand (manual scanning), according to a schedule (scheduled scanning), or in an ongoing and persistent manner (real-time scanning). You configure scans using the Security Risk Scan screen, accessible from the sidebar, or from the Manual Scan and Scheduled Scan screens.

The following describes the key characteristics of security risk scans:

**TABLE 7-1. Security Risk Scan Characteristics**

<table>
<thead>
<tr>
<th>TYPE OF SCAN</th>
<th>CHARACTERISTICS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan method</td>
<td>There are two methods for security risk scans:</td>
</tr>
<tr>
<td></td>
<td>• Conventional Scan</td>
</tr>
<tr>
<td></td>
<td>• Smart Scan</td>
</tr>
<tr>
<td></td>
<td>Configure the scan method on the Scan Service Settings screen (Smart Protection &gt; Scan Service Settings). For details on scan methods, see Scan Service Settings on page 5-8.</td>
</tr>
<tr>
<td>Real-time scan</td>
<td>ScanMail scans the following in real time:</td>
</tr>
<tr>
<td></td>
<td>• All incoming and outgoing email messages</td>
</tr>
<tr>
<td></td>
<td>• Public-folder postings</td>
</tr>
<tr>
<td></td>
<td>• All server-to-server replications</td>
</tr>
</tbody>
</table>
Configuring Security Risk Scans

## Type of Scan and Characteristics

<table>
<thead>
<tr>
<th>Type of Scan</th>
<th>Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual scan and scheduled scan</td>
<td>During manual and scheduled scans, ScanMail scans messages stored in the mailbox and public folder stores.</td>
</tr>
<tr>
<td></td>
<td>Starting another scheduled scan does not interrupt the scheduled scan that is already in progress. ActiveUpdate does not interrupt a scheduled scan.</td>
</tr>
<tr>
<td></td>
<td>On cluster servers:</td>
</tr>
<tr>
<td></td>
<td>Each virtual server has a scan task list. You can specify the store database that belongs to the current virtual server. When there is a running</td>
</tr>
<tr>
<td></td>
<td>scheduled scan task, new tasks are queued. When another task is triggered at the same time, then the task will be queued and finished eventually.</td>
</tr>
</tbody>
</table>

### ScanMail Scan Hierarchy

Administrators can configure security risk scans in ScanMail to provide varying levels of security. Enabling the Advanced Threat Scan Engine in conjunction with Virtual Analyzer assists in discovering and preventing targeted attacks by suspected malware threats.

The following table provides an overview of the scan engine hierarchy in ScanMail.

<table>
<thead>
<tr>
<th>Scan Engine</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virus Scan Engine scanning</td>
<td>The Virus Scan Engine provides pattern-based and heuristic scanning for traditional malware threats.</td>
</tr>
</tbody>
</table>
### Scan Engine Description

<table>
<thead>
<tr>
<th>Scan Engine</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATSE scanning</td>
<td>ATSE enhances the traditional malware threat protection offered by the Virus Scan Engine. ATSE performs an aggressive scan using heuristic algorithms to identify possible targeted attacks, such as document exploits. For scan configurations that enable ATSE without sending files to Virtual Analyzer, ScanMail performs the action configured for <strong>Advanced threats</strong> on any suspicious messages and files detected as an advanced threat by ATSE.</td>
</tr>
</tbody>
</table>

**Note**

Some detected files may be safe. Trend Micro recommends selecting the **Quarantine entire message** action for suspected threats detected by ATSE. Perform an evaluation on files not sent to Virtual Analyzer to determine the actual threat of the quarantined files.

If no Virtual Analyzer is registered, Trend Micro recommends selecting scan level to Low to decrease false positives and selecting the **Quarantine entire message** action for suspected threats detected by ATSE.

| ATSE and Virtual Analyzer    | After ATSE detects a suspected malware threat, ScanMail sends the message to Virtual Analyzer for further analysis. Virtual Analyzer assesses the risk level of the message in an isolated virtual environment and returns the threat rating to the ScanMail server. ScanMail then performs the action configured for **Advanced threats** if the security rating violates the configured security level for suspected threats. The sandbox solution protection scope can be configured with Virtual Analyzer settings; such as traffic direction, target recipients, and so on. For example, the top management group or human resource can be configured as target recipients. The default configuration for the protected traffic direction is **Inbound messages only**. The messages that are not in the sandbox protection scope, are scanned in a traditional manner using local scan engine/pattern file. |
About Advanced Threat Scan Engine

The Advanced Threat Scan Engine (ATSE) uses a combination of pattern-based scanning and heuristic scanning to detect document exploits and other threats used in targeted attacks.

Major features include:

- Detection of zero-day threats
- Detection of embedded exploit code
- Detection rules for known vulnerabilities
- Enhanced parsers for handling file deformities

Important

Because ATSE identifies both known and unknown advanced threats, enabling ATSE may increase the possibility of legitimate files being flagged as malicious.

About Predictive Machine Learning

Trend Micro Predictive Machine Learning uses advanced machine learning technology to correlate threat information and perform in-depth file analysis to detect emerging unknown security risks through digital DNA fingerprinting, API mapping, and other file features. Predictive Machine Learning is a powerful tool that helps protect your environment from unidentified threats and zero-day attacks.

After detecting an unknown or low-prevalence file, ScanMail scans the file using the Advanced Threat Scan Engine to extract file features and sends the report to the
Predictive Machine Learning engine. Through use of malware modeling, Predictive Machine Learning compares the sample to the malware model, assigns a probability score, and determines the probable malware type that the file contains.

Security Risk Scan Actions

ScanMail provides two basic settings for security risk scan: using ActiveAction or setting a customized action according to security risk type.

**TABLE 7-3. Security Risk Scan Actions**

<table>
<thead>
<tr>
<th>SETTING</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>ActiveAction</td>
<td>Select <strong>ActiveAction</strong> to have ScanMail perform Trend Micro recommended actions. Trend Micro recommends using ActiveAction when you are not familiar with scan actions or if you are not sure which scan action is suitable for a certain type of virus/malware.</td>
</tr>
<tr>
<td>Customized action for detected threats</td>
<td>Select <strong>Customized action for detected threats</strong> to instruct ScanMail to execute a customized action according to the type of detected threat. At the bottom of the screen, you can configure ScanMail to <strong>Backup infected file before performing action</strong>. This is a safety precaution designed to protect the original file from damage.</td>
</tr>
</tbody>
</table>

Using Customized Scan Actions

Use these actions when you want to optimize scanning for your environment.

Procedure

- When you want to protect your Exchange servers against a mass-mailing attack, select **Enable action on mass-mailing behavior** and select the action that ScanMail executes whenever it detects a mass-mailing attack. This action overrides any other action for ScanMail. The real-time scanning default action is **Delete entire message**.
• When you want to configure ScanMail to use the same action against all detected security risks, select **All security risks** and accept the default action or select a customized action.

• When you want to configure a ScanMail action for each type of threat that ScanMail detects, select each threat type individually and configure the action ScanMail executes when it detects that threat type.

---

### Enabling Real-time Security Risk Scan

**Procedure**

1. Click **Security Risk Scan** from the main menu.
   
The **Security Risk Scan** screen appears.

2. Select **Enable transport level real-time security risk scan** from the **Security Risk Scan** screen.

---

### Configuring Security Risk Scan Targets

**Procedure**

1. Go to the **Security Risk Scan** screen by navigating to one of the following:
   - For Real-time scans: **Security Risk Scan**
   - For Manual scans: **Manual Scan > Security risk scan**
   - For Scheduled scans: **Scheduled Scan > [Add or Edit] > Security risk scan**

2. Go to the **Target** tab.
   
The **Target** tab displays.
3. Select **Enable Advanced Threat Scan Engine** to allow ScanMail to perform aggressive scanning for less conventional threats and specify the **Scan level**.

---

**Tip**

Some detected files may be safe. Trend Micro recommends selecting the **Quarantine entire message** action for suspected threats detected by ATSE. Perform an evaluation on files not sent to Virtual Analyzer to determine the actual threat of the quarantined files. Selecting a higher scan level may result in a greater number of false positives.

4. If you select **Enable Advanced Threat Scan Engine**, then you can also select **Enable Predictive Machine Learning** to detect more malware variants using the machine learning technology, and configure the following:

- Select **Enable approved file hash list** to skip scanning for the attachments with hashtags on the list.

5. Select one of the following for scanning:

- **All attachment files**: ScanMail scans for viruses/malware, worms, Trojans, and other malicious code in all files except unscannable files. Unscannable files are password protected files, encrypted files, or files that exceed the user-defined scanning restrictions. Other malicious code describes previously unknown threat types for which you want to configure a ScanMail action.

- **IntelliScan**: IntelliScan uses Trend Micro recommended settings to perform an efficient scan.

---

**Note**

There is one key difference between using IntelliScan and performing other scans using ScanMail true file type recognition. ScanMail true file type recognition allows users to define their own selection of files to scan, while IntelliScan always uses the Trend Micro recommended selection of files to scan.

- **Specify file types**: Click the link to expand the list and select the files you want ScanMail to scan. These files are "true file types". The scan engine examines the file header rather than the file name to ascertain the actual file type. Or, select to create a list of file extensions by selecting **Specify file extensions**.
Configuring Security Risk Scans

**Note**
For example: If you click **Specify file types** and then click **Application and executables > Executable (.exe; .dll, .vxd) then ScanMail scans executable, DLL and VXD file types - even when the file has a false file extension name (is labeled .txt when it is actually an .exe). However, if you click **Specify file extensions** and type .exe, then ScanMail scans only .exe type files. ScanMail does not recognize falsely labeled file types.

6. To scan the message body, select **Scan message body**.

7. To use IntelliTrap technology, select **Enable IntelliTrap**.
   For details on IntelliTrap scanning, see **IntelliTrap on page 1-29**.

8. To scan for spyware/grayware, select **Select All** for **Spyware/Grayware Scan** or select from the list.

9. Click **Scan Restriction Criteria** if performance improvement is required.
   For details on compressed file restrictions, see **Security Risk Scan Compressed File Restrictions on page 6-8**.

**Tip**
Trend Micro recommends using scanning restrictions to protect against Denial-of-Service attacks. Denial-of-Service is an attack on a computer or network that causes a loss of 'service', namely a network connection. Typically, Denial-of-Service (DoS) attacks negatively affect network bandwidth or overload computer resources such as memory.

10. Click **Save**.

**Configuring Security Risk Scan Actions**

When ScanMail detects a file that matches your scanning configurations, it executes an action to protect your Exchange environment. The type of action it executes depends on the type of scan it is performing (real-time, manual, or scheduled), the Exchange Server role, and the type of actions you have configured for that scan.
Procedure

1. Go to the **Security Risk Scan** screen by navigating to one of the following:
   - For Real-time scans: **Security Risk Scan**
   - For Manual scans: **Manual Scan > Security risk scan**
   - For Scheduled scans: **Scheduled Scan > [Add or Edit] > Security risk scan**

2. Click the **Action** tab.
   
The **Action** tab displays.

3. Select one of the following:
   - **ActiveAction**: Perform scan actions recommended by Trend Micro.
   - **Customized action for detected threats**: Select to perform an action over all security risks or specify an action for each threat.

   **Note**
   
   To configure the scan action that ScanMail performs on **Advanced threats**, administrators must enable the Advanced Threat Scan Engine on the **Security Risk Scan: Target** tab.

   For details on Security Risk Scan actions, see *Security Risk Scan Actions on page 7-6*.

4. To back up the infected file, select **Backup infected file before performing action**.

5. Select **Do not clean infected compressed files to optimize performance**. if performance improvement is required.

6. Select **Send Predictive Machine Learning Feedback to Trend Micro Smart Protection Network** to send file content and scan results to Trend Micro for analysis.
7. Configure Advanced Options as necessary.

**Note**
For details on advanced scan actions, see Advanced Scan Action Options on page 6-21.

a. Click the Macros heading to configure macro scan.
   i. Select Enable advanced macro scan.
   ii. Select one of the following:
      • Heuristic level
      • Delete all macros detected by advanced macro scan

**Note**
For details on configuring macro scanning, see Configuring Macro Scanning on page 7-11.

b. Click the Unscannable Message Parts heading to specify actions for encrypted and password protected files and files not in the scan restriction criteria.

c. Click Quarantine and Backup Settings to specify the directory paths.

d. Click Replacement Settings to configure the text or file name that replaces infected content.

8. Click Save.

### Configuring Macro Scanning

ScanMail uses the virus pattern file to identify known malicious macro codes during regular virus scanning. ScanMail takes action against malicious macro code depending
on the action that you configure from the Security Risk Scan screen. Use advanced macro scanning to gain additional protection against malicious macro code.

Advanced macro scanning supplements regular virus scanning. It uses heuristic scanning to detect macro viruses/malware or strips all detected macro codes. Heuristic scanning is an evaluative method of detecting viruses that uses pattern recognition and rules-based technologies to search for malicious macro code. This method excels at detecting undiscovered viruses and security risks that do not have a known virus signature. When a malicious macro code is detected using heuristic scanning, ScanMail takes action against the malicious code based on the action that you configured from the Security Risk Scan screen. When you select Delete all macros detected by advanced macro scan, then ScanMail strips all macro code from the scanned files.

Procedure

1. Go to the Security Risk Scan screen by navigating to one of the following:
   - For Real-time scans: Security Risk Scan > Action
   - For Manual scans: Manual Scan > Security risk scan > Action
   - For Scheduled scans: Scheduled Scan > [Add or Edit] > Security risk scan > Action

2. Click Advanced Options and then click Macros.

3. Select Enable advanced macro scan.

4. Select a detection type:
   a. Select Heuristics level and configure a level for the heuristic rules.
      - Level 1 uses the most specific criteria, but detects the least macro codes.
      - Level 4 detects the most macro codes, but uses the least specific criteria and may falsely identify safe macro code as harboring malicious macro code.
Tip
Trend Micro recommends a heuristic scan level of 2. This level provides a high detection level for unknown macro viruses, a fast scanning speed, and it uses only the necessary rules to check for macro virus/malware strings. Level 2 also has a low level of falsely identifying malicious code in safe macro code.

b. Select **Delete all macros detected by advanced macro scan** to have ScanMail delete all of the macro codes that it detects.

5. Click **Save**.

---

## Configuring Security Risk Scan Notifications

### Procedure

1. Go to the **Security Risk Scan** screen by navigating to one of the following:
   - For Real-time scans: **Security Risk Scan**
   - For Manual scans: **Manual Scan > Security risk scan**
   - For Scheduled scans: **Scheduled Scan > [Add or Edit] > Security risk scan**

2. Click the **Notification** tab.
   
The **Notification** screen displays.

3. Click the check boxes corresponding to the people ScanMail will notify.

4. Click **Show details** to customize the notification for that recipient.

5. Select from the notification options.
   
   Refer to **Notification Settings on page 6-24** for details.

6. Click **Write to Windows event log** to have ScanMail write the notification to a Windows event log.
7. Click Save.
Chapter 8

Configuring Attachment Blocking

This chapter explains how to configure Attachment Blocking to protect your Exchange environment.

Topics include:

- About Attachment Blocking on page 8-2
- Enabling Real-time Attachment Blocking on page 8-3
- About the Attachment Blocking Global Policy on page 8-3
- Adding an Exception to the Attachment Blocking Global Policy on page 8-7
- Editing an Attachment Blocking Exception on page 8-8
About Attachment Blocking

Attachment blocking prevents email messages containing suspicious attachments from being delivered. ScanMail can block attachments according to the following:

- Attachment type
- Attachment name
- Attachment extension
- Suspicious URL detection

After detecting a suspicious attachment, ScanMail can then replace, quarantine, or delete all the messages that match a policy rule. Blocking can occur during real-time, manual, and scheduled scanning.

The extension of an attachment identifies the file type, for example .doc, .exe, or .dll. Many viruses/malware are closely associated with certain types of files. By configuring ScanMail to block according to file type, administrators can decrease the security risk to Exchange servers from those types of files. Similarly, specific attacks are often associated with a specific file name.

**Note**

Using attachment blocking is an effective way to control virus/malware outbreaks. Administrators can temporarily quarantine all high-risk file types or those with a specific name associated with a known virus/malware. After the outbreak ends, administrators can examine the quarantine folder and take action on detected files.

Recipients for messages can match one attachment blocking exception or the attachment blocking global rule based on priority. If the recipient matches an attachment blocking exception, then targets selected in the exception are excluded from attachment blocking global rule. If the recipient does not match any attachment blocking exceptions, then the attachment blocking global rule is applied.

Four types of accounts are supported for customizing specified Recipients: Active Directory users, Active Directory contacts, Active Directory distribution groups and special groups.
For each attachment blocking exception, administrators can specify selected accounts and excluded accounts. The exception applies to those accounts that belong to selected accounts but does not apply to those that belong to the excluded accounts. For example, Active Directory Group1 contains ADuser1 and ADuser2. When selected accounts includes "AD Group1", excluded accounts include "ADuser1", then the policy only applies to ADuser2.

**Enabling Real-time Attachment Blocking**

When attachment blocking is enabled, you can enable and disable individual attachment blocking exceptions. The green check icon (✓) indicates the exception is enabled, and the red "x" (✗) indicates the exception is disabled. Click the icon to toggle between enabled and disabled.

**Note**

You cannot disable the Global Policy.

**Procedure**

1. Click **Attachment Blocking** on the main menu.
   
   The **Attachment Blocking** screen displays.
2. Select **Enable transport level attachment blocking**.
3. Click **Save**.

**About the Attachment Blocking Global Policy**

The attachment blocking Global Policy applies to all incoming and outgoing email messages. You can configure the Global Policy to automatically block email messages with attachments by file type or by file name.
You can also create attachment blocking exceptions to allow specific accounts to send and receive email messages with the attachments specified in the Global Policy when certain users have different privilege requirements.

**Configuring Attachment Blocking Targets**

You can block attachments according to a specific name or according to an attachment type. ScanMail determines attachment type by the file name extension and true file type. Block attachments with two general strategies: either block all attachments and then exclude specified attachments or specify all the attachments to block.

---

**Procedure**

1. Go to the Attachment Blocking screen by navigating to one of the following:
   - For Real-time scans: Attachment Blocking > Global Policy
   - For Manual scans: Manual Scan > Attachment Blocking
   - For Scheduled scans: Scheduled Scan > [Add or Edit] > Attachment Blocking

2. Click the Target tab.
   
   The Target screen displays.

3. Select from one of the following:
   - All attachments
     - Select Attachment types to exclude and/or Attachment names to exclude. Click Show details to specify specific types or names.
   - Specific attachments
     - Select Attachment types and/or Attachment names. Click Show details to specify specific types or names.

4. Select Block attachment types or names within compressed files, if you want to block the selected attachment types.
5. Select **Block password protected Office documents and compressed files**, if you want to block the password protected Office documents and compressed files.

6. Click **Scan Restriction Criteria** if performance improvement is required.

   • **Number of layers of compression exceeds**: Specify a number from 1 to 20 to use as the threshold for not scanning compression files. If the number of compression layers exceeds the specified number, the file is not scanned.

7. Click **Save**.

---

**Configuring Attachment Blocking Actions**

ScanMail performs an action whenever it detects an attachment that requires blocking. You configure the action ScanMail performs using this screen. Additionally, configure whether or not ScanMail sends a notification.

---

**Procedure**

1. Go to the **Attachment Blocking** screen by navigating to one of the following:
   - For Real-time scans: **Attachment Blocking > Global Policy**
   - For Manual scans: **Manual Scan > Attachment Blocking**
   - For Scheduled scans: **Scheduled Scan > [Add or Edit] > Attachment Blocking**

2. Click the **Action** tab.

   The **Action** screen displays.

3. Select an action for ScanMail to take when it detects undesirable content.

   For details on the available actions, see **About ScanMail Actions on page 6-9**.

4. Configure **Advanced Options** as necessary.

   For details on advanced scan actions, see **Advanced Scan Action Options on page 6-21**.
5. Click Save.

Configuring Attachment Blocking Notifications

Procedure

1. Go to the Attachment Blocking screen by navigating to one of the following:
   • For Real-time scans: Attachment Blocking > Global Policy
   • For Manual scans: Manual Scan > Attachment Blocking
   • For Scheduled scans: Scheduled Scan > [Add or Edit] > Attachment Blocking

2. Click the Notification tab.
   The Notification screen displays.

3. Click the check boxes corresponding to the people ScanMail will notify.

4. Click Show details to customize the notification for that recipient.

5. Select from the notification options.
   Refer to Notification Settings on page 6-24 for details.

6. Click Write to Windows event log to have ScanMail write the notification to a Windows event log.

7. Click Save.
Adding an Exception to the Attachment Blocking Global Policy

Procedure

1. Click **Attachment Blocking** on the main menu.
   
   The **Attachment Blocking** screen displays.

2. Click **Add Exception**.
   
   The **Select Accounts** screen displays.

3. Select the accounts to exclude from the Global Policy.
   - From specific sender(s) to any recipient
   - From any sender to specific recipient(s).

4. Click the **specific sender(s)** or **specific recipient(s)** link (if applicable).

5. Select one of the following:
   - **Anyone**: Apply this policy or exception to all users.
   - **Specific accounts**: Select from Active Directory groups or ScanMail special groups.

6. Search and select AD Users/Groups/Contacts/Special Groups and add them to the Selected Account(s) list.

7. Search and select AD Users/Groups/Contacts/Special Groups and add them to the Selected Account(s) list on the **Exclude Accounts** screen.

8. Click **Save**.
   
   The **Select Accounts** screen displays.

9. Click **Next >**.
   
   The **Specify Policy** screen displays.
10. Configure the following settings:

   • **Attachment types**: Select specific file types to exclude from the Global Policy.
   
   • **Attachment names**: Specify file names and/or extensions to exclude from the Global Policy.

   **Note**
   Click **Show details** to specify file types or names.

11. Click **Next >**.

   The **Name and Priority** screen displays.

12. Configure the following settings:

   • **Enable this exception**: Select to enable this exception.
   
   • **Exception name**: Type a name for this exception.

13. Type a number for the **Priority**.

14. Click **Save**.

---

**Editing an Attachment Blocking Exception**

**Procedure**

1. Click **Attachment Blocking** on the main menu.

   The **Attachment Blocking** screen displays.

2. Click the exception **Accounts** or **Policy** hyperlink to edit an exception.

3. Configure the following settings:

   • **Enable this exception**: Select to enable this exception.
4. Click the **Accounts** tab.
   a. To change the accounts to exclude from the Global Policy, select an account type:
      - **Specific sender(s)**
      - **Specific recipient(s)**

      **Note**
      ScanMail only applies the policy to the accounts selected for the **Accounts** type. If you select accounts for a different account type, ScanMail does not apply the policy to the previous accounts selected.

   b. Click the **Edit** link in the tables to change the included accounts and excepted accounts for this policy.

   c. Select one of the following:
      - **Anyone**: Apply this policy or exception to all users.
      - **Specific accounts**: Select from Active Directory groups or ScanMail special groups.

   d. Search and select AD Users/Groups/Contacts/Special Groups and add them to the Selected Account(s) list.

   e. Search and select AD Users/Groups/Contacts/Special Groups and add them to the Selected Account(s) list on the **Exclude Accounts** screen.

   f. Click **Save**.

5. To change the targeted attachment settings, click the **Target** tab.

   - **Attachment types**: Select specific file types to exclude from the Global Policy.

   - **Attachment names**: Specify file names and/or extensions to exclude from the Global Policy.
Note
Click **Show details** to specify file types or names.

6. Click **Save**.
Chapter 9

Configuring Content Filtering

This chapter explains how to configure Content Filtering to protect your Exchange environment.

Topics include:

• *About Content Filtering on page 9-2*
• *Enabling Real-time Content Filtering on page 9-3*
• *Global Settings on page 9-4*
• *Configuring Content Filtering Policies on page 9-4*
• *Configuring a Content Filtering Exception on page 9-13*
• *Editing a Content Filtering Policy on page 9-14*
About Content Filtering

The content filter evaluates inbound and outbound messages on the basis of user-defined policies. Each policy contains a list of keywords and phrases. Content filtering evaluates the header and/or content of messages by comparing the messages with the list of keywords. When ScanMail finds a word that matches a keyword it can take action to prevent the undesirable content from being delivered to Exchange clients. ScanMail can send notifications whenever it takes an action against undesirable content.

ScanMail applies the content filtering policies to email messages according to the order shown in the Content Filtering screen. You can configure the order in which the policies are applied. ScanMail filters all email messages according to each policy until a content violation triggers an action that prevents further scanning (such as "delete", or "quarantine"). You can change the order of these policies to optimize content filtering.

The content filter provides a means for the administrator to evaluate and control the delivery of email messages on the basis of the message text itself. It can be used to monitor inbound and outbound messages to check for the existence of offensive or otherwise objectionable message content. The content filter also provides a synonym checking feature, which allows you to extend the reach of your policies.

You can, for example, create policies to check for:

- Sexually harassing language
- Racist language
- Spam embedded in the body of an email message

---

**Note**

This feature is not available on ScanMail Standard versions.

---

Active Directory Integrated Policies

For Active Directory integrated policies, you can specify selected accounts and excluded accounts. The policy applies to accounts that belong to selected accounts but do not belong to excluded accounts. For example, AD Group1 contains ADUser1 and
ADuser2. When selected accounts include "AD Group1" and excluded accounts include "ADuser1", then the policy only applies to ADuser2.

**Data Leakage Prevention**

For convenience, ScanMail includes default content filtering data leakage prevention policies. There are 10 default data leakage prevention policies configured by region. Compared to standard content filtering policies, keywords in the data leakage prevention policies are regular expression description strings and not the actual keyword.

For example, IBAN is the description for the regular expression:

```
[^\w](([A-Z]{2}\d\?))([A-Za-z0-9]{11,27}|([A-Za-z0-9]{3,6}[A-Za-z0-9]{0,3}|([A-Za-z0-9]{3,4}))[^\w]
```

Messages that contain the string "IBAN" do not trigger this policy. Strings such as "BE68 5390 0754 7034 " match the regular expression and trigger this policy.

**Enabling Real-time Content Filtering**

When content filtering is enabled, you can enable and disable individual content filtering policies. The green check icon (✔️) indicates the policy is enabled, and the red "x" (❌) indicates the policy is disabled. Click the icon to toggle between enabled and disabled.

**Procedure**

1. Click **Content Filtering** from the main menu.
   
The **Content Filtering** screen displays.
2. Select **Enable transport level content filtering**.
3. Click **Save**.
Global Settings

ScanMail uses Quarantine to move actionable messages to a quarantine directory, replace the targeted files, and deliver the remaining messages to the original recipient.

You can configure ScanMail to quarantine or backup email messages when it detects a policy incident. You can set the quarantine or backup folder for each policy individually from the Action Settings screen, or you can specify a global directory.

When you specify a global quarantine or backup directory, ScanMail moves all files that it quarantines or backs up as a result of a policy incident to the directory that you specify.

For details on global advanced scan actions, see Advanced Scan Action Options on page 6-21.

To configure the Global Settings, click Content Filtering > Global Settings.

---

Note

You must click Apply to All to configure the new directories. If you click Save, ScanMail only saves directory paths that you typed, but they will not be applied.

---

Configuring Content Filtering Policies

To create a content filtering policy, a policy wizard directs you through a series of steps. At each step, you add to your policy until it is complete. After you have created your policy, ScanMail begins to filter all incoming and outgoing messages according to your policy.

You can create the policies that do the following:
**TABLE 9-1. Content Filtering Policies**

<table>
<thead>
<tr>
<th>POLICY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match any or apply to all</td>
<td>This type of policy is capable of filtering content from any message in real-time or during a manual or scheduled scan.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td>Match all conditions</td>
<td>This type of policy performs an action when ScanMail detects specific details in the From, To, Cc, Subject, Size, and Attachment file name fields in email messages.</td>
</tr>
<tr>
<td>Match any condition</td>
<td>This type of policy scans the message content of particular email account(s). These policies are similar to general content filtering policies, except that they only filter content from specified email account(s).</td>
</tr>
<tr>
<td>Exceptions</td>
<td>This type of policy creates an exception for specific email account(s).</td>
</tr>
</tbody>
</table>

**Configuring the Senders and Recipients List (Match any or apply to all)**

**Note**

When editing a policy, you can only change the accounts for **Match any or apply to all** policies. For other policy types, the default account setting is “All accounts”.

**Procedure**

1. Go to the **Content Filtering** screen by navigating to **Content Filtering**.
2. Add or edit a **Match any or apply to all** policy:
   
   • While creating a new policy:
     
     Click **Add > Match any or apply to all**.
• While editing a policy:
  a. Click the policy name.
  b. Click the **Accounts** tab.

3. Select the senders or recipients for the policy scan.
   • While creating a new policy:
     a. Select the account type:
       • **From any sender to any recipient**
       • **From specific sender(s) to any recipient**
       • **From any sender to specific recipient(s).**
     b. Click the **specific sender(s)** or **specific recipient(s)** link (if applicable).

   • While editing a policy:
     a. Select the account type:
       • **All**
       • **Specific sender(s)**
       • **Specific recipient(s)**

       ScanMail only applies the policy to the accounts selected for the **Accounts** type. If you select accounts for a different account type, ScanMail does not apply the policy to the previous accounts selected.
     b. Click the **Edit** link in the tables to change the included accounts and excepted accounts for this policy.

4. Select one of the following:
   • **Anyone**: Apply this policy or exception to all users.
   • **Specific accounts**: Select from Active Directory groups or ScanMail special groups.

5. Search and select AD Users/Groups/Contacts/Special Groups and add them to the Selected Account(s) list.
6. Search and select AD Users/Groups/Contacts/Special Groups and add them to the Selected Account(s) list on the **Exclude Accounts** screen.

7. Click **Save**.

### Configuring Content Filtering Targets

Specify the content that ScanMail filters by configuring the following target settings.

**Procedure**

1. Go to the **Content Filtering** screen by navigating to one of the following:
   - For Real-time scans: **Content Filtering**
   - For Manual scans: **Manual Scan > Content filtering**
   - For Scheduled scans: **Scheduled Scan > [Add or Edit] > Content filtering**

2. Add or edit a policy:
   - For new policies:
     a. Click **Add > [Policy Type]**.
     b. Go to the **Specify Policy** screen.
   - For pre-existing policies:
     a. Click the policy name.
     b. Click the **Target** tab.

3. Specify the target settings:
### Table 9-2. Content Filtering Target Settings

<table>
<thead>
<tr>
<th>SECTION</th>
<th>SETTINGS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Account(s)</td>
<td>Specify email accounts to scan for in the following fields:</td>
</tr>
<tr>
<td>(Match any condition</td>
<td>• From</td>
</tr>
<tr>
<td>policies)</td>
<td>• To</td>
</tr>
<tr>
<td></td>
<td>• Cc</td>
</tr>
<tr>
<td>Target</td>
<td>Select to scan for keywords in the following:</td>
</tr>
<tr>
<td></td>
<td>• For <strong>Match any or apply to all</strong> policies: <strong>Header, From, To, Cc, Subject, Body, Attachment</strong></td>
</tr>
<tr>
<td></td>
<td>• For <strong>Match any condition</strong> policies: <strong>Subject, Body, Attachment</strong></td>
</tr>
<tr>
<td></td>
<td>For <strong>Match all conditions</strong> policies:</td>
</tr>
<tr>
<td></td>
<td>• Specify keywords to scan for in: <strong>From, To, Cc, Subject, Attachment file name</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Case-sensitive</strong>: Select to make scans for keywords case-sensitive.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Size</strong>: Select greater than, less than, equal to, or not equal to and specify the number of bytes.</td>
</tr>
</tbody>
</table>
Configuring Content Filtering

**Add Keyword(s)**

(Choices: Match any or apply to all, Match any condition)

- **Match**: Select All specified keywords or Any specified keywords.
- **Enter keyword(s)**: Type a keyword to add to the list.
- **Add**: Click to add the keyword to the list.
- **Remove**: Click to remove the selected keyword from the list.
- **Export**: Click to export keywords to a file.
- **Import**: Click to import keywords from a file.
- **Match case-sensitive**: Select to make scans for keywords case-sensitive.
- **Match synonym**: Select to match synonyms.
- **Show details**: Click to manage synonyms.

**Imported Keyword Lists**

When you import a keyword file, the imported keywords appear in the keyword list. The imported file must be a text (.txt) file. The imported keywords use the same format as they had in the text file. You can import keyword lists from previous versions of ScanMail. ScanMail imports the keywords and applies the same syntax as used in this version of ScanMail.

**Table 9-3. Imported Text File for Content Filtering**

<table>
<thead>
<tr>
<th>The Imported Text File Contains</th>
<th>The Keyword List Displays</th>
</tr>
</thead>
<tbody>
<tr>
<td>win cash prize</td>
<td>win cash prize</td>
</tr>
<tr>
<td>win</td>
<td>win</td>
</tr>
<tr>
<td>cash</td>
<td>cash</td>
</tr>
<tr>
<td>prize</td>
<td>prize</td>
</tr>
</tbody>
</table>
Note
Export keywords when the list is complete to keep a copy of keywords to use on other ScanMail servers or to import keywords in the future.

Configuring Content Filtering Actions

ScanMail performs an action whenever it detects undesirable content. You configure the action ScanMail performs using this screen. Additionally, configure whether or not ScanMail sends a notification.

Procedure

1. Go to the Content Filtering screen by navigating to one of the following:
   • For Real-time scans: Content Filtering
   • For Manual scans: Manual Scan > Content filtering
   • For Scheduled scans: Scheduled Scan > [Add or Edit] > Content filtering

2. Add or edit a policy:
   • For new policies:
     a. Click Add > [Policy Type].
     b. Go to the Specify Actions screen.
   • For pre-existing policies:
     a. Click the policy name.
     b. Click the Action tab.

3. Select an action for ScanMail to take when it detects undesirable content.

4. To notify specific individuals:
   • Select the check box Forward to sender’s manager.
   • Select the check box Forward to specific email address(es) and type the email address of the recipients.
5. Specify whether to send notifications when an action is taken by selecting Notify or Do not notify.

6. Configure Advanced Options as necessary.

---

Configuring Content Filtering Notifications

**Procedure**

1. Go to the Content Filtering screen by navigating to one of the following:
   - For Real-time scans: Content Filtering
   - For Manual scans: Manual Scan > Content filtering
   - For Scheduled scans: Scheduled Scan > [Add or Edit] > Content filtering

2. Add or edit a policy before configuring notification settings:
   - For new policies:
     a. Click Add > [Policy Type].
     b. Go to the Specify Notification screen.
   - For pre-existing policies:
     a. Click the policy name.
     b. Click the Notification tab.

3. Click the check boxes corresponding to the people ScanMail will notify.

4. Click Show details to customize the notification for that recipient.

5. Select from the notification options.

Refer to Notification Settings on page 6-24 for details.
6. Click **Write to Windows event log** to have ScanMail write the notification to a Windows event log.

---

**Enabling a Content Filtering Policy**

Enable individual policies and designate each policy a priority for use in scanning.

---

**Procedure**

1. Go to the **Content Filtering** screen by navigating to one of the following:
   - For Real-time scans: **Content Filtering**
   - For Manual scans: Manual Scan > Content filtering
   - For Scheduled scans: Scheduled Scan > [Add or Edit] > Content filtering

2. Add or edit a policy before enabling:
   - For new policies:
     a. Click **Add > [Policy Type]**.
     b. Go to the **Name and Priority** screen.
   - For pre-existing policies:
     Click the policy name.

3. Select to enable this policy or exception.

4. Type the name of your policy in the **Policy name** space.

5. Specify the priority.
   - For new policies:
     Type the priority of your policy in the **Priority** space.
   - For preexisting policies:
     a. Select the check box next to the policy or exception name in the list.
b. Click **Reorder**.

c. Type the priority number in the **Priority** field.

d. Click **Save Reorder**.

6. Click **Save**.

---

### Configuring a Content Filtering Exception

Exception policies follow the same priority behavior as other content filtering policies. Exception policies specify email address exception lists for content filtering policies with a lower priority.

---

**Note**

Exception email addresses can be SMTP addresses or display name (for users in the domain where ScanMail is installed). Regular expressions can be used in exception email addresses.

---

**Procedure**

1. Go to the **Content Filtering** screen by navigating to one of the following:
   - For Real-time scans: **Content Filtering**
   - For Manual scans: **Manual Scan > Content filtering**
   - For Scheduled scans: **Scheduled Scan > [Add or Edit] > Content filtering**

2. Add or edit a policy:
   - For new policies:
     - Click **Add > Exceptions**.
   - For pre-existing policies:
     - Click the policy name.
3. Type an email address under **Enter address(es)**.

4. Click **Add**.
   
The email address appears in the list.

5. Save the list.

---

**Editing a Content Filtering Policy**

A brief description of the editing options is available below.

---

**Procedure**

1. Click **Content Filtering** from the main menu.
   
The **Content Filtering** screen displays.

2. Click the name of the policy to edit.

3. Configure the following options:
   
   - **Enable this policy**: Select to enable this policy.
   - **Policy name**: Edit the policy name by typing a new name.
   - **Accounts**: View the accounts that the current policy applies to.
   - **Target**: Edit the target based on the type of policy.
   - **Action**: Edit the action by selecting from the available actions for this policy.
   - **Notification**: Edit the notifications by selection from the available options for this policy.

4. Click **Save**.
Chapter 10

Configuring Data Loss Prevention

This chapter explains how to configure Data Loss Prevention to protect the Exchange environment.

Topics include:

• About Data Loss Prevention (DLP) on page 10-2
• Data Identifier Types on page 10-2
• About Data Loss Prevention Templates on page 10-12
• About Data Loss Prevention Policies on page 10-17
About Data Loss Prevention (DLP)

With the prevalence and damaging effects of data breaches, organizations now see digital asset protection as a critical component of their security infrastructure.

Data Loss Prevention safeguards an organization’s sensitive data against accidental or deliberate leakage. Data Loss Prevention allows you to:

• Identify the sensitive information that requires protection using data identifiers
• Create policies that limit or prevent the transmission of digital assets through common transmission channels, such as email and external devices
• Enforce compliance to established privacy standards

Before you can monitor sensitive information for potential loss, you must be able to answer the following questions:

• What data needs protection from unauthorized users?
• Where does the sensitive data reside?
• How is the sensitive data transmitted?
• What users are authorized to access or transmit the sensitive data?
• What action should be taken if a security violation occurs?

This important audit typically involves multiple departments and personnel familiar with the sensitive information in your organization.

If you already defined your sensitive information and security policies, you can begin to define data identifiers and company policies.

Data Identifier Types

Digital assets are files and data that an organization must protect against unauthorized transmission. Administrators can define digital assets using the following data identifiers:

• Expressions: Data that has a certain structure.
Configuring Data Loss Prevention

For details, see *Expressions on page 10-3*.

- **Keyword lists**: A list of special words or phrases.
  
  For details, see *Keywords on page 10-8*.

---

**Note**

Administrators cannot delete a data identifier that a DLP template is using. Delete the template before deleting the data identifier.

---

**Expressions**

An expression is data that has a certain structure. For example, credit card numbers typically have 16 digits and appear in the format "nnnn-nnnn-nnnn-nnnn", making them suitable for expression-based detections.

Administrators can use predefined and customized expressions.

For details, see *Predefined Expressions on page 10-3* and *Customized Expressions on page 10-3*.

**Predefined Expressions**

Data Loss Prevention comes with a set of predefined expressions. These expressions cannot be modified or deleted.

Data Loss Prevention verifies these expressions using pattern matching and mathematical equations. After Data Loss Prevention matches potentially sensitive data with an expression, the data may also undergo additional verification checks.

For a complete list of predefined expressions, see the *Data Protection Lists* document at:

- .

**Customized Expressions**

Create customized expressions if none of the predefined expressions meet the company's requirements.
Expressions are a powerful string-matching tool. Become comfortable with expression syntax before creating expressions. Poorly written expressions can dramatically impact performance.

When creating expressions:

• Refer to the predefined expressions for guidance on how to define valid expressions. For example, when creating an expression that includes a date, refer to the expressions prefixed with "Date".

• Note that Data Loss Prevention follows the expression formats defined in Perl Compatible Regular Expressions (PCRE). For more information on PCRE, visit the following website:

• Start with simple expressions. Modify the expressions if they are causing false alarms or fine tune them to improve detections.

Administrators can choose from several criteria when creating expressions. An expression must satisfy the chosen criteria before Data Loss Prevention subjects it to a DLP policy. For details about the different criteria options, see Criteria for Customized Expressions on page 10-4.

Criteria for Customized Expressions

**TABLE 10-1. Criteria Options for Customized Expressions**

<table>
<thead>
<tr>
<th>CRITERIA</th>
<th>RULE</th>
<th>EXAMPLE</th>
</tr>
</thead>
</table>
| None     | None | All - Names from US Census Bureau
<p>|          |      | Expression: [^\w][(A-Z)[a-z]{1,12} (\s?,\s?|\s]s(A-Z))(\s?[A-Z][a-z] {1,12})[^\w] |</p>
<table>
<thead>
<tr>
<th><strong>Criteria</strong></th>
<th><strong>Rule</strong></th>
<th><strong>Example</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Specific characters</td>
<td>An expression must include the characters you have specified. In addition, the number of characters in the expression must be within the minimum and maximum limits.</td>
<td>US - ABA Routing Number&lt;br&gt;&lt;ul&gt;&lt;li&gt;Expression: <code>[^\d]([0123678]\d{8})[^\d]</code>&lt;/li&gt;&lt;li&gt;Characters: 0123456789&lt;/li&gt;&lt;li&gt;Minimum characters: 9&lt;/li&gt;&lt;li&gt;Maximum characters: 9&lt;/li&gt;&lt;/ul&gt;</td>
</tr>
<tr>
<td>Suffix</td>
<td>Suffix refers to the last segment of an expression. A suffix must include the characters you have specified and contain a certain number of characters. In addition, the number of characters in the expression must be within the minimum and maximum limits.</td>
<td>All - Home Address&lt;br&gt;&lt;ul&gt;&lt;li&gt;Expression: `\D(\d+\s[a-zA-Z]+\s([a-zA-Z]+\s){0,2} (lane</td>
</tr>
<tr>
<td>Single-character separator</td>
<td>An expression must have two segments separated by a character. The character must be 1 byte in length. In addition, the number of characters left of the separator must be within the minimum and maximum limits. The number of characters right of the separator must not exceed the maximum limit.</td>
<td>All - Email Address&lt;br&gt;&lt;ul&gt;&lt;li&gt;Expression: <code>[^\w.](\w\.)\{1,20\}@([a-zA-Z0-9]\{2,}\.[a-zA-Z]\{2,5\}[a-zA-Z.]{0,10})[^\w.]</code>&lt;/li&gt;&lt;li&gt;Separator: @&lt;/li&gt;&lt;li&gt;Minimum characters to the left: 3&lt;/li&gt;&lt;li&gt;Maximum characters to the left: 15&lt;/li&gt;&lt;li&gt;Maximum characters to the right: 30&lt;/li&gt;&lt;/ul&gt;</td>
</tr>
</tbody>
</table>
Adding and Editing Expressions

Create customized expressions if none of the predefined expressions meet the company's requirements.

Procedure

1. On the left navigation bar, click Data Loss Prevention > Data Identifiers.
   A list of data identifiers appears.
2. Click the Expressions tab.
3. Click Add or edit an expression by clicking the expression's name.
   A new screen displays.
4. Type a name for the expression.
   The name must not exceed 512 bytes in length.
5. Type a description that does not exceed 2048 bytes in length.
6. Type the expression and specify whether it is case-sensitive.
7. Type the displayed data.
   For example, when creating an expression for ID numbers, type a sample ID number. This data is used for reference purposes only and does not appear elsewhere in the product.
8. Choose one of the following criteria and configure additional settings for the chosen criteria:
   - None
   - Specific characters
   - Suffix
   - Single-character separator
9. Select an additional validation method if necessary.
These additional validators were specifically designed to detect highly specialized digital assets.

10. Test the expression against an actual data.

For example, if the expression is for a national ID, type a valid ID number in the Test data text box, click Test, and then check the result.

11. Click Save.

---

**Tip**

Save the settings only if the testing was successful. An expression that cannot detect any data wastes system resources and may impact performance.

---

**Importing Expressions**

Administrators with a properly-formatted .dat file containing the expressions can use this option. Generate the file by exporting the expressions from either the ScanMail server on the current server or from another ScanMail server.

**Procedure**

1. On the left navigation bar, click **Data Loss Prevention > Data Identifiers**.

   A list of data identifiers appears.

2. Click the **Expressions** tab.

3. Click **Import** and then locate the .dat file containing the expressions.

4. Click **Open**.

   A message appears, indicating the status of the import.
Note

Each expression contains a unique ID value. If an expression with the same ID already exists, ScanMail overwrites the existing expression. If an expression with the same display name already exists, ScanMail appends the suffix “Original” to the preexisting expression and adds the new expression to the list.

Keywords

Keywords are special words or phrases. You can add related keywords to a keyword list to identify specific types of data. For example, "prognosis", "blood type", "vaccination", and "physician" are keywords that may appear in a medical certificate. If you want to prevent the transmission of medical certificate files, you can use these keywords in a DLP policy and then configure Data Loss Prevention to block files containing these keywords.

Commonly used words can be combined to form meaningful keywords. For example, "end", "read", "if", and "at" can be combined to form keywords found in source codes, such as "END-IF", "END-READ", and "AT END".

You can use predefined and customized keyword lists. For details, see Predefined Keyword Lists on page 10-8 and Customized Keyword Lists on page 10-8.

Predefined Keyword Lists

Data Loss Prevention comes with a set of predefined keyword lists. These keyword lists cannot be modified or deleted. Each list has its own built-in conditions that determine if the template should trigger a policy violation.

For details about the predefined keyword lists in Data Loss Prevention, see the Data Protection Lists document at:

Customized Keyword Lists

Create customized keyword lists if none of the predefined keyword lists meet your requirements.
There are several criteria that you can choose from when configuring a keyword list. A keyword list must satisfy your chosen criteria before Data Loss Prevention subjects it to a policy. Choose one of the following criteria for each keyword list:

- Any keyword
- All keywords
- All keywords within \(<x>\) characters
- Combined score for keywords exceeds threshold

For details regarding the criteria rules, see Customized Keyword List Criteria on page 10-9.

**Customized Keyword List Criteria**

**TABLE 10-2. Criteria for a Keyword List**

<table>
<thead>
<tr>
<th>CRITERIA</th>
<th>RULE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any keyword</td>
<td>A file must contain at least one keyword in the keyword list.</td>
</tr>
<tr>
<td>All keywords</td>
<td>A file must contain all the keywords in the keyword list.</td>
</tr>
<tr>
<td>Criteria</td>
<td>Rule</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>All keywords within &lt;x&gt; characters</td>
<td>A file must contain all the keywords in the keyword list. In addition, each keyword pair must be within &lt;x&gt; characters of each other. For example, your 3 keywords are WEB, DISK, and USB and the number of characters you specified is 20. If Data Loss Prevention detects all keywords in the order DISK, WEB, and USB, the number of characters from the &quot;D&quot; (in DISK) to the &quot;W&quot; (in WEB) and from the &quot;W&quot; to the &quot;U&quot; (in USB) must be 20 characters or less. The following data matches the criteria: DISK####WEB###########USB The following data does not match the criteria: DISK**********************<strong>WEB</strong>**USB(23 characters between &quot;D&quot; and &quot;W&quot;) When deciding on the number of characters, remember that a small number, such as 10, usually results in a faster scanning time but only covers a relatively small area. This may reduce the likelihood of detecting sensitive data, especially in large files. As the number increases, the area covered also increases but scanning time might be slower.</td>
</tr>
<tr>
<td>Combined score for keywords exceeds threshold</td>
<td>A file must contain one or more keywords in the keyword list. If only one keyword was detected, its score must be higher than the threshold. If there are several keywords, their combined score must be higher than the threshold. Assign each keyword a score of 1 to 10. A highly confidential word or phrase, such as &quot;salary increase&quot; for the Human Resources department, should have a relatively high score. Words or phrases that, by themselves, do not carry much weight can have lower scores. Consider the scores that you assigned to the keywords when configuring the threshold. For example, if you have five keywords and three of those keywords are high priority, the threshold can be equal to or lower than the combined score of the three high priority keywords. This means that the detection of these three keywords is enough to treat the file as sensitive.</td>
</tr>
</tbody>
</table>
Adding and Editing Keyword Lists

Keywords are special words or phrases. Add related keywords to a keyword list to identify specific types of data. Create customized keyword lists if none of the predefined keyword lists meet the company's requirements.

Procedure

1. On the left navigation bar, click **Data Loss Prevention > Data Identifiers**.
   A list of data identifiers appears.

2. Click the **Keyword Lists** tab.

3. Click **Add** or edit a keyword list by clicking the keyword list's name.
   A new screen displays.

4. Type a name for the keyword list.
   The name must not exceed 512 bytes in length.

5. Type a description that does not exceed 2048 bytes in length.

6. Choose one of the following criteria and configure additional settings for the chosen criteria:
   - Any keyword
   - All keywords
   - All keywords within <x> characters
   - Combined score for keywords exceeds threshold

7. To manually add keywords to the list:
   a. Type a keyword that is 3 to 512 bytes in length and specify whether it is case-sensitive.
   b. Click **Add**.

8. To delete keywords, select the keywords and click **Delete**.
9. Click **Save**.

---

**Importing Expressions**

Administrators with a properly-formatted `.dat` file containing the expressions can use this option. Generate the file by exporting the expressions from either the ScanMail server on the current server or from another ScanMail server.

---

**Procedure**

1. On the left navigation bar, click **Data Loss Prevention > Data Identifiers**.
   
   A list of data identifiers appears.

2. Click the **Expressions** tab.

3. Click **Import** and then locate the `.dat` file containing the expressions.

4. Click **Open**.

   A message appears, indicating the status of the import.

---

**Note**

Each expression contains a unique ID value. If an expression with the same ID already exists, ScanMail overwrites the existing expression. If an expression with the same display name already exists, ScanMail appends the suffix “Original” to the preexisting expression and adds the new expression to the list.

---

**About Data Loss Prevention Templates**

Use Data Loss Prevention templates to tag and detect sensitive content by a set combination of data identifiers. A template combines data identifiers and operators (And, Or) in condition statements. When a set of data matches the criteria of a condition, Data Loss Prevention triggers a policy action. For example, a file containing data matching the All: Names from US Census Bureau AND US: HICN (Health Insurance Claim Number) templates, triggers the HIPAA policy.
Use Data Loss Prevention out-of-the-box templates for regulatory compliance initiatives, such as GLBA, PCI-DSS, SB-1386, US PII, and HIPAA. Companies can also create custom templates or modify existing templates to suit their business requirements. Companies that have preexisting, user-defined templates can import and export templates to maintain policy consistency throughout their organization.

Create company-specific templates after configuring DLP data identifiers or use the predefined templates.

**Predefined DLP Templates**

Data Loss Prevention comes with the following set of predefined templates that you can use to comply with various regulatory standards. These templates cannot be modified or deleted.

- **GLBA**: Gramm-Leach-Billey Act
- **HIPAA**: Health Insurance Portability and Accountability Act
- **PCI-DSS**: Payment Card Industry Data Security Standard
- **SB-1386**: US Senate Bill 1386
- **US PII**: United States Personally Identifiable Information

For a detailed list on the purposes of all predefined templates, and examples of data being protected, see the *Data Protection Lists* document at:

**Defining a Data Loss Prevention Template**

Data Loss Prevention templates define an organization's sensitive data using keyword lists and expressions. Define templates to use in Data Loss Prevention policies and protect sensitive information that is company-specific. For more information on Data Loss Prevention Templates, see *About Data Loss Prevention Templates on page 10-12.*
Note
Administrators cannot modify a pre-packaged template. To use a pre-packaged template as the basis for a new template, select the check box beside the template name and click **Copy** in the Data Loss Prevention Template toolbar. This creates a new template with the suffix "Copy" at the end.

Procedure
1. On the left navigation bar, click **Data Loss Prevention > DLP Templates**.
   A list of templates appears.
2. Choose to create or modify a Data Loss Prevention Template.
   - To create a template, on the Data Loss Prevention Templates toolbar, click **Add**.
   - To modify a template, click the template name.
3. Type the **Name** of the template.
4. (Optional) Type a **Description** of the template.
5. From the drop-down box under **Condition Statement**, beside the (+) control, select the criteria **Expressions** or **Keyword Lists**.
6. Select an expression or keyword list from the drop-down box beside the selected criteria.
7. When adding **Expressions** criteria, type the number of **Occurrences** necessary for the template to trigger. This value designates the number of times an expression must be present in an email message before ScanMail triggers an action.
   
   Note
   The **Occurrences** amount is a required value. The value cannot be zero (0) or blank.
8. Add additional criteria by clicking the (+) control. Remove criteria by clicking the (-) control.
9. When adding more than one template definition, select the **And** or **Or** operator from the drop-down box beside the condition in the **Condition Statement** list.
10. Click **Add** to add the condition to the **Template Definition** list or click **Clear** to clear the condition statement.

11. When adding more than one condition, select the **And** or **Or** operator from the drop-down box beside the template definition in the **Template Definition** list.

12. To remove a definition from the **Template Definition** list, click the delete icon (🗑️) to the right of the definition.

13. Click **Save**.

The **Data Loss Prevention Templates** screen appears with the new template at the bottom of the Data Loss Prevention templates list.

### Deleting a Data Loss Prevention Template

**Note**

Administrators cannot delete a pre-packaged DLP template or any templates associated with a company policy. Remove the template from all policies before deleting the template.

**Procedure**

1. On the left navigation bar, click **Data Loss Prevention > DLP Templates**. A list of templates appears.

2. Select the check box beside the template that you want to delete.

3. On the Data Loss Prevention Templates toolbar, click **Delete**.

### Importing a Data Loss Prevention Template

Administrators can import Data Loss Prevention templates from other ScanMail servers or other Trend Micro products to keep predefined rules consistent throughout the organization.
Procedure

1. On the left navigation bar, click **Data Loss Prevention > DLP Templates.**
   A list of templates appears.

2. On the Data Loss Prevention Templates toolbar, click **Import.**

   **Note**
   Each template contains a unique ID value. If a template with the same ID already exists, ScanMail overwrites the existing template. If a template with the same display name already exists, ScanMail appends the suffix “Original” to the preexisting template and adds the new template to the list.

The **Data Loss Prevention Import Template** screen appears.

3. Click the **Browse...** button, locate, and select the template file to import. Click **Open.**

   **Note**
   Template files save in **DAT** format.

4. Click **Import** to import the template file.

---

**Exporting a Data Loss Prevention Template**

You can export templates to other ScanMail servers or other Trend Micro products to keep predefined rules consistent throughout your organization.

Procedure

1. On the left navigation bar, click **Data Loss Prevention > DLP Templates.**
   A list of templates appears.

2. Select the check box(es) next to the template name(s) that you want to export.
   A File Download dialog appears.

4. Click Save.
   A Save As dialog appears.

5. Select a name and location for the export file. Click Save.

   Note
   Template files save in DAT format.

About Data Loss Prevention Policies

Data Loss Prevention policies allow companies to monitor the flow of sensitive information over the network. Policy rules, through use of Data Loss Prevention templates, help to manage the distribution of sensitive data across the network. Administrators can scale policies to apply to the entire company, groups, or specific endpoints.

Administrators can apply policies to both outbound and inbound mail traffic, as well as to the exact message parts to monitor. Policy configurations can exempt certain groups or users from scans and define specific incident response actions.

ScanMail integrates Data Loss Prevention policy management with Apex Central. Administrators can create and manage the company’s Data Loss Prevention policies from the Apex Central console and deploy the settings to all ScanMail servers registered to Apex Central.

Enabling Real-time Data Loss Prevention

When Data Loss Prevention is enabled, you can enable and disable individual Data Loss Prevention policies. The green check icon (✅) indicates the policy is enabled, and the red "x" (❌) indicates the policy is disabled. Click the icon to toggle between enabled and disabled.
Procedure

1. Click **Data Loss Prevention > DLP Policies** from the main menu.
   The **Data Loss Prevention Policies** screen displays.

2. Select **Enable transport level Data Loss Prevention**.

3. From the **Apply policies to** drop-down select to apply policies to **Outbound messages** only or to **All messages**.

4. From the **Digital asset discovery** drop-down, select how Data Loss Prevention matches digital assets:
   - **Single message part**: Data Loss Prevention identifies digital assets in each message part separately.
     For example, one of the triggers of the “Canada: Cardholder Information” template is the detection of 5 occurrences of credit card numbers. Selecting **Single message part** requires DLP to match 5 credit card numbers all in the same message part before triggering the policy.
   - **Multiple message parts**: Data Loss Prevention identifies digital assets spread among all selected message parts.
     For example, one of the triggers of the “Canada: Cardholder Information” template is the detection of 5 occurrences of credit card numbers. Selecting **Multiple message parts** allows DLP to match credit card numbers among all selected message parts (if 2 credit card numbers are matched in the message body and 3 in the message attachment, DLP triggers the template).

5. Click **Save**.

Global Settings

ScanMail uses Quarantine to move actionable messages to a quarantine directory, replace the targeted files, and deliver the remaining messages to the original recipient.

You can configure ScanMail to quarantine or backup email messages when it detects a policy incident. You can set the quarantine or backup folder for each policy individually from the **Action Settings** screen, or you can specify a global directory.
When you specify a global quarantine or backup directory, ScanMail moves all files that it quarantines or backs up as a result of a policy incident to the directory that you specify.

For details on global advanced scan actions, see *Advanced Scan Action Options on page 6-21*.

To configure the Global Settings, click **Data Loss Prevention > DLP Policies > Global Settings**.

---

**Note**

You must click **Apply to All** to configure the new directories. If you click **Save**, ScanMail only saves directory paths that you typed, but they will not be applied.

---

**Configuring a Data Loss Prevention Policy**

Data Loss Prevention policies govern the actions ScanMail takes when it discovers sensitive information in email messages.

Create a new policy by clicking **Data Loss Prevention > DLP Policies > Add**.

Modify an existing policy by clicking **Data Loss Prevention > DLP Policies > [DLP Policy Name]**.

Configure Data Loss Prevention policies through the following five step process:

1.  *Selecting Accounts on page 10-20*
2.  *Configuring DLP Targets on page 10-21*
3.  *Configuring DLP Actions on page 10-23*
4.  *Configuring DLP Notifications on page 10-24*
5.  *Enabling a DLP Policy on page 10-25*
Selecting Accounts

Procedure


2. Add or edit a policy or exception:
   • For new policies or exceptions:
     Click Add.
   • For preexisting policies or exceptions:
     a. Click the policy or exception name.
     b. Click the Accounts tab.

3. Select the senders or recipients for the policy scan.
   • While creating a new policy:
     a. Select the account type:
        • From any sender to any recipient
        • From specific sender(s) to any recipient
        • From any sender to specific recipient(s).
        • From specific sender(s) to specific recipient(s).
     b. Click the specific sender(s) or specific recipient(s) link (if applicable).
   • While editing a policy:
     a. Select the account type:
        • All
        • Specific sender(s)
        • Specific recipient(s)
Configuring Data Loss Prevention

• Specific sender(s) and recipient(s)

ScanMail only applies the policy to the accounts selected for the Accounts type. If you select accounts for a different account type, ScanMail does not apply the policy to the previous accounts selected.

b. Click the Edit link in the tables to change the included accounts and excepted accounts for this policy.

4. Select one of the following:

• Anyone: Apply this policy or exception to all users.

• Specific accounts: Select from Active Directory groups or ScanMail special groups.

5. Search and select AD Users/Groups/Contacts/Special Groups and add them to the Selected Account(s) list.

6. Search and select AD Users/Groups/Contacts/Special Groups and add them to the Selected Account(s) list on the Exclude Accounts screen.

Configuring DLP Targets

Procedure

1. Go to the Data Loss Prevention Policies screen by navigating to the following:
   • For Real-time scans: Data Loss Prevention > DLP Policies
   • For Manual scans: Manual Scan > Data Loss Prevention
   • For Scheduled scans: Scheduled Scan > [Add or Edit] > Data Loss Prevention

2. Add or edit a policy or exception:
   • For new policies or exceptions:
     a. Click Add.
b. Go to the **Specify Rule** screen.

- For preexisting policies or exceptions:
  a. Click the policy or exception name.
  b. Click the **Target** tab.

3. Select the check box(es) for the target area(s) of the email message to scan.

   Available targets are:
   - **Header** *(From, To, and Cc)*
   - **Subject**
   - **Body**
   - **Attachment**

4. Select templates from the list of available templates and click **Add >>** to apply the templates to the policy.

---

**Note**
A Data Loss Prevention policy requires selecting at least one template before activation.

---

5. In the Available DLP Template(s) toolbar, click **Add** to create a new template or click **Import** to import a template file.

   For details on adding templates, see *Defining a Data Loss Prevention Template on page 10-13*.

   For details on importing templates, see *Importing a Data Loss Prevention Template on page 10-15*. 
Configuring DLP Actions

Procedure

1. Go to the Data Loss Prevention Policies screen by navigating to the following:
   • For Real-time scans: Data Loss Prevention > DLP Policies
   • For Manual scans: Manual Scan > Data Loss Prevention
   • For Scheduled scans: Scheduled Scan > [Add or Edit] > Data Loss Prevention

2. Add or edit a policy or exception:
   • For new policies or exceptions:
     a. Click Add.
     b. Go to the Specify Action screen.
   • For preexisting policies or exceptions:
     a. Click the policy or exception name.
     b. Click the Action tab.

3. Select an action for ScanMail to take when it detects undesirable content.

4. To notify specific individuals:
   • Select the check box Forward to sender’s manager.
   • Select the check box Forward to specific email address(es) and type the email address of the recipients.

5. Specify whether to send notifications when an action is taken by selecting Notify or Do not notify.

6. Configure Advanced Options as necessary.
Configuring DLP Notifications

Procedure

1. Go to the Data Loss Prevention Policies screen by navigating to the following:
   - For Real-time scans: Data Loss Prevention > DLP Policies
   - For Manual scans: Manual Scan > Data Loss Prevention
   - For Scheduled scans: Scheduled Scan > [Add or Edit] > Data Loss Prevention

2. Add or edit a policy or exception:
   - For new policies or exceptions:
     a. Click Add.
     b. Go to the Specify Notification screen.
   - For preexisting policies or exceptions:
     a. Click the policy or exception name.
     b. Click the Notification tab.

3. Click the check boxes corresponding to the people ScanMail will notify.

4. Click Show details to customize the notification for that recipient.

5. Select from the notification options.
   - Refer to Notification Settings on page 6-24 for details.

6. Click Write to Windows event log to have ScanMail write the notification to a Windows event log.
Enabling a DLP Policy

Procedure

1. Go to the **Data Loss Prevention Policies** screen by navigating to the following:
   - For Real-time scans: **Data Loss Prevention > DLP Policies**
   - For Manual scans: **Manual Scan > Data Loss Prevention**
   - For Scheduled scans: **Scheduled Scan > [Add or Edit] > Data Loss Prevention**

2. Add or edit a policy before enabling:
   - For new policies:
     a. Click **Add**.
     b. Go to the **Name and Priority** screen.
   - For pre-existing policies:
     Click the policy name.

3. Select to enable this policy or exception.

4. Type the name of your policy in the **Policy name** space.

5. Specify the priority.
   - For new policies:
     Type the priority of your policy in the **Priority** space.
   - For preexisting policies:
     a. Select the check box next to the policy or exception name in the list.
     b. Click **Reorder**.
     c. Type the priority number in the **Priority** field.
     d. Click **Save Reorder**.
6. Click **Save**.
Chapter 11

Configuring Spam Prevention

This chapter explains how to configure Spam Prevention to protect your Exchange environment.

Topics include:

- *About Spam Prevention* on page 11-2
- *About Email Reputation* on page 11-3
- *About Content Scanning* on page 11-6
About Spam Prevention

Trend Micro spam prevention service intercepts spam to prevent spam messages from reaching your email clients. Spam prevention works by:

- Comparing, in real time, incoming email messages against a list of known spam.
- Making a series of logical deductions to determine whether the mail has the characteristics of spam.

Even when senders of spam change their methods, spam prevention can distinguish spam from legitimate email messages. Trend Micro spam prevention employs patent-pending, heuristic technology that evaluates, identifies, and monitors existing and new messages using multiple email characteristics, providing highly accurate spam capture rates. False positives are kept low by the use of sophisticated behavior-evaluation algorithms, which calculate the probability that a particular message is spam.

ScanMail provides two powerful features, Email Reputation and content scanning, for filtering spam messages.

Spam Folder Configuration

**Important**

The End User Quarantine spam folder (along with Junk Email folder) is only available for Exchange Server 2013 environments. For Exchange Server 2016 and 2019, only Junk Email folder is available.

- Trend Micro Spam Folder

ScanMail creates a spam folder on all of the mailboxes on the Exchange server where you installed ScanMail. During the installation, the installation program prompted you to name this folder and it will have the name that you specified.

After installation, you can rename the spam folder using Microsoft Outlook. Trend Micro identifies the folder by ID, not by folder name.

- Spam detection levels
ScanMail also configures the spam detection level defaults. The spam detection level filters out spam messages arriving at the Exchange server.

- **High**: This is the most rigorous level of spam detection. ScanMail monitors all email messages for suspicious files or text, but there is greater chance of false positives. False positives are those email messages that ScanMail filters as spam when they are actually legitimate email messages.

- **Medium**: ScanMail monitors at a high level of spam detection with a moderate chance of filtering false positives.

- **Low**: This is the default setting. This is most lenient level of spam detection. ScanMail will only filter the most obvious and common spam messages, but there is a very low chance that it will filter false positives.

### About Email Reputation

ScanMail provides Email Reputation features as a part of spam prevention. As the first line of defense, Trend Micro Email Reputation helps stop spam before it can flood your network and burden your system resources.

When your email server accepts an initial connection from another email server, your email server records the IP address of the computer requesting the connection. Your email server then queries its DNS server, which in turn queries the Reputation database(s) to determine if there is a record for the IP address of the requesting computer. If the host is listed in a database, Email Reputation recommends an appropriate action. You can also customize actions.

### Trend Micro Email Reputation Standard

This service helps block spam by validating requested IP addresses against the Trend Micro reputation database, powered by the Trend Micro Threat Prevention Network. This ever-expanding database currently contains over 1 billion IP addresses with reputation ratings based on spam activity. Trend Micro spam investigators continuously review and update these ratings to ensure accuracy.

Email Reputation Standard Service is a DNS single-query-based service. Your designated email server makes a DNS query to the standard reputation database server...
whenever an incoming email message is received from an unknown host. If the host is listed in the standard reputation database, Email Reputation reports that email message as spam. You can set up your Message Transfer Agent (MTA) to take the appropriate action on that message based on the spam identification from Email Reputation.

**Tip**

Trend Micro recommends that you configure your Message Transfer Agent (MTA) to block, not receive, any email from an IP address that is included on the standard reputation database.

---

**Trend Micro Email Reputation Advanced**

This service identifies and stops sources of spam while they are in the process of sending millions of messages. This is a dynamic, real-time antispam solution. To provide this service, Trend Micro continuously monitors network and traffic patterns and immediately updates the dynamic reputation database as new spam sources emerge, often within minutes of the first sign of spam. As evidence of spam activity ceases, the dynamic reputation database is updated accordingly.

Like Email Reputation Standard, Email Reputation Advanced is a DNS query-based service, but two queries can be made to two different databases: the standard reputation database and the dynamic reputation database (a database updated dynamically in real time). These two databases have distinct entries (no overlapping IP addresses), allowing Trend Micro to maintain a very efficient and effective database that can quickly respond to highly dynamic sources of spam. Email Reputation Advanced Service has blocked more than 80% of total incoming connections (all were malicious) in customer networks. Results will vary depending on how much of your incoming email message stream is spam. The more spam you receive, the higher the percentage of blocked connections you will see.

**Enabling Email Reputation**

Email Reputation verifies IP addresses of incoming email messages using one of the world's largest, most trusted reputation databases along with a dynamic reputation database to identify new spam and phishing sources, stopping even zombies and botnets as they first emerge.
Configuring Spam Prevention

Procedure

1. Go to the Email Reputation screen by navigating to Spam Prevention > Email Reputation.
2. Select Enable Email Reputation.
3. Click Save.

Configuring Email Reputation Targets

Procedure

1. Go to the Email Reputation screen by navigating to Spam Prevention > Email Reputation.
2. Configure the following settings:
   - **Smart Protection Network portal**: Click to view global spam information, reports, create or manage Approved and Blocked Sender IP address lists, perform administrative tasks, and configure the service from the Trend Micro Email Reputation website.
   - **Add**: Type an IP address and click to add the IP address to the Approved IP Address list.
3. Click Save.

Configuring Email Reputation Actions

If you specified **Standard** as the Service Level from the Target tab, only the **Standard Reputation Database Action** options display. Otherwise, if you specified **Advanced** as the Service Level from the Target tab, both the **Standard Reputation Database Action** and the **Dynamic Reputation Database Action** display because both databases will be used. If both action boxes display, specify separate actions for detections made with each database.
Procedure

1. Go to the Email Reputation screen by navigating to Spam Prevention > Email Reputation.

2. Click the Action tab.

3. Select one of the following for the Standard Reputation Database Action:
   - **Intelligent action**: Denial of connection for Standard Reputation Database matches.
     (Optional) Type an SMTP error code and type a custom error message.
   - **Close connection with no error message**: Select to close the connection.
   - **Bypass**: Select to pass without logging.

4. (Optional) Select one of the following for the Dynamic Reputation Database Action if Advanced was selected:
   - **Intelligent action**: Denial of connection for Dynamic Reputation Database matches.
     (Optional) Type an SMTP error code and type a custom error message.
   - **Close connection with no error message**: Select to close the connection.
   - **Bypass**: Select to pass without logging.

5. Click Save.

About Content Scanning

ScanMail uses the Trend Micro Anti-spam Engine to implement heuristic-based policies when detecting unwanted content, or blocking, or automatically allowing a message. If you chose to install the End User Quarantine tool when installing ScanMail, ScanMail creates a spam folder on all of the mailboxes on the Exchange server where you installed ScanMail.
Content Scanning uses the Approved and Blocked Sender Lists and the Spam Filter to screen messages for spam.

**Spam Engine and Spam Pattern Files**

ScanMail uses the Trend Micro spam engine and Trend Micro spam pattern files to detect and take action against spam messages. Trend Micro updates both the engine and pattern file frequently and makes them available for download. ScanMail can download these components through a manual or scheduled update.

The spam engine makes use of spam signatures and heuristic rules to screen email messages. It scans email messages and assigns a spam score to each one based on how closely it matches the rules and patterns from the pattern file. ScanMail compares the spam score to the user-defined spam detection level. When the spam score exceeds the detection level, ScanMail takes action against the spam. You cannot modify the method that the spam engine uses to assign spam scores, but they can adjust the detection levels used by ScanMail to decide what is spam and what is not spam.

For example: Many spammers use many exclamation marks, or more than one consecutive exclamation mark (!!!!) in their email messages. When ScanMail detects a message that uses exclamation marks this way, it increases the spam score for that email message.

**End User Quarantine**

During installation, you can add a folder to the server-side mailbox of each end user for Microsoft Exchange. You name the spam folder and configure the storage time limit during the installation process. Trend Micro recommends naming the spam folder "Spam Mail". When ScanMail detects spam messages, the system quarantines them in this folder according to spam filter rules predefined by ScanMail. End users can view this spam folder to open, read, or delete the suspect email messages.

End users can open email messages quarantined in the spam folder. When they open one of these messages, two buttons appear on the actual email message: **Approved Sender** and **View Approved Sender List**. When they click **Approved Sender**, ScanMail moves the message from that sender to their local Inbox, adds the address of the message to their personal Approved Sender List, and logs an entry of the event (the
administrator can view this log in a report at a later time). Clicking View Approved Sender opens another screen that allows the end user to view and modify their list of approved senders by name or domain. When the Exchange server receives messages from the addresses on the end user’s approved sender list, it delivers them to the end user’s Inbox, regardless of the header or content of the message.

ScanMail also provides administrators with an Approved Senders and Blocked Senders list. ScanMail applies the administrator’s approved senders and blocked senders before considering the end user list.

Approved and Blocked Sender Lists

ScanMail does not classify addresses from the Approved senders list as spam (unless it detects a phishing incident), nor does it filter messages from this list as spam. ScanMail filters addresses from Blocked senders lists and always classifies them as spam with the action depending on the rule set by the administrator.

Note

The Exchange administrator maintains a separate Approved and Blocked Senders list for the Exchange server. If an end-user creates an approved sender, but that sender is on the administrator's Blocked Senders list, then ScanMail detects messages from that blocked sender as spam and takes action against those messages.

Spam Filter

Administrators configure a spam detection rate to filter out spam. The higher the detection level, the more likely messages will be classified as spam.

The detection level determines how tolerant ScanMail is towards suspect email messages. A high detection level quarantines the most email messages as spam, but it might also falsely identify and quarantine legitimate email messages as spam, creating "false positive" spam mail. A low detection level does not rigorously screen email messages, but does not create many false positive spam messages.
New Spam Sources

Content Scanning can identify new spam sources in conjunction with Web Reputation Services. After enabling Detect new spam sources, ScanMail performs the following actions after receiving an email message containing a URL:

1. Web Reputation Services determines the reputation score of the URL.
2. ScanMail uses the configured internal gateway MX record or IP address lists to determine the sender IP address of the email message.
3. Email Reputation Services determines the reputation score of the sender IP address.

Content Scanning uses the reputation scores of both the URL contained in the email message and the sender IP address to determine the risk level of the email message.

---

**Important**

You must enable Web Reputation Services to detect new spam sources.

---

Enabling Content Scanning

ScanMail detects spam messages in real time and takes actions to protect Exchange clients. The approved senders list has higher priority than the blocked senders list. If an email address is in both the approved and blocked senders lists, ScanMail will not classify the email message as spam.

---

**Procedure**

1. Go to the Content Scanning screen by navigating to Spam Prevention > Content Scanning.
2. Select Enable content scanning.
3. Click Save.
Configuring Content Scanning Targets

Procedure

1. Go to the Content Scanning screen by navigating to Spam Prevention > Content Scanning.
2. Click the Target tab.
3. Select a detection level:
   - **High**: This is the most rigorous level of spam detection. ScanMail monitors all email messages for suspicious files or text, but there is greater chance of false positives. False positives are those email messages that ScanMail filters as spam when they are actually legitimate email messages.
   - **Medium**: ScanMail monitors at a high level of spam detection with a moderate chance of filtering false positives.
   - **Low**: This is the default setting. This is most lenient level of spam detection. ScanMail will only filter the most obvious and common spam messages, but there is a very low chance that it will filter false positives.
4. Select Detect new spam sources to scan email messages containing URLs that may be new spam sources.

**Important**

You must enable Web Reputation Services to detect new spam sources. For details, see Enabling Web Reputation on page 13-4.

For details about new spam sources, see New Spam Sources on page 11-9.

- Identify your company's Organizational MX records and add the MX records to the list.
- Identify your company's Organizational mail gateway IP addresses and add the IP addresses to the list.
5. Select Detect phishing to scan for phishing email messages.
6. Add addresses to the list of Approved Senders and Blocked Senders.
7. Click Save.

Configuring Content Scanning Actions

Procedure

1. Go to the Content Scanning screen by navigating to Spam Prevention > Content Scanning.
2. Click the Action tab.
3. Select one of the following actions for Spam messages:
   • Quarantine message to user’s spam folder
   • Delete entire message
   • Tag and deliver
   • Pass

For details on the available actions, see About ScanMail Actions on page 6-9.
4. Click Save.
Chapter 12

Configuring Advanced Spam Prevention

This chapter explains how to configure Advanced Spam Prevention to protect your Exchange environment.

Topics include:

- About Advanced Spam Prevention on page 12-2
- About Business Email Compromise on page 12-2
- About Writing Style Verification in ScanMail on page 12-2
- Configuring Advanced Spam Prevention Settings on page 12-3
- Configuring Writing Style Training Settings on page 12-6
- Configuring Writing Style Verification Settings on page 12-9
About Advanced Spam Prevention

The advanced spam prevention enables you to configure scanning modes and the Business Email Compromise (BEC) feature in ScanMail.

The scanning modes in advanced spam prevention includes Conservative mode or Aggressive mode. The Aggressive Mode requires Virtual Analyzer to scan content in an isolated virtual environment, while the Conservative Mode scans content using other methods in the absence of Virtual Analyzer.

The Business Email Compromise (BEC) feature in ScanMail detects a probable scam or attack using email messages that appear to be from a high profile user, such as, a corporate user from the executive team.

About Business Email Compromise

Using Business Email Compromise (BEC) scams, an attacker uses the same or similar account name to spoof the high-profile user's identity to initiate fraudulent wire transfers. The attacker typically uses the identity of a top-level executive to trick the target or targets into sending money into the attacker's account. Also known as Man-in-the-Email scams, BEC scams often target businesses that regularly send wire transfers to international clients and may involve the use of malware, social engineering, or both. For more information, see FBI Public Service Announcement.

With the integrated Antispam Engine, ScanMail for Microsoft Exchange performs the following to effectively protect organizations against BEC scams:

- Scan incoming email messages from external networks with specified high-profile users' account names, to block social engineering attacks

About Writing Style Verification in ScanMail

The Writing Style Verification adds an additional layer of security to corporate email messages. Trend Micro considers the writing style of a person as their "Biological-ID" (or "Bio-ID"). The writing style "Biological-ID" is generated based on the historical data of user email messages. Trend Micro scans old email messages of desired users to learn their particular writing style, and creates a model for each user. The subsequent
incoming email messages are then compared with the existing models of each user to determine the authenticity of these email messages.

---

**Note**

In this release, Writing Style Verification applies only to email messages written in English.

### Configuring Advanced Spam Prevention Settings

#### Enabling Advanced Spam Prevention

**Procedure**

1. Click **Advanced Spam Prevention > Advanced Spam Prevention Settings** from the main menu.
   
   The **Advanced Spam Prevention Settings** screen appears.

2. Select **Enable Advanced Spam Prevention** from the **Advanced Spam Prevention** screen.

3. Click **Save**.

#### Configuring Advanced Spam Prevention Scan Targets

**Procedure**

1. Click **Advanced Spam Prevention > Advanced Spam Prevention Settings** from the main menu.

2. Go to the **Target** tab.

   The **Target** tab displays.
3. If you want to detect more potential threats by sending suspicious messages to Virtual Analyzer, click on Enable Aggressive Mode for Advanced Spam link to configure the feature.

You must configure and registered to Virtual Analyzer to use this feature. Refer to Configuring Virtual Analyzer Settings on page 16-3 for the details.

4. Select Business Email Compromise check to protect against BEC scams, and do the following:
   a. Search the high profile users from the active directory under User Account in Active Directory field.
   b. Click Add to add user to the High Profile Users list on the right side.

5. If you want ScanMail to detect phishing, select Detect phishing option.

6. Click Save.

---

**Configuring Advanced Spam Prevention Scan Actions**

**Procedure**

1. Click Advanced Spam Prevention > Advanced Spam Prevention Settings from the main menu.

   The Advanced Spam Prevention screen displays.

2. Click the Action tab.

3. Select an action for ScanMail to take when it detects undesirable content.

   • Analyzed Category
     • Quarantine message to user’s spam folder
     • Quarantine entire message
     • Delete entire message
     • Tag subject
• Pass
• Probable Category
  • Quarantine message to user’s spam folder
  • Quarantine entire message
  • Delete entire message
  • Tag subject
  • Pass
• Phishing Incident
  • Quarantine message to user’s spam folder
  • Delete entire message
  • Tag and deliver
  • Pass

For details on the available actions, see About ScanMail Actions on page 6-9.

4. Specify whether to send notifications when an action is taken by selecting Notify or Do not notify.

5. Select Send Feedback to Trend Micro Smart Protection Network to send scan results to Trend Micro for analysis.

---

**Note**

To select this option, you must first enable Advanced Spam Prevention feature.

---

6. Configure Advanced Options as necessary.

---

**Note**

For details on advanced scan action options, see Advanced Scan Action Options on page 6-21.
7. Click Save.

---

**Configuring Advanced Spam Prevention Scan Notifications**

**Procedure**

1. Click Advanced Spam Prevention > Advanced Spam Prevention Settings from the main menu.

   The Advanced Spam Prevention screen displays.

2. Click the Action tab, and select Notify under Analyzed Category or Probably Category for which you want to receive notifications.

3. Click the Notification tab.

4. Click the check boxes corresponding to the people ScanMail will notify.

5. Click Show details to customize the notification for that recipient.

6. Select from the notification options.

   Refer to Notification Settings on page 6-24 for details.

7. Click Write to Windows event log to have ScanMail write the notification to a Windows event log.

8. Click Save.

---

**Configuring Writing Style Training Settings**

The writing style verification for high-profile users requires ScanMail to analyze and learn the specific pattern for each user. You must train ScanMail before using the writing style verification feature.
Performing Writing Style Manual Training

Procedure

1. Click Advanced Spam Prevention > Writing Style Training Settings from the main menu.

   The Writing Style Training Settings screen appears.


   ScanMail starts analyzing email messages of the configured users for their writing style, and displays the progress on the screen.

   To configure target users, refer to the topic Configuring Advanced Spam Prevention Scan Targets on page 12-3.

   If you want to stop the process before it completes, click Stop Training.

Configuring Writing Style Regular Training Settings

The writing style of users may change over time. Therefore, it is important to keep updating the user writing style model on regular basis.

Procedure

1. Click Advanced Spam Prevention > Writing Style Training Settings from the main menu.

   The Writing Style Training Settings screen appears.

2. Under Regular Training section, select Enable Regular Training on this server, and then select the schedule as desired.
To configure target users, refer to the topic Configuring Advanced Spam Prevention Scan Targets on page 12-3.

3. Click Save.

ScanMail will analyze the writing style of the configured users according to the configured schedule.

Configuring Writing Style Verification Settings

Enabling Writing Style Verification

Important

Before configuring Writing Style Verification Settings, you must first enable Advanced Spam Prevention and Business Email Compromise settings on Advanced Spam Prevention Settings screen.

Procedure

1. Click Advanced Spam Prevention > Writing Style Verification Settings from the main menu.

The Writing Style Verification Settings screen appears.

2. Select Enable Writing Style Verification Settings from the Writing Style Verification Settings screen.

3. Click Save.
Configuring Writing Style Verification Settings

Procedure

1. Click Advanced Spam Prevention > Writing Style Verification Settings from the main menu.

   The Writing Style Verification Settings screen appears.

2. Under Notification Settings section, configure the following notifications:
   
   • Notify supposed sender: Click Show details, and then configure the settings for the account to use to send notification message to the expected sender.
   
   • Add disclaimer for email message recipients: Click Show details, and then configure the disclaimer message to display at the top of every suspicious email message that is received from an external domain.
   
   • Notify security/IT group: Click Show details, and then configure the email addresses of security/IT group members that ScanMail will notify if it detects a suspicious email message.

3. Under Approved Senders section, configure the email addresses of external domains that you want ScanMail to skip from scanning for writing style verification.

   Important

   Observe special caution in configuring Approved Senders. Since ScanMail skips scanning messages from approved senders, make sure that the email addresses you configure in this section are secure, and really belong to the expected persons.
Chapter 13

Configuring Web Reputation

This chapter explains how to configure Web Reputation Services to protect your Exchange environment.

Topics include:

• About Web Reputation Services on page 13-2
• Configuring the Web Reputation Scan Service on page 13-3
• Enabling Web Reputation on page 13-4
• Configuring Web Reputation Targets on page 13-4
• Configuring Web Reputation Actions on page 13-5
• Configuring Web Reputation Notifications on page 13-6
About Web Reputation Services

Web Reputation Services tracks the credibility of web domains by assigning a reputation score based on factors such as a website's age, historical location changes, and indications of suspicious activities discovered through malware behavior analysis. It will then continue to scan sites and block users from accessing infected ones.

In order to protect your company from possible suspicious websites, you must configure the web reputation source, target, actions, and notifications.

Command & Control Contact Alert Services

Trend Micro Command & Control (C&C) Contact Alert Services provides enhanced detection and alert capabilities to mitigate the damage caused by advanced persistent threats and targeted attacks. C&C Contact Alert Services are integrated with Web Reputation Services which determines the action taken on detected callback addresses based on the web reputation security level.

For details on configuring the Web Reputation Services security level, see Configuring Web Reputation Targets on page 13-4.

<table>
<thead>
<tr>
<th>FEATURE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Intelligence list</td>
<td>Trend Micro Smart Protection Network compiles the Global Intelligence list from sources all over the world and tests and evaluates the risk level of each C&amp;C callback address. Web Reputation Services uses the Global Intelligence list in conjunction with the reputation scores for malicious websites to provide enhanced security against advanced threats. The web reputation security level determines the action taken on malicious websites or C&amp;C servers based on assigned risk levels.</td>
</tr>
<tr>
<td>Virtual Analyzer list</td>
<td>ScanMail retrieves the list from Virtual Analyzer and can evaluate all possible C&amp;C threats against both the Global Intelligence and the local Virtual Analyzer list. For details on connecting the integrated Smart Protection Server to Deep Discovery Advisor, see the Smart Protection Server Administrator's Guide.</td>
</tr>
</tbody>
</table>
Configuring Web Reputation

### Feature Description

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C&amp;C categories</td>
<td>Web Reputation Services logs display information regarding the category of detected threats. C&amp;C Contact Alert Services uses the following categories:</td>
</tr>
<tr>
<td></td>
<td>• <strong>C&amp;C Server</strong>: Servers/Repositories that harbor command-and-control (C&amp;C) servers and dropzones in the C&amp;C Global Intelligence list</td>
</tr>
<tr>
<td></td>
<td>• <strong>Malicious Domain</strong>: Domains that host malicious payloads; such domains cannot be reclassified</td>
</tr>
<tr>
<td></td>
<td>• <strong>New Domain</strong>: Newly-detected domains (for example, throwaway domains); domains that have not been classified by Trend Micro</td>
</tr>
<tr>
<td></td>
<td>• <strong>C&amp;C Server (Virtual Analyzer)</strong>: Servers/Repositories in the C&amp;C Deep Discovery Analyzer server list</td>
</tr>
</tbody>
</table>

### Configuring the Web Reputation Scan Service

ScanMail provides two server options for web reputation queries: the Smart Protection Network and Smart Protection Servers.

For a more information on Smart Protection Network and Smart Protection Servers, see *Smart Protection Sources on page 5-4*.

---

**Procedure**

1. On the left navigation pane, click **Smart Protection > Scan Service Settings**.

   The **Scan Service Settings** screen appears.

2. Under Web Reputation Services, select:

   a. **Smart Protection Network**: Sends all web reputation queries to Trend Micro servers for verification.

   b. **Smart Protection Server**: Verifies all web reputation queries locally. If the local server cannot verify the queries, the server sends them to Trend Micro servers for further analyses.
3. To configure your Local Sources settings, click the related link and refer to 
   *Configuring Local Sources on page 5-7.*

4. Click **Save**.

---

**Enabling Web Reputation**

**Procedure**

1. Click **Web Reputation** from the main menu.
   
   The **Web Reputation** screen displays.

2. Select **Enable Web Reputation**.

3. Click **Save**.

---

**Configuring Web Reputation Targets**

**Procedure**

1. Click **Web Reputation** from the main menu.
   
   The **Web Reputation** screen displays.

2. Click the **Target** tab.

3. Select one of the following security levels:
   
   • **High**: Blocks a greater number of web threats but increases the risk of false positives.
   
   • **Medium**: Blocks most web threats while keeping the false positive count low.
   
   • **Low**: Blocks fewer web threats but reduces the risk of false positives.

4. Select **Scan the content of message attachments for suspicious URLs** to include web reputation scanning within the attachments of email messages.
5. Select **Enable URL Analysis** to configure URL analysis on the Virtual Analyzer screen.

6. Select **Bypass internal domain URLs** to skip scanning URLs generated from your internal organizational server.

7. Select **Enable approved URL list** to avoid scanning URLs deemed safe under your security policy.

8. Add approved URLs to the list.

9. Add addresses to the list of **Approved Senders**.

10. Click **Save**.

### Configuring Web Reputation Actions

**Procedure**

1. Click **Web Reputation** from the main menu.

   The **Web Reputation** screen displays.

2. Click the **Action** tab.

3. Select an action for ScanMail to take when it detects undesirable content.

   • **Quarantine message to user's spam folder**

   **Note**

   The **Quarantine message to user's spam folder** action only quarantines spam folder email messages from external networks when integrating with Outlook Junk E-mail. ScanMail adds the tag “Suspicious URL” to internal email messages and delivers the messages to the user's inbox.

   • **Quarantine entire message**

   • **Delete entire message**
• Tag and deliver
• Pass

For details on the available actions, see About ScanMail Actions on page 6-9.

4. Select Take action on URLs that have not been assessed by Trend Micro Web Reputation Service to treat URLs that have not been classified as suspicious URLs and perform the specified action.

Note
If the URL Analysis option in ScanMail is enabled, this option will not be available or will be disabled.

5. Specify whether to send notifications when an action is taken by selecting Notify or Do not notify.

6. Configure Advanced Options as necessary.

Note
For details on advanced scan actions, see Advanced Scan Action Options on page 6-21.

7. Click Save.

Configuring Web Reputation Notifications

Procedure
1. Click Web Reputation from the main menu.

The Web Reputation screen displays.

2. Click the Notification tab.

3. Click the check boxes corresponding to the people ScanMail will notify.

4. Click Show details to customize the notification for that recipient.
5. Select from the notification options.

Refer to Notification Settings on page 6-24 for details.

6. Click **Write to Windows event log** to have ScanMail write the notification to a Windows event log.
Chapter 14

Configuring URL Time-of-Click Protection

This chapter explains how to configure URL Time-of-Click Protection feature to protect your Exchange environment.

Topics include:

• About URL Time-of-Click Protection on page 14-2
• Enabling URL Time-of-Click Protection on page 14-2
• Configuring URL Time-of-Click Protection on page 14-2
About URL Time-of-Click Protection

ScanMail for Microsoft Exchange provides Time-of-Click protection against malicious URLs in email messages. When this feature is enabled, ScanMail for Microsoft Exchange rewrites suspicious URLs in email messages for further analysis. Trend Micro Smart Protection Network (SPN) analyzes a rewritten URL every time the URL is clicked and applies specified actions based on the risk levels of the URLs.

Enabling URL Time-of-Click Protection

Procedure

1. Click URL Time-of-Click Protection from the main menu.
   The URL Time-of-Click Protection screen appears.

2. Select Enable URL Time-of-Click Protection for incoming mail from the URL Time-of-Click Protection screen.

Configuring URL Time-of-Click Protection

Enable Time-of-Click Protection and specify actions for each URL rating on the Time-of-Click Protection screen.

Procedure

1. Click URL Time-of-Click Protection from the main menu.

2. Select Enable Time-of-Click Protection for incoming mail to activate this feature.

3. Select a URL rewrite settings.
   - Apply to Trend Micro recommended URLs (default): If you select this option, ScanMail for Microsoft Exchange will only rewrite unrated/malicious
URLs that are rated by Trend Micro Web Reputation Service in the email message body.

- **Apply to all URLs**: If you select this option, ScanMail for Microsoft Exchange will rewrite all URLs in the email message body.

**Important**

The setting *Bypass digitally signed email message* is enabled by default. This means, the URL Time-of-Click Protection will NOT rewrite any messages that are signed using digital signature. If this setting is disable, the URLs in a digitally signed message can be damaged.

4. Specify an action for each URL rating.

<table>
<thead>
<tr>
<th>FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
</table>
| Dangerous     | Select an action *(Allow, Warn, or Block)* to take on dangerous URLs. The default action is **Block**.  
Dangerous URLs are verified to be fraudulent or known sources of threats. |
| Highly Suspicious | Select an action *(Allow, Warn, or Block)* to take on highly suspicious URLs. The default action is **Block**.  
Highly Suspicious URLs are suspected to be fraudulent or possible sources of threats. |
| Suspicious    | Select an action *(Allow, Warn, or Block)* to take on suspicious URLs. The default action is **Warn**.  
Suspicious URLs are associated with spam or possibly compromised. |
| Untested      | Select an action *(Allow, Warn, or Block)* to take on untested URLs. The default action is **Warn**.  
While Trend Micro actively tests URLs for safety, users may encounter untested pages when visiting new or less popular web sites. Blocking access to untested pages can improve safety but can also prevent access to safe pages. |

5. Under **Message Target Recipients** section, select from one of the following options for **Analyze messages sent to**:
• **Anyone:**
  
  • Select this option to analyze messages sent to anyone.

• **Specif accounts:**
  
  • Select this option, then click **Show details**, and then search and specify accounts to analyze messages sent to these accounts.

6. Under **Approved URL List**, select **Bypass internal domain URLs**, if you want to bypass the network internal domains. Click the following link to see or update the **Internal Domains** list.

---

**Note**

*Bypass internal domain URLs* option is selected by default.

7. If you want **URL Time-of-Click Protection** to skip certain URLs in email messages from scanning, add these URLs in the **Approved URL List**.

8. If you want ScanMail for Microsoft Exchange to exclude email messages that are sent from certain addresses or domain names from scanning, add such addresses or domains to the **Approved Senders** list.

9. Click **Save**.
Configuring Search & Destroy

This chapter explains how to configure Search and Destroy to protect your Exchange environment.

Topics include:

• About Search & Destroy on page 15-2
• Configuring Search & Destroy Access Accounts on page 15-2
• Activating Search & Destroy on page 15-4
• About Mailbox Searches on page 15-6
• Configuring a Mailbox Search on page 15-13
• Configuring Search & Destroy Settings on page 15-20
• Viewing Search & Destroy Event Logs on page 15-21
• Troubleshooting Search & Destroy on page 15-22
About Search & Destroy

Search & Destroy provides administrators the ability to search and remove mailbox components (for example, email messages, meetings, tasks) from Exchange mailbox servers. Administrators can specify detailed search criteria to focus searches on specific keyword matching, users, mailboxes, and component creation dates.

ScanMail provides administrators with Access Control roles specific to Search & Destroy. Only users assigned to one of the following roles can access Search & Destroy:

- **Search & Destroy Administrator**: Can search for, monitor, and delete undesirable content from both a user's mailbox and the Exchange server
- **Search & Destroy Operator**: Can search for and monitor undesirable content in both a user's mailbox and the Exchange server

---

**Note**

By default, ScanMail does not assign any users, including the Administrator, to the Search & Destroy administrator role. Administrators must assign users access to Search & Destroy manually. For details, see *Configuring Search & Destroy Access Accounts on page 15-2*.

Search & Destroy employs an Exchange service account that performs keyword-matching searches on mailbox components based on administrator-configured search criteria and stores copies of the matches in an Exchange discovery mailbox. Administrators can review the component matches to determine if the content is undesirable. ScanMail can then delete the undesirable search results from the discovery mailbox and the mailbox of the offending user.

Configuring Search & Destroy Access Accounts

Search & Destroy requires administrators to configure two access accounts before use: an Active Directory service account and the Search & Destroy Administrator for ScanMail.
Create the Active Directory service account and add the account to the Exchange Discovery Management group. ScanMail uses this service account to perform the backend mailbox searches.

The Search & Destroy Administrator in ScanMail is a specialized account that permits users to access all Search & Destroy features. Search & Destroy is not visible to any user (Administrator or Operator) if the user is not also a Search & Destroy administrator.

**Note**

The Search & Destroy feature only provides support for mailbox servers running Exchange 2013, Exchange 2016, or Exchange 2019.

The Search & Destroy Operator role can only configure mailbox searches and view results.

**Procedure**

1. Go to **Administration > Access Control**.
2. Click the Search & Destroy role to configure.
3. Optionally, modify the Search & Destroy description.
4. Search for users or groups to add to the Search & Destroy role.
5. In the Available Account(s) list, select the accounts to add to the role and click **Add >**.
6. Click **Save**.
   
   The **Access Control** screen appears.
7. To the right of the **Search & Destroy** role, click the Status icon to enable the role.
   
   The icon changes from a red x to a green check.
8. Click **Save**.
9. Log off from the ScanMail console and log on using an account with a Search & Destroy role to use the feature.
The Search & Destroy menu items appear in the left navigation menu. For users with multiple roles, the Search & Destroy menu items integrate with the existing menu.

### Activating Search & Destroy

Before using Search & Destroy for the first time, administrators must specify the Active Directory service account and the discovery mailbox that stores the search results.

- **Note**
  - The activation process only appears when accessing the Search & Destroy feature for the first time.
  - The Search & Destroy feature only provides support for mailbox servers running Exchange 2013, Exchange 2016, or Exchange 2019.

#### Procedure

1. Click **Search & Destroy > Mailbox Search** or **Search & Destroy > Settings**. The **Search & Destroy Activation** wizard appears.

2. Click **Next >**. The **Exchange Server Prerequisite Configurations** screen appears.

3. Read the prerequisite items carefully. Configure the prerequisite Exchange environment settings before proceeding.

   For details on configuring the Exchange environment settings, see *Search & Destroy Prerequisites on page B-11*.

4. After configuring all necessary settings, select **All Exchange Server prerequisite settings have been properly configured**.

5. Click **Next >**. The service account logon credentials screen appears.
6. Type the **User name** for the previously configured service account.

   **Note**
   The format for the service account is as follows:
   
   domain\user name

7. Type the **Password** for the service account.

8. Click **Next >**.
   
   The discovery mailbox selection screen appears.

9. Select a discovery mailbox that stores the Search & Destroy search results from the **Available Discovery Mailbox(es)** list.

10. Click **Next >**.
   
   The generate PST search results screen appears.

11. Select the **Allow Search & Destroy users to generate a .pst file containing all search results** option to configure ScanMail to create the `<ScanMail installation path>`\SmexSDPst folder and share the folder with the Exchange Trusted Subsystem.

   **Note**
   Ensure that the account is a member of the Exchange Mailbox Import Export role.

12. Click **Next >**.
   
   The Search & Destroy activation details screen appears.

   **Note**
   If the service account or discovery mailbox provided are invalid, the activation process cannot proceed. For possible reasons why Search & Destroy activation was unsuccessful, see *Troubleshooting Search & Destroy on page 15-22*.

13. Review the Search & Destroy settings and click **Finish**.
About Mailbox Searches

A mailbox search discovers email messages, mailbox components (for example, meetings or contacts), and specialized items in the Exchange environment, that contain specified keywords.

The following table lists the Search & Destroy mailbox search types.

**TABLE 15-1. Mailbox Search Types**

<table>
<thead>
<tr>
<th>TYPE</th>
<th>DESCRIPTION</th>
<th>Tip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Estimate Matches</td>
<td>ScanMail searches the Exchange environment and returns an estimated count and an estimated size of the mailbox components that matched the search criteria. ScanMail does not copy the matched items to the discovery mailbox.</td>
<td>Tip: Trend Micro recommends performing an estimated search before performing <strong>Search Now</strong> or <strong>Search Later</strong>. Copying large amounts of data to the discovery mailbox requires more system resources and could result in reduced performance.</td>
</tr>
<tr>
<td>Search Now</td>
<td>ScanMail searches the Exchange environment and copies the mailbox components that match the search criteria to the specified discovery mailbox.</td>
<td></td>
</tr>
<tr>
<td>Search Later</td>
<td>Administrators can schedule mailbox searches to run at specific times to reduce the system resource usage at peak traffic times.</td>
<td></td>
</tr>
</tbody>
</table>

Syntax Used for Keyword Strings

Administrators can specify the keywords to locate using several different methods. Properly formatted keyword search strings reduce the number of matches and make
searches more efficient and productive. ScanMail allows administrators to use logical operators, wildcards, and Advanced Query Syntax (AQS) or Keyword Query Language (KQL) to narrow the scope of keyword searches.

**Table 15-2. Keyword Syntax**

<table>
<thead>
<tr>
<th>Type of Syntax</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
</table>
| Logical operators | Use uppercase logical operators (AND, OR, NOT) to separate multiple keywords. | • administrator AND password  
Matches mailbox components that contain both the words “administrator” and “password”  
• administrator OR salary  
Matches mailbox components that contain either the word “administrator” or “salary”  
• administrator AND NOT payroll  
Matches mailbox components that contain the word “administrator” and do not contain the word “payroll” |
| Parentheses | Use parentheses () to group keywords in specific patterns. | • (administrator OR password) AND NOT salary  
Matches mailbox components that contain either the word “administrator” or “password” and do not contain the word “salary”  
• (administrator AND NOT password) OR salary  
Matches mailbox components that contain the word “administrator” and do not contain the word “password”, or mailbox components that contain the word “salary” |
<table>
<thead>
<tr>
<th><strong>TYPE OF SYNTAX</strong></th>
<th><strong>DESCRIPTION</strong></th>
<th><strong>EXAMPLES</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Double quotation marks</td>
<td>Use double quotation marks (&quot;&quot;’) to search for phrases.</td>
<td>• “administrator salary”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Matches mailbox components that contain the phrase “administrator salary”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “administrator salary” AND “year ending”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Matches mailbox components that contain both the phrases “administrator salary” and “year ending”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• (“administrator salary” OR payroll) AND “year ending”)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Matches mailbox components that contain the phrase “administrator salary” or the word “payroll”, and also contain the phrase “year ending”</td>
</tr>
<tr>
<td>Wildcard (asterisk)</td>
<td>Use an asterisk (*) as a wildcard operator to search for a range of keywords starting with a specific string.</td>
<td>• admin*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Matches mailbox components containing words beginning with “admin”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Examples: admin, administrator, administration, administrative</td>
</tr>
</tbody>
</table>

**Note**
ScanMail only supports the use of wildcard symbols at the end of a string.
Configuring Search & Destroy

<table>
<thead>
<tr>
<th>TYPE OF SYNTAX</th>
<th>DESCRIPTION</th>
<th>EXAMPLES</th>
</tr>
</thead>
</table>

Mailbox Search Options

ScanMail provides multiple search options to narrow the scope of mailbox searches. Properly configured mailbox searches reduce the usage of system resources and return only relevant search results.

**Tip**

Trend Micro recommends performing an estimated search before performing **Search Now** or **Search Later**. Copying large amounts of data to the discovery mailbox requires more system resources and could result in reduced performance.

Configure the following search options to streamline mailbox search matching.
### TABLE 15-3. Mailbox Search Options

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keywords</td>
<td>ScanMail searches for the keywords or phrases that the administrator specifies. Use logical operators, parentheses, double quotation marks, wildcards, or KQL expressions (for Exchange 2013, Exchange 2016 and Exchange 2019) to narrow the search parameters. For details on searching for keywords, see Syntax Used for Keyword Strings on page 15-6.</td>
</tr>
</tbody>
</table>

**Note**

The maximum allowable character length of the **Keywords** field is 8192.
### Configuring Search & Destroy

<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Mailboxes</td>
<td>Administrators may choose to search all mailboxes in the Exchange environment or choose specific users or distribution groups.</td>
</tr>
</tbody>
</table>

**Note**

Trend Micro recommends performing mailbox searches on a limited number of users or distribution groups. Copying large amounts of data to the discovery mailbox requires more system resources and could result in reduced performance.

To select **Specific user or distribution group members' mailboxes**:

1. Type a search string in the text box to find the available users, distribution groups, or databases and click **Search**.
2. Select the accounts or databases to search in the available list and click **Add >>**.

Alternatively, administrators can import pre-existing lists from properly formatted `.txt` files.

**Note**

The maximum allowable number of email addresses to search is 500. When importing a file, ScanMail only adds addresses to the **Selected Mailbox(es)** list until the list contains 500 addresses.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mailbox Components</td>
<td>ScanMail can search all mailbox components in the Exchange environment or administrators may choose to scan only specific components. When choosing specific components, the following options are available:</td>
</tr>
</tbody>
</table>
|                             | • Email  
|                             | • Meetings  
|                             | • Journal  
|                             | • Tasks  
|                             | • Contacts  
|                             | • Notes  
|                             | • Instant messaging conversations                                                                                                                                                                                                                                                                                                     |
|                             | **Note**  
|                             | When selecting **All mailbox components (including components not listed below)**, ScanMail includes results found in any component that exists in the Exchange mailbox.                                                                                                                                                              |
| Specific Senders or Recipients | ScanMail searches email messages addressed to the specified recipients or from the specified senders.                                                                                                                                                                                                                                    |
|                             | **Note**  
|                             | ScanMail can search specific senders and recipients using display names, email addresses, or domain names.                                                                                                                                                                                                                       |
| Date                        | Administrators may choose to search all components in the Exchange environment or only those components created within a specified date range.                                                                                                                                                                                            |
| Discovery Mailbox           | Administrators may choose to use a specific discovery mailbox for the search or accept the previously configured default Search & Destroy discovery mailbox.                                                                                                                                                                                     |
Configuring Search & Destroy

<table>
<thead>
<tr>
<th>OPTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>ScanMail provides two search actions:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Search and compile</strong>: All matched results are compiled for review (recommended)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Search and delete</strong>: All matched results are automatically deleted (not recommended)</td>
</tr>
</tbody>
</table>

**Note**
Trend Micro only recommends automatically deleting messages in high security environments.

**Configuring a Mailbox Search**

**Procedure**

1. Go to **Search & Destroy > Mailbox Search**.

   The **Mailbox Search** screen appears.

2. Click **New**.

   The **New Mailbox Search** screen appears.

3. Type a **Name** for the mailbox search.

4. Specify the **Keywords** for ScanMail to locate.

   For details on searching for keywords, see *Syntax Used for Keyword Strings on page 15-6*.

   **Note**
   The maximum allowable character length of the **Keywords** field is 8192.

5. Specify the **Mailboxes** to search.
Tip
Trend Micro recommends selecting specific mailboxes for each mailbox search. Selecting to Search all mailboxes requires more system resources and could result in reduced performance.

6. Optionally configure the following additional search options:

- Mailbox Components
- Specific Senders or Recipients
- Date
- Discovery Mailbox
- Action

For details on the search criteria, see Mailbox Search Options on page 15-9.

7. Click one of the following buttons:

- Estimate Matches: Starts searching for the specified criteria. ScanMail returns an estimated count and an estimated size of the mailbox components that matched the search criteria.

Tip
Trend Micro recommends performing an estimated search before performing Search Now or Search Later. Copying large amounts of data to the discovery mailbox requires more system resources and could result in reduced performance.

- Search Now: Starts searching for the specified criteria. ScanMail copies the mailbox components that match the search criteria to the specified discovery mailbox.

- Search Later

The Mailbox Search Schedule screen appears.

a. Select the Time zone for the search to use.
b. Specify the **Date and time** of the search.

c. Click **OK** to schedule the search.

- **Save**: Saves the search criteria options without searching the Exchange environment.
- **Cancel**: Discards all changes.

**Note**

A mailbox search may take some time to complete. Administrators can continue using ScanMail and navigate away from the Search & Destroy feature without interrupting the search.

After initiating or saving a mailbox search, the search appears in the table on the **Mailbox Search** screen.

---

### Modifying a Mailbox Search

ScanMail allows administrators to modify the search criteria for a mailbox search even after the search completes. If a search returns a large number of results, administrators may want to narrow the scope of the search to obtain more accurate results.

**WARNING!**

Modifying the search criteria of a search that has already completed automatically deletes any of the original search results stored in the Exchange discovery mailbox and the ScanMail database.

---

**Procedure**

1. Click **Search & Destroy > Mailbox Search**.

2. Click the **Name** of the search to modify.

The **View Mailbox Search** screen appears.
3. Select **Allow changes to the search options**.

   ScanMail unlocks all of the search criteria fields for editing.

4. Modify the necessary settings.

   For details on refining keyword strings, see *Syntax Used for Keyword Strings on page 15-6*. For details on search criteria options, see *Mailbox Search Options on page 15-9*.

5. Click one of the following buttons:

   - **Estimate Matches**: Starts searching for the specified criteria. ScanMail returns an estimated count and an estimated size of the mailbox components that matched the search criteria.

     **Tip**
     
     Trend Micro recommends performing an estimated search before performing **Search Now** or **Search Later**. Copying large amounts of data to the discovery mailbox requires more system resources and could result in reduced performance.

   - **Search Now**: Starts searching for the specified criteria. ScanMail copies the mailbox components that match the search criteria to the specified discovery mailbox.

   - **Search Later**

     The Mailbox Search Schedule screen appears.

     a. Select the **Time zone** for the search to use.

     b. Specify the **Date and time** of the search.

     c. Click **OK** to schedule the search.

   - **Save**: Saves the search criteria options without searching the Exchange environment.

   - **Cancel**: Discards all changes.
A mailbox search may take some time to complete. Administrators can continue using ScanMail and navigate away from the Search & Destroy feature without interrupting the search.

After initiating or saving a mailbox search, the search appears in the table on the Mailbox Search screen.

Deleting a Mailbox Search

Administrators can choose to delete a mailbox search from ScanMail only, or delete both the ScanMail results and the results stored in the discovery mailbox.

Note
Deleting a mailbox search does not delete the mailbox components stored in the users’ mailboxes.

Procedure

1. Go to Search & Destroy > Mailbox Search.

   The Mailbox Search screen appears.

2. Select the check box next to the mailbox search to delete.

3. Click the Delete button and select from the following:

   • Delete search only: Deletes only the mailbox search and the search criteria

   • Delete search and discovery mailbox results: Deletes the mailbox search, search criteria, and all related messages stored in the Exchange discovery mailbox
Viewing Mailbox Search Results

After ScanMail completes a mailbox search, administrators can view a detailed list of the messages retrieved.

Procedure

1. Click **Search & Destroy > Mailbox Search**.

   The **Mailbox Search** screen appears.

2. Choose to view a summary of the search operation before the complete list of search results or directly view a complete list of the search results.

   • To view a summary of the search operation first:
   
     a. Click the **Name** of the search.

     b. View the summary information in the **Status** section.

     Consider refining the search criteria if the search produced a large number of matches. For details, see *Modifying a Mailbox Search on page 15-15*.

   c. Click **View Search Results**.

   • To view the search results directly, click the **View** link under the **Search Result** column of the table beside the name of the search.

   The **Mailbox Search Results** screen appears.

3. Administrators have the option to create, copy, and delete PST files containing all search results. The **Search results package (.pst file)** status determines the options available to administrators:

   • **Not generated**: Click the **Generate** button to create the PST package in the `<ScanMail installation path>\SmexSDPst folder`.

   • **Available on server**

     • Click the **Download** button to copy the PST file to a local location.
• Click the **Delete** button to delete the PST file from the `<ScanMail installation path>\SmexSDPst` folder.

**Note**
ScanMail automatically deletes the PST file if the administrator performs the same mailbox search again.

4. Administrators can perform the following tasks on the search results:

• Filter the search results
  a. Select which part of the message to search in by selecting from the **Filter by** drop-down box.
  b. Type the search text in the text box.
  c. Click **Filter**.

**Note**
Click **Show All** to reset the filter criteria.

• **Delete** selected results

• **Delete All** search results

**Note**
When deleting messages, if a message selected for deletion has been moved to another location or already deleted by the end user, ScanMail cannot locate the message and reports a successful deletion.

• Export results to a CSV file

• View details about individual messages by moving the mouse pointer over the **Subject** of the message
Configuring Search & Destroy Settings

Specify the Active Directory service account and the discovery mailbox that stores the search results.

**Note**

Ensure that a properly configured Active Directory service account and discovery mailbox exist in the Exchange organization before changing the Search & Destroy settings.

**Procedure**

1. Click **Search & Destroy > Settings**.
   
The **Search & Destroy Settings** screen appears.

2. Type the **User name** for the service account that performs the backend searches.

   **Note**
   
The format for the service account is as follows:
   
   `domain\user name`

3. Type the **Password** for the service account.

4. Select a discovery mailbox that stores the Search & Destroy search results from the **Available Discovery Mailbox(es)** list.

5. Optionally select the **Allow Search & Destroy users to generate a .pst file containing all search results** option to display the PST generation options on the **Mailbox Search Results** screen.
Note

- ScanMail automatically creates the folder &lt;ScanMail installation path&gt; \SmexSDPst and shares the folder with the Exchange Trusted Subsystem.
- Ensure that the account is a member of the Exchange Mailbox Import Export role
- Create a mailbox for this account (Exchange 2013 only)

6. Click Save.

Viewing Search & Destroy Event Logs

ScanMail records detailed event tracking logs for Search & Destroy. Because Search & Destroy allows administrators to view and delete Exchange components from users’ mailboxes, a comprehensive audit trail of Search & Destroy operations may be useful in case of user misunderstandings.

Procedure

1. Go to Logs &gt; Query.

   The Log Query screen appears.

2. Specify the dates to search.

3. In the Type drop-down, select Event Tracking.

4. Select the user account(s) for ScanMail to locate and click Add.

5. Select Search & Destroy logs beside Log type.

6. From the drop-down beside Search & Destroy logs, select from the following events:

   • All
   • Configuration change
• Operation

• Task status change

7. Optionally, type a description for the logs.

8. Specify the Sort by and Display options.

9. Click Display Logs.

Troubleshooting Search & Destroy

The following table lists possible reasons why Search & Destroy search tasks may be unsuccessful. Because the Exchange server returns the error results, ScanMail cannot predict all reasons.

**TABLE 15-4. Possible Reasons Why Search Actions Are Unsuccessful**

<table>
<thead>
<tr>
<th>ERROR</th>
<th>POSSIBLE REASONS</th>
<th>UNSUCCESSFUL MAILBOX SEARCH ACTION</th>
</tr>
</thead>
</table>
| Search & Destroy service account is invalid | • The service account has expired  
• The password provided is inaccurate  
• The service account is not a member of the Exchange discovery management group | • Estimate Matches/Search  
• Delete (message)  
• Delete task and mail in discovery mailbox  
• Stop Search |
<table>
<thead>
<tr>
<th><strong>Error</strong></th>
<th><strong>Possible Reasons</strong></th>
<th><strong>Unsuccessful Mailbox Search Action</strong></th>
</tr>
</thead>
</table>
| Discovery mailbox         | - The Exchange system discovery mailbox is unreachable                                | • Estimate Matches/Search  
- The selected discovery mailbox is unreachable | • Stop Search  
- Estimate Matches/Search  
- Delete (message)  
- Delete task and mail in discovery mailbox |
| connection error          |                                                                                      |                                                                              |
| End user mailbox          | The end user mailbox is unreachable                                                  | • Estimate Matches/Search  
- The selected discovery mailbox is full | • Delete (message) |
| connection error          |                                                                                      |                                                                              |
| Exchange web service is   | - WinRM error                                                                         | • Estimate Matches/Search  
- CAS server error                                                                  | • Delete (message)  
- Delete task and mail in discovery mailbox | stop Search |
<p>| unavailable               |                                                                                      |                                                                              |
| Parse search result       | - The Exchange discovery management group does not have full access permission to the | • Search                                                                     |
| was unsuccessful          | selected discovery mailbox                                                            |                                                                              |
|                           | - The Exchange web service is unavailable                                            |                                                                              |
|                           | - The discover mailbox is not accessible                                              |                                                                              |</p>
<table>
<thead>
<tr>
<th><strong>ERROR</strong></th>
<th><strong>POSSIBLE REASONS</strong></th>
<th><strong>UNSUCCESSFUL MAILBOX SEARCH ACTION</strong></th>
</tr>
</thead>
</table>
| The current Exchange settings only allow searches of 1 -%N mailboxes. Select a valid number of mailboxes or change the current Exchange settings and try again. | • No mailboxes exist in the selected database  
• The number of mailboxes in the selected database exceeds the maximum limit defined in the Exchange throttling policy | Estimate Matches/Search                                |
Chapter 16

Configuring Virtual Analyzer

This chapter explains how to configure Virtual Analyzer settings to protect your Exchange environment.

Topics include:

• About Virtual Analyzer on page 16-2
• Configuring Virtual Analyzer Settings on page 16-3
About Virtual Analyzer

Virtual Analyzer is a secure virtual environment used to manage and analyze samples submitted by Trend Micro products. Sandbox images allow observation of file and network behavior in a natural setting without any risk of compromising the network. Virtual Analyzer performs static analysis and behavior simulation to identify potentially malicious characteristics. During analysis, Virtual Analyzer rates the characteristics in context and then assigns a risk level to the sample based on the accumulated ratings.

Virtual Analyzer includes the following features:

- Threat execution and evaluation summary
- In-depth tracking of malware actions and system impact
- Network connections initiated
- System file/Registry modification
- System injection behavior detection
- Identification of malicious destinations and command-and-control (C&C) servers
- Exportable forensic reports and PCAP files
- Generation of complete malware intelligence for immediate local protection

ScanMail sends the suspicious attachments, and the executable and scripted files, that are not detected by the scan engine, to Virtual Analyzer for analysis.

ScanMail supports integration with Virtual Analyzer in the following Trend Micro separately-licensed products:

- Deep Discovery Analyzer 5.0
- Deep Discovery Advisor 2.92 or later
Configuring Virtual Analyzer Settings

Before configuring the Virtual Analyzer settings, select the **Enable Advanced Threat Scan Engine** option on the **Security Risk Scan: Target** screen. Advanced Threat Scan Engine performs the aggressive scanning necessary to detect advanced threats.

**Important**
- Virtual Analyzer settings are not configurable until an administrator enables the Advanced Threat Scan Engine.
- Before enabling Virtual Analyzer integration, administrators must enable the Exchange replay folder.

For details on enabling the Exchange replay folder, see *Virtual Analyzer - Integration Pre-requisites on page B-18*.

**WARNING!**
Disabling the Exchange replay folder after enabling the Virtual Analyzer integration may cause unexpected issues. Trend Micro recommends disabling Virtual Analyzer integration before disabling the Exchange replay folder.

**Procedure**

1. Go to **Virtual Analyzer**.
2. Select **Submit email messages to Virtual Analyzer**.
3. Select a working mode for virtual analyzer. **Inline mode** is selected by default.

   See *What are different working modes in Virtual Analyzer and which one should I choose? on page 21-28*.

4. Configure the Virtual Analyzer server settings:
   - Type the **IP address**.

   **Note**
   The IP address supports IPv4 format.
- Type the **Port** number.
- Type the **API key**.

---

**Note**
Contact the Virtual Analyzer administrator to obtain the IP address, port number, and a valid API key.

5. **Select Use a proxy server to connect to Deep Discovery Analyzer Server** if ScanMail requires a proxy for server communication with Virtual Analyzer.
   
   a. Click the expand button (جتماع) to display the proxy settings.
   
   b. Type the server name or IP address of the proxy server and its port number.
   
   c. If your proxy server requires a password, type your user name and password in the fields provided.

6. Click one of the following buttons:
   - **Register**: Establishes the connection to Deep Discovery Analyzer Server
   - **Test Connection**: Verifies the connection settings to Deep Discovery Analyzer Server but does not register ScanMail to the server

---

**Note**
To enable sending messages to Virtual Analyzer, register Virtual Analyzer before saving the connection settings.

7. Select the traffic direction of the messages to analyze.

8. Choose the sender to exclude from analysis by searching and selecting AD Users/Groups/Contacts/Special Groups and adding them to the Selected Account(s) list.

9. Choose the recipients of the messages to analyze by searching and selecting AD Users/Groups/Contacts/Special Groups and adding them to the Selected Account(s) list.

10. Select the attachment types to analyze.
Tip

As application and executable files pose the greatest threats in respect to advanced threats, Trend Micro recommends only selecting to analyze these file types.

Note

By default, ScanMail sends highly recommendable file types to Virtual Analyzer for further scan. You can also select specific file types for scanning.

11. Select Enable Aggressive Mode for Advanced Spam, if you want to detect more potential threats by analyzing suspicious messages.

12. Do the following:

   a. Click Validate Virtual Analyzer Server Version to verify if the current virtual analyzer supports URL analysis. Once the verification process completes, navigate back to the previous screen.

   b. Select Enable URL Analysis.

Note

This option will not be enabled if the verification process is unsuccessful.

13. Configure the Security Level settings for the messages and files that Virtual Analyzer analyzes.

   • Security level: The security level determines whether ScanMail performs an action on messages and files analyzed and rated by Virtual Analyzer. The available security level settings are: High, Medium, or Low.

Note

For messages and files with a rating that violates the configured security level, ScanMail performs the action configured for Advanced threats on the Security Risk Scan Actions tab (Security Risk Scan > Action). For more information, see Configuring Security Risk Scan Actions on page 7-9.
• **Maximum wait time for analysis ratings**: Select the maximum amount of time to temporarily quarantine messages while Virtual Analyzer analyzes the risk of the message.

• **Action on unanalyzed risks**: Select the action that ScanMail performs on messages for which Virtual Analyzer did not return a rating within the configured wait time.
Part III

Managing ScanMail
Chapter 17

Managing the Quarantine Area

This chapter describes how to manage the quarantine area. Quarantine is one of the actions that ScanMail can take when messages matches certain rules.

Topics include:

• About the Quarantine on page 17-2
• Configuring the Quarantine Folder/Directory on page 17-2
• Performing a Quarantine Query on page 17-3
• SchedulingAutomatic Quarantine Maintenance on page 17-4
• Manually Performing Quarantine Maintenance on page 17-5
• Resending Quarantined Messages on page 17-5
About the Quarantine

ScanMail uses Quarantine to move infected messages to a quarantine directory, replace the infected files, and deliver the remaining messages to the original recipient.

You can configure ScanMail to quarantine or back up email messages when it detects content filtering violations. You can set the quarantine or backup folder for each content filtering rule individually from the Select an action screen, or you can specify a global directory.

Configuring the Quarantine Folder/Directory

When you specify a global quarantine or backup directory, ScanMail moves all files that it quarantines or performs backup on as a result of content rule violations to the directory that you specify.

Specify the quarantine directory separately for each scan filter.

**TABLE 17-1. Quarantine Directory Scan Filter Reference**

<table>
<thead>
<tr>
<th>Scan Filter</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Risk Scan</td>
<td><strong>Configuring Security Risk Scan Actions on page 7-9</strong></td>
</tr>
<tr>
<td>Attachment Blocking</td>
<td><strong>Configuring Attachment Blocking Actions on page 8-5</strong></td>
</tr>
<tr>
<td>Content Filtering</td>
<td>• For policy-specific directories:</td>
</tr>
<tr>
<td></td>
<td><strong>Configuring Content Filtering Actions on page 9-10</strong></td>
</tr>
<tr>
<td></td>
<td>• For global directories:</td>
</tr>
<tr>
<td></td>
<td><strong>Global Settings on page 9-4</strong></td>
</tr>
<tr>
<td>Data Loss Prevention</td>
<td>• For policy-specific directories:</td>
</tr>
<tr>
<td></td>
<td><strong>Configuring DLP Actions on page 10-23</strong></td>
</tr>
<tr>
<td></td>
<td>• For global directories:</td>
</tr>
<tr>
<td></td>
<td><strong>Global Settings on page 10-18</strong></td>
</tr>
</tbody>
</table>
### Performing a Quarantine Query

You can perform a query on quarantined messages before deciding on the action to be taken. After viewing the message details, you can choose to release or delete the quarantined messages.

#### Procedure

1. Click **Quarantine > Query**.
   
   The **Quarantine Query** screen displays.

2. Select the date range.

3. Select **All reasons** or **Specified reasons**:
   - Security risk scan
   - Attachment blocking
   - Content filtering
   - Data Loss Prevention
   - Unscannable message parts
   - Web Reputation
   - Advanced Spam Prevention

4. Select the resend status.
   - Never been resent

<table>
<thead>
<tr>
<th><strong>Scan Filter</strong></th>
<th><strong>Reference</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Spam Prevention</td>
<td><a href="#">Configuring Advanced Spam Prevention Scan Actions on page 12-4</a></td>
</tr>
<tr>
<td>Web Reputation</td>
<td><a href="#">Configuring Web Reputation Actions on page 13-5</a></td>
</tr>
</tbody>
</table>
Resent at least once

Any status

5. (Optional) Specify the sender, recipient, and/or subject of the message.

6. Specify the option for Sort by.

7. Specify the number of items to display per page.

8. Select the Query targets for the query.
   - Local server
   - Remote server(s)
     a. Select the Server group from the drop-down.
     b. Click the server name in the Available Server(s) list and click Add >> to include the server(s) to the Selected Server(s) list.

9. Click Search.

Scheduling Automatic Quarantine Maintenance

Configure scheduled deletion of quarantined messages or manually delete quarantined messages from the Quarantine Maintenance screen.

Procedure

1. Click Quarantine > Maintenance.
   The Quarantine Maintenance screen displays.

2. Click the Automatic tab.

3. Select Enable automatic maintenance to delete logs automatically.

4. Select the files to delete:
   - All quarantined files: Select to delete all quarantined files.
Managing the Quarantine Area

- **Quarantined files that have never been resent**: Select to delete quarantined files that have never been resent.
- **Quarantined files that have been resent at least once**: Select to delete quarantined files that have been resent at least once.

5. Specify the number of days to keep files before deleting.
6. Click Save.

Manually Performing Quarantine Maintenance

Procedure

1. Click **Quarantine > Maintenance**.
   - The **Quarantine Maintenance** screen displays.
2. Click the **Manual** tab.
3. Select the files to delete:
   - **All quarantined files**: Select to delete all quarantined files.
   - **Quarantined files that have never been resent**: Select to delete quarantined files that have never been resent.
   - **Quarantined files that have been resent at least once**: Select to delete quarantined files that have been resent at least once.
4. Specify the number of days to keep files before deleting.
5. Click **Delete Now**.

Resending Quarantined Messages

You can resend messages that you consider to be safe to the original recipient. When you resend messages, the entire email message or the message part is resent.
Procedure

1. Click **Quarantine > Query**.

   The Quarantine Query screen displays.

2. Set up and run a query for the kind of message you want to resend.

   The query runs and displays the results at the bottom of the screen.

3. Select the email messages that you want to resend from the results of your query.

4. Do one of the following:
   - Click **Resend as new message** to send the quarantined email message as an attachment in the notification email.
   - Click **Resend original message** to send the quarantined email message within the email message body, and then confirm on the pop-up message that appears.

   The **Quarantine > Resend** screen opens displaying resending options.

5. Click **Add original recipients** to have ScanMail send the email message to the original recipient.

6. Type an email address in the forward field. ScanMail will send the quarantined email message to the person at this email address in addition to, or instead of, the original recipient.

   **Note**
   Type the recipient's email address in the **Fw** field for ScanMail with Exchange Server 2019, 2016, and 2013 Edge Transport server role.

7. Append the original email message:
   a. Click **Append the original email subject**.
      
      This has ScanMail include the message that appears in the subject line when it resends the email message.
   b. Type a new subject for the resent email in the **Subject** field or do nothing to accept the default.
The default subject line cautions the recipient about opening a resent email message.

8. Type a message in the **Body** field for ScanMail to use as the body of your resent email message.

9. Click **Delete all related quarantined files after resending** to have ScanMail delete the original quarantined message after it is resent.

   By default, ScanMail keeps email messages when they are resent (the check box is clear).

10. Click **Resend Now**.

    ScanMail sends the email message immediately. A progress bar appears to show you the progress of the resend process.

11. When the Resend process is complete, click **OK** to return to the **Quarantine Query** screen.

---

**Note**

Automatically deleting messages after resending deletes the quarantine record in the database.
Chapter 18

Monitoring ScanMail

This chapter describes notifications, reports, and logs to help you monitor your network.

Topics include:

- Viewing the Summary Screen on page 18-2
- About Alerts on page 18-6
- About Reports on page 18-12
- About Logs on page 18-15
Viewing the Summary Screen

The **Summary** screen provides a simple and current report on the ScanMail system and functions. Monitor the current status of the different features and the number of security threats ScanMail has detected. To see more detailed information, generate reports from the **Reports** menu.

**Summary: System**

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scan Summary: Scan Status at a Glance</strong></td>
<td>Quick glance the scan status of Mail Scanned, Attachments Scanned, Security Risks, Suspicious URLs - Web reputation, Data Loss Prevention Incidents and Business Email Compromise.</td>
</tr>
<tr>
<td><strong>Scan Summary: Scan Type</strong></td>
<td>The number of virus/malware detections is not the number of unique viruses/malware. The number of virus/malware detections is the number of times ScanMail detects a virus/malware.</td>
</tr>
<tr>
<td>Detected viruses/malware</td>
<td>View the number of detected viruses/malware that could not be cleaned.</td>
</tr>
<tr>
<td>Uncleanable viruses/malware</td>
<td>View the number of detected spyware/grayware.</td>
</tr>
<tr>
<td>Detected spyware/grayware</td>
<td>View the number of detected advanced threats.</td>
</tr>
<tr>
<td>Detected advanced threats</td>
<td>View the number of detected advanced threats.</td>
</tr>
<tr>
<td>Blocked attachments</td>
<td>View the number of attachments blocked by the attachment blocking policy</td>
</tr>
<tr>
<td>Spam messages</td>
<td>View the number of spam messages detected by content scanning.</td>
</tr>
<tr>
<td>ITEM</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Content filtering violations</td>
<td>View the number of content filtering rule violations detected.</td>
</tr>
<tr>
<td>Suspicious URLs - Web reputation</td>
<td>View the number of suspicious URLs detected by Web reputation.</td>
</tr>
<tr>
<td>Rewritten URLs</td>
<td>View the number of URLs rewritten by URL time-of-click protection.</td>
</tr>
<tr>
<td>Data Loss Prevention incidents</td>
<td>View the number of Data Loss Prevention policy incidents detected</td>
</tr>
<tr>
<td>Phishing messages</td>
<td>View the number of phishing messages detected by content scanning.</td>
</tr>
<tr>
<td>Business Email Compromise</td>
<td>View the number of email messages detected by business email compromise filter.</td>
</tr>
<tr>
<td>Blocked connections - Email reputation</td>
<td>View the number of Email reputation detections of messages from spam sources. Email reputation blocks messages from spam sources from entering the network, so there are no messages to scan.</td>
</tr>
<tr>
<td>Unscannable message parts</td>
<td>View the number of message bodies and attachments not scanned as specified by the Scan Restriction Criteria.</td>
</tr>
</tbody>
</table>

**Scan Method**

| Security risk scan method                  | View the security risk scan method in this section.                        |
| Web reputation source                     | View the web reputation source in this section.                             |
| Smart Protection Service                  | View the current server address and status for each Smart Protection service running. |

**Update Status**

| Update                                    | Click to update the selected components.                                    |
| Component                                 | View the component’s current version, available version, and update status. Select components to manually update. |
Note
ScanMail Standard version does not include spam prevention, content filtering, or Data Loss Prevention capabilities.

Summary: Security Risks

**TABLE 18-2. Summary: Security Risk Information**

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Risk Summary for Today</td>
<td>View the total number of security risks detected and the percentage of those that were uncleanable, spyware/grayware, and advanced threats.</td>
</tr>
<tr>
<td>Viruses/Malware Graph</td>
<td>View the total messages scanned and the number of viruses/malware detected in a graph.</td>
</tr>
<tr>
<td>Spyware/Grayware Graph</td>
<td>View the total messages scanned and the number of spyware/grayware detected in a graph.</td>
</tr>
<tr>
<td>Advanced Threats Graph</td>
<td>View the total messages scanned and the number of advanced threats detected in a graph.</td>
</tr>
<tr>
<td>Top Viruses/Malware</td>
<td>View the viruses/malware that have been detected the most number of times.</td>
</tr>
<tr>
<td>Top Spyware/Grayware</td>
<td>View the spyware/grayware that have been detected the most number of times.</td>
</tr>
<tr>
<td>Top Advanced Threats</td>
<td>View the advanced threats that have been detected the most number of times.</td>
</tr>
</tbody>
</table>

Summary: Spam

The Summary screen provides a simple and current report on the ScanMail system and functions. To see more detailed information, generate reports from the Reports menu.
### TABLE 18-3. Summary Spam Information

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan Status for Today</td>
<td>Click the current spam detection level to change the setting.</td>
</tr>
<tr>
<td>Spam Summary for Today</td>
<td>View the total number of messages, spam, phishing, and reported false positive(s).</td>
</tr>
<tr>
<td>Spam Detection Graph</td>
<td>View a graph of the total messages scanned, reported false positives, and spam detected.</td>
</tr>
<tr>
<td>Business Email Compromise Detection Graph</td>
<td>View a graph of the total messages scanned, reported false positives, and compromised business email messages detected.</td>
</tr>
<tr>
<td>Phishing Detection Graph</td>
<td>View a graph of the total messages scanned, reported false positives, and phishing messages detected.</td>
</tr>
<tr>
<td>Top Reported False Positives</td>
<td>View the false positives that have been reported the most number of times.</td>
</tr>
</tbody>
</table>

**Note**

ScanMail Standard versions do not have spam prevention, Data Loss Prevention, or content filtering capabilities.

### Summary: Ransomware

### TABLE 18-4. Summary: Ransomware Information

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ransomware Summary for Today</td>
<td>View the total number of ransomware detected and the percentage of those that were detected by security risk scan, Web reputation, and virtual analyzer.</td>
</tr>
<tr>
<td>Security Risk Scan</td>
<td>View the total messages scanned and the number of ransomware detected by the Security Risk Scan.</td>
</tr>
<tr>
<td>Web Reputation</td>
<td>View the total messages scanned and the number of ransomware detected by the Web Reputation.</td>
</tr>
</tbody>
</table>
### About Alerts

Administrators can configure ScanMail to send notifications to designated individuals when significant system events or security outbreaks occur. ScanMail can send notifications by email message and Simple Network Management Protocol (SNMP) or write to a Windows event log.

### System Events

A brief description of the system events options is available below (*Alerts > System Events*).

Click an event link to configure the alert notification. For details on the notification settings, see *Alert Notification Settings on page 18-10*.

<table>
<thead>
<tr>
<th>TABLE 18-5. System Events</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>EVENT</strong></td>
</tr>
<tr>
<td><strong>ScanMail Services</strong></td>
</tr>
<tr>
<td>ScanMail service did not start successfully</td>
</tr>
<tr>
<td>ScanMail service is unavailable</td>
</tr>
<tr>
<td><strong>ScanMail Events</strong></td>
</tr>
<tr>
<td><strong>Event</strong></td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td>Smart Protection Server - Each time File Reputation service was</td>
</tr>
<tr>
<td>Smart Protection Server - Each time Web Reputation service was</td>
</tr>
<tr>
<td>Virtual Analyzer - Each time the Virtual Analyzer server was</td>
</tr>
<tr>
<td>Update - Each time update was</td>
</tr>
<tr>
<td>Update - Last update time is older than</td>
</tr>
<tr>
<td>Manual/Scheduled scan tasks were</td>
</tr>
<tr>
<td>Note</td>
</tr>
<tr>
<td>Manual/Scheduled scan time exceeds</td>
</tr>
<tr>
<td>Note</td>
</tr>
<tr>
<td>Search &amp; Destroy - Each time a search was</td>
</tr>
<tr>
<td>The local drive (volume) space for the backup, quarantine, and archive directories is less than</td>
</tr>
<tr>
<td>EVENT</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>The size of the database for quarantine, logs, and mailbox search results exceeds</td>
</tr>
<tr>
<td>Outbreak Prevention Mode started successfully</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Outbreak Prevention Mode stopped and restored configuration successfully</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Predictive Machine Learning service was</td>
</tr>
<tr>
<td>Writing Style service was</td>
</tr>
<tr>
<td>Exchange Events</td>
</tr>
<tr>
<td>The SMTP messages queued continuously exceeds the following number within the specified time</td>
</tr>
</tbody>
</table>
### Monitoring ScanMail

#### 18-9

**Event** | **Description**
--- | ---
The disk space on the local drive of the transaction log is less than | Select to receive an alert each time the available disk space reaches the minimum you specify.

**Note**
This option does not display for Exchange Edge Server role.

The mail store size exceeds | Select to receive an alert each time the mail store size exceeds the size you specify.

**Note**
This option does not display for Exchange Edge Server role.

---

**Note**
To use System Center Operations Manager (SCOM), install the management pack found in the ScanMail installation package and select **Write to Windows event log** in each individual alert setting. Exchange events do not integrate with System Center Operations Manager (SCOM).

---

### Outbreak Alerts

A brief description of the options available on this screen is available below (**Alerts > Outbreak Alert**).

Click an event link to configure the alert notification. For details on the notification settings, see *Alert Notification Settings on page 18-10*. 
### Table 18-6. Outbreak Events

<table>
<thead>
<tr>
<th>EVENT</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viruses/Malware detected reach the following number within the shown time</td>
<td>Set the conditions for the outbreak by setting the number of detected viruses/malware and a duration of time. ScanMail sends an alert when the number of detected viruses/malware reaches this limit.</td>
</tr>
<tr>
<td>Uncleanable viruses/malware reach the following number within the shown time</td>
<td>Set the conditions for the outbreak by setting the number of uncleanable viruses/malware detected and a duration of time. ScanMail sends an alert when the number of detected uncleanable viruses/malware reaches this limit.</td>
</tr>
<tr>
<td>Spyware/Grayware detected reach the following number within the shown time</td>
<td>Set the conditions for the outbreak by setting the number of spyware/grayware detected and a duration of time. ScanMail sends an alert when the number of detected spyware/grayware reaches this limit.</td>
</tr>
<tr>
<td>Blocked attachments reach the following number within the shown time</td>
<td>Set the conditions for the outbreak by setting the number of blocked attachments and a duration of time. ScanMail sends an alert when the number of blocked attachments reaches this limit.</td>
</tr>
</tbody>
</table>

### Alert Notification Settings

Click an alert condition to display the alert notification screen.

### Table 18-7. Notification Settings

<table>
<thead>
<tr>
<th>SETTING</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator Notification</td>
<td></td>
</tr>
<tr>
<td>Mail</td>
<td>Select to send email message notifications.</td>
</tr>
</tbody>
</table>
### Setting Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Type the email address for the administrator.</td>
</tr>
<tr>
<td>Subject</td>
<td>Type the subject of the message to send to the administrator.</td>
</tr>
<tr>
<td>Message</td>
<td>Click a message element and add it to the notification.</td>
</tr>
<tr>
<td></td>
<td>For example, click [Time] and add it to the message list. The notification message contains the time when ScanMail took the action.</td>
</tr>
</tbody>
</table>

#### Advanced Notification

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNMP</td>
<td>Select to send SNMP notifications.</td>
</tr>
<tr>
<td>IP address</td>
<td>Specify the SNMP IP address.</td>
</tr>
<tr>
<td>Community</td>
<td>Specify the SNMP Community name.</td>
</tr>
<tr>
<td>Message</td>
<td>Click a message element and add it to the notification.</td>
</tr>
<tr>
<td></td>
<td>For example, click [Time] and add it to the message list. The notification message contains the time when ScanMail took the action.</td>
</tr>
</tbody>
</table>

Write to Windows event log  
(Select this to allow Microsoft™ System Center Operations Manager to retrieve the Windows event log for alerts.)  
Select to send notifications to Windows event log.

**Note**

To use System Center Operations Manager (SCOM), install the management pack found in the ScanMail installation package and select Write to Windows event log in each individual alert setting. Exchange events do not integrate with System Center Operations Manager (SCOM).
About Reports

Administrators can generate reports to view ScanMail log events in an organized and graphically appealing format. Reports can be printed or sent by email message to a specified address. Administrators can configure the number of reports ScanMail saves on the Report Maintenance screen. When the number of reports exceeds the configured number, ScanMail deletes the excess reports beginning with the oldest report.

Example: If there are 15 reports and the maximum number of reports to save is 10, then ScanMail deletes the five oldest reports, leaving the 10 most recently saved reports.

One-time Reports

Generate a one-time report to get a quick summary of ScanMail information. The web console displays the report as soon as it is generated. Administrators can then print or send an email message of the one-time report.

ScanMail saves generated reports in a cache for quick viewing at a later time. ScanMail retains reports until the administrator manually deletes the report or ScanMail deletes them by following the report maintenance settings.

Generating One-time Reports

Procedure

1. Click Reports > One-time Reports to open the One-time Reports screen.

2. Click Generate report.

3. Type a Report name.

4. Set the time range by typing a date or clicking the calendar icon to select a date.

   ScanMail gathers data to include in the report for the specified time range.

5. Select the servers to include in the report.
Monitoring ScanMail

- **Local server**
- **Remote server(s)**
  a. Select the **Server group** from the drop-down.
  b. Click the server name in the **Available Server(s)** list and click **Add >>** to include the server(s) to the **Selected Server(s)** list.

6. Click the type of information that ScanMail includes in the report.

Click the **Show details** icon next to the report type to view detailed options for that report.

7. Click **Generate**.

---

Scheduled Reports

ScanMail generates scheduled reports according to the specified day and time. Administrators can configure ScanMail to deliver reports by email message to an administrator or other recipient.

Scheduled reports follow a template. To generate individual scheduled reports, define the template and then ScanMail generates reports according to that template. Specify the schedule and content included in each individual report for the report template. ScanMail generates a report at the time specified in the template. Each template can have many individual reports that administrators can view by clicking **List Reports** from the **Scheduled Reports** screen. View the content of the template by clicking the template name.

Generating Scheduled Reports

**Procedure**

1. Click **Reports > Scheduled Reports** to open the **Scheduled Reports** screen.
2. Click **Add**.

   The **Schedule Reports > Add Report** screen opens to let you set up your report.
3. Type a name for the report template.

4. Specify the schedule that the template uses to generate individual reports.
   ScanMail can generate reports on a daily, weekly, and monthly basis.

5. Specify the **Generate report at** time when the template generates the individual report.

   **Note**
   ScanMail uses a 24-hour clock for all time settings.

   For example: After specifying the schedule to be weekly every Sunday and configuring the time for report generation to be 02:00, then ScanMail uses the template to generate an individual report every Sunday at 02:00.

6. Select the servers to include in the report.
   - **Local server**
   - **Remote server(s)**
     a. Select the **Server group** from the drop-down.
     b. Click the server name in the **Available Server(s)** list and click **Add >>** to include the server(s) to the **Selected Server(s)** list.

7. Select the type of report that ScanMail generates according to the schedule.

8. Set a person to receive a report each time the template generates one.

9. Click **Send to email address:**.

10. Type the recipient's email address

11. Click **Save**.

   The browser returns to the **Scheduled Reports** screen. The new template is added to the list of report templates.
Report Maintenance

Configure the **Report Maintenance** screen to specify the number of reports that ScanMail saves. For one-time reports and scheduled reports, type a number. When the number of reports exceeds the specified limit, ScanMail deletes excess reports, beginning with the oldest report. For scheduled reports saved in each template, the number specified limits the amount of saved reports for each template.

For example, there are five saved report templates. The limit for Scheduled reports saved in templates is 4. This means that each template can generate four individual reports, for a total of 20 reports (5 templates x 4 reports each). If a template generates another report, then ScanMail deletes the oldest generated report for that template, keeping the total number of reports at 20.

A brief description of the options available on the **Report Maintenance (Reports > Maintenance)** screen is available below.

- **One-time reports**: Specify the maximum number of reports to save.
- **Scheduled reports saved in each template**: Specify the maximum number of reports to save.
- **Report templates**: Specify the maximum number of report templates to save.

About Logs

ScanMail keeps detailed logs that administrators can use when analyzing system security and configuring ScanMail to provide optimal protection for the Exchange environment. ScanMail provides the following log types:

- Security Risk Scan
- Attachment Blocking
- Content Filtering
- Update
- Scan Events
• Backup for Security Risk
• Backup for Content Filter
• Unscannable Message Parts
• Event Tracking
• Data Loss Prevention
• Backup for Data Loss Prevention
• Web Reputation
• URL Time-of-Click Tracking
• Advanced Spam Protection
• Virtual Analyzer Submissions

Perform a log query to view log information. Use the Log Query page to set up and run your queries.

Types of Logs

The following table lists the type of logs:

<table>
<thead>
<tr>
<th>TYPE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Risk Scan</td>
<td>Information about messages with detected security risks</td>
</tr>
<tr>
<td>Attachment Blocking</td>
<td>Information about the messages with attachments that ScanMail scanned and blocked</td>
</tr>
<tr>
<td>Content Filtering</td>
<td>Information about the messages ScanMail filtered for undesirable content</td>
</tr>
<tr>
<td>Updates</td>
<td>Information about whether components were updated successfully</td>
</tr>
</tbody>
</table>

Note
Components include scan engines and pattern files.
<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan Events</td>
<td>Information about whether manual and scheduled scans have been successful or unsuccessful</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>This option does not display for Exchange Edge Server role.</td>
</tr>
<tr>
<td>Backup for Security Risk</td>
<td>Information about the files that Security Risk Scan moved to the backup folder before taking action against them</td>
</tr>
<tr>
<td>Backup for Content Filter</td>
<td>Information about the files that Content Filtering moved to the backup folder before taking action against them</td>
</tr>
<tr>
<td>Unscannable Message Parts</td>
<td>Information about message parts not scanned as defined by the Scan Restriction Criteria</td>
</tr>
<tr>
<td>Event Tracking</td>
<td>Information about all product console operations including:</td>
</tr>
<tr>
<td></td>
<td>• System and vulnerability logs</td>
</tr>
<tr>
<td></td>
<td>• Search &amp; Destroy logs</td>
</tr>
<tr>
<td>Data Loss Prevention</td>
<td>Information about messages that triggered Data Loss Prevention policy incidents</td>
</tr>
<tr>
<td>Backup for Data Loss Prevention</td>
<td>Information about the files that Data Loss Prevention moved to the backup folder before taking action against them</td>
</tr>
<tr>
<td>Web Reputation</td>
<td>Information about messages that ScanMail detected with malicious URLs</td>
</tr>
<tr>
<td>URL Time-of-Click Tracking</td>
<td>Information about URLs that ScanMail had rewritten</td>
</tr>
<tr>
<td>Advanced Spam Protection</td>
<td>Information about messages that are detected as suspicious</td>
</tr>
<tr>
<td>Virtual Analyzer Submissions</td>
<td>Information about messages that ScanMail sends to Virtual Analyzer for analysis</td>
</tr>
</tbody>
</table>
Querying Logs

Procedure

1. Click Logs > Query.
   
   The Log Query screen displays.

2. Select the date range.

3. Select the type of entry.

4. (Optional) Specify any of the following criteria as available according to your selected type of entry:
   
   • Found in
   • Sender
   • Recipient
   • Subject
   • Attachment
   • Keyword
   • Name
   • IP address
   • Log type
   • Description
   • Source type
   • File name or URL
   • URL
   • Threat name

5. Specify the option for Sort by.
6. Specify the number of items to display per page.

7. Select the *Query targets* for the query.
   - **Local server**
   - **Remote server(s)**
     a. Select the *Server group* from the drop-down.
     b. Click the server name in the *Available Server(s)* list and click **Add >>** to include the server(s) to the *Selected Server(s)* list.

8. Click **Display Logs**.

---

**Log Maintenance**

ScanMail keeps detailed logs of security risk scan, content filtering, attachment blocking, spam prevention, updates, scan events, back up, and event tracking. These logs provide a valuable source of system information. Perform log maintenance to manage disk space usage.

**Performing Manual Log Maintenance**

**Procedure**

1. Click **Logs > Maintenance**.
   
   The **Log Maintenance** screen displays.

2. Click the **Manual** tab.

3. Select the log types to delete.

4. Specify the number of days to keep logs before deleting.

5. Specify the number of days to keep event tracking logs before deleting.

6. Click **Delete Now** to delete logs and events.
Performing Scheduled Log Maintenance

Procedure

1. Click Logs > Maintenance.
   The Log Maintenance screen displays.
2. Click the Automatic tab.
3. Select Enable automatic maintenance.
4. Select the log types to delete.
5. Specify the number of days to keep logs before deleting.
6. Specify the number of days to keep event tracking logs before deleting.
7. Click Save.

Configuring Log Forwarding Settings

You can configure ScanMail to forward events to an external syslog or Security Information and Event Management (SIEM) server. All events are forwarded in clear text.

Procedure

1. Select Enable log forwarding to enable log forwarding.
2. Under Setting for Log Receiving Unit section, configure the following:
   • IP Address: IP address of the log receiving server.
   • Port: Port number of the log receiving server.
   • Transportation Type: Protocol to be used to transport logs to the log receiving server.

   If you select TCP, you can also select Enable SSL to encrypt log content.
• **Facility**: Machine process that created the syslog event.

• **Severity**: Severity level of the log.

3. Under **Setting for Log Forwarding** section, configure the following:
   • **Frequency**: Frequency for collecting and forwarding logs.
   • **Event Format**: Select the event log format.
   • **Log Type**: Select the type of logs you want ScanMail to forward.

4. Click **Test Network Connection** to verify the connection with the log receiving server.

5. Click **Save**.
Performing Administrative Tasks

This chapter describes administrative tasks.

Topics include:

- Configuring Proxy Settings on page 19-2
- Configuring External Disclaimer on page 19-2
- Global Notification Settings on page 19-3
- Configuring Spam Maintenance on page 19-5
- Configuring Real-time Scan Settings on page 19-6
- About Access Control on page 19-6
- About Special Groups on page 19-9
- About Server Groups on page 19-10
- About Internal Domains on page 19-11
- Product License on page 19-12
- About Trend Micro Apex Central on page 19-12
- Using Trend Support / System Debugger on page 19-17
Configuring Proxy Settings

Proxy servers are used for added security and more efficient use of bandwidth. If your network uses a proxy server, configure the proxy settings to connect to the Internet, download the updated components necessary to keep ScanMail updated, and check the license status online.

Procedure

1. Click Administration > Proxy.
2. Select Use a proxy server for Web Reputation, URL Time-of-Click Protection, Predictive Machine Learning, updates, and product license notifications. Select this check box to use a proxy server for web reputation queries to Trend Micro reputation servers, Time-of-Click Protection, Predictive Machine Learning, updates, and product license notifications.
3. Type the proxy server name or IP address.
4. Type the Port.
5. (Optional) Select Use SOCKS 5 proxy protocol.
6. If the proxy server requires authentication, specify the user name and password.

Configuring External Disclaimer

You can configure ScanMail to add a disclaimer at the top of message body of all the incoming messages from external domains.

Procedure

1. Click Administration > External Disclaimer.
   
   The External Disclaimer screen appears.
2. Select Enable External Disclaimer.
3. If required, modify the text in the **External Disclaimer Content** text field.

4. Slick **Save**.

---

**Global Notification Settings**

Configure ScanMail to send notifications after taking an action. ScanMail administrators typically send notifications to the Exchange administrator, using a global default for the administrator’s email address.

Administrators can configure ScanMail to send notifications to the person who is to receive the notification and the person listed as the sender for the notification. That is, when sending notifications, ScanMail lists the address configured on the **Notification Settings** screen as the sender of the message. People receiving the message can contact the sender about the problem.

Setting and applying a global default address for an administrator changes the address in the following locations:

- Security Risk Scan
- Attachment Blocking
- Content Filtering
- Data Loss Prevention
- Advanced Spam Prevention
- Spam Prevention
- Web Reputation
- System Alerts
- Outbreak Alerts

**Note**

Administrators can customize the notification addresses for each of the above locations after applying a default address.

ScanMail divides email traffic into two network categories: internal and external. ScanMail queries the Exchange server to learn how the internal and external addresses are defined. All internal addresses share a common domain and all external addresses do not belong to that domain.
For example, if the internal domain address is "@host.com", then ScanMail classifies addresses such as "abc@host.com" and "xyz@host.com" as internal addresses. ScanMail classifies all other addresses, such as "abc@host.com" and "jondoe@otherhost.com" as external.

ScanMail can automatically send notifications in the following situations:

- Detects and takes action against a security risk or other threat detected in an email message
- Blocks an infected attachment
- Detects suspicious URLs
- Filters out undesirable content from an email message
- Detects and takes action against a Data Loss Prevention incident
- Detects a significant system event
- Detects virus/malware outbreak conditions

Note

For correct resolution of ScanMail notifications with Simple Network Management Protocol (SNMP), import the Management Information Base (MIB) file to the network management tools from the following path in the ScanMail Package: tool\admin\trend.mib.

Configuring Global Notification Settings

 Procedure

1. Click Administration > Notification Settings.
2. Type the email address of the administrator that receives notifications.
3. Type the email address of the sender who sends alerts and notifications.
4. Specify an SNMP IP address and community.
5. Specify the **Internal Email Definition** by selecting **Default** and **Custom internal mail definition**. 

This allows you to customize how ScanMail categorizes email messages as internal.

6. Click **Save**.

---

## Configuring Spam Maintenance

The **Spam Maintenance** screen displays the name of the Spam Folder and the number of days that the End User Quarantine (EUQ) tool retains spam messages. End users can rename the spam folder using Microsoft Outlook. ScanMail identifies the folder by ID, not by folder name.

---

**Note**

**Spam Maintenance** is only available on Exchange Server 2013.

---

### Procedure

- Select **Enable End User Quarantine** to enable End User Quarantine for all mailboxes on the Exchange server.

**Note**

After disabling End Use Quarantine and clicking **Save**, ScanMail displays a confirmation message box. Select **Delete End User Quarantine spam folder** to remove the spam folder (and all contents) from client accounts.

- In the **End User Quarantine Settings** section, click **Create spam folder and delete spam messages** to create a new spam folder for each new user that added to the Exchange server with End User Quarantine. Clicking **Create spam folder and delete spam messages** immediately creates the spam folder for the new user.

- In the **Client Spam Folder Settings** section, configure the spam message deletion schedule.
• In the **End User Quarantine Exception List** section, add or remove users from the exception list. ScanMail does not enable EUQ for users added to this list.

---

### Configuring Real-time Scan Settings

ScanMail performs real-time scan on messages as they are accessed if the message has not been previously scanned using the latest pattern file and scan engine.

**Procedure**

1. Click **Administration > Real-time Scan Settings**.

2. Select **Do not perform on-access scan on email messages older than the following number of days** to limit the messages that are scanned based on the number of days.

3. Specify the number of days.

4. Click **Save**.

---

### About Access Control

Use the role-based administration feature to grant and control access to the ScanMail product console menu and submenu items. If there are multiple ScanMail administrators in the organization, this feature can help delegate management tasks to administrators and manage the menu items accessible to each administrator. Administrators can also grant non-administrators "view only" access to the product console.

---

**Note**

Access control is not available in non-console mode when using remote desktop.
Access Control Permissions

A brief description of the access control permissions (Administration > Access Control > Permissions) is available below.

- **Full**: Select to allow users in this group to enable, disable, and configure this feature.

- **Read**: Select to allow users in this group to view this feature and perform the following:

<table>
<thead>
<tr>
<th>PERMISSION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Updates</td>
<td>Operators can configure manual updates.</td>
</tr>
<tr>
<td>Logs</td>
<td>Operators can query logs.</td>
</tr>
<tr>
<td>Reports</td>
<td>Operators can generate logs.</td>
</tr>
<tr>
<td>Quarantine</td>
<td>Operators can query quarantined messages and files.</td>
</tr>
</tbody>
</table>

- **None**: Select to hide this feature from users in this group.

Enabling Access Control

**Procedure**

1. Click Administration > Access Control.

   The Access Control screen displays.

2. Click the icon under Status to display a green check icon (✓) which indicates that the access role is enabled. A red x icon (✗) indicates the policy is disabled.

This feature is only supported with Microsoft™ Internet Explorer™. If Internet Explorer Enhanced Security is enabled, add the ScanMail product console site to the Local intranet zone to use this feature.

4. Click Save.

---

**Configuring Access Control**

**Procedure**

1. Click **Administration > Access Control**.

   The **Access Control** screen displays.

2. Click one of the following access control roles:
   - Administrator
   - Operator
   - Search & Destroy Administrator
   - Search & Destroy Operator

3. Click the **Authentication** tab.

4. Specify the description for the group.

5. Add accounts from Active Directory using **Search**.

6. Click **Save**.

7. Click the **Permissions** tab.

8. Select the permissions for this group.

9. Click **Save**.
About Special Groups

Create special groups to easily apply policies to segments of the network. Administrators can import and export special groups for ease of management. Special groups cannot contain other special groups.

After deleting an Active Directory user belonging to a special group, ScanMail displays a notification message in the Special Group Selected Account(s) list.

Configuring Special Groups

Configure special groups for ease of management when creating rules and policies.

Procedure

1. Click Administration > Special Groups.
   
The Special Group screen displays.

2. Choose to add or edit a special group:
   
   • For new special groups:
     
     Click Add.

   • For preexisting special groups:
     
     Click the group name.

3. Type a name for the special group and specify a description.

4. Search for Active Directory (AD) users to add to the special group or specify an SMTP address.

5. Click Add >> to add accounts or << Remove to remove accounts from this special group.

6. Click Save.
About Server Groups

Create server groups to easily manage multiple ScanMail servers using the Server Management screen.

You can also use Server Groups to monitor multiple ScanMail servers by querying logs and quarantined messages, and creating reports from any ScanMail server.

---

**Note**

You cannot modify or delete the default server groups ("All servers", "Mailbox servers", and "Transport servers").

---

Configuring Server Groups

**Procedure**

1. Click **Administration > Server Groups**.
   
   The Server Groups screen displays.

2. Choose to add or edit a server group:

   • For new server groups:
     
     Click **Add**.

   • For preexisting server groups:
     
     Click the group name.

3. Type a name for the server group and specify a description.

4. Click **Add >>** to add servers or **<< Remove** to remove servers from this server group.

5. Click **Save**.
About Internal Domains

Configure your company’s internal domains to distinguish them from outgoing mail traffic. Data Loss Prevention policies will disregard email messages that transmit through your internal domains according to the policy configurations. When Data Loss Prevention policies apply to outgoing mail only, no policy violations trigger for the internal domains.

ScanMail allows the usage of the asterisk (*) wildcard to specify internal domains. In order to use the wildcard operator, the following rules apply:

- The asterisk placement is at the beginning of the domain name.
- The asterisk precedes a period (.)

**Table 19-2. Wildcard Examples**

<table>
<thead>
<tr>
<th>VALID WILDCARD EXAMPLES:</th>
<th>INVALID WILDCARD EXAMPLES:</th>
</tr>
</thead>
<tbody>
<tr>
<td>* .smex.com</td>
<td>*smex.com</td>
</tr>
<tr>
<td>*.yourcompany.com</td>
<td>smex.*.com</td>
</tr>
<tr>
<td></td>
<td>smex.*</td>
</tr>
</tbody>
</table>

Configuring Internal Domains

**Procedure**

1. On the left navigation pane, click **Administration > Internal Domains**.
   
The Internal Domains screen appears.

2. Type the name of the internal domain you want to exclude from scans.

3. Click **Add >>** to move the domain into the Internal Domains list.

4. Click **Import** to import an internal domain list. Click **Export** to save the internal domain list in a TXT file.
5. Click Save.

Product License

The Product License screen (Administration > Product License) displays information regarding the license expiry date, status, version, and Activation Code.

Administrators can use the following controls to manage the product license:

• Update License: Click to update the product license.
• New Activation Code: Click to use a new Activation Code.

About Trend Micro Apex Central

Trend Micro™ Apex Central™ is a software management solution that provides the capability to control antivirus and content security programs from a central location—regardless of the program’s physical location or platform. This application can simplify the administration of a corporate virus/malware and content security policy.

• Apex Central server: The Apex Central server is the machine upon which the Apex Central application is installed. The web-based Apex Central management console is generated on this server.

• Agent: The agent is an application installed on a product-server that allows Apex Central to manage the product. It receives commands from the Apex Central server, and then applies them to the managed product. It also collects logs from the product, and sends them to Apex Central. The Apex Central agent does not communicate with the Apex Central server directly. Instead, it interfaces with a component called the Communicator.

• Communicator: The Communicator is the communications backbone of the Apex Central system; it is part of the Trend Micro Management Infrastructure. Commands from the Apex Central server to the managed products, and status reports from the products to the Apex Central server all pass through this component. Only one Communicator is installed on each product server; the
Communicator then handles the needs of all the agents on the aforementioned server.

- **Entity**: An entity is a representation of a managed product on the Product Directory link. You see these icons in the directory tree of the Entity section. The directory tree is a composition of all managed entities, residing on the Apex Central console.

### About Trend Micro Management Communication Protocol

Trend Micro™ Management Communication Protocol (MCP) is the next generation agent for Trend Micro managed products. Management Communication Protocol (MCP) replaces Trend Micro Infrastructure (TMI) as the way Apex Central communicates with Trend Micro ScanMail™ for Microsoft™ Exchange. MCP has several new features:

- Reduced network loading and package size
- NAT and firewall traversal support
- HTTPS support
- One-way and Two-way communication support
- Single sign-on (SSO) support
- Cluster node support

### Using ScanMail with Apex Central

- Multiple ScanMail servers can share the same configurations by using Trend Micro Apex Central (or Trend Micro Control Manager (TMCM)).
- Apex Central permits administrators to configure and deploy Data Loss Prevention policies (rules) directly to ScanMail servers from the Apex Central web console.
- Administrators can also use Apex Central to synchronize virus pattern file and other downloads (Apex Central contacts Trend Micro through the Internet; Apex Central then distributes the updates to the various instances of ScanMail through the Intranet).
• Unless included as part of an Apex Central domain, each instance of ScanMail on
the network updates its own virus pattern file and other updates.

For more information, see the Apex Central documentation.

Registering to Apex Central

Administrators can manage ScanMail using the Trend Micro Apex Central management
console.

Refer to the Trend Micro Apex Central Administrator's Guide for more information about
managing products in Apex Central.

Procedure

1. Click Administration > Apex Central Settings.

   The Apex Central Settings screen displays.

2. Under Connection Settings, type the name of the ScanMail server in the Entity
display name field.

3. Under Apex Central Server Settings specify the following:
   a. Type the Apex Central server IP address or host name in the Server FQDN
      or IP address field.
   b. If you have Apex Central security set to medium (HTTPS and HTTP
      communication is allowed between Apex Central and the MCP agent of
      managed products), select Connect through HTTPS.
   c. If the network requires authentication, type the user name and password for
      the IIS server in the Username and Password fields.

4. Under MCP Proxy Settings, configure the following:
   a. If you want to use a proxy server for communication with the Apex Central,
      select Use a proxy server for communication with the Apex Central
      server.
   b. Type the port number that the MCP agent uses to communicate with Apex
      Central.
c. Select the proxy protocol.

d. Type the proxy server IP address or host name in the **Server FQDN or IP address** field.

e. If you have Apex Central security set to medium (HTTPS and HTTP communication is allowed between Apex Central and the MCP agent of managed products), select **Connect through HTTPS**.

f. If the proxy server requires authentication, type the user ID and password for the proxy server in the **User ID** and **Password** fields.

5. Under **Two Way Communication Port Forwarding**, if using a NAT device, select **Enable two-way communication port forwarding** and type the NAT device's IP address and port number in **IP address** and **port number**.

6. Under **Spam Logs**, select **Send spam logs to Apex Central**, if you want to send spam logs to Apex Central.

```markdown
Note
All other filter logs will be uploaded by default once Apex Central is registered.
```

7. Under **Suspicious Objects**, configure the following:

a. Select **Enable Suspicious Objects List**, if you want ScanMail to leverage the suspicious objects list from the Apex Central. ScanMail synchronizes the consolidated suspicious objects list (including the Virtual Analyzer and User-defined objects) to apply to Security Risk Scan.

b. Select **Enable Suspicious Objects Detection Notification**, to receive notifications about suspicious objects detections. The details of Security Risk Scan detection follow its notification settings.

ScanMail leverages the Smart Protection Network to detect suspicious objects in URLs. The scanning and decision processes for the suspicious objects in files follows the following priority:

**User defined Suspicious Object > Pattern based local scan > Virtual Analyzer reported Suspicious Object.**
The action mapping in ScanMail for the Apex Central settings is defined in the following table.

**TABLE 19-3. Action mapping table for suspicious objects**

<table>
<thead>
<tr>
<th>TYPE</th>
<th>APEX CENTRAL ACTION SETTING</th>
<th>SCANMAIL ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>File suspicious objects</td>
<td>Log</td>
<td>Pass</td>
</tr>
<tr>
<td></td>
<td>Block</td>
<td>Replace with text/file</td>
</tr>
<tr>
<td></td>
<td>Quarantine</td>
<td>Quarantine entire message (Real-time scan)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Quarantine message part (Manual/Schedule scan)</td>
</tr>
</tbody>
</table>

**Note**

Refer to *Connected Threat Defense Primer* document from the Trend Micro Apex Central documentation set for more information on Suspicious Objects and Suspicious Objects Lists.

---

**Unregistering ScanMail from Apex Central**

**Note**

During Outbreak Prevention, administrators cannot unregister from Apex Central or disable communication between the ScanMail MCP agent and the Apex Central server.

**Procedure**

1. Click **Administration > Apex Central Settings**.
   
   The **Apex Central Settings** screen displays.

2. Under **Connection Status**, click **Unregister**.
A progress screen displays.

Using Trend Support / System Debugger

ScanMail Debugger can assist you in debugging or reporting the status of the ScanMail processes. When you are having unexpected difficulties, you can use the debugger to create debugger reports and send them to Trend Micro technical support for analysis.

Procedure

1. Click **Administration > Trend Support/Debugger** from the main menu.

   The **Trend Support/System Debugger** screen displays.

2. Select the modules to debug:
   
   • **ScanMail for Microsoft Exchange Master Service**
   
   • **ScanMail for Microsoft Exchange Remote Configuration Server**
   
   • **ScanMail for Microsoft Exchange System Watcher**
   
   • **Store Level Scan** (for Exchange Server 2013, 2016 and 2019)
   
   • **Transport Service**
   
   • **Common Gateway Interface (CGI)**
   
   • **End User Quarantine (EUQ)**

3. Click **Apply**.

  **Note**
  
  ScanMail does not require that the services restart after enabling or disabling debugging.
Chapter 20

Understanding Security Risks

This chapter describes security risks to help you understand possible risks to your network.

Topics include:

• Understanding the Terms on page 20-2
• About Internet Security Risks on page 20-2
• About Spyware/Grayware on page 20-13
Understanding the Terms

Computer security is a rapidly changing subject. Administrators and information security professionals invent and adopt a variety of terms and phrases to describe potential risks or uninvited incidents to computers and networks. The following is a list of these terms and their meanings as used in this document.

Some of these terms refer to real security risks and some refer to annoying or unsolicited incidents. Trojans, viruses/malware, and worms are examples of terms used to describe real security risks. Joke programs, spyware/grayware are terms used to describe incidents that might be harmful, but are sometimes simply annoying and unsolicited. ScanMail can protect against all of the incidents described in this chapter.

About Internet Security Risks

Thousands of viruses/malware are known to exist, with more being created each day. In addition to viruses/malware, new security risks designed to exploit vulnerabilities in corporate email systems and websites continue to emerge. These include spyware/grayware, phish sites, network viruses/malware, Trojans, and worms.

Collectively, these threats are known as security risks. Here is a summary of the major security risk types:
### Table 20-1. Internet Security Risks

<table>
<thead>
<tr>
<th>Threat Type</th>
<th>Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced threats</td>
<td>Advanced threats use less conventional means to attack or infect a system. Heuristic scanning can detect advanced threats to mitigate the damage to company systems. Some types of advanced threats that ATSE detects include:</td>
</tr>
<tr>
<td></td>
<td>• Advanced Persistent Threats (APT):</td>
</tr>
<tr>
<td></td>
<td>Advanced persistent threats are attacks against targeted companies and resources. Typically, a social engineering attack on an employee triggers a series of activities that open up the company to serious risks.</td>
</tr>
<tr>
<td></td>
<td>• Targeted attacks:</td>
</tr>
<tr>
<td></td>
<td>Targeted attacks refer to computer intrusions staged by threat actors that aggressively pursue and compromise specific targets. These attacks seek to maintain a persistent presence within the target's network so that the attackers can move laterally and extract sensitive information.</td>
</tr>
<tr>
<td></td>
<td>• Exploits:</td>
</tr>
<tr>
<td></td>
<td>Exploits are code purposely created by attackers to abuse or target a software vulnerability. This code is typically incorporated into malware.</td>
</tr>
<tr>
<td></td>
<td>• Zero-day attacks:</td>
</tr>
<tr>
<td></td>
<td>Zero-day attacks exploit previously unknown vulnerabilities in software.</td>
</tr>
<tr>
<td>Denial-of-Service (DoS) attack</td>
<td>A DoS attack happens when a mail server’s resources are overwhelmed by unnecessary tasks. Preventing ScanMail from scanning files that decompress into very large files helps prevent this problem from happening.</td>
</tr>
<tr>
<td>Phish</td>
<td>Unsolicited email requesting user verification of private information, such as credit card or bank account numbers, with the intent to commit fraud.</td>
</tr>
<tr>
<td>Spyware/Grayware</td>
<td>Technology that aids in gathering information about a person or organization without their knowledge.</td>
</tr>
</tbody>
</table>
### Threat Type

<table>
<thead>
<tr>
<th>Threat Type</th>
<th>Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trojan Horse program</td>
<td>Malware that performs unexpected or unauthorized, often malicious, actions. Trojans cause damage, unexpected system behavior, and compromise system security, but unlike viruses/malware, they do not replicate.</td>
</tr>
<tr>
<td>Virus/Malware</td>
<td>A program that carries a destructive payload, and replicates - spreading quickly to infect other systems. By far, viruses/malware remain the most prevalent threat to computing.</td>
</tr>
<tr>
<td>Worm</td>
<td>A self-contained program or set of programs that is able to spread functional copies of itself or its segments to other computer systems, typically through network connections or email attachments.</td>
</tr>
<tr>
<td>Other malicious codes</td>
<td>ScanMail detects some malicious code that is difficult to categorize, but pose a significant threat to Exchange. This category is useful when you want ScanMail to perform an action against a previously unknown threat type.</td>
</tr>
<tr>
<td>Packed files</td>
<td>Potentially malicious code in real-time compressed executable files that arrive as email attachments. IntelliTrap scans for packing algorithms to detected packed files. Enabling IntelliTrap allows ScanMail to take user-defined actions on infected attachments, and to send notifications to senders, recipients, or administrators.</td>
</tr>
<tr>
<td>Ransomware</td>
<td>A type of malware that prevents or limits users from accessing their system, either by locking the system's screen or by locking the users' files unless a ransom is paid. More modern ransomware families, collectively categorized as crypto-ransomware, encrypt certain file types on infected systems and forces users to pay the ransom through certain online payment methods to get a decrypt key.</td>
</tr>
</tbody>
</table>

## Viruses/Malware

A computer virus/malware is a segment of code that has the ability to replicate by infecting files. When a virus/malware infects a file, it attaches a copy of itself to the file in such a way that when the former executes, the virus/malware also runs. When this
happens, the infected file also becomes capable of infecting other files. Like biological viruses, computer viruses/malware can spread quickly and are often difficult to eradicate.

In addition to replication, some computer viruses/malware share another commonality: a damage routine that delivers a payload. While payloads may only display messages or images, they can also destroy files, reformat your hard drive, or cause other damage. Even if the virus does not contain a damage routine, it can cause trouble by consuming storage space and memory, and degrading the overall performance of your computer.

Generally, there are three kinds of viruses/malware:

**Table 20-2. Types of Virus/Malware**

<table>
<thead>
<tr>
<th>TYPE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>File viruses/malware may come in different types—there are DOS viruses/malware, Windows viruses/malware, macro viruses/malware, and script viruses/malware. All of these share the same characteristics of viruses/malware except that they infect different types of host files or programs.</td>
</tr>
<tr>
<td>Boot</td>
<td>Boot viruses/malware infect the partition table of hard disks and boot sector of hard disks and floppy disks.</td>
</tr>
<tr>
<td>TYPE</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>--------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Script</td>
<td>Script viruses/malware are viruses/malware written in script programming languages, such as Visual Basic Script and JavaScript and are usually embedded in HTML documents. VBScript (Visual Basic Script) and Jscript (JavaScript) viruses/malware make use of Microsoft's Windows Scripting Host to activate themselves and infect other files. Since Windows Scripting Host is available on Windows 98, Windows 2000 and other Windows operating systems, the viruses/malware can be activated simply by double-clicking a *.vbs or *.js file from Windows Explorer. What is so special about script viruses/malware? Unlike programming binary viruses/malware, which requires assembly-type programming knowledge, virus/malware authors program script viruses/malware as text. A script virus can achieve functionality without low-level programming and with code as compact as possible. It can also use predefined objects in Windows to make accessing many parts of the infected system easier (for example, for file infection, for mass-mailing). Furthermore, since the code is text, it is easy for others to read and imitate the coding paradigm. Because of this, many script viruses/malware have several modified variants. For example, shortly after the &quot;I love you&quot; virus appeared, antivirus vendors found modified copies of the original code, which spread themselves with different subject lines, or message bodies.</td>
</tr>
</tbody>
</table>

Whatever their type is, the basic mechanism remains the same. A virus contains code that explicitly copies itself. In the case of file viruses/malware, this usually entails making modifications to gain control when a user accidentally executes the infected program. After the virus code has finished execution, in most cases, it passes back the control to the original host program to give the user an impression that nothing is wrong with the infected file.

Take note that there are also cross-platform viruses/malware. These types of viruses/malware can infect files belonging to different platforms (for example, Windows and Linux). However, such viruses/malware are very rare and seldom achieve 100% functionality.

Virus/Malware Writers

In the traditional scenario, it was an individual, highly technical and working alone, who would write a virus/malware program and then introduce it onto a computer, network
server, or the Internet. Why? Ego, revenge, sabotage, and basic disgruntlement have all been cited as motivations.

Now, however, it takes no special skill to create a macro virus/malware, a mass mailer, or other virus/malware with highly disruptive potential. In fact, "virus kits" proliferate on the Internet and are free for the taking for anyone who wants to try their hand at disrupting the Internet or corporate communications.

And increasingly, organized crime from remote countries is getting into the act by creating sophisticated spyware/grayware programs and phish sites. Distributed through a million spam messages, these exploits are low effort but with a high potential for yielding personal information such as passwords, social security numbers, and credit card numbers.

**Malware Naming**

Malware, with the exception of boot sector viruses and some file infectors, is named according to the following format:

PREFIX_THREATNAME.SUFFIX

The suffix used in the naming convention indicates the variant of the threat. The suffix assigned to a new threat (meaning the binary code for the threat is not similar to any existing security risks) is the alpha character "A." Subsequent strains are given subsequent suffixes, for example, "B", "C", "D". Occasionally a threat is assigned a special suffix, (.GEN, for generic detection or .DAM if the variant is damaged or malformed).

<table>
<thead>
<tr>
<th>PREFIX</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>No prefix</td>
<td>Boot sector viruses or file infector</td>
</tr>
<tr>
<td>1OH</td>
<td>File infector</td>
</tr>
<tr>
<td>ADW</td>
<td>Adware</td>
</tr>
<tr>
<td>ALS</td>
<td>Auto-LISP script malware</td>
</tr>
<tr>
<td>ATVX</td>
<td>ActiveX malicious code</td>
</tr>
<tr>
<td>BAT</td>
<td>Batch file virus</td>
</tr>
<tr>
<td>Prefix</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>BHO</td>
<td>Browser Helper Object - A non-destructive toolbar application</td>
</tr>
<tr>
<td>BKDR</td>
<td>Backdoor virus</td>
</tr>
<tr>
<td>CHM</td>
<td>Compiled HTML file found on malicious websites</td>
</tr>
<tr>
<td>COOKIE</td>
<td>Cookie used to track a user's web habits for the purpose of data mining</td>
</tr>
<tr>
<td>COPY</td>
<td>Worm that copies itself</td>
</tr>
<tr>
<td>DI</td>
<td>File infector</td>
</tr>
<tr>
<td>DIAL</td>
<td>Dialer program</td>
</tr>
<tr>
<td>&quot;DOS, DDOS&quot;</td>
<td>Virus that prevents a user from accessing security and antivirus company websites</td>
</tr>
<tr>
<td>ELF</td>
<td>Executable and Link format viruses</td>
</tr>
<tr>
<td>EXPL</td>
<td>Exploit that does not fit other categories</td>
</tr>
<tr>
<td>FLOODER</td>
<td>Tool that allows remote malicious hackers to flood data on a specified IP, causing the target system to hang</td>
</tr>
<tr>
<td>FONO</td>
<td>File infector</td>
</tr>
<tr>
<td>GCAE</td>
<td>File infector</td>
</tr>
<tr>
<td>GENERIC</td>
<td>Memory-resident boot virus</td>
</tr>
<tr>
<td>HKTL</td>
<td>Hacking tool</td>
</tr>
<tr>
<td>HTML</td>
<td>HTML virus</td>
</tr>
<tr>
<td>IRC</td>
<td>Internet Relay Chat malware</td>
</tr>
<tr>
<td>JAVA</td>
<td>Java malicious code</td>
</tr>
<tr>
<td>JOKE</td>
<td>Joke program</td>
</tr>
<tr>
<td>JS</td>
<td>JavaScript virus</td>
</tr>
<tr>
<td>NE</td>
<td>File infector</td>
</tr>
</tbody>
</table>
Compressed Files

Compression and archiving are among the most common methods of file storage, especially for file transfers - such as email attachments, FTP, and HTTP. Before any virus/malware detection can occur on a compressed file, however, you must first decompress it. For other compression file types, ScanMail performs scan actions on the whole compressed file, rather than individual files within the compressed file.

ScanMail currently supports the following compression types:

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NET</td>
<td>Network virus</td>
</tr>
<tr>
<td>PALM</td>
<td>Palm PDA-based malware</td>
</tr>
<tr>
<td>PARITY</td>
<td>Boot virus</td>
</tr>
<tr>
<td>PE</td>
<td>File infector</td>
</tr>
<tr>
<td>PERL</td>
<td>Malware, such as a file infector, created in PERL</td>
</tr>
<tr>
<td>RAP</td>
<td>Remote access program</td>
</tr>
<tr>
<td>REG</td>
<td>Threat that modifies the system registry</td>
</tr>
<tr>
<td>SPYW</td>
<td>Spyware</td>
</tr>
<tr>
<td>SYMBOS</td>
<td>Trojan that affects telephones using the Symbian operating system</td>
</tr>
<tr>
<td>TROJ</td>
<td>Trojan</td>
</tr>
<tr>
<td>UNIX</td>
<td>Linux/UNIX script malware</td>
</tr>
<tr>
<td>VBS</td>
<td>VBScript virus</td>
</tr>
<tr>
<td>WORM</td>
<td>Worm</td>
</tr>
<tr>
<td>W2KM, W97M, X97M, P97M, A97M, O97M, WM, XF, XM, V5M</td>
<td>Macro virus</td>
</tr>
</tbody>
</table>
• Extraction: used when multiple files have been compressed or archived into a single file: PKZIP, LHA, LZH, ARJ, MIME, MSCF, TAR, GZIP, BZIP2, RAR, and ACE.

• Expansion: used when only a single file has been compressed or archived into a single file: PKLITE, PKLITE32, LZEXE, DIET, ASPACK, UPX, MSCOMP, LZW, MACBIN, and Petite.

• Decoding: used when a file has been converted from binary to ASCII, a method that is widely employed by email systems: UUENCODE and BINHEX.

---

**Note**

When ScanMail does not support the compression type, then it cannot detect viruses/malware in compression layers beyond the first compression layer.

---

When ScanMail encounters a compressed file it does the following:

1. ScanMail extracts the compressed files and scans them.

   ScanMail begins by extracting the first compression layer. After extracting the first layer, ScanMail proceeds to the second layer and so on until it has scanned all of the compression layers that the user configured it to scan, up to a maximum of 20.

2. ScanMail performs a user-configured action on infected files.

   ScanMail performs the same action against infected files detected in compressed formats as for other infected files. For example, if you select **Quarantine entire message** as the action for infected files, then ScanMail quarantines entire messages in which it detects infected files.

   ScanMail can clean files from two types of compression routines: PKZIP and LHA. However, ScanMail can only clean the first layer of files compressed using these compression routines.

---

**Joke Programs**

A joke program is an ordinary executable program with normally no malicious intent. Virus authors create joke programs for making fun of computer users. They do not intend to destroy data but some inexperienced users may inadvertently perform actions...
that can lead to data loss (such as restoring files from an older backup, formatting the drive, or deleting files).

Since joke programs are ordinary executable programs, they will not infect other programs, nor will they do any damage to the computer system or its data. Sometimes, joke programs may temporarily reconfigure the mouse, keyboard, or other devices. However, after a joke program finishes its execution or the user reboots the machine, the computer returns to its original state. Joke programs, while normally harmless, can be costly to an organization.

**Macro Viruses/Malware**

Macro viruses/malware are application-specific. They infect macro utilities that accompany such applications as Microsoft Word (.doc) and Microsoft Excel (.xls). Therefore, they can be detected in files with extensions common to macro capable applications, such as .doc, .xls, and .ppt. Macro viruses/malware travel between data files in the application and can eventually infect hundreds of files if undeterred.

As these file types are often attached to email messages, macro viruses/malware spread readily by means of the Internet in email attachments.

ScanMail prevents macro viruses/malware from infecting your server in the following ways:

- Detects malicious macro code using heuristic scanning

  Heuristic scanning is an evaluative method of detecting viruses/malware. This method excels at detecting undiscovered viruses/malware and threats that do not have a known virus signature.

- Strips all macro code from scanned files

**Mass-Mailing Attacks**

Email-aware viruses/malware, like the infamous Melissa, Loveletter, AnnaKournikova and others, have the ability to spread through email by automating the infected computer's email client. Mass-mailing behavior describes a situation when an infection spreads rapidly between clients and servers in an Exchange environment. Mass-mailing attacks can be expensive to clean up and cause panic among users. Trend Micro designed
the scan engine to detect behaviors that mass-mailing attacks usually demonstrate. The behaviors are recorded in the Virus Pattern file that is updated using the Trend Micro™ ActiveUpdate Servers.

You can enable ScanMail to take a special action against mass-mailing attacks whenever it detects a mass-mailing behavior. The action configured for mass-mailing behavior takes precedence over all other actions. The default action against mass-mailing attacks is **Delete entire message**.

For example: You configure ScanMail to quarantine messages when it detects a worm or a Trojan in an email message. You also enable mass-mailing behavior and set ScanMail to delete all messages that demonstrate mass-mailing behavior. ScanMail receives a message containing a worm such as a variant of MyDoom. This worm uses its own SMTP engine to send itself to email addresses that it collects from the infected computer. When ScanMail detects the MyDoom worm and recognizes its mass-mailing behavior, it will delete the email message containing the worm - as opposed to the quarantine action for worms that do not show mass-mailing behavior.

### Trojan Horse Programs

A Trojan is a type of threat named after the Trojan Horse of Greek mythology. Like the Greek Trojan Horse, a Trojan network threat has malicious intent, hidden within its code. While a Trojan may appear innocent, executing a Trojan can cause unwanted system problems in operation, lost data, and loss of privacy.

For example, a Trojan called "happy birthday" might play a song and display an animated dance on your screen, while at the same time opening a port in the background and dropping files that lets malicious hackers take control of the computer for whatever scheme or exploit he or she may have in mind. One common scheme is to hijack the computer for distributing spam. Another is to collect keystrokes and send them, along with all the data they contain, to the malicious hacker.

Trojans are not viruses/malware. Unlike viruses/malware, they do not infect files, and they do not replicate. The scan engine detects and logs these threats and can take whatever action you specify.

With Trojans, however, simply deleting or quarantining is often not enough to rid your system of the Trojan's effects. You must also clean up after it; that is, remove any
programs that may have been copied to the machine, close ports, and remove registry entries.

Worms

A computer worm is a self-contained program (or set of programs) that is able to spread functional copies of itself or its segments to other computer systems. The propagation usually takes place through network connections or email attachments. Unlike viruses/malware, worms do not need to attach themselves to host programs. Worms often use email and applications, such as Microsoft™ Outlook™, to propagate. They may also drop copies of themselves into shared folders or utilize file-sharing systems, such as Kazaa, under the assumption that users will likely download them, thus letting the worm propagate. In some cases, worms use chat applications such as ICQ, AIM, mIRC, or other Peer-to-Peer (P2P) programs to spread copies of themselves.

Zip of Death

"Zip-of-death" describes a subterfuge designed to bring down a network by overwhelming the antivirus software and/or network traffic checking security applications.

Using special techniques, a hacker can compress a file down to as little as 500 KB, that, when decompressed, may reach 15 GB or more in size. Another version of the exploit involves compressing such a large number of files, that, when decompressed, it can crash the system.

ScanMail allows you to set limits on the size, as well as the number of files it will extract from a compressed archive. When the limit is reached, ScanMail stops decompressing and takes the action specified for files outside of the scan restriction criteria.

About Spyware/Grayware

Your clients are at risk from potential threats other than viruses/malware. Grayware can negatively affect the performance of the computers on your network and introduce significant security, confidentiality, and legal risks to your organization.
TABLE 20-3. Types of Grayware

<table>
<thead>
<tr>
<th>TYPE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spyware</td>
<td>Gathers data, such as account user names and passwords, and transmits them to third parties</td>
</tr>
<tr>
<td>Adware</td>
<td>Displays advertisements and gathers data, such as user web surfing preferences, to target advertisements at the user through a web browser</td>
</tr>
<tr>
<td>Dialers</td>
<td>Change computer Internet settings and can force a computer to dial pre-configured phone numbers through a modem</td>
</tr>
<tr>
<td>Joke Programs</td>
<td>Cause abnormal computer behavior, such as closing and opening the CD-ROM tray and displaying numerous message boxes</td>
</tr>
<tr>
<td>Hacking Tools</td>
<td>Help hackers enter computers</td>
</tr>
<tr>
<td>Remote Access Tools</td>
<td>Help hackers remotely access and control computers</td>
</tr>
<tr>
<td>Password Cracking Applications</td>
<td>Help hackers decipher account user names and passwords</td>
</tr>
<tr>
<td>Other</td>
<td>Other types not covered above</td>
</tr>
</tbody>
</table>

Potential Risks and Threats

The existence of spyware/grayware on your network has the potential to introduce the following:

TABLE 20-4. Types of Risks

<table>
<thead>
<tr>
<th>TYPE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reduced computer performance</td>
<td>To perform their tasks, spyware/grayware applications often require significant CPU and system memory resources.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Increased web browser-related crashes</td>
<td>Certain types of grayware, such as adware, are often designed to create pop-up windows or display information in a browser frame or window. Depending on how the code in these applications interacts with system processes, grayware can sometimes cause browsers to crash or freeze and may even require a system reboot.</td>
</tr>
<tr>
<td>Reduced user efficiency</td>
<td>By needing to close frequently occurring pop-up advertisements and deal with the negative effects of joke programs, users can be unnecessarily distracted from their main tasks.</td>
</tr>
<tr>
<td>Degradation of network bandwidth</td>
<td>Spyware/grayware applications often regularly transmit the data they collect to other applications running on your network or to locations outside of your network.</td>
</tr>
<tr>
<td>Loss of personal and corporate information</td>
<td>Not all data that spyware/grayware applications collect is as innocuous as a list of websites users visit. Spyware/grayware can also collect the user names and passwords users type to access their personal accounts, such as a bank account, and corporate accounts that access resources on your network.</td>
</tr>
<tr>
<td>Higher risk of legal liability</td>
<td>If hackers gain access to the computer resources on your network, they may be able to utilize your client computers to launch attacks or install spyware/grayware on computers outside your network. Having your network resources unwillingly participate in these types of activities could leave your organization legally liable to damages incurred by other parties.</td>
</tr>
</tbody>
</table>

**How Spyware/Grayware Gets into your Network**

Spyware/grayware often gets into a corporate network when users download legitimate software that has grayware applications included in the installation package.

Most software programs include an End User License Agreement (EULA), which the user has to accept before downloading. Often the EULA does include information about the application and its intended use to collect personal data; however, users often overlook this information or do not understand the legal jargon.
Encoding Types

The encoding types supported by ScanMail include:

- BINHEX
- UUencode
- Base64
- Quoted-printable

A growing number of malicious security risks seek to embed themselves within a malformed email in an attempt to fool scanning and bypass antivirus products. The ScanMail scan engine's MIME-parsing algorithm can correctly parse and detect malformed versions of MIME-formatted email. The engine also supports 7-bit and 8-bit encoding/decoding.

Multipurpose Internet Mail Extensions (MIME) Types

Top-level media types

Unless a sub-type is specified, ScanMail automatically includes all subtypes.

- application/
- audio/
- image/
- text/
- video/

True File Type

Files can be easily renamed to disguise their actual type. Programs such as Microsoft Word are "extension independent". They will recognize and open "their" documents regardless of the file name. This poses a danger, for example, if a Word document containing a macro virus has been named "benefits form.pdf". Word will open the
file, but the file may not have been scanned if ScanMail is not set to check the true file type.

When set to IntelliScan, ScanMail will confirm a file’s true type by opening the file header and checking its internally registered data type.

Only files of that type that is actually capable being infected are scanned. For example, .mid files make up a large volume of all web traffic, but they are known not to be able to carry viruses. With true file type selected, once the true type has been determined, these inert file types are not scanned.

Disease Vector

A "disease vector" is a website or URL known to distribute Internet security risks including spyware/grayware, password-cracking applications, key-stroke trackers, and virus/malware kit downloads.

Another category of disease vectors are sites made to look legitimate, but below the surface the hacker directs all the "back-end" functionality such as links and data posts to his or her own locations.

Trend Micro quickly adds confirmed malicious sites to the phish and spyware pattern file so you can prevent LAN clients from downloading the virus/malware, or from being duped by the look-alike sites.

Phish

Phish, or Phishing, is a rapidly growing form of fraud that seeks to fool web users into divulging private information by mimicking a legitimate website.

In a typical scenario, an unsuspecting user gets an urgent sounding (and authentic looking) email telling him or her there is a problem with their account that they must immediately fix, or the account will be closed. The email will include a URL to a website that looks exactly like the real thing (it is simple to copy a legitimate email and a legitimate website but then change the so-called back-end—where the collected data is actually sent.)
The email tells the user to log on to the site and confirm some account information. Any data entered at the site is directed to a malicious hacker who steals the log on name, password, credit card number, social security number, or whatever data s/he requests.

Phish fraud is fast, cheap, and easy to perpetuate. It is also potentially quite lucrative for those criminals who practice it. Phish is hard for even computer-savvy users to detect. And it is hard for law enforcement to track down. Worse, it is almost impossible to prosecute.
Chapter 21

Frequently Asked Questions

This chapter discusses some commonly asked questions regarding the configuration of ScanMail and the steps involved in addressing the situations.

Topics include:

• *Scanning and Updating on page 21-2*
• *Expressions and Keywords on page 21-3*
• *File Handling on page 21-13*
• *Quarantine and Log Management on page 21-15*
• *Logs, Quarantine Records, and Server Groups on page 21-19*
• *Logging On and Registration on page 21-20*
• *Security Threats on page 21-24*
• *Virtual Analyzer on page 21-28*
Scanning and Updating

Do I have the latest pattern file or Service Pack?

Depending on which modules you have installed, ScanMail may use the following updatable files:

- Smart Scan Agent Pattern
- Virus Pattern
- Spyware Pattern
- IntelliTrap Pattern
- IntelliTrap Exception Pattern
- Virus Scan Engine
- Anti-spam Pattern
- Anti-spam Engine
- URL Filtering Engine
- Advanced Threat Scan Engine
- Contextual Intelligence Query Handler
- Advanced Threat Correlation Pattern

To find the latest available patterns, open a web browser to the Trend Micro Update Center.

Locating the ScanMail Version

**Procedure**

1. From the main ScanMail menu, click **Summary**.
2. A list of installed components, the current ScanMail version, and update schedules appears.

Where can I find the latest patches for updating ScanMail?

From time to time, Trend Micro may release a patch for a reported known issue or an upgrade that applies to your product. To find out whether there are any patches available, visit the following URL:
http://www.trendmicro.com/download/

The Update Center screen displays. Select your product from the links on this screen. Patches are dated. If you find a patch that you have not applied, open the readme document to determine whether the patch applies to you. If so, follow the installation instructions in the readme.

Expressions and Keywords

What are regular expressions?

Regular expressions are used to perform string matching. See the following tables for some common examples of regular expressions.

---

**Note**

Regular expressions are a powerful string matching tool. For this reason, it is recommended that an administrator who chooses to use regular expressions should be familiar and comfortable with regular expression syntax. Poorly written regular expressions can have a negative performance impact. Trend Micro’s recommendation is to start with simple regular expressions that do not use complex syntax. When introducing new rules, use the backup action and observe how ScanMail manages messages using your rule. When you are confident that the rule has no unexpected consequences, you can change your action.

---

**Table 21-1. Counting and Grouping**

<table>
<thead>
<tr>
<th><strong>ELEMENT</strong></th>
<th><strong>WHAT IT MEANS</strong></th>
<th><strong>EXAMPLE</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>.</td>
<td>The dot or period character represents any character except new line character.</td>
<td>doe matches doe, dog, don, dos, dot, etc.</td>
</tr>
<tr>
<td>*</td>
<td>The asterisk character means zero or more instances of the preceding element.</td>
<td>do* matches d, do, doo, dooo, doooo, etc.</td>
</tr>
<tr>
<td>Element</td>
<td>What It Means</td>
<td>Example</td>
</tr>
<tr>
<td>---------</td>
<td>---------------</td>
<td>---------</td>
</tr>
<tr>
<td>+</td>
<td>The plus sign character means one or more instances of the preceding element.</td>
<td>do+ matches do, doo, dooo, doooo, etc. but not d</td>
</tr>
<tr>
<td>?</td>
<td>The question mark character means zero or one instances of the preceding element.</td>
<td>do?g matches dg or dog but not doog, dooog, etc.</td>
</tr>
<tr>
<td>()</td>
<td>Parenthesis characters group whatever is between them to be considered as a single entity.</td>
<td>d(eer)+ matches deer or deereer or deereereer, etc. The + sign is applied to the substring within parentheses, so the regex looks for d followed by one or more of the grouping &quot;eer.&quot;</td>
</tr>
<tr>
<td>[]</td>
<td>Square bracket characters indicate a set or a range of characters.</td>
<td>d[aeiouy]+ matches da, de, di, do, du, dy, daa, dae, dai, etc. The + sign is applied to the set within brackets parentheses, so the regex looks for d followed by one or more of any of the characters in the set [aeioy].&lt;br&gt; d[A-Z] matches dA, dB, dC, and so on up to dZ. The set in square brackets represents the range of all upper-case letters between A and Z.</td>
</tr>
<tr>
<td>^</td>
<td>Carat characters within square brackets logically negate the set or range specified, meaning the regex will match any character that is not in the set or range.</td>
<td>d[^aeiouy] matches db, dc or dd, d9, d#. d followed by any single character except a vowel.</td>
</tr>
</tbody>
</table>
### Table 21-2. Character Classes (shorthand)

<table>
<thead>
<tr>
<th>Element</th>
<th>What It Means</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>\d</td>
<td>Any digit character; functionally equivalent to [0-9] or [:digit:]</td>
<td>\d matches 1, 12, 123, etc., but not 1b7. One or more of any digit characters.</td>
</tr>
<tr>
<td>\D</td>
<td>Any non-digit character; functionally equivalent to [^0-9] or [:digit:]</td>
<td>\D matches a, ab, ab&amp;, but not 1. One or more of any character but 0, 1, 2, 3, 4, 5, 6, 7, 8, or 9.</td>
</tr>
<tr>
<td>\w</td>
<td>Any &quot;word&quot; character. That is, any alphanumeric character; functionally equivalent to [A-Za-z0-9] or [:alnum:]</td>
<td>\w matches a, ab, a1, but not !&amp;. One or more upper- or lower-case letters or digits, but not punctuation or other special characters.</td>
</tr>
<tr>
<td>\W</td>
<td>Any non-alphanumeric character; functionally equivalent to [^A-Za-z0-9] or [:alnum:]</td>
<td>\W matches *, &amp;, but not ace or a1. One or more of any character but upper- or lower-case letters and digits.</td>
</tr>
<tr>
<td>\s</td>
<td>Any white space character; space, new line, tab, non-breaking space, etc.; functionally equivalent to [:space:]</td>
<td>vegetable\s matches &quot;vegetable&quot; followed by any white space character. So the phrase &quot;I like vegetables in my soup&quot; would not trigger the regex, but &quot;I like a vegetable in my soup&quot; would.</td>
</tr>
</tbody>
</table>
**Table 21-3. Character Classes**

<table>
<thead>
<tr>
<th><strong>Element</strong></th>
<th><strong>What It Means</strong></th>
<th><strong>Example</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><code>\S</code></td>
<td>Any non-white space character; anything other than a space, newline, tab, non-breaking space, etc.; functionally equivalent to <code>^[:space]</code></td>
<td><code>vegetable\S</code> matches &quot;vegetable&quot; followed by any non-white space character. So the phrase &quot;I like vegetables in my soup&quot; would trigger the regex, but &quot;I like a vegetable in my soup&quot; would not.</td>
</tr>
</tbody>
</table>
| `[:alpha:]` | Any alphabetic characters | `.REG. [[:alpha:]]` matches abc, def, xxx, but not 123 or @#$.

<p>| <code>[:digit:]</code> | Any digit character; functionally equivalent to <code>\d</code> | <code>.REG. [[:digit:]]</code> matches 1, 12, 123, etc. |
| <code>[:alnum:]</code> | Any &quot;word&quot; character. That is, any alphanumeric character; functionally equivalent to <code>\w</code> | <code>.REG. [[:alnum:]]</code> matches abc, 123, but not ~!@. |
| <code>[:space:]</code> | Any white space character; space, newline, tab, non-breaking space, etc.; functionally equivalent to <code>\s</code> | <code>.REG. (vegetable)[[:space:]]</code> matches &quot;vegetable&quot; followed by any white space character. So the phrase &quot;I like a vegetable in my soup&quot; would trigger the regex, but &quot;I like vegetables in my soup&quot; would not. |
| <code>[:graph:]</code> | Any characters except space, control characters or the like | <code>.REG. [[:graph:]]</code> matches 123, abc, xxx, &gt;&quot;, but not space or control characters. |
| <code>[:print:]</code> | Any characters (similar with <code>[:graph:]</code>) but includes the space character | <code>.REG. [[:print:]]</code> matches 123, abc, xxx, &gt;&quot;, and space characters. |
| <code>[:cntrl:]</code> | Any control characters (e.g. CTRL + C, CTRL + X) | <code>.REG. [[:cntrl:]]</code> matches 0x03, 0x08, but not abc, 123, !@#. |</p>
<table>
<thead>
<tr>
<th>ELEMENT</th>
<th>WHAT IT MEANS</th>
<th>EXAMPLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>[:blank:]</td>
<td>Space and tab characters</td>
<td>.REG. [:blank:] matches space and tab characters, but not 123, abc, !@#</td>
</tr>
<tr>
<td>[:punct:]</td>
<td>Punctuation characters</td>
<td>.REG. [:punct:] matches ; : ? ! ~ @ # $ % &amp; * 'r; &quot;r; , etc., but not 123, abc</td>
</tr>
<tr>
<td>[:lower:]</td>
<td>Any lowercase alphabetic characters</td>
<td>.REG. [:lower:] matches abc, Def, sTress, Do, etc., but not ABC, DEF, STRESS, DO, 123, !@#. Note: Enable case sensitive matching must be enabled or else it will function as [:alnum:].</td>
</tr>
<tr>
<td>[:upper:]</td>
<td>Any uppercase alphabetic characters</td>
<td>.REG. [:upper:] matches ABC, DEF, STRESS, DO, Def, Stress, Do, etc., but not abc, 123, !@#. Note: Enable case sensitive matching must be enabled or else it will function as [:alnum:].</td>
</tr>
<tr>
<td>[:xdigit:]</td>
<td>Digits allowed in a hexadecimal number (0-9a-fA-F)</td>
<td>.REG. [:xdigit:] matches 0a, 7E, 0f, etc.</td>
</tr>
<tr>
<td>ELEMENT</td>
<td>WHAT IT MEANS</td>
<td>EXAMPLE</td>
</tr>
<tr>
<td>---------</td>
<td>---------------</td>
<td>---------</td>
</tr>
<tr>
<td>^</td>
<td>Indicates the beginning of a string.</td>
<td>^ {notwithstanding} matches any block of text that began with &quot;notwithstanding&quot; So the phrase &quot;notwithstanding the fact that I like vegetables in my soup&quot; would trigger the regex, but &quot;The fact that I like vegetables in my soup notwithstanding&quot; would not.</td>
</tr>
<tr>
<td>$</td>
<td>Indicates the end of a string.</td>
<td>{notwithstanding} $ matches any block of text that ended with &quot;notwithstanding&quot; So the phrase &quot;notwithstanding the fact that I like vegetables in my soup&quot; would not trigger the regex, but &quot;The fact that I like vegetables in my soup notwithstanding&quot; would.</td>
</tr>
<tr>
<td>\</td>
<td>In order to match some characters that have special meaning in regular expression (for example, &quot;+&quot;).</td>
<td>.REG. C\C\C+++ matches 'r;C \C++'. .REG. * matches *. .REG. ? matches ?.</td>
</tr>
<tr>
<td>\t</td>
<td>Indicates a tab character.</td>
<td>(stress) \t matches any block of text that contained the substring &quot;stress&quot; immediately followed by a tab (ASCII 0x09) character.</td>
</tr>
<tr>
<td><strong>ELEMENT</strong></td>
<td><strong>WHAT IT MEANS</strong></td>
<td><strong>EXAMPLE</strong></td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>\n</td>
<td>Indicates a new line character.</td>
<td>\n matches any block of text that contained the substring &quot;stress&quot; followed immediately by two new line (ASCII 0x0A) characters.</td>
</tr>
<tr>
<td>\r</td>
<td>Indicates a carriage return character.</td>
<td>\r matches any block of text that contained the substring &quot;stress&quot; followed immediately by one carriage return (ASCII 0x0D) character.</td>
</tr>
<tr>
<td>\b</td>
<td>Indicates a backspace character</td>
<td>\b matches any block of text that contained the substring &quot;r;stress&quot; followed immediately by one backspace (ASCII 0x08) character.</td>
</tr>
<tr>
<td>\xhh</td>
<td>Indicates an ASCII character with given hexadecimal code (where hh represents any two-digit hex value).</td>
<td>\x7E(\w){6} matches any block of text containing a &quot;word&quot; of exactly six alphanumeric characters preceded with a ~ (tilde) character. So, the words 'r;~ab12cd', 'r;~Pa3499' would be matched, but 'r;~oops' would not.</td>
</tr>
</tbody>
</table>

**How do I use keywords?**

**Content Filtering > [Policy Name] > Edit Rule**

Keywords are not strictly words. They can be any of the following:
Using Keywords Effectively

ScanMail offers simple and powerful features to create highly specific filters. Consider the following, when creating your Content Filtering rules:

- By default, ScanMail searches for exact matches of keywords. Use regular expressions to set ScanMail to search for partial matches of keywords.
- ScanMail analyzes multiple keywords on one line differently than multiple keywords when each word occupies a single line.
- You can also set ScanMail to search for synonyms of the actual keywords.
- Try to use exact matching, regular expressions, operators with keywords, and import keywords to the keyword list from previous configurations.

<table>
<thead>
<tr>
<th>SITUATION</th>
<th>EXAMPLE</th>
<th>MATCH / NON-MATCH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two words on same line</td>
<td>bare sexy</td>
<td>Matches:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Click here to see bare sexy beauties.&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Does not match:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>“Click here to see bare naked sexy hotties.”</td>
</tr>
<tr>
<td>Two words separated by a comma</td>
<td>bare, sexy</td>
<td>Matches:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Click here to see hot, bare, sexy beauties.&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Does not match:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Click here to see hot, bare, and sexy beauties.&quot;</td>
</tr>
</tbody>
</table>
### Frequently Asked Questions

<table>
<thead>
<tr>
<th><strong>Situation</strong></th>
<th><strong>Example</strong></th>
<th><strong>Match / Non-match</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple words on multiple lines</td>
<td>nude</td>
<td>When you choose <em>Any specified keywords</em></td>
</tr>
<tr>
<td></td>
<td>sexy</td>
<td></td>
</tr>
<tr>
<td></td>
<td>bare naked</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Many keywords on same line</td>
<td>sex bare nude naked buff</td>
<td>Matches:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### How do I use operators with keywords?

To format keywords that use operators, refer to the following:

When typing a keyword or phrase that includes an operator, follow the format in the example below:

Example: `.WILD. valu*`

---

**Note**

The operator has a dot immediately preceding and following. There is a space between the final dot and the keyword.
## Table 21-6. Using Operators with Keywords

<table>
<thead>
<tr>
<th>Supported Keyword</th>
<th>How It Works</th>
<th>How To Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any keywords</td>
<td>ScanMail searches content that matches the word</td>
<td>Type the word and add it to the keyword list</td>
</tr>
<tr>
<td>OR</td>
<td>ScanMail searches for any of the keywords separated by OR</td>
<td>Type &quot;.OR.&quot; between all the words you want to include</td>
</tr>
<tr>
<td></td>
<td>For example: apple OR orange. ScanMail searches for either apple or orange. If content contains either, then there is a match.</td>
<td>For example: apple .OR. orange</td>
</tr>
<tr>
<td>AND</td>
<td>ScanMail searches for all of the keywords separated by AND</td>
<td>Type &quot;. AND.&quot; between all the words you want to include</td>
</tr>
<tr>
<td></td>
<td>For example: apple AND orange. ScanMail searches for both apple and orange. If content does not contain both, then there is no match.</td>
<td>For example: apple .AND. orange</td>
</tr>
<tr>
<td>NOT</td>
<td>ScanMail excludes keywords following NOT from search.</td>
<td>Type &quot;.NOT.&quot; before a word you want to exclude</td>
</tr>
<tr>
<td></td>
<td>For example: .NOT. juice. ScanMail searches for content that does not contain &quot;juice&quot;. If the message has &quot;orange soda&quot;, there is a match, but if it contains &quot;orange juice&quot;, there is no match.</td>
<td>For example: &quot;.NOT. juice&quot;</td>
</tr>
</tbody>
</table>
Frequently Asked Questions

Supported Keyword

<table>
<thead>
<tr>
<th>Supported Keyword</th>
<th>How It Works</th>
<th>How To Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>WILD</td>
<td>WILD means wildcard. The wildcard symbol replaces a missing part of the word. Any words that are spelled using the remaining part of the wildcard are matched. For example, if you want to match all words containing &quot;valu&quot;, type &quot;.WILD. valu***&quot;. The words Valumart, valucash, and valubucks all match.</td>
<td>Type &quot;.WILD.&quot; before the parts of the word you want to include</td>
</tr>
<tr>
<td>REG</td>
<td>To specify a regular expression, add a .REG. operator before that pattern (for example, .REG. a.*e).</td>
<td>Type &quot;.REG.&quot; before the word pattern you want to detect. For example: &quot;.REG. a.*e&quot; matches: &quot;ace&quot;, &quot;ate&quot;, and &quot;advance&quot;, but not &quot;all&quot;, &quot;any&quot;, nor &quot;antivirus&quot;</td>
</tr>
</tbody>
</table>

Note
ScanMail does not support using "?" in the wildcard command ".WILD.".

File Handling

How do I handle large files?

From the Security Risk Scan screen, ScanMail provides the following methods to address large-file scan lag under Scan Restriction Criteria:

- **Message body size exceeds**: ScanMail will not scan email messages larger than the size specified.
• **Attachment size exceeds**: ScanMail will not scan attachments larger than the size specified.

---

**WARNING!**

These options effectively allow a hole in your web security - large files will not be scanned. Trend Micro recommends that you only choose this option on a temporary basis.

---

**What is a compression ratio?**

The compression ratio is the uncompressed file size / compressed file size. The following table contains compression ratio examples.

**TABLE 21-7. Compression Ratio Examples**

<table>
<thead>
<tr>
<th>File Size (not compressed)</th>
<th>File Size (compressed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>500 KB</td>
<td>10 KB (ratio is 50:1)</td>
</tr>
<tr>
<td>1000 KB</td>
<td>10 KB (ratio is 100:1)</td>
</tr>
<tr>
<td>1001 KB</td>
<td>10 KB (ratio exceeds 100:1)</td>
</tr>
<tr>
<td>2000 KB</td>
<td>10 KB (ratio is 200:1)</td>
</tr>
</tbody>
</table>

**How do I calculate the size of a decompressed file?**

For compressed files, how can I calculate the "x" value and use it effectively for the option **Size of decompressed file is "x" times the size of compressed file?**

This function prevents ScanMail from scanning a compressed file that might cause a Denial-of-Service (DoS) attack. A DoS attack happens when a mail server's resources are overwhelmed by unnecessary tasks. Preventing ScanMail from scanning files that decompress into very large files helps prevent this problem from happening.

Example: For the table below, the "x" value is 100.
### Table 21-8. Decompressed File Examples

<table>
<thead>
<tr>
<th>File Size (not compressed)</th>
<th>File Size (compressed)</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>500 KB</td>
<td>10 KB (ratio is 50:1)</td>
<td>Scanned</td>
</tr>
<tr>
<td>1000 KB</td>
<td>10 KB (ratio is 100:1)</td>
<td>Scanned</td>
</tr>
<tr>
<td>1001 KB</td>
<td>10 KB (ratio is 100.1:1)</td>
<td>Not scanned *</td>
</tr>
<tr>
<td>2000 KB</td>
<td>10 KB (ratio is 200:1)</td>
<td>Not scanned *</td>
</tr>
</tbody>
</table>

* ScanMail takes the action you configure for unscannable files.

### Quarantine and Log Management

**Are UNC paths supported for quarantine and backup folders?**

ScanMail supports the usage of Universal Naming Convention (UNC) paths when configuring the quarantine and backup folders (for example, `\fileserver\directory`).

To configure a UNC quarantine or backup folder:

1. Create the necessary folder on a remote endpoint that is in the same domain as the Exchange servers.
2. Ensure that the computer accounts for the Exchange servers have read/write permissions for the UNC path.
Important

- UNC paths are not supported on Exchange Edge servers.
- UNC paths cannot contain blank spaces.
- For clustered environments, computer accounts can only select cluster nodes, not virtual server names.

Are mapped network drives supported for quarantine and backup folders?

ScanMail does not support the use of mapped network drives for the quarantine and backup folders. Use UNC paths to use remote storage locations.

How does ScanMail display the "Scan Time" or "Delivery Time" for remote servers?

ScanMail converts time data and displays the data based on the local time settings of the server polling the database.

For example, a remote server in the GMT+9 time zone queries logs from a server located in the GMT+8 time zone. A log time of 2014-12-15 13:10:21 GMT+9 is converted to 2014-12-15 12:10:21 GMT+8 when queried from the server in the GMT+8 time zone.

How does ScanMail generate centralized report data for multiple servers?

ScanMail retrieves data based on the period specified, regardless of time zone settings. If a server is in a location that has not yet reached the period specified, a value of zero records is received.
Note

For example, it is currently 14:00 GMT+8. A remote server in the GMT+8 time zone queries logs for the period of 13:00 to 14:00 from a server located in the GMT+4 time zone. The server located in the GMT+4 time zone returns no records because the current time is only 10:00.

ScanMail then displays all the data for the specified period collected from the specified servers in a single report. If server A displays 4 log items for the specified period and server B displays 5 log items for the same period, ScanMail displays 9 entries for the period.

Does the ScanMail web service port need to be added to the firewall port exception list before generating centralized logs or quarantine queries?

ScanMail requires that you add the ScanMail web service port to your firewall port exception list to perform centralized log and quarantine queries.

Note

By default, the ScanMail web service port is 16373 for HTTPS.

Can I re-create the End User Quarantine spam folder after deleting it?

After disabling and selecting the Delete End User Quarantine spam folder option, you can re-create the spam folder by enabling the Enable End User Quarantine option on the Administration > Spam Maintenance screen.

How to cleanup ScanMail email messages that were temporarily quarantined for advanced threat analysis?

If ScanMail installation/uninstallation is initiated while there are lots of email messages quarantined for advanced threat analysis, these messages will not be removed. To handle
these email messages, ScanMail automatically launches a separate tool: "toolDDAnQuarantinedMailsCleaner.exe". Usually this tool runs successful and without any issue. However, if there is any exception occurs during installation/uninstallation, you may need to run this tool manually.

---

**Procedure**

1. Run **CMD.exe** with local administrators rights.

2. Switch to ScanMail home directory.

3. Do one of the following:
   - If the tool execution is unsuccessful during installation, use the following command to execute the tool:
     
     ```
     toolDDAnQuarantinedMailsCleaner.exe install
     [SMEX_TEMP_QUARANTINE_PATH]
     ```

     **Note**
     
     Replace:
     
     - `[SMEX_TEMP_QUARANTINE_PATH]` with suspicious files quarantine path

     For example:

     ```
     toolDDAnQuarantinedMailsCleaner.exe install "C:\Program Files\Trend Micro\Smex\storage\quarantine\Advanced threats\temp"
     ```

   - If the tool execution is unsuccessful during uninstallation, use the following command to execute the tool:
     
     ```
     toolDDAnQuarantinedMailsCleaner.exe uninstall
     [SMEX_TEMP_QUARANTINE_PATH]
     [SMEX_WTP_TEMP_QUARANTINE_PATH]
     ```
Frequently Asked Questions

Note
Replace:

- \[SMEX_TEMP_QUARANTINE_PATH\] with suspicious files quarantine path
- \[SMEX_WTP_TEMP_QUARANTINE_PATH\] with suspicious URLs quarantine path

For example:

toolDDAnQuarantinedMailsCleaner.exe uninstall "C:\Program Files\Trend Micro\Smex\storage\quarantine\Advanced threats\temp" "C:\Program Files\Trend Micro\Smex\storage\quarantine\Advanced threats\SuspiciousURLs"

Logs, Quarantine Records, and Server Groups

How do I increase number of query results for each remote server?

By default, ScanMail sets a maximum value of 3000 results for each remote server. If you want to query more than 3000 records for each remote server when performing centralized log and quarantine queries, add following hidden registry key:

Path: HKEY_LOCAL_MACHINE\SOFTWARE\TrendMicro\ScanMail for Exchange\CurrentVersion

Key: MaxRemoteQuery

Type: DWORD

Note
Restart the ScanMail Master service after adding the registry value.
How do I update newly installed ScanMail servers to the Server Groups list?

Click the Refresh button the first time that you go to the Server Groups screen. This automatically polls the network and returns a list of all available ScanMail servers. If you do not click Refresh when opening the screen, each group will take some time to populate when opening each separately.

After upgrading an existing ScanMail server, click Refresh again to update the lists.

Logging On and Registration

Where can I find my Activation Code and Registration Key?

Administration > Product License

You can activate ScanMail during the installation process or later using the ScanMail console. To activate ScanMail, you need to have an Activation Code.

Obtaining an Activation Code

- You automatically get an evaluation Activation Code if you download ScanMail from the Trend Micro website.
- You can use a Registration Key to obtain an Activation Code online.
- Activation Codes have 37 characters and look like this:
  xx-xxxx-xxxxx-xxxxx-xxxxx-xxxxx-xxxxx

Obtaining a Registration Key

The Registration Key can be found on:

- Trend Micro Enterprise Solution CD
- License Certificate (which you obtained after purchasing the product)

Registering and activating your copy of ScanMail entitles you the following benefits:
• Updates to the ScanMail pattern files and scan engine
• Technical support
• Easy access in viewing the license expiration update, registration and license information, and renewal reminders
• Easy access in renewing your license and updating the customers profile
• Registration Keys have 22 characters and look like this:

  xx-xxxx-xxxx-xxxx-xxxx

When the full version expires, security updates will be disabled; when the evaluation period expires, both the security updates and scanning capabilities will be disabled. In the Product License screen, you can obtain an Activation Code online, view renewal instructions, and check the status of your product.

What if the remote SQL server database account password is changed?

When you install ScanMail with a remote SQL server, an account is required to connect to the remote SQL server. If the password for this account is changed, the password needs to be manually updated in the ScanMail configuration file.

To manually update the remote SQL server account password:

Procedure

1. Open the command line interface and navigate to the ScanMail installation path tool folder.

   The default path is `C:\Program Files\Trend Micro\Smex\tools`

2. Use `toolChangeRemoteDBPWD.exe` to encrypt the new password by typing the following:

   `toolChangeRemoteDBPWD.exe -p <output_folder_path> -c <password>`
3. Replace dbcfg_SQLPassword.txt with the newly generated file. The encrypted password file can be found:
   - For noncluster server installations:
     ScanMail installation path\config\dbcfg_SQLPassword.txt
   - For VERITAS clusters (on share disks)
     ScanMail data path\config\dbcfg_SQLPassword.txt

4. Restart the ScanMail Master service.

What if the remote Windows authentication database account password is changed?

When you install ScanMail with a remote SQL server, an account is required to connect to the remote SQL server. If the password for this account is changed, the password needs to be manually updated in the ScanMail configuration file.

To manually update the remote SQL server account password:

Procedure

1. Get all the host names for all ScanMail servers and save them in a text (.txt) file.

   Host name example:
   
   ExchangeMailbox01
   ExchangeMailbox02
   ExchangeMailbox03
   ... (and so on)

   File name example: Server.txt

2. Open the command line interface and navigate to the ScanMail installation path tool folder.

   The default path is C:\Program Files\Trend Micro\Smex\tools
3. Batch stop all the ScanMail related services using the following commands:
   - for /F %i in (Server.txt) do sc %i stop ScanMail_RemoteConfig
   - for /F %i in (Server.txt) do sc %i stop ScanMail_Master
   - for /F %i in (Server.txt) do sc %i stop ScanMail_SystemWatcher

   **Note**
   Replace *(Server.txt)* with the actual file name.

4. Batch change password for all the host names using the following commands:
   - for /F %i in (Server.txt) do sc %i config ScanMail_RemoteConfig password=[NEW PASSWORD]
   - for /F %i in (Server.txt) do sc %i config ScanMail_Master password=[NEW PASSWORD]
   - for /F %i in (Server.txt) do sc %i config ScanMail_SystemWatcher password=[NEW PASSWORD]

   **Note**
   Replace *(Server.txt)* with the actual file name.

5. Batch start all ScanMail related services using the following commands:
   - for /F %i in (Server.txt) do sc %i start ScanMail_RemoteConfig
   - for /F %i in (Server.txt) do sc %i start ScanMail_Master
   - for /F %i in (Server.txt) do sc %i start ScanMail_SystemWatcher

   **Note**
   Replace *(Server.txt)* with the actual file name.
Security Threats

What is spyware/grayware?

Spyware includes software programs and technologies (called "bots") that seek to surreptitiously collect data and transmit it back to a host source.

The category of spyware and other grayware security risks includes adware, Internet cookies, Trojans, and surveillance tools. The type of information collected by spyware ranges from the relatively innocuous (a history of visited websites) to the downright alarming (credit card and Social Security numbers, bank accounts, and passwords).

The majority of spyware/grayware comes embedded in a "cool" software package which a user finds on a website and downloads. Some spyware programs are part of a legitimate program. Others are purely illicit. The network administrator needs to determine whether a given class of software is something he or she wants to allow on the network, or something they want to block.

Spyware installs in a variety of ways, for example:

• As a by-product that results from installing software
• As a result of clicking something in a popup window
• As an invisible addition that is installed along with a legitimate download
• Through Trojans, worms and viruses

The result is typically a background Internet connection, that opens a surveillance channel to the user's computer. Multiple connections may also be established, which can lead to sluggish network performance.

When ScanMail detects spyware/grayware, it can take the following actions:

• Replace with text/file: ScanMail deletes the infected, malicious, or undesirable content and replaces it with text or a file.
• Quarantine entire message: ScanMail moves the email message to a restricted access folder.
• **Delete entire message**: ScanMail deletes the entire email message.

• **Pass**: ScanMail records the detection in logs and delivers the message unchanged.

• **Quarantine message part**: ScanMail moves the email message body or attachment to a restricted access folder.

**Growing Hazard**

Increasingly, users are installing more and more malicious types of spyware without their knowledge, either as a "drive-by download", or as the result of clicking some option in a deceptive pop-up window. What concerns corporate security departments is that the more sophisticated types of spyware can be used to monitor keystrokes, scan files, install additional spyware, reconfigure web browsers, and snoop email and other applications. In some cases, spyware can even capture screen shots or turn on web cams.

Theft of confidential information, loss of employee productivity, consumption of large amounts of bandwidth, damage to corporate desktops, and a spike in the number of help desk calls related to spyware are forcing corporations of all sizes to take action. Spyware can represent both a security and system management nightmare.

**What are phish attacks?**

A phish is an email message that falsely claims to be from an established or legitimate enterprise. The message encourages recipients to click on a link that will redirect their browsers to a fraudulent website where the user is asked to update personal information such as passwords, social security numbers, and credit card numbers in an attempt to trick a recipient into providing private information that will be used for identity theft.

When the content scanning feature in ScanMail detects a phish message, it can take the following actions:

• **Delete entire message**

  ScanMail deletes the entire message and Exchange does not deliver it.

• **Tag and deliver**

  ScanMail adds a tag to the header information of the email message that identifies it as phish and then delivers it to the intended recipient.
What is the EICAR test virus?

The European Institute for Computer Antivirus Research (EICAR) has developed a test "virus" you can use to test your product installation and configuration. This file is an inert text file whose binary pattern is included in the virus pattern file from most antivirus vendors. It is not a virus and does not contain any program code.

You can download the EICAR test virus from the following URLs:

www.eicar.org/anti_virus_test_file.htm

Alternatively, you can create your own EICAR test virus by typing the following into a text file, and then naming the file "eicar.com":

X5O!P%@AP[4\PZX54(P^)7CC)7}$EICAR-STANDARD-ANTIVIRUS-TEST-FILE!$H+H*

---

**Note**

Flush the cache in the cache server and local browser before testing.

What are false positives?

A false positive occurs when a website, URL, "infected" file, or email message is incorrectly determined by filtering software to be of an unwanted type. For example, a legitimate email between colleagues may be detected as spam if a job-seeking filter does not distinguish between resume (to start again) and résumé (a summary of work experience).

You can reduce the number of future false positives in the following ways:

1. Update to the latest pattern files.
2. Exempt the item from scanning by adding it to an Approved List.
3. Report the false positive to Trend Micro.

Are some files dangerous?

Are files under quarantine/backup folders dangerous?
ScanMail renames all files in quarantine/backup folders with specially formatted filenames that have the extension name removed. This stops Windows from directly launching the file and prevents any executable files from being launched accidentally (by double-clicking on the file or other attempts to open.)

However, there is danger for users with applications such as Microsoft™ Office 2003 that can recognize a file with it's true file type. In this situation, a user could unintentionally launch even a backup file that has no extension name.

**How do I send Trend Micro suspected Internet threats?**

You can send Trend Micro the URL of any website you suspect of being a phish site, or other so-called "disease vector" (the intentional source of security risks).

You can do one of the following:

- Send an email to: virusresponse@trendmicro.com, and specify "Phish or Disease Vector" as the Subject

**How do I send Trend Micro detected viruses?**

If you have a file you think is infected but the scan engine does not detect it or cannot clean it, Trend Micro encourages you to send the suspect file to us. For more information, refer to the following site:


Please include in the message text a brief description of the symptoms you are experiencing. The team of antivirus engineers will analyze the file to identify and characterize any virus(es) it may contain, usually the same day it is received.
Virtual Analyzer

What are different working modes in Virtual Analyzer and which one should I choose?

ScanMail provides the following two working modes of integration with Virtual Analyzer:

- **Inline mode**: Quarantines suspicious or specified messages, and sends to Virtual Analyzer for analysis. Messages will be delivered if no advanced threat is detected by Virtual Analyzer.
  
  Trend Micro recommends configuring this mode in a production environment, and configuring Attachment Types option to Highly recommendable file types.

- **Monitor mode**: Copies suspicious or specified messages and sends to Virtual Analyzer for analysis. Messages will be delivered immediately to the end user without any time delay.
  
  Trend Micro recommends configuring this mode for administrators who only need to monitor or audit advanced threats.

If ScanMail is integrated with Virtual Analyzer, can I install the latest version of ScanMail along with an older version?

If ScanMail is integrated with Virtual Analyzer, then Trend Micro strongly recommends deploying the same version of ScanMail throughout all Exchange servers in the organization.

The latest version of ScanMail can use the updated scan logic and security enhancements for email messages than the older one. Therefore, it is possible that the older version of ScanMail may not recognize the messages routed from the newer version after they are analyzed by Virtual Analyzer.
Troubleshooting

This chapter discusses some common troubleshooting tasks that administrators can perform manually.

Topics include:

- *Updating the Scan Engine Manually on page 22-2*
- *Updating the Pattern File (lpt$vpn.xxx) Manually on page 22-3*
- *Known Issues on page 22-4*
Updating the Scan Engine Manually

Although Trend Micro recommends that you schedule ScanMail to perform automatic updates of the scan engine, you can do it manually, as shown below.

Procedure

1. Download the latest scan engine from the Trend Micro website.
   

2. Extract the contents of the engv_x64dll_v####-####.zip file to a temporary directory.

3. Stop the following ScanMail services by clicking the Windows Start button and navigating to Programs > Administrative Tools > Services:

   • ScanMail for Microsoft Exchange Remote Configuration Server (ScanMail_RemoteConfig)
   
   • ScanMail for Microsoft Exchange Master Service (ScanMail_Master)

4. Back up the following scan engine file:

   • \Program Files\Trend Micro\Smex\engine\vsapi\latest\vsapi64.dll

5. Extract the new scan engine files from their temp directory to:

   \Program Files\Trend Micro\Smex\engine\vsapi\latest\

6. Start the ScanMail services:

   a. Click the Windows Start button, then Programs > Administrative Tools > Services.

   b. Right click each of the following ScanMail scan services and select Start in the pop-up menu that appears.

      • ScanMail for Microsoft Exchange Remote Configuration Server (ScanMail_RemoteConfig)
Troubleshooting

• ScanMail for Microsoft Exchange Master Service (ScanMail_Master)

Updating the Pattern File ($lpt$vpn.xxx) Manually

Procedure

1. Download the latest pattern file from the Trend Micro website.
   http://www.trendmicro.com/download/pattern.asp

2. Download and save to a temporary directory on the ScanMail server:
   • The following latest Official Pattern Release (OPR) file:
     Enterprise Pattern - Windows
   • The following Controlled Pattern Release (CPR) file:
     Enterprise Pattern - CPR

Note
A Controlled Pattern File Release (CPR) is an early release of the virus pattern file. It has been fully tested, and is intended to provide customers with advanced protection against burgeoning security risks.

3. Click the Windows Start button, then Programs > Administrative Tools > Services to stop all ScanMail services.

4. Extract the contents of the compressed file you downloaded to following folder:
   \Program Files\Trend Micro\Smex\engine\vsapi\latest

5. Restart all the ScanMail services, then refresh the ScanMail console.
Known Issues

Known issues document unexpected ScanMail behavior that might require a temporary workaround.

Trend Micro recommends always checking the readme file for information about system requirements and known issues that could affect installation or performance. Readme files also contain a description of what’s new in a particular release, and other helpful information.

Trend Micro product readme files and other documentation can be found at the Trend Micro Update Center:

http://www.trendmicro.com/download/

Known issues and possible workarounds can also be found in the Trend Micro Knowledge Base:

http://esupport.trendmicro.com/
Chapter 23

Technical Support

Learn about the following topics:

• Troubleshooting Resources on page 23-2
• Contacting Trend Micro on page 23-3
• Sending Suspicious Content to Trend Micro on page 23-4
• Other Resources on page 23-5
Troubleshooting Resources

Before contacting technical support, consider visiting the following Trend Micro online resources.

Using the Support Portal

The Trend Micro Support Portal is a 24x7 online resource that contains the most up-to-date information about both common and unusual problems.

Procedure

2. Select from the available products or click the appropriate button to search for solutions.
3. Use the Search Support box to search for available solutions.
4. If no solution is found, click Contact Support and select the type of support needed.

Tip

To submit a support case online, visit the following URL:


A Trend Micro support engineer investigates the case and responds in 24 hours or less.

Threat Encyclopedia

Most malware today consists of blended threats, which combine two or more technologies, to bypass computer security protocols. Trend Micro combats this complex malware with products that create a custom defense strategy. The Threat Encyclopedia
provides a comprehensive list of names and symptoms for various blended threats, including known malware, spam, malicious URLs, and known vulnerabilities.

Go to [http://about-threats.trendmicro.com/us/threatencyclopedia#malware](http://about-threats.trendmicro.com/us/threatencyclopedia#malware) to learn more about:

- Malware and malicious mobile code currently active or "in the wild"
- Correlated threat information pages to form a complete web attack story
- Internet threat advisories about targeted attacks and security threats
- Web attack and online trend information
- Weekly malware reports

**Contacting Trend Micro**

In the United States, Trend Micro representatives are available by phone or email:

<table>
<thead>
<tr>
<th>Address</th>
<th>Trend Micro, Incorporated</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>225 E. John Carpenter Freeway, Suite 1500</td>
</tr>
<tr>
<td></td>
<td>Irving, Texas 75062 U.S.A.</td>
</tr>
<tr>
<td>Phone</td>
<td>Phone: +1 (817) 569-8900</td>
</tr>
<tr>
<td></td>
<td>Toll-free: (888) 762-8736</td>
</tr>
<tr>
<td>Website</td>
<td><a href="http://www.trendmicro.com">http://www.trendmicro.com</a></td>
</tr>
<tr>
<td>Email address</td>
<td><a href="mailto:support@trendmicro.com">support@trendmicro.com</a></td>
</tr>
</tbody>
</table>

- Worldwide support offices:
- Trend Micro product documentation:
  [http://docs.trendmicro.com](http://docs.trendmicro.com)
Speeding Up the Support Call

To improve problem resolution, have the following information available:

- Steps to reproduce the problem
- Appliance or network information
- Computer brand, model, and any additional connected hardware or devices
- Amount of memory and free hard disk space
- Operating system and service pack version
- Version of the installed agent
- Serial number or Activation Code
- Detailed description of install environment
- Exact text of any error message received

Sending Suspicious Content to Trend Micro

Several options are available for sending suspicious content to Trend Micro for further analysis.

Email Reputation Services

Query the reputation of a specific IP address and nominate a message transfer agent for inclusion in the global approved list:

https://ers.trendmicro.com/

Refer to the following Knowledge Base entry to send message samples to Trend Micro:

File Reputation Services

Gather system information and submit suspicious file content to Trend Micro:


Record the case number for tracking purposes.

Web Reputation Services

Query the safety rating and content type of a URL suspected of being a phishing site, or other so-called "disease vector" (the intentional source of Internet threats such as spyware and malware):

http://global.sitesafety.trendmicro.com/

If the assigned rating is incorrect, send a re-classification request to Trend Micro.

Other Resources

In addition to solutions and support, there are many other helpful resources available online to stay up to date, learn about innovations, and be aware of the latest security trends.

Download Center

From time to time, Trend Micro may release a patch for a reported known issue or an upgrade that applies to a specific product or service. To find out whether any patches are available, go to:

http://www.trendmicro.com/download/

If a patch has not been applied (patches are dated), open the Readme file to determine whether it is relevant to your environment. The Readme file also contains installation instructions.
Documentation Feedback

Trend Micro always seeks to improve its documentation. If you have questions, comments, or suggestions about this or any Trend Micro document, please go to the following site:

http://www.trendmicro.com/download/documentation/rating.asp
Appendix A

ScanMail Windows Event Log Codes

Event Identifications for notifications written into Windows event logs may impact the monitoring of ScanMail. Consult the following table to understand the Windows event logs.

### Table A-1. ScanMail Windows Event Log Codes

<table>
<thead>
<tr>
<th>Event ID</th>
<th>Facility</th>
<th>Type / Severity</th>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Application</td>
<td>Error</td>
<td>None</td>
<td>Alert. ScanMail service did not start successfully.</td>
</tr>
<tr>
<td>4</td>
<td>Application</td>
<td>Error</td>
<td>None</td>
<td>Alert. ScanMail service is unavailable.</td>
</tr>
<tr>
<td>5</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Security risk scan notification.</td>
</tr>
<tr>
<td>6</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Attachment blocking notification.</td>
</tr>
<tr>
<td>7</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Content filtering notification.</td>
</tr>
<tr>
<td>17</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>Alert. Manual update successful.</td>
</tr>
<tr>
<td>18</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Alert. Last update time is older than specified time.</td>
</tr>
<tr>
<td>Event ID</td>
<td>Facility</td>
<td>Type / Severity</td>
<td>Category</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>----------</td>
<td>-----------------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>19</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>Alert. Manual scan successful.</td>
</tr>
<tr>
<td>20</td>
<td>Application</td>
<td>Error</td>
<td>None</td>
<td>Alert. Manual scan unsuccessful.</td>
</tr>
<tr>
<td>21</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Alert. Scan time exceeds specified time.</td>
</tr>
<tr>
<td>22</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Alert. The disk space on the local drive (volume) of the backup or quarantine directory is less than specified size.</td>
</tr>
<tr>
<td>23</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Alert. The size of database to keep quarantine and logs exceeds specified size.</td>
</tr>
<tr>
<td>24</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>Alert. Scheduled scan successful.</td>
</tr>
<tr>
<td>25</td>
<td>Application</td>
<td>Error</td>
<td>None</td>
<td>Alert. Scheduled scan unsuccessful.</td>
</tr>
<tr>
<td>32</td>
<td>Application</td>
<td>Error</td>
<td>None</td>
<td>Alert. Scheduled update unsuccessful.</td>
</tr>
<tr>
<td>33</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>Alert. Scheduled update successful.</td>
</tr>
<tr>
<td>34</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Web reputation notification.</td>
</tr>
<tr>
<td>35</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Data Loss Prevention notification</td>
</tr>
<tr>
<td>80</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>Alert. Outbreak Prevention Mode started.</td>
</tr>
<tr>
<td>82</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>Alert. Outbreak Prevention Mode stopped and configuration restored.</td>
</tr>
<tr>
<td>257</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Virus/Malware Outbreak Alert.</td>
</tr>
<tr>
<td>258</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Uncleanable Virus/Malware Outbreak Alert.</td>
</tr>
<tr>
<td>259</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Blocked attachment Outbreak Alert.</td>
</tr>
<tr>
<td>260</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Spyware/Grayware Outbreak Alert.</td>
</tr>
<tr>
<td>Event ID</td>
<td>Facility</td>
<td>Type / Severity</td>
<td>Category</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>----------</td>
<td>----------------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>513</td>
<td>Application</td>
<td>Error</td>
<td>None</td>
<td>Filter loading exception.</td>
</tr>
<tr>
<td>514</td>
<td>Application</td>
<td>Error</td>
<td>None</td>
<td>Adapter loading exception.</td>
</tr>
<tr>
<td>4097</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Alert. The disk space on the local drive of the MS Exchange transaction log is less than specified size.</td>
</tr>
<tr>
<td>4098</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Alert. The Microsoft Exchange mail store size exceeds specified size.</td>
</tr>
<tr>
<td>4099</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Alert. The Microsoft Exchange SMTP messages queued continuously exceeds the specified number.</td>
</tr>
<tr>
<td>4112</td>
<td>Application</td>
<td>Error</td>
<td>None</td>
<td>ScanMail Master Service stopped due to insufficient disk space. Please free up some disk space and restart ScanMail Master Service.</td>
</tr>
<tr>
<td>8193</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>EUQ. Processing manual End User Quarantine maintenance task started.</td>
</tr>
<tr>
<td>8194</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>EUQ. Processing of manual End User Quarantine maintenance task ended.</td>
</tr>
<tr>
<td>8195</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>EUQ. Processing of schedule End User Quarantine maintenance task started.</td>
</tr>
<tr>
<td>8196</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>EUQ. End of processing schedule End User Quarantine maintenance task.</td>
</tr>
<tr>
<td>8197</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>EUQ. Start to process enable End User Quarantine task.</td>
</tr>
<tr>
<td>8198</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>EUQ. End of processing enable End User Quarantine task.</td>
</tr>
<tr>
<td>Event ID</td>
<td>Facility</td>
<td>Type / Severity</td>
<td>Category</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
<td>-----------------</td>
<td>----------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>8199</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>EUQ. Start to process disable End User Quarantine task.</td>
</tr>
<tr>
<td>8200</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>EUQ. End of processing disable End User Quarantine task.</td>
</tr>
<tr>
<td>12289</td>
<td>Application</td>
<td>Error</td>
<td>None</td>
<td>&quot;The transport scan module was unable to load the ScanMail transport hook. This could be caused by improper COM registration, missing DLL files, or privilege issues with the hookSMTP.dll. Check if the required files are complete, manually register hookSMTP.dll, and restart ScanMail Master Service.&quot;</td>
</tr>
<tr>
<td>12290</td>
<td>Application</td>
<td>Error</td>
<td>None</td>
<td>The ScanMail transport scan module is unable to send IPC requests to the ScanMail Master service. Check Windows event log for system errors.</td>
</tr>
<tr>
<td>12291</td>
<td>Application</td>
<td>Error</td>
<td>None</td>
<td>The transport scan module is unable to detect ScanMail or it does not have proper permission to access ScanMail related files or registries. ScanMail Master Service has not started. Please restart ScanMail Master Service.</td>
</tr>
<tr>
<td>12292</td>
<td>Application</td>
<td>Error</td>
<td>None</td>
<td>Another transport scan module may be active. Please check if a transport scan module has already been loaded by the Exchange transport service. Another transport scan module is running.</td>
</tr>
<tr>
<td>12293</td>
<td>Application</td>
<td>Error</td>
<td>None</td>
<td>The ScanMail transport scan module is unable to create a transport agent object. Make sure the ScanMail DLL files are complete.</td>
</tr>
<tr>
<td>EVENT ID</td>
<td>FACILITY</td>
<td>TYPE / SEVERITY</td>
<td>CATEGORY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>----------</td>
<td>--------------</td>
<td>----------------</td>
<td>----------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>12294</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>&quot;Transport scan has been disabled and messages have been passed through without being scanned by ScanMail. To enable transport scanning, log on to the ScanMail Management Console and enable any of the following transport level real-time security risk scan, transport level attachment blocking, transport level content filtering, or spam prevention.&quot;</td>
</tr>
<tr>
<td>12545</td>
<td>Application</td>
<td>Error</td>
<td>None</td>
<td>The MCP agent between ScanMail and Apex Central stopped unexpectedly.</td>
</tr>
<tr>
<td>20480</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>Log on/off ScanMail product console.</td>
</tr>
<tr>
<td>20481</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>ScanMail configuration change.</td>
</tr>
<tr>
<td>20482</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>ScanMail management operation.</td>
</tr>
<tr>
<td>28672</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>Switch security risk scan methods</td>
</tr>
<tr>
<td>28673</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Smart Scan - Each time File Reputation service was Unavailable.</td>
</tr>
<tr>
<td>28675</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>Smart Scan - Each time File Reputation service was Recovered.</td>
</tr>
<tr>
<td>28676</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Smart Scan - Each time Web Reputation service was Unavailable.</td>
</tr>
<tr>
<td>28677</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>Smart Scan - Each time Web Reputation service was Recovered.</td>
</tr>
<tr>
<td>28678</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>Search &amp; Destroy - Each time a search was successful</td>
</tr>
<tr>
<td>28679</td>
<td>Application</td>
<td>Error</td>
<td>None</td>
<td>Search &amp; Destroy - Each time a search was unsuccessful</td>
</tr>
<tr>
<td>Event ID</td>
<td>Facility</td>
<td>Type / Severity</td>
<td>Category</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------------</td>
<td>-----------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>28681</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Virtual Analyzer - Each time the Virtual Analyzer was unavailable</td>
</tr>
<tr>
<td>28682</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>Virtual Analyzer - Each time the Virtual Analyzer was recovered</td>
</tr>
<tr>
<td>28684</td>
<td>Application</td>
<td>Error</td>
<td>None</td>
<td>ScanMail is unable to access its database, but ScanMail is still protecting mail traffic</td>
</tr>
<tr>
<td>24578</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>The connection between ScanMail service and its database has been recovered</td>
</tr>
<tr>
<td>28687</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Predictive Machine Learning service was unavailable</td>
</tr>
<tr>
<td>28688</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>Predictive Machine Learning service was recovered</td>
</tr>
<tr>
<td>28690</td>
<td>Application</td>
<td>Warning</td>
<td>None</td>
<td>Writing Style service was unavailable</td>
</tr>
<tr>
<td>28691</td>
<td>Application</td>
<td>Information</td>
<td>None</td>
<td>Writing Style service was recovered</td>
</tr>
</tbody>
</table>
Appendix B

Best Practices

This chapter provides best practice information.

Topics include:

• Set Up Account for Installation with Microsoft Windows Authentication on page B-2
• Real-time Scan Settings for Server Roles on page B-2
• Attachment Blocking Policies on page B-3
• Content Filtering Active Directory Integrated Policies on page B-5
• Data Loss Prevention Policies on page B-6
• Optimizing Web Reputation on page B-9
• Search & Destroy Best Practices on page B-10
• Virtual Analyzer - Integration Pre-requisites on page B-18
• Internal Domains on page B-19
• Recommended Settings on page B-20
Set Up Account for Installation with Microsoft Windows Authentication

Trend Micro recommends using the same Windows account to access the remote SQL server and to log on to the target servers.

The minimum privilege requirements for the Windows account are as follows:

- Domain User
- Local Administrators
- Organization Management
- Exchange ApplicationImpersonation role
- Domain Administrator (temporarily required if using End User Quarantine on Exchange 2013 platform)
- SQL server dbcreator role

Real-time Scan Settings for Server Roles

The following table lists the recommended real-time scan settings for different server roles.
### Table B-1. Recommended Scan Settings for Different Server Roles

<table>
<thead>
<tr>
<th>Exchange Role</th>
<th>Transport Level Real-time Scan</th>
<th>Store Level Real-time Scan</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge</td>
<td>• Security Risk Scan</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>• Email Reputation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Content Scanning</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Web Reputation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• (Optional) Attachment Blocking</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• (Optional) Content Filtering</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• (Optional) Data Loss Prevention</td>
<td></td>
</tr>
<tr>
<td>Hub</td>
<td>• Security Risk Scan</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>• Attachment Blocking</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Content Filtering</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Data Loss Prevention</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• (Optional) Email Reputation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• (Optional) Content Scanning</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• (Optional) Web Reputation</td>
<td></td>
</tr>
<tr>
<td>Mailbox</td>
<td>N/A</td>
<td>• Security Risk Scan</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• (Optional) Attachment Blocking</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• (Optional) Content Filtering</td>
</tr>
</tbody>
</table>

## Attachment Blocking Policies

The following table lists the recommended attachment blocking settings.
**Table B-2. Recommended Attachment Blocking Settings**

<table>
<thead>
<tr>
<th>Server Role</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge server</td>
<td>Disable</td>
</tr>
<tr>
<td>Transport Level Real-time Scan</td>
<td>Enable</td>
</tr>
<tr>
<td>Store Level Real-time Scan</td>
<td>Disable</td>
</tr>
</tbody>
</table>

**Exception Rule Replication**

Replicate exception rules using the Server Management console.

**Table B-3. Attachment Blocking Exception Rule Limitations**

<table>
<thead>
<tr>
<th>Resource</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform</td>
<td>Exceptions are only supported for:</td>
</tr>
<tr>
<td></td>
<td>• Exchange Server 2019</td>
</tr>
<tr>
<td></td>
<td>• Exchange Server 2016</td>
</tr>
<tr>
<td></td>
<td>• Exchange Server 2013 SP1 or above</td>
</tr>
<tr>
<td>Server roles</td>
<td>• In Edge server, ScanMail cannot obtain sufficient information from Windows Active Directory to implement attachment blocking policies.</td>
</tr>
<tr>
<td></td>
<td>• Exception rules will not be applied in Store Level real time scan, manual scan, and scheduled scan.</td>
</tr>
<tr>
<td></td>
<td>• Exception rules only display on the Summary screen for transport level real time scan.</td>
</tr>
<tr>
<td></td>
<td>• On store level scan and edge servers, only the global policy is applied.</td>
</tr>
</tbody>
</table>

**Sample Usage Scenarios**

**Scenario 1**

- Scenario:
The company policy is to prevent all users from receiving Sound attachment types, but allow users that belong to the Music Club receive mp3 files.

- Solution:
  1. Configure the Global rule to **Block specified > Sound**.
  2. Create an exception rule that applies to **Music Club**.
  3. Configure the exception rule target to **mp3**.
  4. Typical User scenario II (AB Exception)

**Scenario 2**

- Scenario:
  The company policy is to block .mp3, .doc, and .exe files. However, allow the Music Club to receive .mp3 files and allow ScanMail to receive .exe files.

- Solution:
  1. Set the Global policy to block .mp3, .doc, and .exe files.
  2. Create an exception rule named **Music Club** and configure it to pass .mp3 files and set the priority to 1.
  3. Create an exception rule named ScanMail and configure it to pass .exe files and set the priority to 2.

**Known Issue**

If a user belongs to both the Music Club and ScanMail groups, when an email message includes .mp3, .doc, and .exe files, the user will receive the .doc and .exe files.

**Content Filtering Active Directory Integrated Policies**

The following table lists the recommended Content Filtering settings.
**Table B-4. Recommended Content Filtering Settings**

<table>
<thead>
<tr>
<th>Server Role</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge server</td>
<td>Disable</td>
</tr>
<tr>
<td>Transport Level Realtime Scan</td>
<td>Enable</td>
</tr>
<tr>
<td>Store Level Realtime Scan</td>
<td>Disable</td>
</tr>
</tbody>
</table>

**Content Filtering Policy Replication**

Use Server Management to replicate settings between different exchange servers. Only replicate the settings between same server roles.

**Table B-5. Content Filtering Policy Limitations**

<table>
<thead>
<tr>
<th>Resource</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform</td>
<td>Policies are only supported for:</td>
</tr>
<tr>
<td></td>
<td>• Exchange Server 2019</td>
</tr>
<tr>
<td></td>
<td>• Exchange Server 2016</td>
</tr>
<tr>
<td></td>
<td>• Exchange Server 2013 SP1 or above</td>
</tr>
<tr>
<td>Server roles</td>
<td>• Content filtering policies only apply for Transport level real-time scan</td>
</tr>
<tr>
<td></td>
<td>• Store level scan and edge server only apply the global policy.</td>
</tr>
</tbody>
</table>

**Data Loss Prevention Policies**

The following table lists the recommended Data Loss Prevention settings for real-time scans.
### TABLE B-6. Recommended Data Loss Prevention Settings

<table>
<thead>
<tr>
<th>SERVER ROLE</th>
<th>SETTING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hub server</td>
<td>Apply policies to &quot;Outbound messages&quot;</td>
</tr>
<tr>
<td>Edge server</td>
<td>Disable</td>
</tr>
</tbody>
</table>

**Note**

When Data Loss Prevention policies only apply to outbound messages, no policy violations trigger for the internal domains. This will highly improve the real-time scan performance of Data Loss Prevention.

---

### Data Identifiers and Template Creation

Data Loss Prevention includes over 100 predefined templates and data identifiers that administrators can use to create Data Loss Prevention policies. These predefined templates and data identifiers should cover the majority of a company’s Data Protection needs. Trend Micro recommends using the built-in items when creating policies.

If the predefined items do not meet a company’s specific needs, administrators can copy the existing items and modify them accordingly. Select the desired template or data identifier and click **Copy**. Click the newly created item (<DLP Item>_Copy) to edit the content.

**Note**

Predefined Data Loss Prevention templates and data identifiers cannot be modified or deleted.

Administrators that require completely new expressions can create unique expressions using the web console. ScanMail Data Loss Prevention expressions follow the Perl Compatible Regular Expression (PCRE) format. Trend Micro recommends testing the user-defined expressions before implementing the new expression in a Data Loss Prevention policy.
Tip

Save the expression only if the testing was successful. An expression that cannot detect any data wastes system resources and may impact performance.

ScanMail allows administrators to import and export Data Loss Prevention templates and data identifiers in DAT files. To edit the contents of a DAT file, import the items back into the ScanMail environment first. Modifying the contents of an exported DAT file can cause data corruption and unusable data.

Data Loss Prevention Policy Replication

When replicating settings between servers using the Server management console, Trend recommends replicating the Data Loss Prevention policy settings between the same server roles.

To maintain the integrity of your Data Loss Prevention policies, ensure that each Exchange server has an identical copy of the current Data Loss Prevention Templates.

Data Loss Prevention: Hidden Keys

You can configure Data Loss Prevention through use of the following hidden keys.

**TABLE B-7. Hidden Keys Used in Data Loss Prevention Configuration**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EmMaxEntitySize</td>
<td>REG_DWORD</td>
<td>Use this key to customize the bypassing attachment size for Data Loss Prevention scans. The hidden key indicates the file scan threshold in megabytes.</td>
</tr>
<tr>
<td>DmcDisableMask</td>
<td>String</td>
<td>Use this key to bypass the scanning of specified file types. By default, Data Loss Prevention scans all files types. The hidden key allows you to choose file types not to scan. This applies to all scan types.</td>
</tr>
</tbody>
</table>
Optimizing Web Reputation

You can optimize the performance of the web reputation scanning by configuring your settings in several different ways. Consider implementing the following web reputation settings to optimize network and scanning performance:

- Enable the **Bypass internal domain urls** option. This will allow ScanMail to bypass messages containing internal domain URLs, which will reduce network bandwidth usage and reduce the Virtual Analyzer working load if **URL Analysis** is enabled.

- Add your company's internal URL to the "Approved URL List". This will allow ScanMail to bypass messages containing internal URLs, which will reduce network bandwidth usage and improve performance.

- Use a Smart Protection Server to reduce network bandwidth usage. Web reputation services sends URL queries to the external Smart Protection Network or to the local Smart Protection Server. Networks can suffer a performance impact with a slow Internet connection when querying the Smart Protection Network. Configure a Smart Protection Server using the management console and change the web reputation source by clicking **Smart Protection > Scan Service Settings**.

- To optimize Smart Protection Server performance, consider a dedicated Smart Protection Server for ScanMail. If your Smart Protection Server is providing services to both ScanMail and OfficeScan, for example, server performance could suffer.

- Scanning attachments for URLs can introduce a performance impact to your system. If you are already using content filtering or Data Loss Prevention policies with attachment scanning, the URL scanning in attachments should introduce a limited impact to your system. If you are not using content filtering or Data Loss Prevention policies with attachment scanning, using the URL scanning in attachments can noticeably affect performance.
Troubleshooting Web Reputation Performance Issues

If web reputation services is experiencing poor performance, try the following to test your web reputation settings:

- Verify that the network connection is stable.

  ScanMail monitors its connection status to the Smart Protection Network and the Smart Protection Server providing web reputation services. Enable the alert "Smart Protection Server - Each time Web Reputation service was unavailable/recovered" to receive notifications whenever ScanMail is unable to connect to the web reputation source. If you frequently receive this alert, it is an indication that your network connection is not very stable.

- Test the speed of one web reputation query

  You can check the web reputation performance log to monitor the speed of the web reputation queries. Add the line `wtp_performance:1` to the registry key `DebugModule`. The registry key path is as follows:

  `HKEY_LOCAL_MACHINE\SOFTWARE\TrendMicro\ScanMail for Exchange\CurrentVersion`

  ScanMail will then generate the file `wtp_performance.log` in the ScanMail debug folder located in `<ScanMail install path>\Debug`. The default debug folder path is as follows:

  `C:\Program Files\Trend Micro\Smex\Debug`

  This log will list the time it took to query each URL (in milliseconds).

  **Note**

  You do not need to enable the ScanMail debug log to perform this check.

Search & Destroy Best Practices

Take note of the following best practices when configuring the Search & Destroy feature.
Search & Destroy Prerequisites on page B-11

Configuring Search & Destroy in a Multiple Data Center Environment on page B-14

Using Search & Destroy in Mixed Exchange Environments on page B-12

Optimizing Search Criteria on page B-14

Optimizing Mailbox Searches on page B-15

Deleting Mailbox Searches on page B-15

Exchange Management Shell Commands on page B-16

**Search & Destroy Prerequisites**

Before using Search & Destroy in the Exchange environment, take note of the following prerequisite knowledge.

**Table B-8. Features**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service account</td>
<td>This account performs the backend searches in the Exchange environment. Only one service account is necessary for the entire organization. Configure the service account as follows:</td>
</tr>
<tr>
<td></td>
<td>• Ensure that the account is a member of the Exchange discovery management group</td>
</tr>
<tr>
<td></td>
<td>• Ensure that the account never expires</td>
</tr>
<tr>
<td></td>
<td>• Ensure that the account is a member of the Exchange Mailbox Import Export role to export search results to a.pst file</td>
</tr>
<tr>
<td></td>
<td>• Create a mailbox for this account (Exchange Server 2013/2016 only)</td>
</tr>
<tr>
<td></td>
<td>For details on Exchange Management Shell Commands related to the service account, see Service Account Settings on page B-16.</td>
</tr>
</tbody>
</table>
### Discovery mailbox

This mailbox stores the search result messages. ScanMail copies messages from the end users’ mailboxes into the discovery mailbox. Configure the discovery mailbox(es) as follows:

- Ensure that the discovery management group has full access permission to each discovery mailbox
- Assign at least one discovery mailbox to each data center in the organization

**Note**

Trend Micro recommends that administrators do not place the discovery mailbox in Data Availability Groups (DAG) solutions. The discovery mailbox consumes more database space when used in a DAG solution.

For details on Exchange Management Shell Commands related to the discovery mailbox, see [Discovery Mailbox Settings on page B-17](#).

---

### Using Search & Destroy in Mixed Exchange Environments

The Search & Destroy feature can only search and take action on mailboxes in Exchange environments that are the same version as the Exchange environment associated with the ScanMail installation. For administrators with multiple ScanMail servers that manage multiple Exchange versions, Search & Destroy tasks must be run separately on each ScanMail server.

For example:

A ScanMail server installed in an Exchange 2010 environment cannot perform Search & Destroy tasks on an Exchange 2013 database. To search both Exchange 2010 and Exchange 2013 databases, administrators must perform a Search & Destroy search task from the ScanMail server installed on Exchange 2010 and then run a separate Search & Destroy task from the ScanMail server installed on Exchange 2013.
ScanMail can perform Search & Destroy tasks on multiple Exchange servers if the Exchange Server versions are the same as the Exchange Server version the ScanMail server is associated with.

Preparing Exchange Server 2013/2016/2019 for Mixed Exchange Environments

Exchange Server 2013/2016 requires that the SystemMailbox{e0dc1c29-89c3-4034-b678-e6c29d823ed9} mailbox exists on the Exchange server before starting a search in a mixed Exchange environment. If the mailbox does not exist on Exchange Server 2013/2016, configure the mailbox using Exchange Management Shell Commands.

Procedure

1. Execute the command: `Get-Mailbox -Arbitration`

   Retrieves the current system mailbox information

2. Execute the command: `Get-Mailbox -Arbitration "SystemMailbox{e0dc1c29-89c3-4034-b678-e6c29d823ed9}" | New-MoveRequest -Targetdatabase "Exchange2013/2016 DB Name"

   Moves the SystemMailbox{e0dc1c29-89c3-4034-b678-e6c29d823ed9} mailbox to the Exchange Server 2013/2016 mailbox database

3. Execute the command: `Get-MoveRequest`

   Checks the status of the move operation

   Note

   The move operation may take few minutes to complete.
Configuring Search & Destroy in a Multiple Data Center Environment

Procedure

1. Select a dedicated Exchange mailbox server to perform all Search & Destroy tasks across all data centers.

2. Configure a Search & Destroy administrator using the ScanMail console.
   For details, see Configuring Search & Destroy Access Accounts on page 15-2.

3. Prepare one service account to manage all Search & Destroy tasks.

4. Prepare a separate discovery mailbox for each data center in the organization.

5. Activate Search & Destroy and assign the most used discovery mailbox as the default mailbox.
   For details, see Activating Search & Destroy on page 15-4.

6. For each data center, create a search task and only search mailboxes that reside in a single data center.
   For details, see Mailbox Search Options on page 15-9.

7. For each search task, select a discovery mailbox that resides at the same level as the target mailboxes.

Optimizing Search Criteria

When performing mailbox searches, attempt to narrow the search scope by defining the following search criteria.

- Search in message subject, body, or attachment:
  - Administrators can use KQL to search for text that only resides in specific message parts. The following examples display some simple KQL search strings:
Best Practices

Example 1: To search for messages containing the word “test” in the message subject, type `Subject:test`.

Example 2: To search for messages containing the attachment “test.xslx”, type `attachment:'test.xslx'`.


- Search for users in specific mailbox servers:
  
  ScanMail does not provide a direct way to search specific mailbox servers. Administrators can, however, create a distribution group that contains all users on a specific mailbox server and then perform a search on that distribution group.

### Optimizing Mailbox Searches

During a mailbox search, the service account copies messages from the end user mailbox to the Exchange discovery mailbox and then parses the search results to the ScanMail database. This is a time-consuming and resource-intensive task. Trend Micro recommends performing an estimate of the search results before performing the actual search.

Performing an estimate of the search results does not require the service account to copy any messages and has a limited impact on the Exchange server. After performing an estimate, administrators can optimize the search criteria before performing the actual search.

If administrators think a mailbox search may affect the performance of the Exchange server, Trend Micro recommends scheduling the search to run at off-peak hours using the **Search Later** function.

### Deleting Mailbox Searches

- To delete search result messages from end users’ mailboxes without deleting the search criteria:
Go to the search results screen and manually select the messages to delete from end users’ mailboxes. This also deletes the selected search results stored in the Exchange server discovery mailbox and the ScanMail database.

**Note**

Administrators can use the Exchange management shell commands to manually delete Exchange search tasks.

- When using the **Delete task only** function:
  - ScanMail only deletes the search criteria, task name, and search results from the ScanMail database
  - The Exchange search task still exists along with all search results stored in the discovery mailbox
  - ScanMail does not delete any messages in the end users’ mailboxes

**Note**

Use **Delete task only** to retain the search results for archival purposes.

### Exchange Management Shell Commands

Administrators can use Exchange Management Shell Commands to perform a variety of tasks on the Exchange server. Trend Micro recommends noting the following prerequisite and useful tasks:

- *Service Account Settings on page B-16*
- *Discovery Mailbox Settings on page B-17*
- *Backend Search Tasks on page B-17*

### Service Account Settings

An Exchange service account is necessary to perform the backend searches in the Exchange environment. Administrators can use the following Exchange Management Shell Commands to configure the service account:
### Table B-9. Service Account Commands

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add-RoleGroupMember -Identity &quot;Discovery Management&quot; -Member &quot;SERVICE_ACCOUNT_NAME&quot;</td>
<td>Adds the &quot;SERVICE_ACCOUNT_NAME&quot; account to the Exchange Discovery Management group</td>
</tr>
<tr>
<td>New-ManagementRoleAssignment -Role &quot;mailbox import export&quot; -User &quot;SERVICE_ACCOUNT_NAME&quot;</td>
<td>Adds the &quot;SERVICE_ACCOUNT_NAME&quot; account to the Exchange Mailbox Import Export role</td>
</tr>
</tbody>
</table>

### Discovery Mailbox Settings

An Exchange discovery mailbox is necessary to store the mailbox search result messages. Administrators can use the following Exchange Management Shell Commands to configure the discovery mailbox:

**Table B-10. Discovery Mailbox Commands**

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get-Mailbox -Filter {RecipientTypeDetails -eq &quot;DiscoveryMailbox&quot;}</td>
<td>Returns all discovery mailboxes that exist on the Exchange server</td>
</tr>
<tr>
<td>New-Mailbox &quot;NEW_DISCOVERY_MAILBOX_NAME&quot; -Discovery -database &quot;MAILBOX_DATABASE_NAME&quot;</td>
<td>Creates a new discovery mailbox named &quot;NEW_DISCOVERY_MAILBOX_NAME&quot; in the database named &quot;MAILBOX_DATABASE_NAME&quot;</td>
</tr>
<tr>
<td>Add-MailboxPermission -Identity &quot;DISCOVERY_MAILBOX_NAME&quot; -user &quot;Discovery Management&quot; -AccessRights FullAccess</td>
<td>Assigns the Exchange Discovery Management group full access permission to the &quot;DISCOVERY_MAILBOX_NAME&quot;</td>
</tr>
</tbody>
</table>

### Backend Search Tasks

When administrators create a mailbox search, ScanMail creates an Exchange search task to perform the backend search. This Exchange search task name implements the following format:
For example, for the mailbox search “task1” performed on “serverA” at 4:30 am on September 12, 2012, the Exchange search task name is:

task1serverA20120912043000

Administrators can use the following shell commands to perform actions on the backend search tasks:

**TABLE B-11. Backend Search Commands**

<table>
<thead>
<tr>
<th>EXCHANGE VERSION</th>
<th>COMMAND</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exchange Server 2013/2016 /2019</td>
<td>get-mailboxsearch</td>
<td>Returns the full search task name</td>
</tr>
<tr>
<td>Exchange Server 2013/2016 /2019</td>
<td>get-mailboxsearch -identity [task name]</td>
<td>Returns the task status</td>
</tr>
<tr>
<td>Exchange Server 2013/2016 /2019</td>
<td>remove-mailboxSearch-identity [task_name]</td>
<td>Removes the mailbox search from the Exchange server and all associated search results from the discovery mailbox</td>
</tr>
</tbody>
</table>

**Virtual Analyzer - Integration Pre-requisites**

Before enabling Virtual Analyzer integration, administrators must enable the Exchange replay folder.

**WARNING!**

Disabling the Exchange replay folder after enabling the Virtual Analyzer integration may cause unexpected issues. Trend Micro recommends disabling Virtual Analyzer integration before disabling the Exchange replay folder.

Use the following cmdlet commands to enable the Exchange replay folder using the Exchange Management Shell.
**TABLE B-12. Exchange Management Shell Cmdlet Commands**

<table>
<thead>
<tr>
<th>CMDLET</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get-TransportService</td>
<td>This cmdlet returns the current replay folder attributes. If the ReplayDirectoryPath attribute is NULL, the Exchange administrator has disabled the replay folder. The Exchange administrator must enable the replay folder using the Set-TransportService command.</td>
</tr>
<tr>
<td>Set-TransportServer -Identity {server name} -ReplayDirectoryPath &quot;E:\Program Files \Microsoft\Exchange Server \TransportRoles\Replay&quot;</td>
<td>This cmdlet enables the replay folder in the directory specified.</td>
</tr>
<tr>
<td>Set-TransportService -Identity {Server name} -PickupDirectoryMaxMessagesPerMinute 1000</td>
<td>If the message throughput of this Exchange server is high, such as 3600 messages per minute, and this situation lasts for hours, administrator should increase the maximum rate of message processing for the Pickup and Replay directories before enabling URL sandbox.</td>
</tr>
</tbody>
</table>

**Internal Domains**

- The Internal Domain settings synchronize with the accepted domains in Exchange server during ScanMail installation. This information will not update after installation completes. Trend Micro recommends synchronizing the corresponding settings when the Exchange server updates its accepted domain settings.

- ScanMail allows the usage of the asterisk (*) wildcard to specify internal domains. If you want to bypass a domain and its child domains, use the wildcard as a prefix to the parent domain. For example, if you want to bypass smex.com, child1.smex.com, and child2.smex.com, type the following:
  
  `*.smex.com`

  However, if you want to bypass a domain but still scan its child domains, type the following:
Recommended Settings

Although ScanMail is fully configurable, Trend Micro recommends the following settings:

- **Content Scanning**: Set to Quarantine message to user’s spam folder.
- **Content Filtering**: Set to Quarantine entire message:
  - Match any or apply to all
  - Match all conditions
  - Match any condition
  Set to Pass for creating an exception for a particular email account.
- **Attachment Blocking**: Set to Pass for suspicious attachments.
- **Security Risk Scan**: Clean
- **Data Loss Prevention**: Set to Quarantine entire message.
- **Other**:
  - Set to Pass for password protected or encrypted message or file.
  - Set to Pass for compressed file over scanning restrictions.
Index

A
access control
  configuring, 15-2, 19-7, 19-8
  enabling, 19-7
  permissions, 19-7
    full, 19-7
    read, 19-7
  role, 19-6
  Search & Destroy administrator, 15-2
actions, 6-9, 6-12–6-21
  advanced spam prevention, 12-4
  attachment blocking, 8-5
  compressed files, 20-10
  Data Loss Prevention, 10-23
  security risk scan, 7-6
  spam prevention
    content scanning, 11-11
    web reputation, 13-5
activating ScanMail
  Activation Code, 2-12
    additional features, 2-14
    suite, 2-13
activating Trend Micro products, 2-11, 2-16
  Activation Code
    standard, 2-13
    reactivating, 2-16
  Activation Code, 2-12
    locating, 21-20
    reactivating, 2-16
    standard, 2-13
    suite, 2-13
    suite with additional features, 2-14
ActiveAction, 1-30, 7-6
ActiveUpdate, 1-28, 2-20
  incremental updates, 1-28
advanced spam prevention, 12-2, 12-4, 12-6
  actions, 12-4
  configuring target settings, 12-3
  enabling advanced spam prevention, 12-3
  notifications, 12-6
advanced spam prevention scan, 12-3
advanced threats, 20-3
  actions, 6-9, 6-15
  APT, 20-3
  exploits, 20-3
  targeted attacks, 20-3
  zero-day attacks, 20-3
Advanced Threat Scan Engine, 7-5
  about, 7-5
  actions, 6-9, 6-15
Advanced Threat Scan Engine (ATSE) scan engine, 1-24, 7-4
adware, 20-14
alerts, 18-6, 18-7
  notifications, 18-10
  outbreak, 18-9
  system events, 18-6
Apex Central
  see Trend Micro Apex Central, 19-12
ATSE, 7-5
  about, 7-5
  actions, 6-9, 6-15
attachment blocking, 8-2
  actions, 6-9, 6-17, 8-5
    configuring, 8-5
  compressed file handling, 6-7
  enabling, 8-3
exceptions
  add, 8-7
  edit, 8-8
global policy, 8-7
logs, 18-16
notifications
  settings, 8-6
  target
  configuring, 8-4

B
Business Email Compromise (BEC), 12-2

C
Command & Control Contact Alert
Services, 13-2
  categories, 13-3
  Global Intelligence list, 13-2
  Smart Protection Server, 13-2
  Virtual Analyzer, 13-2
  Virtual Analyzer list, 13-2
compressed files, 6-7, 6-8, 20-4, 20-9, 21-14
  actions, 20-10
  compression ratios, 21-14
  compression types, 6-7
  Denial-of-Service, 6-9
compression types, 20-9
configuring
  access control, 19-7, 19-8
  advanced spam prevention scan
    target, 12-3
  internal domains, 19-11
  local sources, 5-7
  macro scans, 7-11
  notifications, 19-3
  proxy settings, 2-18, 19-2
  quarantine folder/directory, 17-2
real-time scan, 19-6
security risk scan
  target, 7-7
server groups, 19-10
special groups, 19-9
web reputation, 13-3
content filtering, 9-2
  actions, 6-9, 6-18, 6-19
  data leakage prevention, 9-3
  enabling, 9-3, 9-14
  exceptions, 9-13
  global settings, 9-4
  keywords, 21-9–21-11
  logs, 18-16
  policies, 9-4
    edit, 9-14
    enabling, 9-12
    exceptions, 9-13
    name and priority, 9-12
    selecting accounts, 9-5
    specify action, 9-10
    specify notification, 9-11
    specify target, 9-7
content scanning, 11-6
  actions, 11-11
  enabling, 11-9
  target, 11-10
criteria
  customized expressions, 10-4, 10-5
  keywords, 10-9, 10-10
customized expressions, 10-3–10-5
criteria, 10-4, 10-5
customized keywords, 10-8
criteria, 10-9, 10-10

D
data identifiers, 10-2
expressions, 10-2
    creating, 10-6
    importing, 10-7, 10-12
keyword lists
    creating, 10-11
keywords, 10-3
Data leakage prevention, 9-3
Data Loss Prevention, 10-2
    actions, 6-9, 6-19, 10-23
data identifiers, 10-2
    best practices, B-7
    expressions, 10-6, 10-7, 10-12
    keyword lists, 10-11
enabling, 10-18
expressions, 10-3–10-5
global settings, 10-19
hidden keys, B-8
keywords, 10-8–10-10
logs, 18-16
policies, 10-17, 10-19–10-21, 10-23–10-25
    actions, 10-23
    creating, 10-19
    enabling, 10-25
    name and priority, 10-25
    notifications, 10-24
    selecting accounts, 10-20
    targets, 10-21
templates, 10-12, 10-13
    best practices, B-7
    creating, 10-13
    deleting, 10-15
    exporting, 10-16
    importing, 10-15
Denial-of-Service, 6-9, 7-9, 20-2
Denial-of-Service attack, 20-3
dialers, 20-14
disease vector, 20-17
documentation feedback, 23-6
E
    EICAR, 21-26
    email reputation
        actions, 11-5
        enabling, 11-4
        target, 11-5
    email reputation services, 11-3
        advanced, 11-4
        standard, 11-3
    encoding types, 20-16
End User Quarantine, 11-7, 19-5
Enterprise Protection Strategy, 1-31
expressions, 10-2, 10-3
    customized, 10-3
        criteria, 10-4, 10-5
        predefined, 10-3
F
    false positive, 21-26
    file reputation, 5-3
File Reputation Services, 5-3
files
    uncleanable, 1-23
frequently asked questions
    backup folders, 21-15, 21-16
    calculating decompressed file size, 21-14
    central reports, 21-16
    checking pattern file updates, 21-2
    checking service pack updates, 21-2
    compression ratios, 21-14
    dangerous files, 21-26
    EICAR test virus, 21-26
    End User Quarantine spam folder, 21-17
false positives, 21-26
firewall port exceptions, 21-17
handling large files, 21-13
latest patches, 21-2
locating Activation Code, 21-20
locating Registration Key, 21-20
mapped network drives, 21-16
phish attacks, 21-25
quarantine folders, 21-15, 21-16
regular expressions, 21-3
remote SQL server password changed, 21-21
removing quarantined email messages, 21-17
sending detected viruses to Trend Micro, 21-27
sending suspected threats to Trend Micro, 21-27
spyware/grayware, 21-24
time settings, 21-16
UNC paths, 21-15
using keywords, 21-9–21-11
using operators with keywords, 21-11
virtual analyzer
working modes, 21-28

G
global policy, 8-7
global settings
    quarantine folder/directory, 17-2
grayware, 20-3

H
hacking tools, 20-14
hot fixes, 1-30

I
icons, 4-10
integrated server, 5-5
IntelliScan, 7-7, 7-8
IntelliTrap, 7-7
internal domains, 19-11
    configuring, 19-11

J
joke program, 20-10, 20-14

K
keywords, 10-3, 10-8, 21-9–21-11
    customized, 10-8–10-10
    predefined, 10-8
known issues, 22-4

L
licenses, 19-12
    registering, 2-9
local sources
    configuring, 5-7
    settings, 5-7
    Smart Protection Server, 5-7
logs, 18-15
    maintenance, 18-19
    querying, 18-18
    Search & Destroy, 15-21
    types, 18-16
    Windows events, A-1

M
machine learning, 7-5
macro scan, 7-11
macro viruses/malware, 20-11
mailbox search
    configuring, 15-13
    criteria
        date, 15-12
        discovery mailbox, 15-12
keywords, 15-10
mailbox components, 15-12
mailboxes, 15-11
specific senders or recipients, 15-12
deleting, 15-17
keywords, 15-6
modifying, 15-15
options, 15-9
results, 15-18
syntax, 15-6
types, 15-6
viewing, 15-18
maintaining security, 3-3
managing outbreak situations, 3-4
analyzing, 3-5
confirming the outbreak, 3-5
recovering, 3-6
responding, 3-5
manual scan, 6-3
alerts, 18-7
characteristics, 7-3
compressed file handling, 6-7, 6-8
settings, 6-5
manual updates, 2-19
mass-mailing attack, 20-11
master services
ScanMail EUQ Monitor, 4-10
ScanMail for Exchange Remote Configuration Server, 4-10
ScanMail for Microsoft Exchange Master Services, 4-10
ScanMail for Microsoft Exchange System Watcher, 4-10
starting and stopping, 4-10
multipurpose internet mail extensions, 20-16
N
notifications, 6-23–6-26, 19-3
about, 6-23
actions that trigger, 19-4
advanced spam prevention, 12-6
alerts, 18-10
configuring, 19-3
global settings, 19-4
web reputation, 13-6
O
one-time reports, 18-12
generating, 18-12
online help
accessing, 2-9
operator, 19-7
outbreak alerts, 18-9
Outbreak Prevention Services, 1-31
alerts, 18-7
P
password cracking applications, 20-14
patches, 1-30
updating FAQ, 21-2
pattern files, 1-27, 5-6, 21-2, 22-3
incremental updates, 1-28
Smart Scan Agent pattern, 5-7
Smart Scan pattern, 5-7
spam pattern files, 11-7
updates, 2-17
updating manually, 22-3
Web Blocking list, 5-7
PCRE, 10-4
Perle Compatible Regular Expressions, 10-4
phish, 20-2, 20-3, 20-17, 21-25
policies
content filtering, 9-4
Data Loss Prevention, 10-17
post-installation spam folder, 11-2
predefined expressions, 10-3
predefined templates, 10-13
product console, 2-2
  banner, 2-5
  configuration area, 2-8
generating help, 2-9
  side menu, 2-7
  viewing remote servers, 4-8
  viewing servers, 4-7
proxy settings, 2-18, 19-2
  configuring, 2-18, 19-2
Q
quarantine alerts, 18-7
  configuring, 17-2
folder/directory, 17-2
global settings, 17-2
  queries
    maintenance, 17-4, 17-5
    performing, 17-3
    resending messages, 17-5
quarantine folder/directory, 17-2
  alerts, 18-7
quarantine query
  maintenance
    automatic, 17-4
    manual, 17-5
    performing, 17-3
    resending messages, 17-5
R
ransomware, 20-4
reactivating Trend Micro products, 2-16
real-time monitor, 4-2
  viewing remote servers, 4-4
real-time scan, 6-2, 19-6
  characteristics, 7-2
  configuring, 19-6
registering to Apex Central, 19-14
registering ScanMail reseller purchase, 2-10
registering Trend Micro products, 2-9
  how to, 2-10
  online purchase, 2-9
Registration Key, 2-9
Registration Key
  locating, 21-20
regular expressions, 21-3
remote access tools, 20-14
remote servers
  viewing with real-time monitor, 4-4
replicating configurations, 4-9
reports, 18-12
  generating scheduled, 18-13
  maintaining, 18-15
  one-time reports, 18-12
  scheduled, 18-13
role
  operator, 19-7
S
scan engine, 1-25
  ATSE, 1-24, 7-4
  hierarchy, 7-3
machine learning, 7-5
update manually, 22-2
updates, 2-17
Virtual Analyzer, 1-25, 7-4
VSAPI, 1-24, 7-3
ScanMail EUQ Monitor, 4-10
ScanMail for Exchange Remote Configuration Server, 4-10
ScanMail for Microsoft Exchange Master Services, 4-10
ScanMail for Microsoft Exchange System Watcher, 4-10
ScanMail technology, 1-23
scans, 6-2
   about scans, 6-2
   actions, 6-9, 6-12–6-21
   logs, 18-16
   macro scan, 7-11
   manual scan, 6-3
   manual scan settings, 6-5
   on cluster servers, 6-4
   real-time scan, 6-2
   scheduled scan, 6-4
   scheduled scan settings, 6-5
scheduled scan, 6-4
   alerts, 18-7
   characteristics, 7-3
   compressed file handling, 6-7, 6-8
   settings, 6-5
scheduled updates, 2-19
Search & Destroy
   about, 15-2
   access account, 15-2
      configuring, 15-2
   activating, 15-4
   discovery mailbox, 15-4, 15-20
   event logs, 15-21
   mailbox search, 15-6
      configuring, 15-13
      deleting, 15-17
      keywords, 15-6
   modifying, 15-15
   options, 15-9
   syntax, 15-6
   types, 15-6
   viewing, 15-18
   service account, 15-4, 15-20
   settings, 15-20
   troubleshooting, 15-22
Search & Destroy administrator, 15-2
security baseline, 3-2
   managing real-time monitor, 3-2
   performing a manual scan, 3-2
   update ScanMail, 3-2
security risks, 20-2
   advanced threats, 20-3
   compressed files, 20-4
   Denial-of-Service, 20-2
   Denial-of-Service attack, 20-3
   disease vector, 20-17
   encoding types, 20-16
   grayware, 20-3
   joke program, 20-10
   macro viruses/malware, 20-11
   mass-mailing attack, 20-11
   multipurpose internet mail extensions, 20-16
   other malicious codes, 20-4
   packed files, 20-4
   phish, 20-2, 20-3, 20-17
   ransomware, 20-4
   spyware, 20-3
   spyware/grayware, 20-2, 20-13
   Trojan Horse, 20-4, 20-12
   true file type, 20-16
   virus/malware writers, 20-6
   viruses/malware, 20-4
worms, 20-4, 20-13
zip-of-death, 20-13

security risk scan
about, 7-2
actions, 6-12, 7-6
settings, 7-9
ActiveAction, 7-6
compressed file handling, 6-7, 6-8
configuring target settings, 7-7
custom settings, 7-6
enabling real-time scan, 7-7
IntelliScan, 7-7, 7-8
IntelliTrap, 7-7
logs, 18-16
notifications
settings, 7-13
summary screen, 18-4

server groups, 19-10
configuring, 19-10

server management console, 4-4
activating, 4-4
replicating configurations, 4-9
replicating servers, 4-6
view last replication, 4-6
view pattern and engine version, 4-5
view scan results, 4-5
view scan status, 4-5
view smart scan status, 4-6

Server Management Console
about, 4-4
service packs, 1-30, 21-2
services
starting and stopping, 4-10
smart protection, 5-2, 5-3, 5-5, 5-6
File Reputation Services, 5-3
Smart Protection Network, 5-5
source, 5-5, 5-6
sources
comparison, 5-5
protocols, 5-6
volume of threats, 5-2

Smart Protection, 5-3
File Reputation Services, 5-3
integrated server, 5-5
pattern files, 5-6
Smart Protection Server, 5-5
standalone server, 5-5
Web Reputation Services, 5-3
Smart Protection Network, 5-5, 13-3
web reputation, 13-3
Smart Protection Server, 5-5, 5-8, 5-9, 13-3
alerts, 18-6
integrated server, 5-5
security risk scan
alerts, 18-6
standalone, 5-5
web reputation, 5-8, 5-9, 13-3, 18-7

Smart Protection sources
integrated server, 5-5
local source settings, 5-7
Smart Protection Server, 5-5
standalone server, 5-5

spam engine, 11-7
spam maintenance, 19-5
End User Quarantine, 19-5
spam pattern files, 11-7
spam prevention, 11-2
content scanning, 11-6
actions, 11-11
enabling, 11-9
target, 11-10
email reputation
actions, 11-5
enabling, 11-4
target, 11-5
email reputation services, 11-3
End User Quarantine, 11-7
maintenance, 19-5
spam engine, 11-7
spam pattern files, 11-7
special groups, 19-9
configuring, 19-9
spyware, 20-3
spyware/grayware, 7-7, 20-2, 20-13, 21-24
adware, 20-14
dialers, 20-14
entering the network, 20-15
hacking tools, 20-14
joke program, 20-14
malware naming, 20-7
password cracking applications, 20-14
remote access tools, 20-14
risks and threats, 20-14
SQL server
manually updating password, 21-21
standalone server, 5-5
summary, 18-2
ransomware tab, 18-5
security risks, 18-4
spam tab, 18-4
system tab, 18-2
support
resolve issues faster, 23-4
support/system debugger, 19-17
modules, 19-17
using, 19-17

T
targets

web reputation, 13-4

technology
scan engine, 1-25

templates, 10-12, 10-13
creating, 10-13
deleting, 10-15
exporting, 10-16
importing, 10-15
predefined, 10-13

Trend Micro Apex Central, 19-12, 19-13
agent, 19-12
communication protocol, 19-13
communicator, 19-12
entity, 19-12
registering, 19-14
server, 19-12
unregistering, 19-16

Trend Micro Control Manager, 19-13

Trojan Horse, 20-4, 20-12
ture file type, 20-16

U
uncleanable files, 1-23
unregistering
from Apex Central, 19-16
updates
ActiveUpdate, 1-28
alerts, 18-7
download source, 2-20
latest patches FAQ, 21-2
logs, 18-16
manual updates, 2-19
pattern file, manual, 22-3
pattern files, 2-17
scan engine, manual, 22-2
scheduled updates, 2-19
updating, about, 2-17
URLs
   Knowledge Base, 22-4
   update center, 22-4
URL time-of-click protection
   enabling URL time-of-click protection, 14-2
V
   version comparison, 1-17
Virtual Analyzer, 7-4
   about, 16-2
   configuring, 16-3
   scan engine technology, 1-25
   settings, 16-3
virtual analyzer working modes, 21-28
virtual servers, 7-3
viruses/malware, 20-4, 20-11
   boot, 20-5
   file, 20-5
   malware naming, 20-7
   script, 20-6
   writers, 20-6
Virus Scan Application Programming Interface (VSA PI), 1-25
Virus Scan Engine, 1-24
   scan engine, 7-3
W
   web reputation, 13-2–13-6
      about, 13-2
      actions, 6-9, 6-21, 13-5
      alerts, 18-7
      configuring, 13-3
      enabling, 13-4
      logs, 18-16
      notifications, 13-6
      Smart Protection Network, 13-3
Smart Protection Server, 5-8, 5-9, 13-3
   targets, 13-4
Web Reputation Services, 5-3
wildcard, 21-13
wildcards, 19-11
Windows event log codes, A-1
worms, 20-4, 20-13
writing style training
   manual, 12-7
   regular, 12-7
writing style verification
   configuring, 12-9
   enabling, 12-8
Z
   zip-of-death, 20-13